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About this Guide

Revised: December 14, 2011, OL-7205-19

Introduction

This preface describes who should read the Cisco Service Control Application for Broadband User
Guide, how it is organized, its document conventions, and how to obtain documentation and technical

assi stance.

This guide assumes a basic familiarity with the concept of the Service Control solution, the Service
Control Engine (SCE) platforms, and related components.

Document Revision History

The Document Revision History below records changes to this document.

Table 1 Document Revision History
Cisco Service Control

Revision Release and Date Change Summary

OL-7205-19 |3.55 Improved the quality of the user documentation by
December 14, 2011 adding customer and internal feedback.

OL-7205-18 |3.5.5 Updated Managing Subscriber Bandwidth, page 28.
June 07, 2011

OL-7205-17 |355 Minor correction regarding global controllers.
May 30, 2011

OL-7205-16 |3.55 Updated Table 10-3 “Advanced Service Configuration
February 14, 2011 Properties’.

Updated Traffic Classification, page 3.

OL-7205-15 [355 Updated How to Install the SCA BB Configuration
January 12, 2010 Utilities section of Chapter 4.

OL-7205-14 |3.55 Added the “Easy Definition of Port-Based Protocols”

December 15, 2009

section on page 3-7. Updated Managing Procotols section
of Chapter 7.
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Table 1 Document Revision History (continued)
Cisco Service Control
Revision Release and Date Change Summary
OL-7205-13 [3.5.5 Corrected the “Anonymous Subscriber Mode” section on
August 11, 2009 page 4-34. Reorganized Chapter 9, “Using the Service
Configuration Editor: Traffic Control,” to match software
tree organization.
OL-7205-12 |3.55 Addition of information regarding global controllers.
June 15, 2009 Updated Chapter 4, “ Getting Started,” Chapter 9, “Using
the Service Configuration Editor: Traffic Control,” and
Chapter 10, “Using the Service Configuration Editor:
Additional Options.”
OL-7205-11 [3.5.0 Addition of information regarding traffic mirroring and
January, 2009 blacklist URL database.
OL-7205-10 |3.1.7 Changes to the default configuration. See Managing
December, 2008 Advanced Service Configuration Options, page 10-47.
OL-7205-09 [3.1.6 Minor correction regarding filter rules.
July, 2008
OL-7205-08 |3.1.6 Minor changes throughout the guide.
May, 2008
OL-7205-07 [3.1.5 Added the following new features:

November, 2007

- Configuration Wizards, page 4-34
See:
— How to Use the Usage Analysis Wizard,
page 4-35

— How to Use the P2P Traffic Optimization
Wizards, page 4-47

— How to Use the Reporter DB Configuration
Wizard, page 4-62

— How to Configure SCE and CM Devices Using a
Wizard, page 5-10

» DSCP ToS Classification (ToS is added as a flavor
type, see Managing Flavors, page 7-51)

- DSCP ToS Marking (see How to Manage DSCP ToS
Marker Values, page 9-73)
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Table 1 Document Revision History (continued)
Cisco Service Control
Revision Release and Date Change Summary
OL-7205-05 [3.1.0 Added the following new features:
May, 2007 « Virtual Links (see Managing Quotas, page 9-75)
« Asymmetric Routing Classification Mode,
page 10-45
» NetFlow (see NetFlow records, page 8-2)
» Quota Replenish Scatter, page 9-75
Updated the following sections of the document
« Managing Bandwidth, page 9-2
- Information About the System Modes, page 10-45
« Managing Advanced Service Configuration Options,
page 10-47
OL-7208-04 |3.0.5 Added the following new feature:
November, 2006 - The SCA BB Real-Time Monitoring Configuration
Utility, page 13-4
Updated the following sections of the document
* Quick Forwarding (see Filter Rule Actions,
page 10-20 and Automatic Quick Forwarding of
Media Flows, page 10-21)
OL-7205-03 |3.0.3 Added the following new features:
May, 2006

» Hitless Upgrade of the SLI, page 4-27

- Content Filtering (see Managing Content Filtering,
page 7-63)

« The Service Security Dashboard, page 10-2
Removed the following deprecated feature:

« Attack Filtering and Subscription Notification
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Table 1

Document Revision History (continued)

Revision

Cisco Service Control
Release and Date

Change Summary

OL-7205-02

3.0.0
December, 2005

Document name changed to Cisco Service Control
Application for Broadband User Guide.

Both the look-and-feel and the functionality of the Cisco
Service Control Application for Broadband (SCA BB)
Console were redesigned for release 3.0. Consequently,
this document underwent a major rewrite. The major
changes in this document are listed below.

« Appendixes B, C, D of the 2.5.5 release user guide
were moved to a new document: the Cisco Service
Control Application for Broadband Reference Guide.

- Chapter 8 and Appendix A of the 2.5.5 release user
guide were moved to a new document: the Cisco
Service Control Application Suite Reporter User
Guide.

» The Cisco Service Control Application Suite for
Broadband I nstallation Guide was deprecated; it
formsthe basis for part of the Getting Started chapter.

« Chapter 5 of the 2.5.5 release user guide
(Constructing Service Configurations) was
completely rewritten and split into three chapters.

« New chapters were added for the new tools included
in the Console: the Network Navigator tool and the
Signature Editor tool.
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First version of this document (then named Cisco Service
Control Application Suite for Broadband User Guide).
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Organization

This guide contains the following sections:

Table 2 Document Organization

Section Title Description

1 Cisco Service Control Overview, Provides a general overview of the Cisco Service

page 1-1 Control solution.

2 System Overview, page 2-1 Provides a functional overview of the Cisco
Service Control solution.

3 Traffic Processing Overview, Provides a technical overview of the Cisco

page 3-1 Service Control solution.

4 Getting Started, page 4-1 Guides you through the process of installing or
upgrading SCA BB and describes the concept of
the Console as a collection of tools.

5 Using the Network Navigator, Explains how to use the Network Navigator to

page 5-1 create amodel of all devices that are part of the
Cisco Service Control solution and how to
manage the devices remotely.
6 Using the Service Configuration Explains how to use the Service Configuration
Editor, page 6-1 Editor to manage service configurations.

7 Using the Service Configuration Explains how to configure service configurations
Editor: Traffic Classification, to perform traffic classification.
page 7-1

8 Using the Service Configuration Explains how to configure service configurations
Editor: Traffic Accounting and to perform traffic reporting.
Reporting, page 8-1

9 Using the Service Configuration Explains how to configure service configurations
Editor: Traffic Control, page 9-1 to perform traffic control.

10 Using the Service Configuration Documents additional, advanced options
Editor: Additional Options, page 10-1 |available in the Service Configuration Editor.

11 Using the Subscriber Manager GUI  |Explains how to use the SM GUI tool to configure
Tool, page 11-1 subscribers on the SCMS-SM database.

12 Using the Signature Editor, page 12-1 |Documents the Signature Editor tool, which can
create files for updating protocols in SCA BB.

13 Additional Management Tools and Documents and explains other tools that are

Interfaces, page 13-1

available for use with SCA BB.
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Related Publications

Use this Cisco Service Control Application for Broadband User Guidein conjunction with thefollowing
Cisco documentation:

Cisco Service Control Application for Broadband Reference Guide
Cisco Service Control Application for Broadband Service Configuration API Programmer Guide
Cisco Service Control Management Suite Collection Manager User Guide
Cisco Service Control Management Suite Subscriber Manager User Guide
Cisco Service Control Application Reporter User Guide
The SCE platform installation and configuration guides:
— Cisco SCE 1000 2xGBE Installation and Configuration Guide
— Cisco SCE 2000 Installation and Configuration Guide
— Cisco SCE8000 10GBE Installation and Configuration Guide
— Cisco SCE8000 GBE Installation and Configuration Guide
Cisco SCE 2000 and SCE 1000 CLI Command Reference
Cisco SCE8000 CLI Command Reference
Cisco SCE 2000 and SCE 1000 Software Configuration Guide
Cisco SCE8000 10GBE Software Configuration Guide
Cisco SCE8000 10GBE Software Configuration Guide
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Conventions

This document uses the following conventions:

Table 3

Document Conventions

Convention

Indication

bold font

Commands and keywords and user-entered text appear in bold font.

italic font

Document titles, new or emphasi zed terms, and arguments for which you supply
values are initalic font.

[ ]

Elements in square brackets are optional.

{xlylz}

Required alternative keywords are grouped in braces and separated by
vertical bars.

[x]ylz]

Optional alternative keywords are grouped in brackets and separated by
vertical bars.

string

A nonquoted set of characters. Do not use quotation marks around the string or
the string will include the quotation marks.

courier font

Terminal sessions and information the system displays appear in courier font.

< >

Nonprinting characters such as passwords are in angle brackets.

[ ]

Default responses to system prompts are in square brackets.

L #

An exclamation point (!) or apound sign (#) at the beginning of aline of code
indicates a comment line.

Note Means reader take note.

Tip Means the following information will help you solve a problem.

Caution  Meansreader be careful. In this situation, you might perform an action that could result in equipment
damage or loss of data.

Q)

Timesaver  Means the described action saves time. You can save time by performing the action described in

the paragraph.

A

Warning  Means reader be warned. In this situation, you might perform an action that could result in

bodily injury.
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Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What's New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general /whatsnew/whatsnew.html

Subscribe to the What's New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using areader application. The RSS feeds are afree
service and Cisco currently supports RSS version 2.0.
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Cisco Service Control Overview

Revised: December 14, 2011, OL-7205-19

Introduction

This chapter provides a general overview of the Cisco Service Control solution. It introduces the Cisco
service control concept and capabilities.

It also briefly describes the hardware capabilities of the service control engine (SCE) platform and the
Cisco specific applications that together compose the total Cisco service control solution.

- Cisco Service Control Solution, page 1-1

» Cisco Service Control Capabilities, page 1-2
- SCE Platform Description, page 1-3

« Management and Collection, page 1-4

Cisco Service Control Solution

The Cisco service control solution is delivered through a combination of hardware and specific software
solutions that address various service control challenges. Service providers can use the SCE platform to
support classification, analysis, and control of Internet and IP traffic.

Service control enables service providers to:
» Capitalize on existing infrastructure.
- Analyze, charge for, and control IP network traffic at multigigabit wire line speeds.
« ldentify and target high-margin content-based services and enable their delivery.

As the downturn in the telecommunications industry has shown, |P service providers' business models
need to be reworked to make them profitable. Having spent billions of dollars to build ever larger data
links, providers have incurred massive debts and faced rising costs. At the same time, access and
bandwidth have become commaodities where prices continually fall and profits disappear. Service
providers have realized that they must offer value-added servicesto derive more revenue from the traffic
and services running on their networks.

Cisco service control solutions allow the service provider to capture profits from | P services through
detailed monitoring, precise, real-time control, and awareness of services as they are delivered.
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Service Control for Broadband Service Providers

Service providers of any access technology (DSL, cable, mobile, and so on) targeting residential and
business consumers must find new ways to get maximum leverage from their existing infrastructure,
while differentiating their offerings with enhanced IP services.

The Cisco service control application for broadband adds a layer of service intelligence and control to
existing networks that can:

Report and analyze network traffic at subscriber and aggregate level for capacity planning

Provide customer-intuitive tiered application services and guarantee application service level
agreements (SLAS)

Implement different service levels for different types of customers, content, or applications
Identify network abusers who are violating the acceptable use policy (AUP)

Identify and manage peer-to-peer traffic, NNTP (news) traffic, and spam abusers

Enforce the AUP

Integrate Service Control solutions easily with existing network elements and business support
systems (BSS) and operational support systems (OSS)

Cisco Service Control Capabilities

The core of the Cisco service control solution isthe network hardware device: the Service control engine
(SCE). The core capahilities of the SCE platform, which support a wide range of applications for
delivering service control solutions, include:

Subscriber and application awareness—Application-level drilling into IP traffic for real-time
understanding and controlling of usage and content at the granularity of a specific subscriber.

— Subscriber awareness—The ability to map between IP flows and a specific subscriber to
maintain the state of each subscriber transmitting traffic through the SCE platform and to
enforce the appropriate policy on this subscriber’s traffic.

Subscriber awareness is achieved either through dedicated integrations with subscriber
management repositories, such asaDHCP or aRADIUS server, or through sniffing of RADIUS
or DHCP traffic.

— Application awareness—The ability to understand and analyze traffic up to the application
protocol layer (Layer 7).

For application protocolsimplemented using bundled flows (such as FTP, which isimplemented
using Control and Data flows), the SCE platform understands the bundling connection between
the flows and treats them accordingly.

Application-layer, stateful, real-time traffic control—The ability to perform advanced control
functions, including granular bandwidth (BW) metering and shaping, quota management, and
redirection, using application-layer, stateful, real-time traffic transaction processing. This requires
highly adaptive protocol and application-level intelligence.

Programmability—The ability to quickly add new protocols and adapt to new services and
applications in the service provider environment. Programmability is achieved using the Cisco
Service Modeling Language (SML).

Programmability allows new services to be deployed quickly and provides an easy upgrade path for
network, application, or service growth.

Cisco Service Control Application for Broadband User Guide
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- Robust and flexible back-office integration—The ability to integrate with existing third-party
systems at the service provider, including provisioning systems, subscriber repositories, billing
systems, and OSS systems. The SCE provides a set of open and well-documented APIsthat allows
aquick integration process.

- Scalable high-performance service engines—The ability to perform all of these operations at wire
speed.

SCE Platform Description

The SCE family of programmable network devices performs application-layer stateful-flow inspection
of IP traffic, and controls the traffic based on configurable rules. The SCE platform is a network device
that uses ASIC components and reduced instruction set computer (RISC) processors to exceed beyond
packet counting and expand into the contents of network traffic. Providing programmable, stateful
inspection of bidirectional traffic flows, and mapping these flows with user ownership, SCE platforms
provide real-time classification of network use. The classification providesthe basis of the SCE platform
advanced traffic-control and bandwidth-shaping functionality. Where most bandwidth shaper
functionality ends, the SCE platform provides further control and shaping options, including:

» Layer 7 stateful wire-speed packet inspection and classification
» Robust support for more than 600 protocols and applications, including:

— Generd—HTTR, HTTPS, FTP, Telnet, Network News Transfer Protocol (NNTP), Simple Mail
Transfer Protocol (SMTP), Post Office Protocol 3 (POP3), Internet Message Access Protocol
(IMAP), Wireless Application Protocol (WAP), and others

— Peer-to-Peer (P2P) file sharing—FastTrack-KazaA, Gnutella, BitTorrent, Winny, Hotline,
eDonkey, DirectConnect, Piolet, and others

— P2P Vol P—Skype, Skinny, DingoTel, and others

— Streaming and Multimedia—Real Time Streaming Protocol (RTSP), Session Initiation Protocol
(SIP), HTTPstreaming, Real Time Protocol (RTP) and Real Time Control Protocol (RTCP), and
others

- Programmable system core for flexible reporting and bandwidth control
- Transparent network and BSS and OSS integration into existing networks
» Subscriber awareness that relates traffic and usage to specific customers

Figure 1-1 illustrates a common deployment of an SCE platform in a network.

Cisco Service Control Application for Broadband User Guide
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Figure 1-1 SCE Platform in the Network
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Management and Collection

The Cisco service control solution includes a complete management infrastructure that provides the
following management components to manage all aspects of the solution:

« Network management
» Subscriber management
» Service Control management

These management interfaces are designed to comply with common management standards and to
integrate easily with existing OSS infrastructure (Figure 1-2).
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Management and Collection

Figure 1-2 Service Control Management Infrastructure
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Network Management

The Cisco service control solution provides complete network Fault, Configuration, Accounting,
Performance, Security (FCAPS) Management.

Two interfaces provide network management:

- Command-line interface (CLI)—Accessible through the Console port or through a Telnet
connection, the CL1 is used for configuration and security functions.

» SNMP—Provides fault management (through SNMP traps) and performance-monitoring
functionality.

Subscriber Management

Where the Cisco service control application for broadband (SCA BB) enforces policies on different
subscribers and tracks usage on an individual subscriber basis, the Cisco service control management
suite (SCMS) subscriber manager (SM) may be used as middleware software for bridging between OSS
and SCE platforms. Subscriber information is stored in the SM database and can be distributed between
multiple platforms according to actual subscriber placement.

The SM provides subscriber awareness by mapping network IDs to subscriber IDs. It can obtain
subscriber information using dedicated integration modules that integrate with AAA devices, such as
RADIUS or DHCP servers.

Subscriber information may be obtained in one of two ways:

» Push Mode—The SM pushes subscriber information to the SCE platform automatically upon logon
of a subscriber.

» Pull Mode—The SM sends subscriber information to the SCE platform in response to a query from
the SCE platform.

Cisco Service Control Application for Broadband User Guide
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Service Configuration Management

Service configuration management is the ability to configure the general service definitions of a service
control application. A service configuration file containing settings for traffic classification, accounting
and reporting, and control is created and applied to an SCE platform. The SCA BB application provides
tools to automate the distribution of these configuration files to SCE platforms. This standards-based
approach makes it easy to manage multiple devices in alarge network.

Service Control providesa GUI to edit and create these files and acompl ete set of APIsto automate their
creation.

Data Collection

Data collection occurs as follows:

1.

All analysis and data processing functions of the SCE platform result in the generation of Raw Data
Records (RDRs), which the SCE platform forwards using a simple TCP-based protocol
(RDR-Protocol).

RDRs are processed by the Cisco service control management suite collection manager.

The collection manager software is an implementation of a collection system that receives RDRs
from one or more SCE platforms. It collects these records and processes them in one of its adapters.
Each adapter performs a specific action on the RDR.

RDRs contain a variety of information and statistics, depending on the configuration of the system.
Three main categories of RDRs include;

Transaction RDRs—Records generated for each transaction, where a transaction is a single event
detected in network traffic. The identification of atransaction depends on the particular application
and protocol.

Subscriber Usage RDRs—Records generated per subscriber, describing the traffic generated by that
subscriber for a defined interval.

Link RDRs—Records generated per link, describing the traffic carried on the link for a defined
interval.

Cisco Service Control Application for Broadband User Guide
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Introduction

The Cisco Service Control Application for Broadband (SCA BB) is the Cisco Service Control solution
that allows broadband service providers to gain network-traffic visibility, to control the distribution of
network resources, and thereby to optimize traffic in accordance with their business strategies. It enables
service providers to reduce network costs, improve network performance and customer experience, and
create new service offerings and packages.

« System Components, page 2-1
- Subscribers and Subscriber Modes, page 2-3
» Service Configuration, page 2-6

System Components

The Cisco Service Control solution consists of four main components:

= The Service Control Engine (SCE) platform—A flexible and powerful dedicated network-usage
monitor that is purpose-built to analyze and report on network transactions at the application level.

For more information about the installation and operation of the SCE platform, see the Cisco SCE
Platform Installation and Configuration Guides.

» The Service Control Management Suite (SCMS) Subscriber Manager (SM)—A middleware
software component that is used where dynamic binding of subscriber information and policiesis
required. The SM manages subscriber information and provisionsit in real time to multiple SCE
platforms. The SM can store subscriber policy information internally, and act as a stateful bridge
between the AAA system (such as RADIUS and DHCP) and the SCE platforms.

For more information about the installation and operation of the SM, see the Cisco Service Control
Management Suite Subscriber Manager User Guide.

The Quota Manager (QM) is an optional component of the Subscriber Manager. It enables Service
Control solution providersto manage subscriber quota across subscriber sessions with ahigh degree
of flexibility.

For more information about the installation and operation of the QM, see the Cisco Service Control
Management Suite Quota Manager User Guide.

| oL-7205-19
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» The Service Control Management Suite (SCMS) Collection Manager (CM)—An implementation of
a collection system that receives Raw Data Records (RDRs) from one or more SCE platforms. It
collects usage information and statistics, and stores them in a database. The CM also converts
subscriber usage information and statistics into simple text-based files for further processing and
collection by external systems.

For more information about the installation and operation of the CM, see the Cisco Service Control
Management Suite Collection Manager User Guide.

» The Service Control Application (SCA) Reporter—A software component that processes data stored
by the CM and provides a set of insightful reports from this data. The SCA Reporter can run as a
standalone or as an integrated part of the Console.

Together, the SCE platform, the SCMS-CM, the SCMS-SM, and the SCA Reporter are designed to
support detailed classification, analysis, reporting, and control of | P network traffic. The SCMS-CM, the
SCA Reporter, and the SCMS-SM are optional components; not all deployments of the Cisco Service
Control solution require them. Sites that employ third-party collection and reporting applications, those
that do not require dynamic subscriber-aware processing, and those that use a RADIUS or DHCP
sniffing option may not require all of these components.

Figure 2-1 illustrates the flow of information in the Cisco Service Control solution.
» Horizontal flow—Represents traffic between subscribers and an | P network.
The SCE platform monitors traffic flow.

» Vertical flow—Represents transmission of the Raw Data Records (RDRs) from the SCE platform to
the CM.

The SM may be added to the control flow to provide subscriber data. Thisallows SCA BB to conduct
subscriber-level analysis and control.

Figure 2-1 Flow of Information in SCA BB
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Subscribers and Subscriber Modes

One of the fundamental entitiesin the Cisco Service Control solution isasubscriber. A subscriber isthe
most granular entity on which SCA BB can individually monitor, account, and enforce a policy. In the
most granular instance of the SCA BB system a subscriber is an actual customer of the service provider
on whom an individual policy isimplemented. However, you can also to use SCA BB to monitor and
control traffic at a higher granularity, such as when monitoring or controlling traffic by subnets or
aggregation devices.

One of the most important decisions to be made when designing a service control solution is what
subscribers in the system represent. This determines which subscriber mode will be used, which in turn
determines what (if any) integrations are required and what policies to define. The following sections
describe the different subscriber modes supported and, for each mode, the functions supported, any
prerequisites, and the components needed.

SCA BB supports the following four subscriber modes:

» Subscriberless mode—No subscribers are defined. Control and link-level analysis functions are
provided at a global platform resolution.

« Anonymous subscriber mode—IP addresses are controlled and monitored individually. The SCE
platform automatically identifies | P addresses as they are used and assigns them to a package.

» Static subscriber mode—Incoming I P addresses are bound and grouped statically into “ subscribers”
as configured by the system operator.

» Subscriber-aware mode—Subscriber information is dynamically bound to the IP address currently
in use by the subscriber. This can be achieved by integrating with the system (RADIUS, DHCP) that
assigns | P addresses to subscribers, or by sniffing this information. Policy information is either
administered to SCA BB directly or provisioned dynamically via an integration.

Subscriberless Mode

Note

Subscriberless mode is the choice for sites where control and analysis functions are required only at a
global platform resolution. It can be used, for example, to monitor and control the total P2P traffic over
the link.

Subscriberless mode requires no integration; hence the SCMS-SM is not required.

Subscriberless mode is not influenced by the number of subscribers or inbound IP addresses Thus the
total number of subscribers using the monitored link is unlimited from the point of view of the SCE
platform.

| oL-7205-19
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Anonymous Subscriber Mode

Anonymous subscriber mode provides the means to analyze and control network traffic at
subscriber-inbound 1P address granularity. Use this mode when you do not require
subscriber-differentiated control or subscriber-level quota tracking, when analysison an IP level is
sufficient, or when offline |P-address/subscriber binding can be performed. For example, you can
identify which subscribers generate the most P2P traffic by identifying the top | P addresses and
correlating them to individual subscribers using RADIUS or DHCP logs. The total bandwidth of P2P
traffic allowed for each subscriber can also be limited.

Anonymous subscriber mode requires no integration or static configuration of the | P addresses used, so
the SCMS-SM is not required. Rather, ranges of |1P addresses are configured directly on the SCE
platform, for which the system dynamically creates “anonymous” subscribers, using the |P address as
the subscriber name.

N
Note  Thetotal number of concurrently active anonymous subscribers supported by the SCE platform is the
same as the total number of concurrently active subscribers.
Static Subscriber Mode

Static subscriber mode binds incoming | P addresses together into groups, so that traffic from and to
defined subscribers can be controlled as a group. For example, you can define all traffic from and to a
particular network subnet (used by multiple subscribers concurrently) as a (virtual) “subscriber” and
controlled or viewed as a group.

Static subscriber mode supports cases in which the entity controlled by the Cisco Service Control
solution uses a constant |P address or address range that does not change dynamically, such as:

» Environmentswhere the subscriber | P addresses do not change dynamically via, for example, DHCP
or RADIUS

» Deploymentsinwhich agroup of subscribers using acommon pool of | P addresses (such asall those
served by a particular aggregation device) will be managed together to provide a shared bandwidth
to the entire group

The system supports the definition of static subscribers directly on an SCE platform; it does not require
external management software (such as the SCMS-SM). Use the SCE platform CLI to define the list of
subscribers, their |P addresses, and the associated package.

Subscriber-Aware Mode

In subscriber-aware mode, the SCE is populated by subscriber information (OSS ID and policy) that is
dynamically bound to the (1P) address currently in use by the subscribers. Regardless of the IP address
in use, this provides differentiated and dynamic control per subscriber and subscriber-level analysis. Use
this mode to control and analyze traffic on a subscriber level, to monitor subscriber usage, and to assign
and enforce different control policies (packages) for different subscribers.

In this mode, the SCMS-SM may provision the SCE platform with subscriber information.

Cisco Service Control Application for Broadband User Guide
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Table 2-1

Subscribers and Subscriber Modes

Table 2-1 summarizes the different subscriber modes supported by the system.

Summary of Subscriber Modes

Mode

Features Supported

Main Advantages

Use for...

Subscriberless
mode

» Global (platform-level)
analysis and control

» No subscriber configuration
required.

Global control solution or
subscriber-level analysis.

Examples:

» Control P2P uploads at
peering points.

- Limittotal bandwidth of P2P
to a specified percentage.

Anonymous
subscriber mode

» Global analysis and control

e Individual IP address-level
analysis and control

» No subscriber configuration
required; only define
subscriber 1P address ranges
used.

» Provide subscriber-level
control without integration.

IP-level analysisor control that is
not differentiated per subscriber,

and where offline

| P-address/subscriber binding is

sufficient.

Examples:

e Limit P2P bandwidth per
subscriber.

» ldentify top subscribers by
identifying top IP addresses
and correlating them with
RADIUS or DHCP logs.

Static subscriber
mode

» Global analysis and control

- Control based on individual
or group |P addresses as
configured statically to the
SCE platform

= One-time static subscriber
configuration, with no
integration requirements.

» Manage subscriber traffic in
logical groups.

Control of traffic of groups of
subscribers.

Example:

» Assign abandwidth limit for
P2P traffic for each group of
subscribers using a single
CMTS device.

Subscriber-aware
mode

« Full system functionality

- Differentiated and dynamic
control per subscriber.

» Subscriber-level analysis,
regardless of |P addressin
use.

Control and analysis of traffic on
a subscriber level.

Examples:

» Monitor subscriber-usage,
regardless of |P addresses.

- Assign different control
policies (packages) to
different subscribers, and
change packages
dynamically.
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Service Configuration

Service configuration defines the way the SCE platform analyses and controls traffic. In very general
terms, asillustrated in Figure 2-2, service configuration defines the following:

» Protocol and service classification
» Packages and policies
« Bandwidth controllers

« Global controllers

Figure 2-2 Service Configuration
® Services 3
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and utilities
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” configuration
® Bandwidth controllers (PQB file)
® Global controllers

® Time frames J

Apply/retrieve service
configuration definition

Service configuration is accomplished using one of the following:
- The Console
» The SCA BB Service Configuration Utility
« The Service Configuration API

The SCA BB Console

The SCA BB Consoleisaset of GUI tools that are used to manage, configure, and monitor the solution
components.

The Console is fully documented in the remainder of this guide.

The Service Configuration Utility

The SCA BB Service Configuration Utility (servconf) isasimple command-line utility that you can use
to apply PQB configuration files onto SCE platforms or to retrieve the current configuration from an
SCE platform and save it as a PQB file. The utility configures SCE platforms with the service
configuration defined in a PQB file. You can install and execute it in a Windows or Solaris environment.

For full documentation of servconf, see The SCA BB Service Configuration Utility, page 13-1.
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The Service Configuration API

The Service Configuration API is a set of Java classes used to:
» Program and manage service configurations
- Apply service configurations to the SCE platforms
» Integrated applications with third-party systems
This allows service providers to automate and simplify management and operational tasks.

The Service Configuration APl is documented in the Cisco Service Control Application for Broadband
Service Configuration APl Programmer Guide.

Cisco Service Control Application for Broadband User Guide
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Traffic Processing Overview
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Introduction

This module describes how the Cisco Service Control Application for Broadband (SCA BB) installed on
a Service Control Engine (SCE) platform processes traffic.

The module also defines the main elements (service configuration entities) of the SCA BB system and
explains how they relate to each other.

Routing Environment, page 3-2

Traffic Processing, page 3-2

Traffic Classification, page 3-3

Traffic Accounting and Reporting, page 3-11
Traffic Control, page 3-15

Other Traffic Processing Features, page 3-20
Service Configurations, page 3-23
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Routing Environment

Traffic processing depends on the routing environment. The Cisco Service Control solution can operate
in two typical routing schemes:

Symmetric (Normal)—For most flows the inbound and outbound traffic is routed through one SCE
platform. For a marginal number of flows only one direction goes through this SCE platform.

Asymmetric—For asignificant number of flows, only one direction (inbound or outbound) is routed
through the SCE platform. For other flows, both directions go through this SCE platform.

A flow is bidirectional when the inbound and outbound traffic of the flow pass through the same
SCE platform. A unidirectional flow is one where only one of the inbound traffic and the outbound
traffic go through the SCE platform.

The Cisco Service Control solution can handle both unidirectional and bidirectional flows. The SCE
platform can be configured to operate in either a symmetric or an asymmetric routing environment.
The traffic processing capabilities of the SCE platform in the asymmetric environment is a subset of
its capabilities in the symmetric environment.

When the Cisco Service Control solution is deployed in an asymmetric routing environment, and
unidirectional classification is enabled, the SCE platform classification is better tuned to identify
traffic based on a single direction. The SCE platform handles unidirectional flows independently,
with no synchronization with other SCE platforms that might handle the flows' opposite direction.

Traffic Processing

There are three stages of traffic processing:

Traffic classification—SCA BB analyses traffic flows and determines their type (for example,
browsing, e-mail, file sharing, or voice).

Traffic accounting and reporting—SCA BB performs bookkeeping and generates Raw Data Records
(RDRs) that let you analyze and monitor the network.

Traffic control—SCA BB limits and prioritizes traffic flows according to their service,
subscriber-package, subscriber quota state, and so on.

These three stages are described in the following sections.

You control how classification, reporting, and control are performed by editing service configurations
and applying them to the SCE platform.
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Traffic Classification

Traffic processing starts with traffic classification, which categorizes network sessions into services.

For each commercial service that a provider offersto its subscribers, a corresponding service is defined
in the Cisco Service Control solution. You can use this service to classify and identify the traffic, report
on its usage, and control it.

Cisco SCE internal architecture has two concepts that aid traffic classification:

- Hardware flow—created entirely in hardware, with a maximum limit of 32 million flows on
SCE8000.

- Software flow—created in software, with a maximum limit of 16 million flows on SCE8000.
Each flow context is unidirectional. Flows are opened based on the following logic:

« If theflow isonfilter list or traffic rule with ignore, it isignored and bypassed

» |If the packet is Non-IP, it isignored and bypassed

- If the packet is larger than 1600 bytes, it is ignored and bypassed

« If the packet is TCP-retransmit or has wrong checksum, packet isignored and bypassed

- If the packet matches any of the active attack filters, it isignored and bypassed

« |If the packet is TCP and the flow isin half-open state (3 way handshake), hardware flow is created
for each direction

» |If the packet is TCP and isin established state, software flows (2 unidirectional) are created for the
first payload packet

- If the packet is UDP, hardware flows are created for first packet in each direction.
» If the packet is UDP, software flow is created for the 5th packet.

This helps to avoid creation of software flows for port-scans, and thus, protect SCE from DoS
conditions. Port-scans are still detected because their flows are opened in hardware temporarily.
Also, someflowsarestill opened on 1st packet, based on SCA-BB GUI options (Advanced settings).

« If theflow isnon-TCP, non-UDP but still IP (for example, ICMP), hardware flow is opened for each
direction on first packet

« If theflow isnon-TCP, non-UDP but still 1P (for example, ICMP), software flow is opened for each
direction on 2nd packet

User counters, Service Counters, and Protocol counters are updated, and RDRs are generated only for
software flows.

» Services, page 3-4

» Protocols, page 3-6

- Initiating Side, page 3-8

e Zones, page 3-8

» Flavors, page 3-9

« Mapping Flow Attributes to Services, page 3-11

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter 3 Traffic Processing Overview |

W Traffic Classification

Services

Note

Note

In the traffic classification process, SCA BB categorizes network sessions into services.
Services are the building blocks for:
» Service configurations (because SCA BB can enforce different rules on different services)
» Aggregated usage reporting

From aprovider’s point of view, aserviceisanetwork product sold to asubscriber. The serviceisusually
a network application—such as browsing, e-mail, file sharing, or voice—that the subscriber uses. From
atechnical point of view, a service consists of one or more service elements, each of which enables a
decision about the service associated with a network traffic flow type.

A number of services are predefined in the default service configuration (these services are listed in the
“Default Service Configuration Reference Tables” chapter of the Cisco Service Control Application for
Broadband Reference Guide). You can modify these services and add additional servicesto a service
configuration.

A service configuration can contain up to 500 services.

The classification process occurs when a session starts. The process examines the first few packets of
the session and decides to which service the session belongs. The session is then assigned a service ID
that remains the same during the session’s life cycle.

Trafficis classified and mapped to services on the basis of some or all of the following service elements:;

» Protocol—The protocol used. This allows, for example, the mapping of browsing flows and e-mail
flows to separate services.

 Initiating side—Whether the subscriber side or the network side generated the flow. Thisallows, for
example, the mapping of subscriber-initiated and network-initiated peer-to-peer traffic to separate
services.

» Zone—Lists of IP addresses of the network-side host of the flow. This allows, for example, the
mapping of all voice flows going to a specified server to a specific service.

- Flavor—Specific Layer 7 properties such as host hames of the network-side host of the flow. This
allows, for example, the mapping of all HTTP flows where the URL matches a certain pattern to a
specific service.

Flavors are not used for classification when unidirectional classification is enabled.

SCA BB uses these flow mappings to map each network connection passing through it to a service. You
define rules for the different services to implement control policies. The classification rules can contain
Layer 3 and Layer 4 parameters (such as port numbers and | P addresses), and also Layer 7 parameters
(such as host name and user agent for HT TP connections).

SCA BB cannot achieve 100% classification of all P2P services, because some P2P applications are very
persistent in trying to connect. They use many alternate protocols and connection schemes. Their native
protocol isencrypted and this encryption tendsto change whenever anew versionisreleased. This means
that if you try to block the P2P traffic, the client may eventually connect in some cases. A better approach
may be to limit bandwidth for this traffic to make it ineffective instead of trying for a complete block.

Cisco Service Control Application for Broadband User Guide


http://www.cisco.com/en/US/docs/cable/serv_exch/serv_control/broadband_app/rel355/scabbrg/scabbrg.html
http://www.cisco.com/en/US/docs/cable/serv_exch/serv_control/broadband_app/rel355/scabbrg/scabbrg.html
http://www.cisco.com/en/US/docs/cable/serv_exch/serv_control/broadband_app/rel355/scabbrg/01_SCA_BB_RG.html

| Chapter3

Traffic Processing Overview

Service Elements

Note

Traffic Classification W

A service consists of one or more service elements; different network traffic flow types are mapped to
different service elements.

A service element maps a specific protocol, initiating side, zone, and flavor to the selected service. Some
or al of these parameters can take wild-card values.

When unidirectional classification is enabled, the flavor of a service element is always the wild-card
value.

A traffic flow is mapped to a specific service if it meets all four of the following criteria:

The flow uses the specified protocol of the service element.

The flow matches the initiating side specified for the service element.

The destination of the flow is an address that belongs to the specified zone of the service element.
The flow matches the specified flavor of the service element.

If aflow matches two service elements and one is more specific than the other, the flow will be
mapped to the more specific of the two.

For example: Service A is defined for browsing and Service B is defined for browsing to a specific
list of URLs. A browsing flow to a URL on Service B’s list matches both services, but will be
mapped to Service B.

If aflow matches one parameter of one service element and a different parameter of another service
element, precedence will be given first to matching flavors, then to protocols, then to zones, and
finally to the initiating side.

For example: Service A is defined for e-mail and Service B is defined for all traffic to a specific
network zone. An e-mail flow to the specific network zone matches both services, but will be
mapped to Service A.

| oL-7205-19
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Examples of Services

Protocols

Table 3-1 contains examples of services and their network parameters.

Table 3-1 Examples of Services and Service Parameters

Service Name Protocol Initiating Side Zone Flavor

Web Browsing HTTP Subscriber- * *
HTTPS initiated

Web Hosting HTTP Network-initiated |* *

(network-initiated [HTTPS

browsing)

Local SMTP SMTP * Local-mail servers |*

(215.53.64.0/24)

One of the main classifications of aflow isthe protocol of asession (that is, of the network application
that generated the session).

A protocol, as defined in the SCA BB system, is a combination of one or more signatures, one or more
port numbers, and a transport type. The protocol of the network flow is identified according to these
parameters. For example, if the port number is 80, the transport type is TCP, and content matches the
HTTP signature, SCA BB maps the flow to the HTTP protocol.

The default service configuration contains along list of predefined protocols. You can add additional
protocols.

When a TCP or UDP flow does not match a specific protocol definition, SCA BB maps the flow to the
Generic TCP or Generic UDP protocol.

When anon-TCP/UDP flow does not match a specific protocol definition, SCA BB maps the flow to the
Generic IP protocol.

When unidirectional classification is enabled protocol classification is performed in the normal way,
with one exception: unidirectional UDP flows. In this case, SCA BB triesto classify the protocol using
the destination port of the first packet. If no exact match isfound, SCA BB triesto classify the protocol
using the source port.

[l Cisco Service Control Application for Broadband User Guide
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Protocol Elements

A protocol is a collection of protocol elements.

A protocol element maps a specific signature, | P protocol, and port range to the selected protocol. Some
or all of these parameters can take wild-card values; port numbers can take range values.

A traffic flow is mapped to a specific protocol if it meets all three of the following criteria:
« The flow matches the specified signature of the protocol element.
» Theflow protocol matches the IP Protocol of the protocol element.
« The flow matches the specified port range of the protocol element.

- If aflow matches two protocol elements and one is more specific than the other, the flow will be
mapped to the more specific of the two.

For example: Protocol A isdefined for flowsthat match the FTP signature and Protocol B is defined
for flows that match the FTP signature on TCP port 21. An FTP flow on port 21 matches both
protocols, but will be mapped to Protocol B.

- If aflow matches the signature of one protocol element and the port of another protocol element; it
will be mapped to the matching signature.

For example: Protocol A isdefined for flows that match the FTP signature and Protocol B is defined
for flows on TCP port 21. An FTP flow on port 21 matches both protocols, but will be mapped to
Protocol A.

Easy Definition of Port-Based Protocols

Note

All generic (unclassified) traffic on a specific port can be assigned to a protocol, by adding the
protocol-element in the form <* Generic” signature, specific port> to that protocol. When the “ Generic”
signature on a specific port is assigned to a protocol, the “Behavioral” signatures are automatically
assigned to that protocol as well. For example, in the default configuration, the “Generic” signature on
port 555 is assigned to the H20 protocol, and therefore the “ Behavioral Upload/Download” signature on
port 555 is also automatically assigned to the H20 protocol.

This assignment is done automatically, so users do not need to do the assignment manually. These
protocol-elements that are added automatically are not displayed in the GUI. If, on the other hand, users
want to assign the “Behavioral Upload/Download” signature on a specific port to a different protocol,
they can do it by creating an appropriate protocol-element and assigning it to the other protocol.

In the default configuration, the HTTP protocol definition accepts not just the HTTP signature, but also
all other generic (unclassified) traffic on port 80, by including the protocol-element <* Generic”
signature, port 80>. As described above, when a protocol-element in this form, <“Generic” signature,
specific port>, isused in acertain protocol definition, the SCE maps both the generic and the behavioral
signatures, on the specified port, to that protocol.

In the case of HTTP, this means that traffic on port 80, which is classified as “Behavioral
Upload/Download” signature, would also be assigned to the HTTP protocol. As described above, the
purpose of this behavior isto allow easy definition of port-based protocols. Nevertheless, this behavior
can be avoided, by adding the protocol-element <"Behavioral” signature, specific port> to a different
protocol.

| oL-7205-19
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Signatures

SCA BB examines traffic flows using the SCE platform’s deep-packet-inspection capabilities, and
compares each flow with an installed set of protocol signatures to identify the network application that
generated the flow.

SCA BB comeswith aset of predefined signaturesfor common network applications and protocols, such
as browsing, e-mail, file sharing, and Vol P.

When unidirectional classification is enabled and a unidirectional flow (inbound or outbound) passes
through the SCE platform, the flow is matched against a special set of unidirectional protocol signatures.
When abidirectional flow passes through the SCE platform the protocol library tries to match it to one
of its standard (bidirectional) protocol signatures.

Cisco periodically publishes protocol packs containing new signatures and updates to existing
signatures. You can use these protocol packs to update the set of signatures installed on SCA BB,
enhancing its classification capabilities.

Dynamic Signatures

Most signatures used by SCA BB are predefined and hard-coded. SCA BB also allows you to add
dynamic signatures, which can be user-defined.

You can create and edit dynamic signatures in the Signature Editor tool. The Dynamic Signature Script
(DSS) enginein SCA BB carries out the classification using these user-defined signaturesin addition to
the predefined signatures.

Initiating Side

Zones

The SCE platform is usually located between the provider’s subscribers and the network.
Subscriber-initiated flows areinitiated by the subscriber toward the network; network-initiated flows are
initiated from the network toward the subscriber.

You can limit some flow-types to one initiating side. For example, with HTTP you can restrict the
direction of the flow to subscriber-initiated, because HTTP is always subscriber-initiated when the
subscriber ventures outward to surf the Internet. If the direction of the HTTP flow is network-initiated,
this probably means that a web server is open on the subscriber’s local machine for receiving incoming
HTTP traffic. The provider can block network-initiated HTTP.

A zoneis a collection of network-side | P addresses.

You configure zones by arranging | P addresses in groups connected by a common purpose. A
subscriber’s network flow mapped to a service may be applied to a zone. In practice, zones often define
geographical areas.

Zones are used to classify network sessions; each network session can be assigned to a service element
based on its destination | P address.

Examples of Zones:

« A “walled garden”—A range of |P addresses of aserver farm with premium video content, for which
the provider would like to limit access to specific subscribers and to assure traffic priority.

« A zoneto differentiate between off-net and on-net flows.
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Example of Assigning a Zone to a Session:

e Zone A and Zone B are two user-defined zones. Zone A includes the | P address range 10.1.0.0/16,
and Zone B includes the IP address range 10.2.0.0/16. Analysis of a new session shows that its
network 1P address is 10.1.1.1—the session belongs to zone A.

Zone ltems

A zoneis acollection of related zone items.
A zoneitemisan IP address or arange of |P addresses.
Table 3-2 gives examples of zone items.

Table 3-2 Examples of Zone Items

Network Address Example
IP address 123.123.3.2
I P address range (and mask) 123.3.123.0/24

This means that the first 24 bits of the |P address
must be included as specified and the final 8 bits
cantakeany value. (Thatis, all IP addressesin the
range 123.3.123.0 to 123.3.123.255.)

Flavors

Flavors are advanced classification elements that classify network sessions according to
signature-specific Layer 7 properties.

Flavors provide an additional level of granularity in defining servicesin the Cisco Service Control
solution. A protocol flavor uses an additional protocol attribute in classifying a service, making this
service aflavor of the service based on the protocol only. For example, the user-agent attribute of the
HTTP protocol could be added as a protocol flavor, enabling the definition of all HTTP traffic generated
by the same browser type (indicated in the user-agent field) as one service.

Examples of flavor types are HTTP User Agent and SIP Source Domain.

~

Note Flavors are not used for traffic classification when unidirectional classification is enabled.

Flavor Items

A flavor is acollection of flavor items.

Thetype of aflavor item depends on the flavor type. For alist of available flavor types, see Flavor Types
and Parameters, page 7-51.

The default service configuration includes some predefined flavors, such as HTTP Streaming Agents (a
flavor of HTTP) and Vonage (a flavor of SIP).

Cisco Service Control Application for Broadband User Guide
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DSCP ToS

Content Filtering

Note

One flavor typeis TOS. This allows DSCP ToS to be used as a classification criterion so that a packet
carrying a specific marking can be assigned to a predefined service with, for example, unlimited
bandwidth or reported. The DSCP ToS classification process takes precedence over other classification
mechanismsto allow external devices, such as avoice gateway, to dictate how the flow istreated. DSCP
ToS-based classification is an excellent way of marking proprietary managed services where SCA BB
does not recognize the applications but identifies them viathe DSCP ToS field.

Content filtering involves classification and control of HTTP flows according to the requested URL. The
classification of the URL is performed by accessing an external database.

Service providers require effective web filtering for their subscribers, for various purposes such as
avoiding litigation and providing parental control. The problem is that the web is huge and constantly
growing, and SCA BB and the SCE platform are not designed to track and maintain the huge database
of URLs required for effective filtering.

SCA BB provides content filtering by integrating with SurfControl Content Portal Authority (CPA).
SurfControl’s technology enhances SCA BB URL classification capabilities by eliminating the need for
anetwork administrator to manage a URL database or interact with the server, while creating a powerful
filtering solution. It provides compl ete coverage of the web’s most trafficked sites and access to the most
accurate and relevant database of URLs classified by risk category, such as sexually explicit, racist,
hacker, and so forth.

The integration of SurfControl’s CPA into SCA BB provides the required web-filtering solution. SCA
BB, running on the SCE platform, contacts a CPA server to categorize the website that a subscriber
requests. The returned category is then used to classify the HTTP flow. This classification is then used
for the normal SCA BB traffic control and reporting.

SCA BB includes an internal database of URLs used by the HTTP URL flavor classification. When a
URL isfound in both the internal database and the external content filtering database, the URL is
classified according to the internal database.
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Mapping Flow Attributes to Services

Figure 3-1 illustrates the mappings of flow elements of a session to service elements of a service.

Figure 3-1 Mapping Flow Attributes to a Service
Flow/Session — Service Element
Network-side IP Zone
address
Initiating side Initiating side
IP protocol Protocol T
TCP/UDP port Signature Flavor Class
L7 attributes

157290

Traffic Accounting and Reporting

You can use data gathered by the SCE platforms for real-time signaling, billing, and reporting.

Various metrics are collected in different scopes—global (per entire link), per service (or group of
services), per package (or group of packages), and per subscriber—based on user-defined usage
counters.

» Global control bandwidth is based on Layer 1 volume.
» Subscriber bandwidth control (and accounting and reporting) is based on Layer 3 volume.
The values from the usage counters can be either pushed or pulled:

» The SCE platform generates and transmits Raw Data Records (RDRs) that contain flow, usage, and
other data.

» The SCE platform maintains an SNMP MIB that can be queried by external systems.

Cisco Service Control Application for Broadband User Guide
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Usage Accounting

Note

SCA BB collects and maintains various network metrics, per service, in different scopes.
The network metrics are:

» Upstream volume (L3 kilobytes)

» Downstream volume (L 3 kilobytes)

e Sessions

- Active subscribers

» Concurrent sessions

» Session duration

For Vol P services, such as SIP and M GCP, the concurrent sessions usage counter counts concurrent voice
calls, and the session duration usage counter measures voice call duration.

Per service accounting takes place in the following scopes:
 Per subscriber
» Per group of subscribers (package)
» Per link (global)

Several services may share the same service usage counter. For example, in the default service
configuration, the SMTP service and the POP3 service share the E-Mail Counter. The assignment of
services to usage countersis determined by the service hierarchy, as explained in the following section.
Similarly, several packages may share the same package usage counter, and the assignment of packages
to usage counters is determined by The Package Hierarchy.

The Service Hierarchy

Services are arranged in a hierarchal tree. A single default service is at the root, and you can place each
new service anywhere in the tree.

Services inherit the rule of their parents. When arule is defined for a particular service (in a specific
package), all its child services are controlled by the same rule for that package, unless explicitly
specified.

Service Usage Counters

The service hierarchy provides away to share usage counters and to organi ze services according to their
semantics. Services are accounted in groups, as defined in the service hierarchy. Each serviceisassigned
usage counters.

There are two categories of usage counters for services:
» Global—Used for Link Usage and Package Usage RDRs and reports
» Subscriber—Used for Real-Time Subscriber Usage RDRs and reports
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A global usage counter and a subscriber usage counter are assigned to each service. The use of aservice
can be accounted either exclusively for traffic classified to it or in conjunction with the traffic of its
parent service. For example, if a service called Premium Video Content is defined as a child of
Streaming, the operator can either define a special usage counter for Premium Video Content or
configure it to use the same usage counter as Streaming. The global usage counter and the subscriber
usage counter are independent; for the same service, one usage counter may be the same for parent and
child, whereas the other is exclusive to the child.

The Package Hierarchy

Packages are arranged in a hierarchal tree. A single default package is the root of the tree, and you can
place new packages anywhere in the tree.

Package Usage Counters

The package hierarchy allows you to organize packages according to their semantics and provides for
sharing package usage counters. You can define a maximum of 1024 different exclusive package usage
counters per service configuration, one of which is used for the Unknown Subscriber Traffic package.

Usage reporting at a package level is grouped as follows:;

» Package assigned an exclusive package usage counter—All traffic associated with this package is
accounted separately in the assigned counter, along with any children that are not assigned exclusive
counters.

» Package NOT assigned an exclusive package usage counter—Al| traffic associated with this package
is accounted together with its parent package.

For example, in the example package tree shown in Figure 3-2, if the Mail & Web Baseline package is
allocated an exclusive counter, but neither child package is assigned an exclusive counter, then all
Package Usage RDRs and derived reports (such as “Package Bandwidth per Service”) would group
together usage of subscribers assigned to all three packages.

On the other hand, if the Mail & Web Boost package also had an exclusive counter, the traffic for Main
& Web Baselineand Mail & Web Captive HT TP would be accounted together, but traffic for Mail & Web
Boost would be accounted separately. (In general thisis not an efficient configuration. You should use
the hierarchical structure to group packages that can share the same counter.)

Figure 3-2 Example Package Tree

= policies B Classification

%@ d¢ 3 . Configuration ~

------ H Service Security

g@f; Global Palicy
=@ Subscriber Policies
—ﬁj Default Package
= {'i_'] Mail & Web Baseline
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Reporting
SCE platforms running SCA BB generate and transmit Raw Data Records (RDRs) that contain
information relevant to the service provider.
RDRs contain awide variety of information and statistics, depending on the configuration of the system.

RDRs are transmitted using a Cisco proprietary protocol. This requires you to use the Cisco Service
Control Management Suite (SCMS) Collection Manager (CM) or to develop software to process the
RDRs.

The data in some RDRs can also be exported using the NetFlow reporting protocol, which has become
an industry standard. NetFlow reporting allows the SCA BB solution to be more easily integrated with
your existing data collectors.

 RDRs, page 3-14
» NetFlow, page 3-14

RDRs

The following are the main categories of RDRs:

- Usage RDRs—Generated periodically. These RDRs contain the state of the usage counters, per
service and per accounting scope. There are four types of usage RDRs:

— Link Usage RDRs—Global usage per service, for the entire link.
— Package Usage RDRs—Usage per group of subscribers, per service.

— Subscriber Usage RDRs—Usage per subscriber, per service. These RDRs are generated for all
subscribers. The Cisco Service Control Management Suite (SCMS) Collection Manager (CM)
and Cisco Service Control Application (SCA) Reporter use these RDRs to generate
top-subscriber reports and aggregated usage billing records.

— Real-Time Subscriber Usage RDRs—Generated for selected subscribers only. The SCMS-CM
and SCA Reporter use these RDRs by to generate detailed subscriber activity reports.

» Transaction RDRs—Generated for a sample of the flows. These RDRs are used to create statistical
histograms such as Top TCP Ports.

» Transaction Usage RDRs—Generated for every flow according to user-defined filters. These RDRs
contain detailed Layer 7 information for browsing, streaming, and voice flows. They are used for
flow-based billing.

» Real-Time Signaling RDRs—Generated to indicate specific network events such as flow start or
end. These RDRs are used to signal external systemsto allow real-time actions across the network.

- Malicious Traffic RDRs—Generated to indicate that the SCE platform has detected a traffic
anomaly, such as a DDoS attack. These RDRs are used to detect attacks and attackers in order to
mitigate them.

NetFlow

The following information can be exported using the NetFlow protocol

» Usage—Generated periodically. These RDRs contain the state of the usage counters, per service and
per accounting scope.

- Malicious Traffic—Generated to indicate that the SCE platform has detected a traffic anomaly, such
as a DDoS attack.
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Traffic Control

Packages

Traffic Control provides meansto block, limit, or prioritize traffic flows according to service, subscriber
package, subscriber quota state, and so on.

» Packages, page 3-15

» Unknown Subscriber Traffic, page 3-15
* Rules, page 3-16

« Bandwidth Management, page 3-16

< Quota Management, page 3-19

A packageisacollection of rules describing subscriber policy. The package definesthe group of services
delivered to a specific group of subscribers and the system’s behavior for each service. It may contain
restrictions on network flows, guidelines for flows’ prioritization, and instructions about how to report
flows.

Each subscriber in the network is provided a reference to a package to which that subscriber belongs.
The system:

1. Maps each network flow to a service by matching the flow with a service element

2. ldentifies the subscriber to whom the flow pertains, according to the subscriber’s network 1D
(usually the subscriber’s | P address)

3. ldentifies the package to which the subscriber belongs
4. Applies the correct rule to the service of the subscriber’s network flow
Another scheme is described in Virtual Links Mode, page 3-15.

Virtual Links Mode

In normal mode, you define bandwidth controllers for each package (see Bandwidth Management,
page 3-16). In Virtual Links mode, you define template bandwidth controllers. The actual bandwidth
parameters are assigned to a subscriber when the subscriber enters the system. These parameters depend
on the subscriber's package and the direction of the virtual link.

For more information, see Managing Quotas, page 9-75.

Unknown Subscriber Traffic

The SCE platform tries to identify the subscriber responsible for every traffic flow that it processes. The
platform looks at the IP address or VLAN tag of the traffic flow, and checks its internal database for a
subscriber identified by this IP Address or VLAN tag. If such a subscriber is not found in the database,
the traffic flow is mapped to the Unknown Subscriber Traffic category.

| oL-7205-19
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Rules
A ruleisaset of instructions that tell the SCE platform how to treat network flows of a specific service.
A rule may:
» Specify that a flow should:
— beblocked
— be granted a certain amount of bandwidth
— haveits packet's DSCP ToS marked with a given value (see DSCP ToS Marking, page 3-22)
- Define an aggregate volume or session limit, after which a set of different restrictions will be
enforced on the flow
- Specify how aflow will be reported for billing or analysis purposes
Calendars

You can use calendars to divide the hours of the week into four time frames.
After you have configured a calendar, you can add Time-Based Rules to a package that uses the calendar.

Time-Based Rules

A time-based rule is arule that applies to only one time frame. Time-based rules allow you to set rule
parameters that will only apply at specific times. You might, for example, want to define different rules
for peak, off-peak, nighttime, and weekend usage.

You can add time-based rulesto any rule. If atime-based rule is not defined for atime frame, the parent
ruleis enforced.

Often, you will want the rules for the different time frames to be similar. When you add a time-based
rule, the settings of the parent rule are copied to the new time-based rule; you can make any needed
changes. Subsequent changes to the parent rule do not affect the time-based rule.

Bandwidth Management

The physical link bandwidth is an absolute limit on the bandwidth that can pass through the system. You
can limit the total bandwidth passing through the SCE platform to a value lower than the physical link
bandwidth. For example, if another device sitting next to the SCE platform on the I P stream has limited
BW capacity, you can limit the bandwidth passing through the SCE platform to match the capacity of
the other device.

Bandwidth control in SCA BB is accomplished in two stages:
« Global control
- Subscriber bandwidth control
- Global control bandwidth is based on Layer 1 volume.

» Subscriber bandwidth control (and accounting and reporting) is based on Layer 3 volume.
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Global Bandwidth Control

Total bandwidth use is controlled by global controllers. Global controllers are virtual queues in SCE
platforms. You configure them for the entire system, rather than for individual subscribers.

Global controllers provide constraints for large, global volumes of traffic, such as “ Total Gold
Subscriber Traffic”, or “Total P2P Traffic”. Each global controller defines the maximum percentage of
total available bandwidth allocated to all traffic of a particular type. Using a global controller, you can
limit total traffic of services such as P2P in the system to any desired percentage of the total available
bandwidth. In this way, you keep the total bandwidth consumed by this traffic under control.

The upstream and downstream interfaces are each assigned one default global controller that, by default,
controls 100 percent of thelink traffic. You can add up to 1023 more global controllersfor each interface,
and you can assign a maximum percentage of the total link limit to each global controller separately.

For each global controller, you can define separate val ues for the maximum percentage of total available
bandwidth separately for each time frame. (See Calendars, page 3-16.)

In dual-link systems you can define different bandwidth values for each link. You can also set alimit on
the aggregated bandwidth passing on the two links.

Virtual Links mode usestemplate global controllers. Template global controllers are templates of virtual
gueues, they are applied to as many separate physical links as exist in the system. For each physical link,
actual bandwidth parameters depend on the link. (For more information, see Managing Quotas,

page 9-75.)

Subscriber Bandwidth Control

Bandwidth used by individual subscribersis controlled by Subscriber BW Controllers (BWCs). Each
BWC controls available bandwidth for selected services. Services controlled by a particular BWC are
defined per package, but bandwidth control is per service.

A BWC is specified by the following parameters:

» Committed Information Rate (CIR)—The minimum bandwidth that must be granted to the services
that are controlled by the BWC

» Peak Information Rate (PIR)—The maximum bandwidth that can be allocated to the services that
are controlled by the BWC

» Global Controller—The global controller to which this BWC links

« Assurance Level (AL)—The rate of change of available bandwidth under conditions of traffic
congestion

Asillustrated in Figure 3-3, the maximum available bandwidth (Admitted Information Rate (AIR))
ranges between the CIR and the PIR. The actual consumed bandwidth is always less than the AIR.

The BWC has a third parameter that controls how the AIR is determined at different congestion
conditions. When the network is not congested the system allows the PIR and when the network is highly
congested the system provides the CIR. In between these two extremes, the AIR is determined by athird
parameter—Assurance Level (AL). The AL controls how fast the AIR would decrease from the PIR to
the CIR as congestion builds, or increase from the CIR to the PIR as congestion decreases. A higher AL
ensures a higher AIR compared to a similar BWC with alower AL.

The BWC ensures that even when the network is congested (PIR-congestion) at |east the CIR is granted.
Similarly, the BWC ensures that even when there is little traffic associated with aBWC the PIR is not
exceeded.

| oL-7205-19
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Figure 3-3 Bandwidth Control Levels

Bandwidth may be thought of in terms of avirtual pipe of adjustable width. The PIR is the maximum
allowed width of the virtual pipe. The CIR is the minimum width to which the pipe can contract. The
actual pipe width isthe AIR. During network congestion, the system contracts each pipe differently to
differentiate between subscribers and between their services.

Primary and Internal Bandwidth Control

In SCA BB each subscriber has an independent set of BWCs, consisting of asingle Primary (Total) BWC
(tBWC) that controlsthe total bandwidth available to the subscriber and several Internal BWCs (iBWCs)
that control the available bandwidth of some services of that subscriber, asillustrated in Figure 3-4. For
example, one BWC may control the Streaming Service; another may control the Download and E-mail
Services together.

The PIR defines the maximum bandwidth for the associated services; the CIR defines the minimum
bandwidth for them.
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Figure 3-4 Bandwidth Control on Two Levels

Total level
tBWC

Internal level

141643

You can link iBWCs to traffic in the following way:
1. Inthe package general definitions, add a subscriber BWC, defined by its CIR, PIR, AL and CoS.
2. When defining a rule, assign each service to one subscriber BWC.

Quota Management

Note

You can assign subscribers a quota limit on selected services.

Each subscriber has 16 quota buckets, each of which you can define for volume or sessions. When a
subscriber uses a certain service, the amount of consumed volume or number of sessionsis subtracted
from one of the buckets.

The service configuration determines which bucket to use for each service. Consumption of volume
bucketsis measured in units of L3 kilobytes. Consumption of session bucketsis measured by the number
of sessions. For example, you can define that the Browsing and E-Mail services consume quota from
Bucket #1, that the P2P service consumes quotafrom Bucket #2, and that all other services are not bound
to any particular bucket.

External quota provisioning systems can use the Quota Provisioning API (see the Cisco SCMS SCE
Subscriber APl Programmer’s Guide) to dynamically modify the quotain each bucket. For example, you
can increase the quota of a certain bucket when a subscriber purchases additional quota. These external
systems can also query the amount of remaining quotain each bucket. This can be used, for example, to
show subscribers in a personal web page how much of their quota remains.

External quota provisioning can also be acquired using the Quota Manager (QM), an off-the-shelf
solution provided by Cisco. For more information about the installation and operation of the QM, see
the Cisco Service Control Management Suite Quota Manager User Guide.

External quota provisioning is not supported when unidirectional classification is enabled.
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Cisco Service Control Application for Broadband User Guide g


http://www.cisco.com/en/US/docs/cable/serv_exch/serv_control/broadband_app/rel355/subscAPI/subsc_api.html
http://www.cisco.com/en/US/docs/cable/serv_exch/serv_control/broadband_app/rel355/subscAPI/subsc_api.html
http://www.cisco.com/en/US/docs/cable/serv_exch/serv_control/broadband_app/rel355/qm_sol/qm_sol.html

Chapter 3 Traffic Processing Overview |

M Other Traffic Processing Features

Theinternal SCA BB quota provisioning system replenishes each quota bucket by a fixed amount at
fixed intervals.

Subscribers can be notified when they breach the quota in any bucket.

Subscriber Notification

The subscriber notification feature lets you push web-based messages (such as notifications of quota
depletion) to a subscriber by redirecting the subscriber HTTP traffic to relevant web pages. HTTP
redirection starts when the subscriber notification is activated and ceases when the notification is
dismissed.

~

Note  Subscriber notification is not supported when unidirectional classification is enabled.

Other Traffic Processing Features

This section outlines other traffic processing features provided by SCA BB.
» Service Security, page 3-20
- Traffic Filters, page 3-22
- Traffic Forwarding to Value Added Services Servers, page 3-22

Service Security

SCA BB includes service security functionality to help protect network operators and their subscribers
from attacks and malicious traffic:

- DoS attacks

- DDoS attacks

« VoIP threats

« Worms

» Hacker activity

» Malicious takeover of subscriber computers:
— Spam zombies
— E-mail based viruses

Although it is never possible to provide complete protection from network threats, the Cisco Service
Control solution provides insight into malicious activity in a network, and can mitigate large scale
eruptions of malicious activity that compromise overall network performance.

Networks operators can use SCA BB to:
« Monitor network traffic for suspicious activity
- Block malicious traffic

» Notify subscribers that are creating or have been affected by malicious traffic
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Detecting Malicious Traffic

SCA BB uses three threat detection mechanisms:

- Anomaly Detection—This set of mechanisms monitorsthe rate of connections (both successful and
unsuccessful) to and from each host |P address. High connection rates or alow ratio between
successful and unsuccessful connections indicate malicious activity.

Anomaly detection characteristics can indicate the following categories of malicious activity:
— 1P sweep—Scanning multiple I P addresses, all on the same port (a behavior typical of worms)
— Port scan—Scanning all ports at one IP address (a behavior typical of hackers)
— DoS attack—An attack (on a single IP address) from a single |P address
— DDosS attack—An attack (on a single IP address) from multiple | P addresses
~

Note  SCA BB will identify a DoS attack with spoofing (using many fake IP addresses instead of one real
address) as a DDoS attack.

» Theanomaly detection mechanism is effective in addressing new threats as they appear. It does not
need knowledge about their exact nature and Layer 7 signatures, but is based on the characteristics
of their network activity.

» Mass mailing activity detection—This mechanism monitors SMTP session rates for individual
subscribers (using SCE platform subscriber-awareness; it can work in subscriber-aware or
anonymous subscriber mode). A high rate of SM TP sessionsfrom an individual subscriber isusually
an indicator of malicious activity that involves sending e-mail (either mail-based viruses or
spam-zombie activity).

» Signature based detection—The SCE platform’s stateful Layer 7 capabilities are used to detect
malicious activity that is not easily detectable by the other mechanisms. Operators can add
signatures for such threats, achieving a very quick response time in addressing new threats.

Responding to Malicious Traffic
You can define the following actions when configuring the detection mechanisms described in the
preceding section:
« Monitor the network for malicious activity detected by each of these mechanisms.
You can display graphs in the Console based on data collected for malicious activity analysis.

- Automatically block malicious activity detected by the SCE platform to avoid threat propagation
and adverse effects to the network.

» Notify subscribers that are involved in malicious activity by redirecting their web sessions to a
captive portal.

SCA BB provides ahigh level of flexibility in tuning the detection methods to define malicious activity
and in configuring the actions to be taken when malicious activity is detected.

Cisco Service Control Application for Broadband User Guide
[ oL-7205-19 .m



Chapter 3 Traffic Processing Overview |

M Other Traffic Processing Features

Traffic Filters

Filter rules are part of service configurations. They allow you to instruct the SCE platform to ignore
some types of flow (based on the flow’s Layer 3 and Layer 4 properties) and to transmit the flows
unchanged.

When atraffic flow entersthe SCE platform, the platform checks whether afilter rule appliesto the flow.
If afilter rule applies to this traffic flow, the SCE platform performs one of the following actions:

» Bypass—The SCE platform passes the traffic flow to its transmit queues without generating any
RDRs (the flow will not appear in records generated for analysis purposes) and without enforcing
any service configuration rules.

e Quick forward—A flow filter rule action whose aim is to ensure low latency for delay sensitive
flows. The packets of quick-forwarded flows are duplicated and sent through different paths: one
copy goes directly to the transmit queue and thus suffers only a minimal delay, the other copy goes
through the normal packet path.

A filter rule can also set the DSCP ToS value of thefiltered traffic. (See DSCP ToS Marking, page 3-22.)

It is recommended that you add filter rules for OSS protocols (such as DHCP) and routing protocols
(such as BGP) that might traverse the SCE platform. These protocols usually should not be affected by
policy enforcement, and their low volume makes them insignificant for reporting.

A number of filter rules are included in the default service configuration.

Flows of certain protocols can also be filtered according to the flow’s Layer 7 characteristics.

DSCP ToS Marking

DSCP ToS marking is used in IP networks to signal the type and priority of aflow between network
elements. DSCP ToS marking is typically performed by elements that have an insight regarding how
traffic should be treated throughout the network. Such an element can be the element generating
traffic—a voice gateway, for example. SCA BB, being application aware, can, for example, allocate
bandwidth resources based on the business model and the specific needs of latency sensitive
applications.

Traffic Forwarding to Value Added Services Servers

Note

Traffic forwarding to Value Added Services (VAS) servers allows the Cisco Service Control solution to
use an external expert system (VAS server) for additional traffic processing. The SCE reroutes traffic to
the preconfigured location of the VAS server. After processing, the traffic is sent back to the SCE, which
then sends it to its original destination.

VAS traffic forwarding is not supported when unidirectional classification is enabled.

[l Cisco Service Control Application for Broadband User Guide
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Service Configurations

A service configuration implements and enforces the provider’s business strategy and vision.

A service configuration can take effect only after it is propagated to the appropriate SCE platform. SCA
BB enforces the service configuration by analyzing the network traffic passing through them.

A service configuration consists of:

Traffic classification settings—Services, such as web browsing, file sharing, and Vol P. Each service
consists of elements that define how network traffic is mapped to the service. The configuration
building blocks of services are protocols, zones, flavors, and signatures.

Traffic accounting and reporting settings—Settings that determine how traffic flows and network
usage accounting are reported.

Traffic control settings—Packages, which consist of a set of rules (such as bandwidth rate limit and
guotalimits) defined for different services. The main configuration building blocks of packages are
rules, quota buckets, subscriber BWCs, and global controllers.

Defining Service Configurations in Practice

In practice, defining service configurations is an iterative process.

It is recommended that you use the following sequence of steps:

1.

o~ DD

Set up the system.
Apply the default service configuration.
Gather data.
Analyze.
Do one or both of the following:
— Continue traffic discovery by partitioning the traffic into (additional) services.

— Createrulesto limit and prioritize traffic according to services and subscriber packages.
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Getting Started

Revised: December 14, 2011, OL-7205-19

Introduction

This chapter:

» Guidesyou through the process of installing or upgrading the Cisco Service Control Application for
Broadband (SCA BB)

» Explains how to install Protocol Packs, which contain new and updated protocol signatures

- Describes the concept of the Console as a collection of tools, presents each tool and its role, and
describes how to launch the tools and navigate between them

« Concludes with a Quick Start that describes how to apply your first service configuration and
generate your first report

Cisco Service Control Application for Broadband User Guide
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How to Install SCA BB

You install SCA BB in two stages:
1. Install the SCA BB front ends:
— The SCA BB Console

— The SCA BB Service Configuration Utility, the SCA BB Signature Configuration Utility, and
the SCA BB Real-Time Monitoring Configuration Utility

2. Install the SCA BB application components:

— The SCA BB Service Modeling Language Loadable Image (SL1) and the SCA BB Service
Control Engine (SCE) applicative management plug-in

— The SCA BB Subscriber Manager applicative management plug-in (for systems with a Cisco
Service Control Management Suite (SCMS) Subscriber Manager (SM))

If you are upgrading an existing installation of SCA BB, see How to Upgrade the SCE Using the SCE
Software Upgrade Wizard, page 4-9 or Working with Protocol Packs, page 4-19.

The SCA BB Installation Package

The SCA BB installation package is a ZIP file located in the CCO.
The installation package consists of the following files:
« Theinstaler for the Console: sca-bb-console-<version>-<build>.exe.

» A Ciscoinstallation application packagefile (PQI file) for each type of SCE platform. Each PQI file
islocated in a subfolder whose name is the platform name.

- Thefilesca bb_util.tgz, which contains the files for the SCA BB Service Configuration Utility
(servconf), the SCA BB Signature Configuration Utility (sigconf), and the SCA BB Real-Time
Monitoring Configuration Utility (rtmcmd) (together with real-time monitoring report templates).

» The file PCubeEngageMib.mib, which defines the SCAS BB MIB, located in the SNM P subfolder.
« The SCA BB Service Configuration Java API distribution file: serviceconfig-java-api-dist.tgz.

« Thefile surfcontrol.xml, which lists the content categories for content filtering using SurfControl
Content Port Authority, located in the URL Filtering subfolder.
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Installing SCA BB Application Components

SCA BB has two software components that reside on the SCE platform:
- The SCA BB SLI, which performs traffic processing

« The SCA BB SCE applicative management plug-in, which performs some service configuration
operations

SCA BB also has one software component that resides on the SM device;

« The SCA BB SM applicative management plug-in, which performs some application-specific
subscriber management operations

To install these components from the Console, see How to Install PQI Files on SCE Devices, page 5-24
and Managing CM Devices, page 5-28.

To install these components from a command line, see Installing PQI Files from the Command Line,
page 13-9.

Prerequisites

Beforeinstalling SCA BB, verify that the SCE platform and, if used, the SCMS-SM are operational and
are running appropriate versions of their software.

« How to Verify that the SCE Platform is Operational, page 4-3

» How to Verify that the SCE Platform is Running an Appropriate Version of the OS, page 4-3
» How to Verify that the SM is Correctly Installed, page 4-4

- How to Verify that an Appropriate Version of the SM is Running, page 4-4

How to Verify that the SCE Platform is Operational
Step1  Verify that the status LED on the SCE flashes green. (Orange—booting up; flashing orange—warning;
red—failure.)
How to Verify that the SCE Platform is Running an Appropriate Version of the OS

Stepl At the SCE platform CLI prompt (sce#), type show version.
Step 2 Press Enter.
The response shows the version of the OS running on the SCE platform.

Cisco Service Control Application for Broadband User Guide
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How to Verify that the SM is Correctly Installed

Stepl  Open a Telnet session to the SM.
Step2  Gotothe SM bin directory and type p3sm --sm-status.
Step 3 Press Enter.
The response to this command displays the operational status of the SM.

How to Verify that an Appropriate Version of the SM is Running

Stepl  Open aTelnet session to the SM.
Step2  Go to the SM bin directory and type p3sm version.
Step3  Press Enter.

The response to this command displays the SM version.

How to Install SCA BB Front Ends

You should install the following SCA BB front ends:
- The Console

- The SCA BB Service Configuration Utility (servconf), the SCA BB Signature Configuration Utility
(sigconf), and the SCA BB Real-Time Monitoring Configuration tool (rtmcmd) (together with
associated real-time monitoring report templates)

— servconf requires access to the Java Runtime Environment (JRE) (see Installing the Java
Runtime Environment, page 4-5).

Hardware Requirements

- Atleast 1024 MB RAM isrequired to run the Console

- The minimal supported screen resolution for the Console is 1024x768 pixels.

Operating System Requirements

The SCA Reporter GUI front end can be installed on any computer running Windows 2000 or Windows
XP.

Cisco Service Control Application for Broadband User Guide
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Installing the Java Runtime Environment

The SCA BB Service Configuration Utility, servconf, requires access to JRE version 1.6.
You can download a JRE from the Sun™ website at http://java.com/en/download/

To verify that the JRE isinstalled, run java -ver sion from the command prompt. The Java version should
start with 1.6.

If adifferent version of JRE is also installed on the workstation, you may need to tell servconf whereto
find the appropriate JRE. Do this by setting the JAVA_HOME environment variable to point to the JRE
1.6 installation directory. For example:

JAVA_HOME=C:\Program Files\Java\j2rel.6_08

How to Install the Console

Stepl  Navigate to the Console installation file, sca-bb-console-3.5.5.exe, and double-click it.
The Welcome page of the SCA BB Console 3.5.5 Setup wizard appears (Figure 4-1).

Figure 4-1 Welcome to the SCA BB Console Setup Wizard

® SCA BB Console 3.5.5 Setup

Welcome to the SCA BB Console
3.5.5 Setup Wizard
This wizard will guide vou through the installation of SCA BB

Consale 3.5.5,
1t is recommended that wou close all other applications
befare starting Setup. This will make it possible to update

relevant system files without having ko reboat vour
compuker,

Click Mext to continue,

Mext> | [ Cancel ]

275728

Step2  Click Next.
The Install Location page of the Setup wizard opens (Figure 4-2).

Cisco Service Control Application for Broadband User Guide
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Figure 4-2 Choose Install Location

@ SCcA BB Console 3.5.5 Setup

‘ Choose Install Location
L Choose the folder in which to install SCA BB Console 3.5.5,

Setup will install SCA BB Console 3.5.5 in the Following Folder. To install in & different Folder,
click Brawse and select anather falder, Click MNext ko continue,

Destination Folder

i Browse. ..

Space required: 164, 7ME
Space available: 103, 7GE

’ < Back ” Mext > l[ Cancel ]

275729

Step3  (Optional) Click Browse and choose a different destination folder.
Step4  Click Next.
The Start Menu Folder page of the Setup wizard opens (Figure 4-3).

Figure 4-3 Choose Start Menu Folder

@ ScA BB Console 3.5.5 Setup

‘ Choose Start Menu Folder
L Choase a Start Menu Folder For the SCA BB Console 3.5.5
@ sharteuts,

Select the Start Menu Folder in which you would like to create the program's shortcuts, You
can also enter a name to create a new Folder,

| 7-Zip ~ |
i Accessoties

| dsdminiskr ative Tools ‘
| &anix PERC 4.2 i
| CEPS Clignk

| Cisco

| Cisca IPTY Wiewer
| Cisco IT Tools

| Cisco SCA

| Cikrio

| Connected

|:| Do not create shortouks

’ < Back ” Install J[ Caneel ]

275730

Step5  (Optional) Enter a different Start Menu folder in the Start Menu Folder field.

Step6  (Optional) Check the Do not create shortcuts check box.
Step7  Click Install.
The Installing page of the Setup wizard opens (Figure 4-4).

[l Cisco Service Control Application for Broadband User Guide
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Step 8

Step 9

Step 10

Figure 4-4 Installing

How to Install SCABB Il

@ SCcA BB Console 3.5.5 Setup

Insztalling
Please wait while SCA BE Console 3.5.5 is being installed.

Extract; org.eclipse.emf.edit_2.4.0.+200302090050.jar

[-FFH

Extract

Extract
Extract

Extract

Extract:

Extract:
: obg.edipse. core.runtime, compatibilicy _3.2.0,+20071008 jar... 100%
Extract:
Extract:
Extract:
: org.eclipse.emf.common_2.4.0,w200802090050. jar ... 100%:
: org.eclipse, emf.ecore, change_Z2.4,0,vZ00802090050, jar, .. 100%
Extract:
Extract:
Extract:
s org.eclipse. emf.edit_2.4.0,+200802090050, jar

org,eclipse,core,resources_3,4,0,v20030205, jar, .. 100%
org,eclipse, core,runtime. compatibility, auth_3. 2, 100, v20070502.jar, .. 100%

org.eclipse.core.runtime_3.4.0,+20030201 .jar... 100%
org,eclipse,core,variables_3.2,0,v20070910,jar, ., 100%:
org.eclipse. emf.commaon. ui_2,4.0.+200802090050.jar .. 100%

org.eclipse.emf.ecore, xmi_2,4.0,+200802090050,jar ... 100%
org.eclipse.emf.ecare_2.4.0,v200502090050. jar. .. 100%:
org.eclipse.emf . edit,ui_2.4.0,v200302090050,jar, .. 100%

v

Wait until installation is complete.
The Next button is enabled.

Click Next.

The Installation Complete page of the Setup wizard opens (Figure 4-5).

Figure 4-5

Completing the SCA BB Console Setup Wizard

@ ScA BB Console 3.5.5 Setup

275731

Completing the SCA BB Console
3.5.5 Setup Wizard

SCA BB Console 3.5.5 has been installed on wour computer,

Click Finish ko close this wizard,

[¥]Launch the 504 BE Consale 3,55

< Back [ Finish l [ Caneel ]

275732

To launch the Console, check the Run SCA BB Console after installation check box.
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Step11 Click Finish.
The SCA BB Console 3.5.5 Setup wizard closes.
The Console is now installed on the machine.
A shortcut is added to the Start menu.

How to Install the SCA BB Configuration Utilities

Stepl  From the SCA BB installation package, extract the file sca_bb_util.tgz, and copy it to a Windows,
Solaris, or Linux workstation.

Step2  Unpack the file to a new folder.

The SCA BB Service Configuration Utility (servconf), the SCA BB Real-Time Monitoring
Configuration Utility (rtmemd) (and associated real -time monitoring report templates), and the SCA BB
Signature Configuration Utility (sigconf) are located under the bin folder.

How to Upgrade SCA BB Components

Upgrading SCA BB includes upgrading each of the following software components:
« SCE Firmware
- The SCE PQI file
» Protocol Pack SPQI file
- Policy file

N

Note  Thissection describesthe upgrade of SCA BB application components only. For afull description of the
entire Cisco solution upgrade procedure, consult the solution upgrade document accompanying the
formal release.

» When you upgrade old PQB files, some protocol |Ds are changed automatically. M essages such as
the following may be displayed to indicate the change:

Protocol ID of BaiBao changed from 80 to 43
Protocol ID of PPLive changed from 81 to 44

» When you upgrade adevice with anew SPQI or PQI file, all other devicesthat are not upgraded may
fail

» New SCA BB releases do not use the default Dynamic Signature Script (DSS) file (see that was
installed for a previous SCA BB release.

« |If aprotocol pack for the new releaseisavailable, install it after the product installation is compl ete.
Do not install an old protocol pack on top of a new product installation.
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How to Upgrade the SCE Using the SCE Software Upgrade Wizard

You can upgrade the SCE using the Network Navigator Tool via the SCE Software Upgrade Wizard.

Stepl  Open the Network Navigator.

Step2  Choose one or more devices in the Site Manager tree.

Step3  Right-click one of the selected devices.

Step4  From the popup menu that appears, choose SCE Software Upgrade Wizard.
The SCE Software Upgrade Wizard appears (Figure 4-6).

Figure 4-6 SCE Software Upgrade

H SCE Software Upgrade Wizard

SCE Software Upgrade :

This wizard helps to upgrade set of SCE devices with most recent software, including
5C05 and Application, and also apply policy settings through POE and Protocaol Packs,

273596

Step5  Click Next.
The SCE I P Addresses page of the SCE Software Upgrade Wizard opens (Figure 4-7).

Cisco Service Control Application for Broadband User Guide
[ oL-7205-19 .m



Chapter4  Getting Started |

WM Howto Upgrade SCA BB Components

Figure 4-7 SCE IP Address

3£ SCE Software Upgrade Wizard |Z|@@

SCE IP Addresses :

Configuring the SCE platforms requires that they are First added to the Metwork
Mawigatar,

Tao add SCE platforms to the Metwork Mavigator, tvpe their IP addresses in the text
bax below (For exarnple: 10.56.216.37, 10.56,216,38):

ho.56.201.81
10,56.216,40

[ < Back ” Mek = l

273505

Step6  (Optional) In the edit box, enter additional 1P addresses.
Step7  Click Next.
The SCE Usernames and Passwords page of the SCE Software Upgrade Wizard opens (Figure 4-8).
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Figure 4-8 SCE Usernames and Passwords

3 SCE Software Upgrade Wizard

SCE Usernames and Passwords
@ & password For the SCE 10.56.201.81 is missing

In otdet bo connect to the SCE platforms, & username and a password need to be
specified for each SCE.

(%) Use a common username and a common password for all SCE platforms:

Username: | admin

Password: | |
() Use separate usernames and passwords for each SCE platform:

SCE IP Address | Username  Password

273587

Step8  Enter the user names and passwords for the SCE devices.
Do one of the following:

» To usethe same user name and password for all the SCE devices that you are adding, enter the user
name in the Username field and the password in the Password field.

- To provide a different user name and password pair for each SCE device, choose the Use separ ate
usernames and passwor ds for each SCE platform radio button, and, for each SCE device, enter
the user name and password in the appropriate cell of the table.

Step9  Click Next.
The Connectivity Test page of the SCE Software Upgrade Wizard opens (Figure 4-9).

Cisco Service Control Application for Broadband User Guide
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Step 10

Figure 4-9 Connectivity Test

3 SCE Software Upgrade Wizard

Connectivity Test
Testing conneckivity ...

The wizard will now test the cannectivity to the devices that wou specified, to werify
that carrect IP addresses, usernames and passwords were used,
Please wait for the connectivity test bo camplete,

In case of an error, you may use the 'Back! button to go back to previous steps and
correct the IP addresses, usernames of passwords, if necessary. You may alsa choose
to skip or retry the connectivity test using the buttans belaw,

Type | IP Address Status

SCE 10.56.201.81  Testing connectivity ...
SCE 10.56.216,40  Testing connectivity ...

Skip connectivity besk ] ’Retry conneckivity kest

273589

The wizard tests to see that the connections to the defined devices can be made.

>

Note If aconnection to one or more of the devices cannot be made or if there is some problem with
the connection (such as invalid version of the device) an error is displayed next to the device.
You can skip these tests by clicking Skip connectivity test. The connections will be validated

when you click Finish at the end of the wizard.

Click Next.

The SCE Firmware (PKG) Installation page of the SCE Software Upgrade Wizard opens (Figure 4-10).

[l Cisco Service Control Application for Broadband User Guide
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Figure 4-10 SCE Firmware (PKG) Installation

3 SCE Software Upgrade Wizard

SCE Firmware (PKG) Installation
Configure the SCE firmware installation options.

() Install SCE Firmware From a Local File

() Install SCE Firmware From a Remote File (FTR)
{e.g. ftpiffuser: password@10,56, 216, 129:21 [software, pai)

(%) Skip SCE Firmware Installation

[ < Back ” Mek = I

273594

Choose the SCE Firmware installation file.
Do one of the following:
- Toinstall SCE Firmware from alocal file, click Browse.
A Select file dialog box appears.
Browse to the SCE Firmware installation file that you are installing.

« Todownload SCE Firmware from aremote site, choose the I nstall SCE Firmware from a Remote
File (FTP) radio button and in the FTP URL field, enter the URL.

Step11  Choose the Skip SCE Firmware Installation radio button.
Step12 Click Next.

The SCE Application Software (PQI) Installation page of the SCE Software Upgrade Wizard opens
(Figure 4-11).

Cisco Service Control Application for Broadband User Guide
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Figure 4-11 SCE Application Software (PQI) Installation

3 SCE Software Upgrade Wizard |Z|@g|
SCE Application Software (PQI) Installation
Configure the SCE application software installation options,

() Install SCE Application Software from a Local File

() Install SCE Application Software From a Remote File (FTR)
{e.q. Ftp:ffuser: password@10.56.216.129: 21 fsaftware. pgi)

(%) Skip 5CE Application Software Installation

’ < Back ” et = l Finist

—
273502

Step13  Choose the PQI installation file.
Do one of the following:
- Toinstall the PQI file from alocal file, click Browse.
A Select file dialog box appears.
Browse to the PQI file that you are installing.

- To download a PQI file from aremote site, choose the Install SCE Application Software from a
Remote File (FTP) radio button and in the FTP URL field, enter the URL.

Choose the Skip SCE Software Application I nstallation radio button.
Step14  Click Next.
The Protocol Pack (SPQI) Update page of the SCE Software Upgrade Wizard opens (Figure 4-12).
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Figure 4-12 Protocol Pack (SPQI) Update

3 SCE Software Upgrade Wizard

Protocol Pack (SPQI) Update
) The file name is empky.

(%) Update Protocol Pack From a Local File

File name: v| [Browse ]

() Skip Protocaol Pack Update

273598

Step 15 Update the protocol pack.
Do one of the following:
» To update the SPQI file from alocal file, click Browse.
A Select file dialog box appears.
Browse to the SPQI file that you are updating.
» Choose the Skip Protocol Pack Update radio button.
Step16 Click Next.

The Service Configuration (PQB) Update page of the SCE Software Upgrade Wizard opens
(Figure 4-13).

Cisco Service Control Application for Broadband User Guide
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Figure 4-13 Service Configuration (PQB) Update

3 SCE Software Upgrade Wizard

Service Configuration {POB) Update
Configure the PQE update options.

(%) apply the Current Service Configuration

() apply the Defaul: Service Configuration
() apply a Service Configuration From a Local File

[ < Back ” Mek = l

27353

Step 17 Choose one of the PQB update options.
- Apply the Current Service Configuration—Keep the existing service configuration.

- Apply the Default Service Configuration—Apply the default service configuration delivered with
the product.

« Apply the Service Configuration from a L ocal File—Apply a service configuration from alocal
file.

Step 18 If you selected the Apply the Service Configuration form a Local File radio button, click Browse.
A Select file dialog box appears.
Browse to the file containing the service configuration.

Step19  Click Next.
The Confirmation page of the SCE Software Upgrade Wizard opens (Figure 4-14).
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Figure 4-14 Confirmation

,.?f \SCE Software Upgrade Wizard

—

The Following upgrade process will take place when you click the ‘Finish' buttan:

SCE platforms participating in the process:
10.56.201.51
10,56.216.40

SCE Firmware:
Skipped

SCE Application Softveare:
Skipped

Protocal Pack:
Skipped

Service Configuration:
Keep current configuration

ek = L Finish ][ Cancel ]

273588

The actions that the wizard is about to take are listed in the page.
Step20  Click Finish.
You can view the progress in the Progress view (Figure 4-15).

Cisco Service Control Application for Broadband User Guide
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Figure 4-15 Progress
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Working with Protocol Packs

SCA BB uses stateful Layer 7 capabilities for classification of traffic flows.

When atraffic flow is handled by the system, it is assigned a signature 1D according to the set of Layer
3 to Layer 7 parameters (the signature) characterizing this flow. Typically, these signatures come
embedded in SCA BB.

In order to enable rapid response to the ever-changing protocol environment, SCA BB was enhanced to
allow signatures to be updated dynamically. You can load a protocol support plug-in onto an operational
system, enhancing the system’s protocol support without compromising the stability of the system (no
update of an existing software component is required) and without any service downtime.

» Protocol Packs, page 4-19

« Installing Protocol Packs, page 4-20

« Installing the Service Hierarchy Tree, page 4-20

« How to Verify Version Compatibility for Protocol Packs, page 4-26
- How to Verify the Installation of a Protocol Pack, page 4-26

» Hitless Upgrade of the SLI, page 4-27

Protocol Packs

Note

Note

Periodically, Cisco publishes protocol packs containing new and improved protocol signatures for SCA
BB. A typical protocol pack is afile containing signatures for detecting network worms, popular
peer-to-peer applications, and other relevant protocols. When loaded into SCE platforms, these
signatures improve SCA BB classification abilities.

You can install a protocol pack on an SCE platform only if a PQI is already installed on the platform.

A protocol pack for SCA BB may be either a DSSfile or an SPQI file:
- Loading a DSS file to the SCE platform requires no downtime of SCA BB or the platform.
» Loading an SPQI file to the SCE platform entails updating the SCE application:

— If hitless upgrade (see Hitless Upgrade of the SLI, page 4-27) is enabled, there is no downtime
of the SCE platform when loading the SPQI file.

— If hitless upgrade is not enabled, loading an SPQI file requires a short downtime (up to one
minute) of the SCE platform. During that time, network traffic bypasses the platform and is
neither controlled nor reported.

If hitless upgrade is disabled, SPQI installation can cause the loss of the following subscriber data from
all subscribers: package ID, real-time monitoring flag, and quota settings. Subscribers are assigned
default values for these properties.

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter4  Getting Started |

M Working with Protocol Packs

Installing Protocol Packs

N

Note

You install a protocol pack on an SCE platform using one of the following:
- The SCA BB Service Configuration Utility, page 13-1
» The Network Navigator tool (see How to Install a Protocol Pack, page 5-19)

If the protocol pack isan SPQI fileyou can enable and configure the hitless upgrade option using Hitless
Upgrade CLI commands. (See Hitless Upgrade of the SL1, page 4-27.)

The tool or utility performs the following steps:

1. Retrievesthe current service configuration from the SCE platform and (optionally) stores a backup
copy in afolder that you specify.

2. Imports the signatures that are in the DSS or SPQI file into the service configuration. This
overwrites any DSS that was previously imported into the service configuration.

3. For each new signature that includes a Buddy Protocol attribute (an attribute that points to an
existing protocol) (see The Buddy Protocol, page 12-4)—Adds the new signatureto all servicesthat
include the buddy protocol.

4. If the protocol pack is an SPQI file—Replaces the SCE application. This causes a short (up to one
minute) downtime in SCE platform service.

5. Applies the new service configuration to the SCE platform.

If the protocol pack is an SPQI file and the hitless upgrade option is enabled, you can monitor the
progress of the upgrade using Hitless Upgrade CLI Commands, page 4-28.

Installing the Service Hierarchy Tree

Note

Opening a POB using the Client (GUI) exposesits service hierarchy tree (signatures, flavors, protocols,
and so forth). The Service Configuration Hierarchy is defined by the Client.

When loading a PQB file from the SCE, it is essential that the PQB Hierarchy Tree will be the same
version as the one in the Client, or in other words, the PQB must be the same version as the Client,
otherwise the PQB will not be opened.

Since the client can be connected with different SCE with different versions, and since each PQB can
have different Service Hierarchy Tree definition, the user needsto install the relevant Service Hierarchy
Treein the Client (GUI) before opening a PQB.

The client has the ability to install the service hierarchy tree according to the SCE version. The GUI
installation comes with afixed set of service hierarchy elements which are placed in a specific version
related jar files. This enables the user to select between different jars related to different versions.

The SCE service hierarchy tree is different than the client version. When installing a service hierarchy
tree for a SCE:

Always Back up user PQB prior to upgrade to PPXY and keep a copy since the PQB will be changed.

Remove/Reinstall Service Tree Protocol

To view, install, and remove the service hierarchy tree use the following procedures.
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View and Install Service Hierarchy Tree

Stepl  To view the service hierarchy tree open the Protocol Pack tab.

Step2  From the tool bar select Service Configuration Editor as shown in Figure 4-16.

Figure 4-16 Service Configuration Editor - Preferences

3 Service Configuration Editor - SCA BB Console

File Tools BEEEG=N Window Help

0 e

=4 Signature Editor -Q Service Configuration Editor |ﬂ Metwork Mavigator

275733

Step3  Select Preferences and then select Service Configuration as shown in Figure 4-17. A Preferences
window will open.

Cisco Service Control Application for Broadband User Guide
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Figure 4-17 Service Configuration Editor - Service Configuration

¥ Sorvice Configuration Editor - SCA BE Console

SR £ sorvee Corvoronen. [N —

2TETM

Step4  Select Protocol Pack from the Service Configuration tree as shown in Figure 4-18. The upper window

provides information related to service hierarchy tree related to the GUI.

[l Cisco Service Control Application for Broadband User Guide
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Step 5

Figure 4-18

Preferences (Filtered)

¥ Preferences (Filtered)

Working with Protocol Packs

Itype filker text

SCA BB

(= Service Configuration
Default DSS
Pratocal Pack

Protocol Pack

SPGI File Information:

Protocol Pack Descripkion:
This is an FCS version, changes are detailed in release notes,

Prokocol Pack location:
CADocuments and Settingsikaharon).p-cubeldpi-3.5.5. jar

Clear Default Protacol Pack] [ Choose File ]

[ 0K ] [ Cancel ]

275735

Toinstall anew service hierarchy tree, press the Choose File button and select either ajar file or a SPQI
file as shown in Figure 4-19.

Figure 4-19

Select Protocol Pack Jar File @

4y Recent
Documents

Desktop

s

My Documents

My Computer
FAHARDM- ..

<«

My M é?work

Select Protocol Pack

Loak in: |u'::j' pcube vi o e m

I yuserlog

%] dpi-3.5.0.ar

] dpi-3.5.1.jar

] dpi-3.5.5.jar

| =] dpi-3.5.5_backup PP18.jar

i-3,5.5_hackup. jar

File hame: !dpi-B. 5.5 backup.jar b l [ Open l

Files of type: iPmtocoI Fack Jar Files [*.jar] Vl [ Canel ] E
&
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Step6  Press Open, and approve the warning message (Figure 4-20) by pressing OK.

Figure 4-20 Protocol Pack Selection Warning Message

3£ Protocol Pack Selection

p | Setting new Protocol Pack may affect vour classification

[ Ok 1 [ Canicel ]

275737

Step7  To backup the current protocol pack and install the new service hierarchy tree, approve the backup
message (Figure 4-21) by pressing OK.

Figure 4-21 Protocol Pack Selection Backup Message

3£ Protocol Pack Selection

& Swstem will backup the current PP File in the Following path
. | Ci\Documents and Settingstkaharont, p-cube\dpi-3.5.5_backup.jar
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Remove Service Hierarchy Tree

Stepl  Toremove the service hierarchy tree and to return to the default configuration, select the Clear Default
Protocol Pack button in the Preferences window (Figure 4-22).

Figure 4-22 Preferences (Filtered)

¥ Preferences (Filtered)

|bvpe Fiter text | 5% | protocol Pack i

(=) Service Configuration
Defaulk D55
Protocol Pack
SCABE Protocol Pack Description:

This is an FCS version, changes are detailed in release nates,

SPQI File Informmation:

Protocol Pack location:
Ci\Dacurents and Settingsikaharon.p-cubeldpi-3.5.5.jar

Clear Default Protacal Pack] [ Choase Fila ]

[ K ][ Cancel ]

275739

Step2  Accept the operation by pressing OK on the Protocol Pack Removal message screen (Figure 4-23).

Figure 4-23 Protocol Pack Removal Message

3 Protocol Pack Removal

|, Removing the current Protocol Pack may affect waour classification
-

[ oK |[ Cancel ]

275740

The service hierarchy tree is removed from the system, and when a new PQB is opened, the client will
install the default service classifications.
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How to Verify Version Compatibility for Protocol Packs

A protocol pack is compatible only with specific versions of the SCE application. When working with
protocol packs, you should verify that the protocol pack version matches the SCE application version.
For example, only use a protocol pack for 3.5.5 on SCE application version 3.5.5.

The version compatibility information for each protocol pack isincluded in the protocol pack’s release
notes.

Stepl  Verify that the correct version of servconf isinstalled and running correctly.
e From the command prompt, type servconf --version.
e Press Enter.
The version of the utility should match that of the protocol pack.
Step2  Verify that the correct version of the SCE application is installed.
« At the SCE platform CLI prompt (sce#), type show version.
e Press Enter.
The application version should match that of the protocol pack.
Step3  Verify that a service configuration (PQB) is applied to the SCE platform.
» Inthe Console, retrieve and view the current PQB.

How to Verify the Installation of a Protocol Pack

Stepl At the SCE platform CLI prompt (sce#), type show version.
Step 2 Press Enter

The response shows the version of the OS running on the SCE platform. Thisincludesinformation about
the installed protocol pack version.

Step3  Retrieve the PQB from the SCE platform and view it using the Console.

Step4  Verify that the new protocols from the protocol pack were added to the service configuration.
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The problems that may cause the installation of a protocol pack to fail and their remedies include:

» Missing or incorrect version of the JRE—Install the correct version of the JRE (see Installing the
Java Runtime Environment, page 4-5).

« Incorrect or missing SCE application version on the SCE platform—Verify that the correct version
of the SCE application isinstalled (see How to Verify Version Compatibility for Protocol Packs,
page 4-26).

« No service configuration (PQB) is applied to the SCE platform—Create a new PQB and apply it
using the Console.

» servconf failed to import the new signatures into the PQB—Use the --force-signature update
signature option when running servconf (see servconf Syntax, page 13-1).

When reporting problems to Cisco, please include the servconf log file, located at
<user.home>\.p-cube\servconf.log. On Windows, this usually maps to C:\Documents and
Settings\<username>\.p-cube\servconf.log.

Hitless Upgrade of the SLI

Hitless upgrade is the SCA BB method of upgrading the software components that reside on the SCE
platform without incurring any service downtime.

» Hitless upgrade is available on SCE 2000 and SCE 1000_2U platforms.
» Hitless upgrade is not available on SCE 1000 _1.5U platforms.

If hitless upgrade is enabled, classification, reporting, and control continue uninterrupted when you
install an SPQI file (see Working with Protocol Packs, page 4-19). You caninstall SPQI filesusing either
the Console or servconf, the SCA BB Service Configuration Utility. An SPQI file is a package that
includes the required (SL1) files.

After the new application is loaded on the SCE platform:
» The new application services al new flows and bundles.

- The old application continues to service existing flows (and new flows that belong to bundles of
existing flows).

- Both applications share available memory.

Until all old flows die or are killed, the hitless upgrade is considered to be in progress. In order to make
the hitless upgrade process bounded, you can set criteriathat will trigger the explicit killing of all flows
still executing on the old application. Two such criteria exist:

» When a specified amount of time has passed since the process started.
= When the number of old flows goes below a specified threshold.

The default value for the first criterion is 60 (minutes); the default value for the second is zero (flows).
This means that the replace operation is guaranteed to complete after no more than one hour (sooner, if
all old flows die naturally), but no old flows are killed by the application before one hour passes.

These criteria are configurable by CLI commands.

You can initiate the explicit killing of all old flows using a manual command.

| oL-7205-19
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Hitless Upgrade CLI Commands

You can configure, monitor, and control hitless upgrade using the SCE platform Command-Line
Interface (CLI). For more information about the SCE platform CLI, see the Cisco SCE8000 CLI
Command Reference.

The commands listed here are explained in the following section.

Use the following CLI commands to configure the criteria for completing a hitless upgrade:

replace completion time <minutes>

no replace completion time

default replace completion time
replace completion num-flows <num>
no replace completion num-flows
default replace completion num-flows

These commands are lineinterface configuration commands. To run these commands you must enter line
interface configuration mode (see How to Enter Line Interface Configuration Mode, page 4-29) and see
the sce (config if)# prompt displayed.

The following two CLI commands are EXEC mode commands.

Use the following CLI command to monitor the progress of a hitless upgrade:

show applications slot <num> replace

Use the following CLI command to force immediate completion of a hitless upgrade:

application slot <num> replace force completion

Description of Hitless Upgrade CLI Commands
Table 4-1 describes the hitless upgrade CLI commands listed in the previous section.

Table 4-1 Hitless Upgrade CLI Commands

Command Description

replace completion time <minutes> Setsthe time criterion for killing all old flows and
completing the hitless upgrade.

Specifying a value of zero disables this
criterion—the hitless upgrade is completed only
when the number-of -flows criterion is met.

no replace completion time Sets the time criterion for completing the hitless
upgrade to zero.

default replace completion time Resets the time criterion for completing the
replace operation to the default value of 60.

replace completion num-flows <num> Sets the number-of-flows criterion for completing
the hitless upgrade operation.

When the number of old flows drops below the
number specified by this criterion, the remaining
flows are killed and the hitless upgrade is
complete.
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Table 4-1 Hitless Upgrade CLI Commands (continued)
Command Description

no replace completion num-flows

Sets the number-of-flows criterion for completing
the hitless upgrade to zero.

default replace completion num-flows

Resets the number-of-flows criterion for
completing the hitless upgrade to the default value
of zero.

show applications slot <num> replace

Shows the current hitless upgrade state:
« Current replace stage
« Current completion criteria

« Current completion status (elapsed time and
number of flows on each traffic processor)

« Whether thisis an upgrade or a downgrade
« Values for spare memory

application slot <num> replace force
completion

Forces the current hitless upgrade process to
complete (killing all old flows).

How to Enter Line Interface Configuration Mode

Step 1
Step 2

Step 3
Step 4

To run line interface configuration commands you must enter line interface configuration mode and see

the SCE(config if)# prompt displayed.

At the SCE platform CLI prompt (scEe#),

Press Enter.

The sce (config) # prompt appears.
Typeinterface LineCard 0.

Press Enter.

The sce (config if)# prompt appears.

type configure.

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter4  Getting Started |

I How to Launch the Console

How to Launch the Console

Stepl  Choose Start > All Programs > Cisco SCA > SCA BB Console 3.5.5 > SCA BB Console 3.5.5.
The Cisco Service Control SCA BB Console splash screen appears (Figure 4-24).

Figure 4-24 Cisco Service Control SCA BB Console

i
ciIsco

Cisco Service Control
SCA BB Console

s, and the Cisco Systems logo are trademarks
5 affiliates inthe United States and certain

275741

After the Console has loaded, the main window of the Console appears.
The first time that you launch the Consol e, the Welcome view is open in the main window(Figure 4-25).
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Figure 4-25 Welcome - Introducing Cisco Service Control
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Close the Welcome view and click Go to the console.

The Welcome view closes. The Network Navigator tool is open in the Console (Figure 4-26).
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Figure 4-26 Network Navigator
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Note

When you close the Console, it will remember which tools are open, whichisthe activetool, and whether
the Welcome view is displayed, and apply this the next time you launch the Console.

[l Cisco Service Control Application for Broadband User Guide
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How to Use the Console

The Console is the front end of SCA BB. You use it to configure the services that the SP offers to you.
The Console consists of the following tools:

» Network Navigator tool

» Service Configuration Editor tool

- Signature Editor tool

» Subscriber Manager GUI tool

» Reporter tool
The Console GUI hasamenu bar and a standard toolbar (Figure 4-27). Underneath the tool bar is another
bar that displays the button of any open Console tool. When you launch atool, a button is added to this
bar. To switch between open tools, click the appropriate button on the bar.
Figure 4-27 Menu Bar and Toolbar of the Console GUI

Eile Tools Preferences Window Help

275744

Ey [ signature Editor _é Subscriber Manager & Reporter | @ njetwark Mavigatar g Service Configuration Editar

Note  Thetitle of the Console window shows the active tool and the active service configuration.

The Welcome View of the Console links to a number of Configuration Wizards that can configure the
initial, basic configuration of your system.

- Configuration Wizards, page 4-34

» The Network Navigator Tool, page 4-68

» The Service Configuration Editor Tool, page 4-70
» The Signature Editor Tool, page 4-72

» The Subscriber Manager GUI Tool, page 4-73

- The Reporter Tool, page 4-74

e Online Help, page 4-75

Cisco Service Control Application for Broadband User Guide
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Configuration Wizards

Four configuration wizards are available from the Welcome view (three of these wizards can also be
executed from the Network Navigator tool):

» Usage Analysis wizard—Creates a simple model of devices and connects to them.
» The P2P Traffic Optimization wizards:

— P2P Traffic Optimization wizard—Creates a simple model of devices, connects to them, and
limits P2P traffic to a specified percentage of total available bandwidth.

— P2P Traffic Optimization at a Peering Point wizard—Creates a simple model of devices,
connects to them, limits P2P traffic to a specified percentage of total available bandwidth, and
allows you to enable asymmetric routing classification mode.

- Reporter DB Configuration wizard—Connects the SCA BB Reporter tool to a database.

Asymmetric Routing

Traffic processing depends on the routing environment. The Cisco Service Control solution can operate
in two typical routing schemes, symmetric and asymmetric. In asymmetric routing, for a significant
number of flows, only one direction (inbound or outbound) is routed through the SCE platform.

Anonymous Subscriber Mode

Anonymous subscriber mode is a mode in which entities defined as | P addresses are treated as
subscribers.

Cisco Service Control Application for Broadband User Guide
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N

Note

Step 1

Step 2

The Usage Analysis wizard allows you to create a simple model of devices and connect to them.

If they do not already exist, devices defined in thewizard are added to the default sitein the Site Manager

tree.

From the Console main menu, choose Help > Welcome.
The Welcome view opens (Figure 4-28).

Figure 4-28
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Click Usage Analysis Wizard.
The Welcome page of the Usage Analysis wizard appears (Figure 4-29).
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Figure 4-29 Usage Analysis

3 Usage Analysis Wizand |;|
Usage Analysis .r_

SCA BE can collect statistics about the applications and services used by individual
subscribers, This data can be used For capacity planning and detailing the subscriber
dermographics.

This wizard lets wou quickly setup the system For usage analvsis,

Cancel

275745

S

Note  You can also execute the Usage Analysis wizard from the Network Navigator tool:

1. Select one or more devices in the Site Manager tree.
2. Right-click one of the selected devices.

3. From the popup menu that appears, select Configuration Wizards > Usage Analysis
Configuration.

4. You can set only one CM and one Reporter database in the wizard. If you select more than one CM
or Reporter database, only one CM and one Reporter database is selected and a warning messageis
displayed. Click OK to continue.

Step3  Click Next.
The SCE | P Addresses page of the Usage Analysis wizard opens (Figure 4-30).
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Figure 4-30 SCE IP Addresses

3 Usage Analysis Wizand |;|IE|[‘§__(J

SCE IP Addresses .f_
@ One or more SCE IP addresses must be specified —¥;
Configuring the SCE platforms requires that they are first added to the Metwork
Mawigatar,

Tao add SCE platforms to the Metwaork Mavigataor, tvpe their IP addresses in the text
bax below (For exarnple: 10.56.216.37, 10.56,216,38):

275748

In the edit box, enter the IP addresses of the SCE devices that should be added to the model.

If you started from the Network Navigator, the |P addresses of the SCE devices that you selected are
displayed in the edit box. You can add additional addresses.

You can work with up to 20 SCE devices at one time using the wizard.

Click Next.

The SCE Usernames and Passwords page of the Usage Analysis wizard opens (Figure 4-31).

| oL-7205-19
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Figure 4-31 SCE Usernames and Passwords

3£ Usage Analysis Wizand |Z|@

SCE Usernames and Passwords -r
@ & password for the SCE 10.56.216.37 is missing 4

In order bo connect to the SCE platforms, & username and a password need to be
specified for each SCE,

(%) Use a common username and a common password For all SCE platforms:
Username: ac!mln
Password:

() Use separate usernames and passwords for each SCE platform:

SCE IP Address | Username  Password

275747

Step6  Enter the user names and passwords for the SCE devices.
Do one of the following:

» To usethe same user name and password for all the SCE devices that you are adding, enter the user
name in the Username field and the password in the Password field

- To provide a different user name and password pair for each SCE device, select the Use separ ate
usernames and passwor ds for each SCE platform radio button, and, for each SCE device, enter
the user name and password in the appropriate cell of the table.

Step7  Click Next.
The CM Setup page of the Usage Analysis wizard opens (Figure 4-32).
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Figure 4-32 CM Setup

3 Usage Analysis Wizand |;|
CM Setup .r_
& AnIP address is missing N

Configuring the CM requires that it is First added ko the Mebwork Mavigatar, To add the
M ta the Metwork Mavigator, tvpe its IP address, username and password in the bext
boxes below,

The wizard will werify the CM operational state, and configure the SCE platforms to
send RDRs ko the M. ¥ou may skip this step if the CM is already defined as the RDR
destination of the SCE platforms.

[ 3kip this step

CM IP address: | |

=

CM PRPC username; | SCMSEM

CM PRPC password: |

275748

Step8  Define the SCSM Collection Manager (CM) to use with this configuration.
Do one of the following:
- Enter the IP address, user name, and password of the CM device in the appropriate fields.

If you started from the Network Navigator, thisinformation is retrieved and displayed. You can
modify these parameters.

» Check the Skip this step check box.
Step9  Click Next.

The Reporter Setup page of the Usage Analysis wizard opens (Figure 4-33).

Cisco Service Control Application for Broadband User Guide
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Figure 4-33 Reporter Setup

3 Usage Analysis Wizand

Reporter Setup

& AnIP address is missing E

The Reporter generates reparts by executing queties on a database, Specify the
database IP address and its bvpe below,

‘Yol may skip this step if the Reporter is already connected to a database.
[ skip this step

Database IP address: | v ;

Database type:

275749

Step 10  Define the database to which the Reporter tool should connect.
Do one of the following:

« Enter the IP address of the database and select the database type.

If you started from the Network Navigator, thisinformation is retrieved and displayed. You can
modify these parameters.

« Check the Skip this step check box.
Step11  Click Next.

The Connectivity Test page of the Usage Analysis wizard opens (Figure 4-34).

[l Cisco Service Control Application for Broadband User Guide
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Figure 4-34 Connectivity Test

3£ Usage Analysis Wizard @
Connectivity Test .f_
Al connectivity tests have passed.

The wizard will now test the connectivity to the devices that wou specified, to werify
that carrect IP addresses, usernames and passwords were used.
Flease wait Ffor the connectivity test bo camplete,

In case of an error, you may use the 'Back! button ko go back to previous steps and

cotrect the IP addresses, usernames of passwords, if necessary. You may alsa choose
to skip or retry the connectivity test using the buttons belaw,

[ Type IP Address Status

SEE 10,56,216,37  Connection succeeded
Database 10.56.201.81 Connection succeeded
M 10.56,201.81  Connection succeaded

Skip connectivity besk ] ’Eetry conneckivity kest

| =Back ” Pt = I

244853

The wizard tests to see that the connections to the defined devices can be made.

Note  If aconnection to one or more of the devices cannot be made or if there is some problem with the
connection (such asinvalid version of the device) an error is displayed next to the device. You can skip
these tests by clicking Skip connectivity test. The connections will be validated when you click Finish
at the end of the wizard.

Step12 Click Next.
The Anonymous Subscribers page of the Usage Analysis wizard opens (Figure 4-35).

Cisco Service Control Application for Broadband User Guide
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Figure 4-35 Anonymous Subscribers

3£ Usage Analysis Wizard

Processing traffic per individual subscriber’s IP address 3
in Anonymous Subscribers Mode

In Anonymous Subscribers mode, analysis is performed on an incoming IP address, as
the 5CE platform creates an ‘anonymous', on-the-fly record for each subscriber,

This permits analyzing and controlling traffic at an individual subscriber IP address level,
without OS5 integration,

‘fou may choose to skip this step if other Form of subscriber integration is already
configured in the system,

[¥]Enable Anon mous Subscribers mode:

[ « Back ” Tk = I

241844

Step 13 To disable anonymous subscriber mode, clear the Enable Anonymous Subscriber s mode check box.
Step14 Click Next.
The Confirmation page of the Usage Analysis wizard opens (Figure 4-36).
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Figure 4-36 Confirmation

¥ Usage Analysis Wizard EJ

The Follnﬁwing actions will be pe'rfo-rmed when you hit the *Firish’ buttan:

Connect to the following SCE platforms and add them to the Mebwork Mavigator:

| 10.56.216.37

Connect to the CM 10.56.201.81 and add it to the Network Navigator

Configure the SCE platforms ko send category 1 RDRs bo the CM

Set the SCE platForms to Anonymous Subscribers mode

Create a Report Only service configur ation with transaction ROR rate set as default,
divided by the number of SCE platforms

Apply the service configuration ko the SCE platforms

Connect the Reporter to the database 10.56.201 .81

Merify that the database is connected and configured correckhy

[ Einish H Cancel ]

241008

The actions that the wizard is about to take are listed in the page.
Step15 Click Finish.
The Configuration Output page of the Usage Analysis wizard opens (Figure 4-37).

Cisco Service Control Application for Broadband User Guide
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Figure 4-37 Configuration Output

Configuration Dutput

Please wait while the system is being configured.

+ 11 11 O? IST | IWFOD | ha‘t the CM 15 1n5‘ta'|1ed [Jr‘u:!per"l:.-r A
4 1 PM IST | WarN | | ‘] W p=mNg3-sce, C1Sco . Com
+ 11/11/0.? I5T | INFO | App]:ﬂng conﬁgur‘atmn tD SCE 10.56.216.37 (1 out of
+ 11,/11,/07 I5T INFD kReading SCE platform data ...
+ 1111707 L& | INFD | Preparing configuration script for SCE2000 - 4<FE ..
+ 11711707 IST | INFD sending configuration to SCE ...
+ 11711707 IST | IHFD | Executing configuration script on SCE ...
+ 11,1107 IST | INFD Updating configuration registry ..
+ 11/11/07 IST | IHFD | Updating CM at 10.56.201.81 with service configurati
+ 11/11/07 IST | INFD Updating the M at 10.56.201.81 completed.
+ 11,/11,/07 B | INFQ | Updating CM at 10.56.216.38 with service configurati
+ 11[11[0? = 15T INFD App]ymg cnn'F'lgur'atmn ‘tD SCE 1O 56 216 3? cnmp'le'ted
+ 11/11/07 i 37 PM.IST WAEN | Fai i"‘\.'. TO update ¢ SeryiICE
+ 11711707 2.00.3? PM IST | INFD | Connectmg the Reporter tD the datahase
+ 111107 2:00:42 PM IST | INFD | Werifying that the database 1s connected and configu
SC4 BE Templates:

[PASS] A database connection 1s defined and available.

[Pa55] A11 mandatory preferences hawe settings.

[PaS5] Policy string translations are awvailahle.

[PASS] Timezone information in CM DB is available.
+ 1111707 2:00:42 PM IST | INFD | Configuration completed successTuly

v

4 | >

|_ et = H Close ][ Cancel J

241825

New devices are added to the default site of the Site Manager tree in the Network Navigator
(Figure 4-38).

Figure 4-38 Site Manager Tree

= & Site Manager

=R
SCE device 1 [10.56.216,37]
é‘ M device [10.56.201,51]

Database device [10,56,201.81]

241865

The wizard attempts to connect to all devices that you defined. The operation fails if:
« Thewizard cannot connect to any of the SCE devices that you listed in Step 4.
» You defined aCM in Step 8, but the wizard cannot connect to it.
» You defined a database in Step 10, but the wizard cannot connect to it.

If you defined a CM in Step 8, the SCE devices are configured so that the only category 1 RDR
destination isthe CM.

Cisco Service Control Application for Broadband User Guide
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Note  RDR categories are the mechanism by which different types of RDRs can be sent to different collectors.
For more information about RDR categories, see either the Raw Data Formatting: The RDR Formatter
and NetFlow Exporting” chapter of the Cisco SCES8000 10GBE Software Configuration Guide or the
Raw Data Formatting: The RDR Formatter and NetFlow Exporting” chapter of the Cisco SCE8000 GBE
Software Configuration Guide.
A new service configuration named Usage Analysis is created, and opens in the Service Configuration
Editor (Figure 4-39).
Figure 4-39 Service Configuration Editor
FE§ | & servie Confguration Edr |
Q PZP Traffic Optimization Wizard.pgb - &3
Policies : Service Security
L& Palicies | Bl Classification |
L I I _‘j}c_ Configuration -
[~ Fitered Traffic
E.i Service Security
5 Glabal Policy
Subscriber Policies
% Default Package g
- Unknown Subscriber Package E
The service configuration has the following characteristics:

» Report Only mode.

» The maximum Transaction RDR rate is set as the default value (250) divided by the number of SCE
devices. (To configure the Transaction RDR see How to Manage Transaction RDRs, page 8-6; the
content and structure of the Transaction RDR islisted in “ Transaction RDR” in the “Raw Data
Records: Formats and Field Contents” chapter of the Cisco Service Control Application for
Broadband Reference Guide.)

The service configuration is applied to the SCE devices.
If you defined a database in Step 10:

1. The SCA BB Reporter tool is connected to the selected database.

2. Thefirst SCE platform entered in Step 4 is selected as the source of service configuration data.

3. The Next button is enabled.

Step 16  If you did not define a database in Step 10, click Close.
The Usage Analysis wizard closes.
Step17  Click Next.
The Create common reports page of the Usage Analysis wizard opens (Figure 4-40).
Cisco Service Control Application for Broadband User Guide
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Figure 4-40 Create Common Reports

3

Create common reports

Step 18

N

Note

Step 19

This wizard can create and display common reports once the system configuration is completed.

Moke that in order for the reports to show meaningful information, sufficient data must First be accumulated in the database, You may
refresh the reports every Few minutes, as data arrives from the SCE platforms to the database,

[ reate and display common reparts once the canfiguration is completed

[ Close ] ’ Cancel

I

To create reports, check the Create and display common reports check box.

241897

Report instances will be created for four predefined report types:

Global Bandwidth per Service

Global Active Subscribers per Service

Top P2P Protocols

Global Hourly Call Minutes per Service (VolP)

Click Close.
The wizard closes.

The Reporter tool opensin the Console.

Report instances of each of the four report types open in the Report View of the Reporter tool.

[l Cisco Service Control Application for Broadband User Guide
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How to Use the P2P Traffic Optimization Wizards

There are two wizards for optimizing P2P traffic:

» The P2P Traffic Optimization wizard allows you to create a simple model of devices, connect to
them, and limit P2P traffic to a specified percentage of total available bandwidth.

- The P2P Traffic Optimization at a Peering Point wizard allows you to create a simple model of
devices, connect to them, limit P2P traffic to a specified percentage of total available bandwidth, and
enable asymmetric routing classification mode.

Note  If they do not already exist, devices defined in the wizard are added to the default sitein the Site Manager
tree.

Stepl  From the Console main menu, choose Help > Welcome.
The Welcome view opens (Figure 4-41).

Figure 4-41 Welcome - Introducing Cisco Service Control
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Step2  Click P2P Traffic Optimization Wizard or P2P Traffic Optimization for Asymmetrical Routing
Wizard.

The Welcome page of the selected wizard appears (Figure 4-42 or Figure 4-43).

Cisco Service Control Application for Broadband User Guide
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Note

Step 3

Figure 4-42 P2P Traffic Optimization

3¢ P2P Traffic Optimization Wizard

P2P Traffic Dptimization :

SCA BE can prevent nebwork congestion and reduce costs, caused by
bandwidth-hungry applications such as P2P, and imprave subscriber experience in using
latency sensitive applications such as woice,

This wizard lets wou quickly setup the system Far P2P Traffic Optimization.

Figure 4-43 P2P Traffic Optimization for Asymmetrical Routing

3 P2P Traffic Optimization for Asymmetrical Routing Wizard [g]

P2P Traffic Dptimization ;

SCA BE can prevent nebwork cangestion and reduce costs, caused by
bandwidth-hungry applications such as P2P, and imprave subscriber expetience alsa in
environments where Asyrmmetrical Rouking occurs (that is, the bwo sides of a TCP ar
LIDP Flow, or some parts of the averall subscriber's traffic braverse on different netwark
routes),

This wizard lets wou quickly setup the system For P2P Traffic Optimization in
Asymmetrical Routing Environments.,

—
241855

241857

You can also execute the P2P Traffic Optimization wizard from the Network Navigator tool:

1. Select one or more devices in the Site Manager tree.
2. Right-click one of the selected devices.

3. From the popup menu that appears, select Configuration Wizards > P2P Traffic Optimization
Wizard or Configuration Wizards > P2P Traffic Optimization for Asymmetrical Routing

Wizard.

4. You can set only one CM and one Reporter database in the wizard. If you select more than one CM
or Reporter database, only one CM and one Reporter database is selected and a warning messageis

displayed. Click OK to continue.
Click Next.

The SCE I P Addresses page of the P2P Traffic Optimization wizard opens (Figure 4-44).

Cisco Service Control Application for Broadband User Guide
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Figure 4-44 SCE IP Addresses

3 P2P Traffic Optimization Wizard

SCE IP Addresses

@ One or more SCE IP addresses must be specified F

Configuring the SCE platforms requires that they are first added to the Metwork
Mawigatar,

Tao add SCE platforms to the Metwaork Mavigataor, tvpe their IP addresses in the kext
bax below (For exarnple: 10.56.216.37, 10.56.216,38):

275751

In the edit box, enter the |P addresses of the SCE devices that should be added to the model.

If you started from the Network Navigator, the IP addresses of the SCE devices that you selected are
displayed in the edit box. You can add additional addresses.

You can work with up to 20 SCE devices at one time using the wizard.

Click Next.

The SCE Usernames and Passwords page of the P2P Traffic Optimization wizard opens (Figure 4-45).
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Figure 4-45 SCE Usernames and Passwords

3 P2P Traffic Optimization Wizard

SCE Usernames and Passwords
@ & password For the SCE 10.56.216.37 is missing

In order bo connect to the SCE platforms, & username and a password need to be
specified for each SCE.

(%) Use a common username and a common password for all SCE platforms:
Username: ac!mln
Passward: |

() LUse separate usernames and passwords for each SCE platform:

SCE IP Address | Username  Password

275752

Step6  Enter the user names and passwords for the SCE devices.
Do one of the following:

» To usethe same user name and password for all the SCE devices that you are adding, enter the user
name in the Username field and the password in the Password field.

» To provide a different user name and password pair for each SCE device, select the Use separ ate
usernames and passwords for each SCE platform radio button, and, for each SCE device, enter
the user name and password in the appropriate cell of the SCE device table.

Step7  Click Next.
The CM Setup page of the P2P Traffic Optimization wizard opens (Figure 4-46).
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Figure 4-46 CM Setup

3 P2P Traffic Optimization Wizard

CM Setup
& AnIP address is missing

Configuring the CM requires that it is First added ko the MNebwork Mavigatar, To add the
M ta the Metwork Mavigator, tvpe its IP address, username and password in the text
boxes below,

The wizard will werify the CM operational state, and configure the SCE platforms to
send RDRs ko the M. You may skip this step if the CM is already defined as the RDR
destination of the SCE platforms.

[ 3kip this step

CM IP address: | |

[

CM PRPC username; | SCMSEM

CM PRPC password: |

Define the SCSM Collection Manager (CM) to use with this configuration.

Do one of the following:

275753

How to Use the Console M

« Enter the IP address, user name, and password of the CM device in the appropriate fields.

If you started from the Network Navigator, thisinformation is retrieved and displayed. You can

modify these parameters.
« Check the Skip this step check box.
Click Next.

The Reporter Setup page of the P2P Traffic Optimization wizard opens (Figure 4-47).
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Figure 4-47 Reporter Setup
3¢ Reporter DB Configuration Wizard
Reporter Setup ﬂ
& AnIP address is missing /X'\
.
The Reporter generates reparts by executing queties on a database, Specify the
database IP address and its bvpe below,
Database IP address: | v_l
Database bype: E_Sybase v!
o

Step 10  Define the database to which the Reporter tool should connect.

Do one of the following:

Enter the | P address of the database and select the database type.

If you started from the Network Navigator, thisinformation is retrieved and displayed. You can
modify these parameters.

» Check the Skip this step check box.
Step11 Click Next.

The Connectivity Test page of the P2P Traffic Optimization wizard opens (Figure 4-48).

[l Cisco Service Control Application for Broadband User Guide
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Figure 4-48 Connectivity Test

3 P2P Traffic Optimization Wizard

Connectivity Test
Testing conneckivity ...

The wizard will now test the connectivity to the devices that wou specified, to werify
that carrect IP addresses, usernames and passwords were used.
Flease wait Ffor the connectivity test bo camplete,

In case of an error, you may use the 'Back! button ko go back to previous steps and

cotrect the IP addresses, usernames of passwords, if necessary. You may alsa choose
to skip or retry the connectivity test using the buttons belaw,

[ Type IP Address Status

SEE 10,56,216,37  Connection succeeded
Database 10.56,201.8  Testing conneckivity ...
M 10.56,201.81  Connection succeaded

Skip connectivity besk ] ’Eetry conneckivity kest

Cancel

241852

The wizard tests to see that the connections to the defined devices can be made.

Note  If aconnection to one or more of the devices cannot be made or if there is some problem with the
connection (such asinvalid version of the device) an error is displayed next to the device. You can skip
these tests by clicking Skip connectivity test. The connections will be validated when you click Finish
at the end of the wizard.

Step12 Click Next.
The Anonymous Subscribers page of the P2P Traffic Optimization wizard opens (Figure 4-49).

Cisco Service Control Application for Broadband User Guide
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Figure 4-49 Anonymous Subscribers

3 P2P Traffic Optimization Wizard

Processing traffic per individual subscriber’s IP address
in Anonymous Subscribers Mode

In Anonymous Subscribers mode, analysis is performed on an incoming IP address, as
the 5CE platform creates an ‘anonymous', on-the-fly record for each subscriber,

This permits analyzing and controlling traffic at an individual subscriber IP address level,
without OS5 integration,

‘fou may choose to skip this step if other Form of subscriber integration is already
configured in the system,

[¥]Enable Anon mous Subscribers mode:

[ « Back “ Tk = I Einish

244853

Step 13 To disable anonymous subscriber mode, clear the Enable Anonymous Subscriber s mode check box.
Step14 Click Next.
The effect of P2P traffic optimization page of the P2P Traffic Optimization wizard opens (Figure 4-50).
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Figure 4-50 Effect of P2P Traffic Optimization

3 P2P Traffic Optimization Wizard

The effect of P2P traffic optimization :

This wizard configures the system to enfarce strick priority between 3 levels of service:
High {vaice), Mediurn {ather) and Low (P2P),

The bwao charts below demonstrate the effect of P2P traffic optimization. The chart an
the left shows how, during peak hours, uncontralled P2P (in blue) causes congestion
(total kraffic crosses the red line), while browsing (vellow) and woice (green) quality
deteriorates.

The prictitization that is enforced by this configuration takes place when the katal
traffic rate crosses the configured limit. The chart on the right shows how congestion is
mitigated by thrattling P2P traffic, while allowing brawsing and voice traffic to kake its

place.

[ = Back “ Mewt > | Finish

241854

This page explains why you should optimize (limit) P2P traffic.
Step15 Click Next.

The Link rate limits for P2P traffic optimization page of the P2P Traffic Optimization wizard opens
(Figure 4-51).

Cisco Service Control Application for Broadband User Guide
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Figure 4-51

Link Rate Limits

3 P2P Traffic Optimization Wizard

Upstream limit:

Downstream limit:

Link rate imits for P2P traffic optimization

J

]

AR A F

[ < Back. ” Tet = ]

=

In the sliders below, corfigure the total upstream and downstrean traffic rate limits
(the red line) that should be enforced by the SCE platform, The SCE platfarm will maks
sure that total rate does not exceed this configuration, while maintaining priovity
between different applications.

These settings can be changed later in the Glabal Controllers configuration dislag,

¢ 6000 Mbps

20000 Mbps

Cancel

Step 16  Use the sliders to configure the upstream and downstream link rate limits.
The scale of each slider is the percentage of the aggregated bandwidth of both links.
Step 17 If you are running the P2P Traffic Optimization wizard, go to Step 20.

275755

If you are running the P2P Traffic Optimization for Asymmetrical Routing wizard, continue at the next

step.
Step18 Click Next.

The Classification of split flows page of the P2P Traffic Optimization wizard opens (Figure 4-52).
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Figure 4-52 Classification of Split Flows

3 P2P Traffic Optimization for Asymmetrical Routing Wizard

Classification of split flows :

Enable Asymmetric Routing Classification Made when the SCE platforms are inserted in
topalogies with Asymmetrical Routing where the SCE platforms "sees" one direction
part of the each TCP ar UDP bi-directional Flow,

In this mode, the system is better tuned Far still classifying the traffic correcthy while
the SCE platform "sees" only one direction of & flaw, but, some of the system?s
functionality is disabled in this mode (please refer ta the SCA BE User Guide For details).

[JEnable asymmetric Routing Classification Mode:

[ « Back ” [k = l Einish

244855

Step 19  To enable asymmetric routing classification mode, check the Enable Asymmetric Routing
Classification M ode check box.

Step20 Click Next.
The Confirmation page of the P2P Traffic Optimization wizard opens (Figure 4-53).

Cisco Service Control Application for Broadband User Guide
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Step 21

Figure 4-53 Confirmation

3 P2P Traffic Optimization Wizard

The Foilowing actions will be perFormed when you hit the 'Finish' buttan:

Connect to the fFollowing SCE platforms and add them to the Mebwork Mavigator:
10,56.216.37
Connect to the CM 10.56.201.81 and add it to the Metwork Navigator
Configure the SCE platforms ko send category 1 RDRs to the M
Set the SCE platforms to Anonymous Subscribers mode
Create a Fully Functional service configuration with the following characteristics:
Defaulk Upstream GC PIR is sek ab 30%
Default Downstream GC PIR is set at 100%
For both the 'Default Package' and the 'Unknown Subscriber Package’, the
following BWCs are created:
P2P BWC: CIR=Min, PIR=Unlimited, AL=1
Yol BWC: CIR=Mazx, PIR=Unlimited, AL.=10
Other BWC: CIR=Max, PIR=Unlimited, Al=1
Apply the service configuration ko the SCE platforms
Connect the Reporter to the database 10.56.201.81
Merify that the database is connected and configured correckhy

[ Finish I [ Cancel

l

The actions that the wizard is about to take are listed in the page.

241867

For an explanation of the bandwidth controller parameters, see Subscriber BWC Parameters, page 9-29.

Click Finish.

The Configuration Output page of the P2P Traffic Optimization wizard opens (Figure 4-54).
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Figure 4-54 Configuration Output

e

Configuration Dutput

Please wait while the system is being configured.

+ 11 11 O? 2:3d:42 PM IST | INFO | \-fer1'Fy1ng ‘tha‘t the CM 15 1n5‘ta'|1ed [Jr‘u:!per"l:.-r N
t 2:34:42 PM IST | WAEN | Found anonymous agm l-sce, C1scO. com
+ 11/11/0.? 2 IsT INFO App]:ﬂng conﬁgur‘atmn tD SCE 1D 56 216 37 {1 out of
+ 11/11,/07 2 I5T INFD kReading SCE platform data ...
+ 11511707 2 L& INFD Preparing configuration script for SCE2000 - 4<FE ..
+ 11711707 2: IST | INFD sending configuration to SCE ...
+ 11711707 2: IST | INFD Executing configuration script on SCE ...
+ 11711707 2 IST | INFD Updating configuration registry ..
+ 11711 /07 2 IST | INFOD Updating CM at 10.56.201.81 with service configurati
+ 11/11/07 2: IST | INFD Updating the M at 10.56.201.81 completed.
+ 11[11[0? bt L5 INFD Upda‘t'lng M a‘t 10 Sh. 216 38 w1th service con'F'lgur'a‘t'l
: Jr 2:35 | T5T | WARN | Failed to update cM at 10, S e L Sl T
+ 11/11/0? 2z IST | INFD App'ly'lng canﬁgur'atmn to SCE 10 56 216,37 comp'leted
+ 11711707 2: IST | INFD Connecting the Reporter to the database
+ 11711707 2 IST | INFD Werifying that the database s connected and configu
SCA BB Templates:

[PASS] A database connection 1s defined and available.

[Pa55] A11 mandatory preferences hawe settings.

[Pa5S5] Policy string translations are awvailahle.

[PASS] Timezone information in CM DB is available.
+ 1111707 2:35:30 PM IST | INFD | Configuration completed successfTuly
I v
4 | >

241858

|_ et = ” Close ][ Cancel J

New devices are added to the default site of the Site Manager tree in the Network Navigator
(Figure 4-55).

Figure 4-55 Network Navigator

= ||&] Site Manager

Bl
SCE device 1 [10.56,216,37]
g CM device [10,56.201.51]

Database device [10,56,201.81]

241865

The wizard attempts to connect to all devices that you defined. The operation fails if:
« Thewizard cannot connect to any of the SCE devices that you listed in Step 4.
» You defined aCM in Step 8, but the wizard cannot connect to it.
» You defined a database in Step 10, but the wizard cannot connect to it.

If you defined a CM in Step 8, the SCE devices are configured so that the only category 1 RDR
destination isthe CM.

RDR categories are the mechanism by which different types of RDRs can be sent to different collectors.
For more information about RDR categories, see the “Raw Data Records: Formats and Field Contents”
chapter of the Cisco Service Control Application for Broadband Reference Guide.

| oL-7205-19
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A new service configuration named P2P Traffic Optimization (or P2P Traffic Optimization for
Asymmetrical Routing) is created, and opens in the Service Configuration Editor (Figure 4-56).

Figure 4-56 Service Configuration Editor

By -Q Service Configuration Editor |
Q PZP Traffic Optimization Wizard.pgb - &3

Policies : Service Security

L& Pelicies | 1] Classification
L 3\ Corfiguration ~

[ - Fiered Traffic

Service Security

L Global Palicy
| Subscriber Policies

7 Default Package

%,J Urknawn Subscriber Package

275756

The service configuration has the following characteristics:
« Full functionality mode.
« The upstream and downstream default AGCs are set with the link limit values defined in Step 16.

« For both the default package and the Unknown Subscriber Traffic package, the following upstream
and downstream BWCs are created:

- P2P
CIR=0
PIR = <value set in global controller>
AL=1
- VolP
CIR = <value set in global controller>
PIR = <value set in global controller>
AL =10
- P2P
CIR = <value set in global controller>
PIR = <value set in global controller>
AL=1
The service configuration is applied to the SCE devices.
If you defined a database in Step 10:
1. The SCA BB Reporter tool is connected to the selected database.
2. Thefirst SCE platform entered in Step 4 is selected as the source of service configuration data.
3. The Next button is enabled.
Step22 If you did not define a database in Step 10, click Finish.
The P2P Traffic Optimization wizard closes.
Step23  Click Next.
The Create common reports page of the P2P Traffic Optimization wizard opens (Figure 4-57).
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Figure 4-57 Create Common Reports

¥ X

Create common reports

This wizard can create and display common reports once the system configuration is completed.

Moke that in order for the reports to show meaningful information, sufficient data must First be accumulated in the database, You may
refresh the reports every Few minutes, as data arrives from the SCE platforms to the database,

[ reate and display common reparts once the canfiguration is completed

241897

[ Close ] ’ Caricel I

Step24  To create reports, check the Create and display common reports check box.

N

Note  Report instances will be created for four predefined report types:

» Global Bandwidth per Service
» Global Active Subscribers per Service
» Top P2P Protocols
« Global Hourly Call Minutes per Service (VolP)
Step25 Click Close.
The wizard closes.
The Reporter tool opensin the Console.

Report instances of each of the four report types open in the Report View of the Reporter tool.

Cisco Service Control Application for Broadband User Guide
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How to Use the Reporter DB Configuration Wizard

A

The Reporter DB Configuration wizard allows you to connect the Reporter to a database.

Caution

Step 1

Step 2

You should run the Reporter DB Configuration wizard only after you have applied a service
configuration to the SCE platform.

From the Console main menu, choose Help > Welcome.
The Welcome view opens (Figure 4-58).

Figure 4-58 Welcome - Introducing Cisco Service Control

B retwork Havipan

Fle Tods Felreoes Wrdies (e
£ wecoes | fiv

silnanlie
c'.;éin Introducing Cisco Service Control

Tha Ciito Swnids Cosliol Apsicahion [HCA] SISHE S0es-0ackel Inapichan sni Spoks RS (i Moaton Blowing Mrace [rovesen 10 G REEUEEBSn i and BUtacHbe-s=ies
BErAsEE e T wizards bt 19 quathly Setn T ayiiem, br clogs Ml YWaltoess view isd ga i e BCA B Conssis

T B e b A T Taii

"Ihnq- Analysis Wiraid A Wmhial Aepnitei Setup Witerd
SCA B 30 colsel wistbes sl Bw sppboniony e anAren e by Then wirmrd isls you goicidy connsst the GCA G Reponsr 0§ CoBecine
ikl RUEsCrinars. Thin dats can (W used foe Ccapacty planning i setaibng ManIgerL dalutane
hia aubsrber deenogrishscs. This wesed s you Quitidy sl T TyTie i
ELTESA TN

= P2E TraMc ptimizasion Wirard

BCA B can previl nefscrk tosgRIBen iy Medes CONN, CEEEES by BEndwish-
tahgy Bopicattnd st as PIP, and moor Subiocher sgerence M seng
\nisncy ansdve seplominmy surh 0 woies, This wean lesy you guickly srks Ba
wrtiem i P IF i opivncaion

h PAR Tantc Gpimisasion for Aeyrmmen kel saning Wirand

BCABH can prevesl nebeon tOAQRIBON Shd etets DOSES, Caesd Ly Bandwich:
tang®y Epeleabany suth i FIP, and mmpetvd MbMISer mpenEnce B0 0
arsianimanls whies Asyrermaties] Fouseg ofcury (8l i, B Sen pidiy of & TCP
of LGP Ao, o sodns pats of e svwtall suliisabery Bl Fovsia on sl
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Cptrmizatan fo Assmimenrs Reung Erdmnmans

Click Initial Reporter Setup Wizard.
The Welcome page of the Reporter DB Configuration wizard appears (Figure 4-59).

275742
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Figure 4-59 Reporter DB Configuration

3£ Reporter DB Configuration Wizard
Reporter DB Configuration ﬁ

This wizard lets wou quickly setup the Reparter, by connecting it to a database and
fFetching policy data from the database to initislize the report termplates.

Cancel

241878

Step3  Click Next.
The Reporter Setup page of the Reporter DB Configuration wizard opens (Figure 4-60).

Cisco Service Control Application for Broadband User Guide
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Figure 4-60 Reporter Setup
3¢ Reporter DB Configuration Wizard |z|
Reporter Setup a
& AnIP address is missing %\
.
The Reporter generates reparts by executing queties on a database, Specify the
database IP address and its bvpe below,
Database IP address: | | :I
Database bype: :_Syb_asn? _V__!
o
Step4  Inthe Configure the IP address of the database field, enter the | P address of the database.
Step 5

From the Select the correct database type drop-down list, select the type of the database.
Step6  Click Next.

The Connectivity Test page of the Reporter DB Configuration wizard opens (Figure 4-61).

[l Cisco Service Control Application for Broadband User Guide
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Figure 4-61 Connectivity Test

3£ Reporter DB Configuration Wizard

Connectivity Test
Al connectivity tests have passed. %\

The wizard will now test the connectivity to the devices that wou specified, to werify
that carrect IP addresses, usernames and passwords were used.
Flease wait Ffor the connectivity test bo camplete,

In case of an error, you may use the 'Back! button ko go back to previous steps and
cotrect the IP addresses, usernames of passwords, if necessary. You may alsa choose
to skip or retry the connectivity test using the buttons belaw,

[ Type IP Address Status
Database 10.56.201.81 Connection succeeded

Skip connectivity besk ] ’Eetry conneckivity kest

e [ wen> ]| ena

Click Next.

241880

How to Use the Console M

The Confirmation page of the Reporter DB Configuration wizard opens (Figure 4-62).

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter4  Getting Started |

I How to Use the Console

Figure 4-62 Confirmation

3£ Reporter DB Configuration Wizard

The Foilowing actions will be perFormed when wau hit the 'Finish' buttan:

Connect the Reporter to the database 10.56.201.81
Merify that the database is connected and configured correckhy

[ Finish ” Cancel ]

241804

The actions that the wizard is about to take are listed in the page.
Step8  Click Finish.
The Configuration Output page of the Reporter DB Configuration wizard opens (Figure 4-63).
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Figure 4-63 Configuration Output

Configuration Output
3 Configuration Failed

Please wait while the swstem is being configured.
+ 11/14/0F7 7:26:09 &M IST | INFQ | Adding devices to the MNetwork Nawigator

+ 11/14 /07 7:26:09 &M IST INFO Connecting the Reporter to the database
+ 11/14,/07 7:26:09 AM IST | ERROR | Configuration failed

Cancel

241802

The wizard attempts to connect the SCA BB Reporter tool to the selected database. The operation fails
if the wizard cannot connect to the database.

The database is queried for its service configuration data and the first SCE device in the response is
chosen as the source of service configuration data.

The database device is added to the Site Manager tree in the Network Navigator.
Step9  Click Next.
The Create common reports page of the Reporter DB Configuration wizard opens (Figure 4-64).

Cisco Service Control Application for Broadband User Guide
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Figure 4-64 Create Common Reports

¥ X

Create common reports

This wizard can create and display common reports once the system configuration is completed.

Moke that in order for the reports to show meaningful information, sufficient data must First be accumulated in the database, You may
refresh the reports every Few minutes, as data arrives from the SCE platforms to the database,

[ reate and display common reparts once the canfiguration is completed

[ Close ] ’ Caricel I

241897

Step 10  To create reports, check the Create and display common reports check box.

N

Note  Report instances will be created for four predefined report types:

- Global Bandwidth per Service
- Global Active Subscribers per Service
» Top P2P Protocols
« Global Hourly Call Minutes per Service (VolP)
Step11 Click Close.
The wizard closes.
The Reporter tool opensin the Console.

Report instances of each of the four report types open in the Report View of the Reporter tool.

The Network Navigator Tool

The Network Navigator is atool that allows you to create and manage a simple model of all local and
remote devices that are part of the Cisco Service Control solution.

For more information about the Network Navigator, see Using the Network Navigator, page 5-1.

Cisco Service Control Application for Broadband User Guide
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How to Open the Network Navigator Tool

Stepl  From the Console main menu, choose Tools > Network Navigator.
The Network Navigator tool opens (Figure 4-65).

Figure 4-65 Network Navigator

EEX

3 Network Navigator - SCA BB Console

File Tools Preferences Window Help

B |ﬂ Nebwark Mavigator

B Network Navigator 53 & 7 7 O = properties &2 | '|':_:|_‘,=,“>

Property Yalue

=& Site Manager
o) default site

@ Progress i3 % - — O

Mo operations to display at this time,

El console &2 G BE | 2 [i- =08

Consale

—
274095

How to Close the Network Navigator Tool

Stepl  Right-click the Network Navigator button.
Step2  From the popup menu that appears, select Close.
The Network Navigator tool closes.

Cisco Service Control Application for Broadband User Guide g
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The Service Configuration Editor Tool

The Service Configuration Editor is atool that allows you to create service configurations. A service
configuration is a data structure that defines how the SCE platform analyses network traffic, what rules
apply to the traffic, and what actions the SCE platform takes to enforce these rules.

Most of this document discusses using the Service Configuration Editor. See Using the Service
Configuration Editor, page 6-1.

« How to Open the Service Configuration Editor Tool, page 4-70
» How to Close the Service Configuration Editor Tool, page 4-71

How to Open the Service Configuration Editor Tool

Step 1

Step 2

From the Console main menu, choose Tools > Service Configuration Editor.
A No Service Configuration s Open dialog box appears (Figure 4-66).

Figure 4-66 No Service Configuration Is Open

3 No Service Configuration Is Open

Mo service configuration is currently open.
_:f) Would you like to edit a new service configuration?

155885858

Click Yes.
A New Service Configuration Settings dialog box appears (Figure 4-67).

Figure 4-67 New Service Configuration Settings

3 New Service Configuration Settings

System Operational Mode

Select the system's operational mode for handling the network traffic;

(%) Report Cnly

() Full Functionality

rRouting Classification Mode

Enable Asymmetric Routing Classification Mode in topologies
with high rate of unidirectional flows, In this mode, the syskem is
better tuned For classifying traffic according to just one side of the
Flowe, but some control capabilities are disabled,

[ Enable the asymmetric Routing Classification Made

7 [s]4 l [ Cancel

275758
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Step3  Select one of the System Operational M ode radio buttons.

- Transparent —The system does not generate RDRs and does not enforce active rules on the
network traffic.

» Report only —The system generates RDRs only. No active rule enforcement is performed on the
network traffic.

« Full functionality —The system enforces active rules on the network traffic and performs reporting
functions (that is, generates RDRS).

Note  You can change the system operational mode at any time.

Step4  (Optional, but highly recommended if your system has a high proportion of unidirectional flows) To
switch to asymmetric routing classification mode, check the Enable the Asymmetric Routing
Classification M ode check box.

Note It isrecommended that you do not change the routing classification mode after creating a service
configuration, as this causes |oss of service configuration data. (See Asymmetric Routing Classification
Mode, page 10-45.)

Step5  Click OK.

A default service configuration opens in the Service Configuration Editor tool (Figure 4-68).

Figure 4-68 Service Configuration Editor
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How to Close the Service Configuration Editor Tool

Stepl  Right-click the Service Configuration Editor button.
Step2  From the popup menu that appears, select Close.

The Service Configuration Editor tool closes.

Cisco Service Control Application for Broadband User Guide
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The Signature Editor Tool

The Signature Editor is atool that allows you to create and modify files that can add and modify

protocols and protocol signaturesin SCA BB.

For more information about the Signature Editor, see Using the Signature Editor, page 12-1.

« How to Open the Signature Editor Tool, page 4-72
» How to Close the Signature Editor Tool, page 4-72

How to Open the Signature Editor Tool

Stepl  From the Console main menu, choose Tools > Signature Editor.
The Signature Editor tool opens (Figure 4-69).

Figure 4-69 Signature Editor Tool
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How to Close the Signature Editor Tool

Stepl  Right-click the Signature Editor button.
Step2  From the popup menu that appears, select Close.
The Signature Editor tool closes.

[l Cisco Service Control Application for Broadband User Guide
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The Subscriber Manager GUI Tool

The Subscriber Manager (SM) GUI isatool that allowsyou to connect to an SCM S-SM and then manage
subscribers, assign packages to subscribers, edit subscriber parameters, and manually add subscribers.

For more information about connecting to an SCMS-SM and using the SM GUI, see Using the
Subscriber Manager GUI Tool, page 11-1.

For more information about the SCM S-SM, see the Cisco Service Control Management Suite Subscriber
Manager User Guide.

» How to Open the SM GUI Tool, page 4-73
« How to Close the SM GUI Tool, page 4-73

How to Open the SM GUI Tool

Stepl  From the Console main menu, choose Tools > Subscriber Manager.
The SM GUI tool opens (Figure 4-70).

Figure 4-70 Subscriber Manager
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How to Close the SM GUI Tool

Stepl  Right-click the Subscriber Manager button.
Step2  From the popup menu that appears, select Close.
The SM GUI tool closes.

Cisco Service Control Application for Broadband User Guide
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The Reporter Tool

The Cisco Service Control Application (SCA) Reporter is atool that allows you to query the Cisco
Service Control Management Suite (SCMS) Collection Manager (CM) RDR database, and present the
resultsin a chart or atable. This valuable tool helps you to understand the habits and resource
consumption of the applications and subscribers that use your network. It also helps you evaluate the
efficacy of various rules and the possible impact of their implementation on the network. You can view
the reports in both tabular and chart formats, export them, save them, and edit their appearance.

You can run the SCA Reporter as a standalone or inside the Reporter tool in the Console. For more
information about the SCA Reporter, see the Cisco Service Control Application Reporter User Guide.

« How to Open the Reporter Tool, page 4-74
» How to Close the Reporter Tool, page 4-75

How to Open the Reporter Tool

Stepl  From the Console main menu, choose Tools > Reporter.
The Reporter tool opens (Figure 4-71).

Figure 4-71 Reporter
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N
Note  You can use the SCA Reporter to generate reports only if the Console is connected to a database. (See
How to Make Databases Accessible to the SCA Reporter, page 5-30.)
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How to Close the Reporter Tool

Stepl  Right-click the Reporter button.
Step2  From the popup menu that appears, select Close.
The Reporter tool closes.

Online Help

You can access relevant parts of this user guide from the Console.
» How to Access Online Help, page 4-75
» How to Search Online Help, page 4-76

How to Access Online Help

Stepl  From the Console main menu, choose Help > Help Contents.
Online help opens in a separate window.

Cisco Service Control Application for Broadband User Guide
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How to Search Online Help

You can also search online help from the current tool.

Stepl  From the Console main menu, choose Help > Sear ch.
The Help view opens next to the current tool (Figure 4-72).

Figure 4-72 Help
Help 3
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% Search

Search expression;

W

b Search scope Default
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Eﬂ] Bookmarks (5 Index
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Step2  Enter aword, phrase, or more complex search expression in the Search expression field.
The Go button is enabled.

Note  Click >> (Expand) for an explanation of how to construct search expressions.

Step3  Click Go.
Help topics containing your search expression are listed under Local Help.

Step4  Click ahelp topic to view its contents.

Note  You can bookmark topics for later reference.

Step5 By clicking the appropriate link at the bottom of the Help view, you can switch to:
« All topics
- Related topics
- Bookmarks

Cisco Service Control Application for Broadband User Guide
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Quick Start with the Console

This Quick Start section will help you get started with the Console. The section includes an exampl e of
using the Network Navigator tool and the Service Configuration Editor to apply the default service
configuration to an SCE platform.

Example: How to Configure the Console and Apply the Default Service
Configuration

Inthisexample, you will add an SCE deviceto the default site and apply the default service configuration
to the SCE.

Stepl  Launch the Console.

Choose Start > All Programs > Cisco SCA > SCA BB Console 3.5.5 > SCA BB Console 3.5.5.
Step2  If necessary, close the Welcome view.
Step3  Open the Network Navigator.

From the Console main menu, choose Tools > Networ k Navigator.

This step sets up the Console for network device operations.

Note  The Network Navigator tool is open the first time you launch the Console.

You should now be able to see the default site displayed in the Network Navigator view.
Step4  Add an SCE device to the default site.
a. Right-click the default site, and, from the popup menu that appears, select New > SCE.
The Create new SCE wizard appears.
In the Address field, enter the actual |P address of an SCE platform.
b. Click Finish.
The Create new SCE wizard closes.
The new device is added to the site.
Step5  Check the SCE platform version and operational state.
a. Right-click the SCE device and, from the popup menu that appears, select Online Status.
A Password Management dialog box appears.
b. Enter the username and password for managing the SCE and click Extract.
The SCE online status is retrieved.
c. Check that the system and application versions are correct, and that the operational state is Active.
Step6  Open the Service Configuration Editor.
» From the Console main menu, choose Tools > Service Configuration Editor.
The Service Configuration Editor opens.
A No Service Configuration Is Open dialog box appears.

Cisco Service Control Application for Broadband User Guide
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Step7  Create anew service configuration.
a. Click Yesin the No Editor Is Open dialog box.
A New Service Configuration Settings dialog box appears.
b. Click OK.
A default service configuration opens in the Service Configuration Editor tool.
Step8  Apply the service configuration to the SCE platform.
a. From the toolbar, select (Apply Service Configuration to SCE Devices).
A Password Management dialog box appears.
b. Enter the username and password for managing the SCE and click Apply.
The service configuration is applied to the SCE platform.

Cisco Service Control Application for Broadband User Guide
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Using the Network Navigator

Revised: December 14, 2011, OL-7205-19

Introduction

To manage a network entity—Service Control Engine (SCE) platform, Subscriber Manager (SM), or
Collection Manager (CM)—from the Console, you must first define it as a device in the Network
Navigator.

This chapter describes how to use the Network Navigator tool to create a model of all local and remote
sitesand devicesthat are part of the Cisco Service Control solution, how to manage the devices remotely,
and other functionality that is part of the Network Navigator tool.

The Usage Analysiswizard, which can be used to create a simple model of devices and connect to them,
is also described in this chapter.

- The Network Navigator Tool, page 5-2

- Managing Sites, page 5-3

« Managing Devices, page 5-7

« Working with Network Navigator Configuration Files, page 5-34
» Network Settings Requirements, page 5-38

Cisco Service Control Application for Broadband User Guide
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The Network Navigator Tool

The Network Navigator tool (Figure 5-1) contains four views:

- Network Navigator view—Displays, in the Site Manager tree, all sites and devices that you have
defined as part of your system

- Properties view—Displays the editable properties of the node selected in the Site Manager treein
the Network Navigator view

» ProgressView view—When you perform an operation on a site or device in the Site Manager tree,
displays a progress bar

« Console view—Displays |og messages concerning actions performed in the Network Navigator tool

Figure 5-1 The Network Navigator Tool
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Managing Sites

You can manage an SCE, SM, or CM from the Console only if the network entity is defined as a device
in the Network Navigator. After adevice is added to the Network Navigator, you can perform
management and monitoring operations on the device.

You can also perform operations on a group of devices. For example, you can apply the same service
configuration to a group of SCE platforms. The Network Navigator allows you to group devices by
adding them under the same site. A site is a group of devices that can be managed together. At
installation, the Network Navigator contains a default site with no devices. You can add devices to this
site or add additional sites, as described in the following sections.

Grouping devices in sites can also help to manage the passwords for these devices (see Password
Management, page 5-8).

- How to Add a Site to the Site Manager, page 5-3
» How to Add Devices to a Site, page 5-4
« How to Delete Sites, page 5-7

How to Add a Site to the Site Manager

Step 1

Step 2

Step 3
Step 4

Before adding devices, you must add your sites to the Site Manager.

In the Network Navigator view, right-click the Site Manager node.
A popup menu appears (Figure 5-2).

Figure 5-2 Site Manager Menu
B ste
Editing 3

274118

Show Properties Wiew

From the menu, select New > Site.

A new Site node is added to the Site Manager.

In the Properties view, enter a name for the site in the Name cell.
(Option) In the Version cell, enter a version number.

| oL-7205-19
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How to Add Devices to a Site

You can add SCE, SM, CM, or database devices to a site.
- How to Add SCE Devicesto a Site, page 5-4
 How to Add SM Devices to a Site, page 5-5
» How to Add CM Devicesto a Site, page 5-5
- How to Add Database Devices to a Site, page 5-6
- How to Delete Devices, page 5-7

How to Add SCE Devices to a Site

Step 1

Step 2

Step 3
Step 4
Step 5

To use the Network Navigator to configure, monitor, and update the software of an SCE platform, you

must first add the SCE platform to a site.

In the Site Manager tree, right-click a site.
A popup menu appears (Figure 5-3).

Figure 5-3 Site Manager Tree Menu
9 Apply Service Configuration... ﬁ Database
4 Retrieve Service Configuration. ., % SCE
2 M
‘ﬁ Install Protocol Pack (SPOIL..
Configuration ‘Wizards 4
Editing L4

Show Properties Yiew
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From the menu, select New > SCE.
The Create New SCE wizard appears.
In the Address field, enter the | P address of the SCE.

(Option) In the Name field, enter a meaningful name for the SCE.

Click Finish.
The Create New SCE wizard closes.
The new device is added to the site.

[l Cisco Service Control Application for Broadband User Guide
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How to Add SM Devices to a Site

Step 1

Step 2

Step 3

Step 4
Step 5

To use the Network Navigator to configure, monitor, and update the software of an SM, you must first
add the SM to a site.

In the Site Manager tree, right-click a site.

A popup menu appears.

From the menu, select New > SM.

The Create New SM wizard appears.

In the Address field, enter the | P address of the SCMS-SM.
(Option) In the Name field, enter a meaningful name for the SM.
Click Finish.

The Create New SM wizard closes.

The new device is added to the site.

How to Add CM Devices to a Site

Step 1

Step 2

Step 3

Step 4
Step 5

To use the Network Navigator to monitor a CM, you must first add the CM to a site.

In the Site Manager tree, right-click asite.

A popup menu appears.

From the menu, select New > CM.

The Create New CM wizard appears.

In the Address field, enter the | P address of the CM.

(Option) In the Name field, enter a meaningful name for the CM.
Click Finish.

The Create New CM wizard closes.

The new device is added to the site.

| oL-7205-19
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How to Add Database Devices to a Site

Step 1

Step 2

Step 3
Step 4
Step 5
Step 6

Step 7

To use the Reporter tool to produce reports, you must first connect to a database.

In the Site Manager tree, right-click a site.
A popup menu appears.
From the menu, select New > Database.

The Create New Database wizard appears (Figure 5-4).

Figure 5-4 Create New Database
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In the Address field, enter the | P address of the database.

210583

(Option) In the Name field, enter a meaningful name for the database.

From the Database type drop-down list, select a database type.

(Option) Check the Enable Advanced Settings check box and enter new valuesin the Url, Driver, User,

and Password fields.

Click Finish.

The Create New Database wizard closes.
The new device is added to the site.

[l Cisco Service Control Application for Broadband User Guide
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How to Delete Devices

Stepl  Inthe Site Manager tree, right-click a device.
A popup menu appears.
Step2  From the menu, select Delete.
The device is deleted and removed from the Site Manager tree.

How to Delete Sites

Step1  Inthe Site Manager tree, right-click a site in the Site Manager tree.
A popup menu appears.
» Enter your password if prompted.
Step2  From the menu, select Delete.

The site and all its devices are deleted and the site is removed from the Site Manager tree.

Managing Devices
The Network Navigator allows you to manage SCE, SM, CM, and database devices.

N

Note The Usage Analysis wizard allows you to create a simple model of devices and connect to them. (See
How to Use the Usage Analysis Wizard, page 4-35.)

» Password Management, page 5-8

- Managing SCE Devices, page 5-9

- Managing SM Devices, page 5-26

« Managing CM Devices, page 5-28

- Managing Database Devices, page 5-30

Cisco Service Control Application for Broadband User Guide
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Password Management

Normally, before you can access a device (SCE, SM, CM, or database), you must enter its password.
When you try to perform any operation on a site device, the Network Navigator first asks for the device
username and password. (Repeating the same operation on the same device does not always require a
second entry of the password.)

When performing operations on multiple devices, password entry can become tedious. The Site Master
Password can help you remember some or all of your element’s usernames and passwords by storing
them as part of the site’s data, and entering them for you automatically when you connect to an element.

The Site Master Password protects saved usernames and passwords in the password manager. The
Password Management dialog box (Figure 5-5) prompts you for the site’'s master password when you
wish to activate the site password manager. If you have multiple sites, each site will require a separate
master password.

Figure 5-5 The Password Management Dialog Box
3 Password Management |g|
Password Required for Apply to SCE Operation ﬁ

This wizard gets the password for the device SCE 1 [172.2,5.31]. \‘_\\

Target:  SCE 1[172.2.5.31]

Type: SCE
Service: RPC
User: admin

Password: | sew

The Site Master Password can help you remember some or all of your
element's passwords by storing them as part of the site's data, and
entering them for you automatically when you connect to an element.

[¥IEnable Site Master Password:

[Change Site Master Password

[ Apply l[ Cancel ]
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For each site, when the Password Management dialog box appears, check the Enable Site M aster
Password check box.
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Managing SCE Devices

- How to Configure SCE and CM Devices Using a Wizard, page 5-10

- How to Generate Tech Support Info Files for SCE Devices, page 5-17

« How to Retrieve the Online Status of SCE Devices, page 5-19

« How to Install a Protocol Pack, page 5-19

« How to Apply Service Configurations to SCE Devices, page 5-21

- How to Retrieve Service Configurations from SCE Devices, page 5-23

- How to Install PQI Files on SCE Devices, page 5-24

- How to Install an SCE OS Software Package on SCE Devices, page 5-25

Cisco Service Control Application for Broadband User Guide
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How to Configure SCE and CM Devices Using a Wizard

The Network Navigator Device wizard allows you to configure SCA and CM devices and connect to

them.

Y

Note  If they do not already exist, devices defined in the wizard are added to the default sitein the Site Manager
tree.

Stepl  Inthe Network Navigator view toolbar, click B (Configure SCE and CM devices).
The Welcome page of the Network Navigator Device wizard appears (Figure 5-6).

Figure 5-6 Welcome - Network Navigator Device

F Network Navigator Device Wizard

This wizard lets vou quickly add SCE platforms and CM to the hebwork Navigator device
tree,

Cancel
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Step2  Click Next.
The SCE |IP Addresses page of the Network Navigator Device wizard opens (Figure 5-7).
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Step 3

Note

Step 4

Figure 5-7 SCE IP Addresses

3 Network Navigator Device Wizard

SCE IP Addresses £ ,_E| 1
4 m

@ One or more SCE IP addresses must be specified

|

Configuring the SCE platforms requires that they are first added to the Metwork
Mawigatar.,

Tao add SCE platforms to the Mebwork Mavigataor, tvpe their IP addresses in the text
bax below (For exarnple: 10.56.216.37, 10.56,216,38):

241847
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In the edit box, enter the IP addresses of the SCE devices that should be added to the model.
If you started from the Network Navigator, the |P addresses of the SCE devices that you selected are

displayed in the edit box. You can add additional addresses.

You can work with up to 20 SCE devices at one time using the wizard.

Click Next.

The SCE Usernames and Passwords page of the Network Navigator Device wizard opens (Figure 5-8).
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Figure 5-8 SCE Usernames and Passwords

3 Network Navigator Device Wizard

SCE Usernames and Passwords I 1
@ & password For the SCE 10.56.216.37 is missing '_E‘

In otdet bo connect to the SCE platforms, & username and a password need to be
specified for each SCE.

Use a common username and a common password for all SCE platforms:
Username: | admin
Password:

() Use separate usernames and passwords for each SCE platform:

SCE IP Address | Username  Password
10.56.216.37 adrnin

241848

Step5  Enter the user names and passwords for the SCE devices.
Do one of the following:

» To usethe same user name and password for all the SCE devices that you are adding, enter the user
name in the Username field and the password in the Password field.

- To provide a different user name and password pair for each SCE device, check the Use separ ate
usernames and passwor ds for each SCE device radio button, and, for each SCE device, enter the
user name and password in the appropriate cell of the SCE device table.

Step6  Click Next.
The Setting CM devices page of the Network Navigator Device wizard opens (Figure 5-9).
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Step 8

Figure 5-9 CM Setup

3 Network Navigator Device Wizard

CM Setup ]

3 AnIP address is missing '_E‘

Configuring the CM requires that it is First added ko the Nebwork Mavigatar, To add the

M ta the Metwork Mavigator, tvpe its IP address, username and password in the text
boxes below,

The wizard will werify the CMM operational state, and configure the SCE platfroms to

send RDRs ko the M. You may skip this step if the CM is already defined as the RDR
destination of the SCE platforms.

[ 3kip this step
M IP address: |

CM username: SCMSCM

CM password: [

Define the SCSM Collection Manager (CM) to use with this configuration.

Do one of the following:

241844
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- Enter the IP address, user name, and password of the CM device in the appropriate fields.

If you started from the Network Navigator, thisinformation is retrieved and displayed. You can

modify these parameters.
» Check the Skip this step check box.
Click Next.

The Connectivity Test page of the Network Navigator Device wizard opens (Figure 5-10).

| oL-7205-19
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Note

Step 9

Figure 5-10 Connectivity Test

3 Network Navigator Device Wizard

Connectivity Test
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The wizard will now test the connectivity to the devices that wou specified, to werify
that carrect IP addresses, usernames and passwords were used.
Flease wait Ffor the connectivity test bo camplete,

In case of an error, you may use the 'Back! button ko go back to previous steps and
cotrect the IP addresses, usernames of passwords, if necessary. You may alsa choose
to skip or retry the connectivity test using the buttons belaw,

[ Type | IP Address Status

SEE 10.56.216,37 Connection succeeded
M 10.56,201.81 Connection succeeded

Skip connectivity besk ] ’Eetry conneckivity kest

| =Back ” Pt = I
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The wizard tests to see that the connections to the defined devices can be made.

If a connection to one or more of the devices cannot be made or if there is some problem with the
connection (such asinvalid version of the device) an error is displayed next to the device. You can skip
these tests by clicking Skip Connections. The connections will be validated when you click Finish at

the end of the wizard.

Click Next.

The Confirmation page of the Network Navigator Device wizard opens (Figure 5-11).
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Figure 5-11 Confirmation

3 Network Navigator Device Wizard
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The Foilowing actions will be perFormed when wau hit the 'Finish' buttan:

Connect to the following SCE platforms and add them to the Mebwork Mavigator:
10,56.216.37

Conmect ko the CM 10056,201.81 and add it bo the Mebwark Mavigatar

Configure the SCE platforms ko send category 1 RDRs to the M

=

[ Finish I [ Cancel

l

The actions that the wizard is about to take are listed in the page.

Click Finish.

244851
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The Configuration Output page of the Network Navigator Device wizard opens (Figure 5-12).
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Figure 5-12 Configuration Output
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[ Close ][ Caricel J

New devices are added to the default site in the Site Manager tree in the Network Navigator
(Figure 5-13).

Figure 5-13 Network Navigator

@ Tebwork Mavigator

= & Site Manager

=R
SCE device 1 [10.56.216,37]
§ M device [10.56.201,81]

The wizard attempts to connect to all devices that you defined. The operation fails if:

241854

- Thewizard cannot connect to any of the SCE devices that you listed in Step 3.
» You defined aCM in Step 7, but the wizard cannot connect to it.

If you defined a CM in Step 7, the SCE devices are configured so that the only category 1 RDR
destination isthe CM.

RDR categories are the mechanism by which different types of RDRs can be sent to different collectors.
For more information about RDR categories, see the see either the Raw Data Formatting: The RDR
Formatter and NetFlow Exporting” chapter of the Cisco SCE8000 10GBE Software Configuration Guide
or the Raw Data Formatting: The RDR Formatter and NetFlow Exporting” chapter of the Cisco SCE8000
GBE Software Configuration Guide.

[l Cisco Service Control Application for Broadband User Guide
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A new service configuration is created:
» Report Only mode.

» The maximum Transaction RDR rateis set as the default value (250) divided by the number of SCE
devices. (To configure the Transaction RDR see How to Manage Transaction RDRs, page 8-6; the
content and structure of the Transaction RDR islisted in “ Transaction RDR” section in the “Raw

Data Records: Formats and Field Contents” chapter of the Cisco Service Control Application for
Broadband Reference Guide.

Step11  Click Finish.

The Network Navigator Device wizard closes.

How to Generate Tech Support Info Files for SCE Devices

This operation generates the SCE platform’s support file, for the use of Cisco technical support staff.

Stepl  Inthe Site Manager tree, right-click an SCE device.
A popup menu appears (Figure 5-14).

Figure 5-14 Site Manager Tree Menu
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Editing L4 w
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Step2  From the menu, select Generate Tech Support Info File.

The Generate Tech Support Info File dialog box appears (Figure 5-15).

Cisco Service Control Application for Broadband User Guide
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Figure 5-15 Generate Tech Support Info File

3 Generate Tech Support Info File

Extracts the logs from the device
Extracting the logs from the device
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Add GUI Console log files
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Cancel
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Step3  Click Browse.
A Select File dialog box appears.
Step4  Browse to the folder where you want to save the tech support info file.
Step5  Inthe File name field, enter a new file name, or select an existing ZIP file.
Step6  Click Open to select thefile.
If the file exists, it will be overwritten when you generate the tech support info.
The Select File dialog box closes.

Step7  (Optional) To add log files to the output tech support info file, check the Add GUI Console log files
check box.

Step8  (Optional) Check the Open file after it isfetched check box.
Step9  Click Finish.
The Generate Tech Support Info File dialog box closes.
A Password Management dialog box appears.
Step 10  Enter the appropriate password. (For more information, refer to Password Management, page 5-8.)
Step11 Click Generate.
The Password Management dialog box closes.
A Generate tech support info file progress bar appears.
Thefileis generated.
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How to Retrieve the Online Status of SCE Devices

Step 1

Step 2

Step 3
Step 4

This operation provides information about the SCE platform’s current software version and operational
status.

In the Site Manager tree, right-click an SCE device.

A popup menu appears.

From the menu, select Online Status.

A Password Management dialog box appears.

Enter the appropriate password. (For more information, refer to Password Management, page 5-8.)
Click Extract.

The Password Management dialog box closes.

An Extracting info progress bar appears.

The SCE online status is retrieved (Figure 5-16).

Figure 5-16 SCE Online Status
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How to Install a Protocol Pack

Note

You can install a protocol pack on a single SCE platform, on selected SCE platforms, or on all SCE
platforms at one or more selected sites. For more information about protocol packs, see Working with
Protocol Packs, page 4-19.

It isrecommended to use the SCE Software Upgrade Wizard when installing a protocol pack on multiple
SCE platforms

- How to Install a Protocol Pack on a Single SCE Platform, page 5-20
- How to Install a Protocol Pack on Multiple SCE Platforms, page 5-21
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How to Install a Protocol Pack on a Single SCE Platform

Stepl  Inthe Site Manager tree, right-click the SCE where the protocol pack isto be installed.
Step2  From the popup menu that appears, select Update Dynamic Signature Pack.
The Update Dynamic Signature Pack dialog box appears (Figure 5-17).

Figure 5-17 Update Dynamic Signature Pack

: B

Update Dynamic Signature Pack
This wizard updates SCE boxes with a Dynmaic Signature Pack.

Select the dynamic signature: |

Backup the current configuration:
[l Backup the current configuration

Backup file :

Cancel

210041

Step3  Click Browse.
A Select file dialog box appears.
Step4  From the Files of type drop-down list, select *.spqi or *.dss, according to the file to be installed.
Step5  Browseto thefile to be installed.
Step6  Click Open.
The Select file dialog box closes.

Step7  (Recommended) Check the Backup the current configuration check box, click Browse, and select a
backup file.

Step8  Click Finish.

A Password Management dialog box appears.
Step9  Enter the appropriate password.

For more information, refer to Password Management, page 5-8.
Step 10  Click Update.

The Password Management dialog box closes.

An Update Dynamic Signature Pack progress bar appears.

The service configuration on the SCE platform is updated.
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How to Install a Protocol Pack on Multiple SCE Platforms

You caninstall aprotocol pack on multiple SCE Platforms using the SCE Software Upgrade Wizard. See
How to Upgrade the SCE Using the SCE Software Upgrade Wizard, page 4-9

How to Apply Service Configurations to SCE Devices

~

Note

A

You can apply aservice configuration to asingle SCE platform, to selected SCE platforms, or to all SCE
platforms at one or more selected sites.

The service configuration that you are applying must be open in the Service Configuration Editor.

Caution

Step 1

Step 2

Note

If anomaly-based detection of malicious traffic is enabled, any access control list (ACL) that is
configured on the Service Control Engine (SCE) platform but is not applied to anything (for example,
an interface, an access map, or an SNMP community string) might be deleted when a service
configuration is applied to the platform.

Wor karound:

Disable anomaly-based detection of malicious traffic.

In the Network Traffic tab, select Service Security.

In the Service Security Dashboard, clear the Enable anomaly detection check box.

- How to Apply a Service Configuration to a Single SCE Platform, page 5-21
« How to Apply a Service Configuration to Multiple SCE Platforms, page 5-22

How to Apply a Service Configuration to a Single SCE Platform

In the Site Manager tree, right-click an SCE device.
A popup menu appears.
From the menu, select Apply Service Configuration.

The Choose Policy dialog box appears (Figure 5-18), listing all service configurations that are open in
the Service Configuration Editor.

If only one service configuration is open in the Service Configuration Editor, a Password Management
dialog box appears. Continue at Step 5. (If no service configurations are open in the Service
Configuration Editor, an error message is displayed.)

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter5  Using the Network Navigator |

M Managing Devices

Step 3
Step 4

Step 5
Step 6

Step 1

Step 2

Note

Figure 5-18 Choose Policy

3£ Choose Policy

' cscol.pgb
dscoZ.pgb

I OK Jl Cancel ]

158777

Select a service configuration from the list.

Click OK.

A Password Management dialog box appears.

Enter the appropriate password. (For more information, refer to Password Management, page 5-8.)
Click Apply.

The Password Management dialog box closes.

An Applying service configuration to SCE progress bar appears.

The service configuration is applied to the selected SCE platform.

How to Apply a Service Configuration to Multiple SCE Platforms

In the Site Manager tree, select sites or SCE devicesto which you are applying the service configuration
and right-click one of them.

From the popup menu that appears, select Apply Service Configuration.

The Choose Policy dialog box appears, listing all service configurations that are open in the Service
Configuration Editor.

If only one service configuration is open in the Service Configuration Editor, a Password M anagement
dialog box appears. Continue at Step 4. (If no service configurations are open in the Service
Configuration Editor, an error message is displayed.)
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Select a service configuration from the list and click OK.

A separate Password Management dialog box appears for each SCE device that you have selected.
For each SCE device, enter the password and click Apply.

The service configuration is applied to each selected SCE platform in turn.

How to Retrieve Service Configurations from SCE Devices

Step 1

Step 2

Step 3
Step 4

Step 1

Step 2

Step 3

You can retrieve service configurations from a single SCE platform, from selected SCE platforms, or
from all SCE platforms at one or more selected sites.

- How to Retrieve Service Configurations from a Single SCE Platform, page 5-23
» How to Retrieve Service Configurations from Multiple SCE Platforms, page 5-23

How to Retrieve Service Configurations from a Single SCE Platform

In the Site Manager tree, right-click an SCE device.
A popup menu appears.
» Enter your password if prompted.
From the menu, select Retrieve Service Configuration.
A Password Management dialog box appears.
Enter the appropriate password. (For more information, refer to Password Management, page 5-8.)
Click Retrieve.
The Password Management dialog box closes.
A Retrieving from SCE progress bar appears.

The service configuration is retrieved from the SCE platform and opened in the Service Configuration
Editor.

How to Retrieve Service Configurations from Multiple SCE Platforms

In the Site Manager tree, select sites or SCE devices whose service configurations you want to retrieve,
and right-click one of them.

From the popup menu that appears, select Retrieve Service Configuration.
A separate Password Management dialog box appears for each SCE device that you have selected.
For each SCE device, enter the password and click Retrieve.

The service configuration is retrieved from each SCE platform in turn, and is opened in the Service
Configuration Editor.

| oL-7205-19
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How to Install PQI Files on SCE Devices

This operation installs the Cisco Service Control Application for Broadband (SCA BB) on the SCE
platform.

Note  Itisrecommended to use the SCE Software Upgrade Wizard when installing a PQI file on multiple SCE
devices. See How to Upgrade the SCE Using the SCE Software Upgrade Wizard, page 4-9.

Note  Installing a PQI file usually takes a few minutes.

Stepl  Inthe Site Manager tree, select an SCE device.
Step2  From the Console main menu, choose Network > Install Application Software (PQI).

The Update Software dialog box appears (Figure 5-19).

Figure 5-19 Update Software

¥ Update Software

Please choose a file

Select the pagi file: | v-i

Cancel

210046

Step3  Click Browse.
A Select file dialog box appears.
Step4  Browseto the PQI file that you are installing.
Step5  Click Open.
The Select file dialog box closes.
Step6  Click Finish.
A Password Management dialog box appears.
Step7  Enter the appropriate password. (For more information, refer to Password Management, page 5-8.)
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Click Apply.

The Password Management dialog box closes.

An Updating software to SCE progress bar appears.
The PQI fileisinstalled on the selected SCE.

How to Install an SCE OS Software Package on SCE Devices

>

Note

Step 1
Step 2

Step 3

Step 4
Step 5

Step 6

Step 7

This operation installsthe SCE OS software package (the operating system software and firmware of the
SCE platform).

It is recommended to use the SCE Software Upgrade Wizard when installing an SCE OS software
package on multiple SCE platforms. See How to Upgrade the SCE Using the SCE Software Upgrade
Wizard, page 4-9.

In the Site Manager tree, select an SCE device.
From the Console main menu, choose Network > Upgrade SCE Platform Firmware (PKG).
The Update OS dialog box appears (Figure 5-20).

Figure 5-20 Update OS

3 Update 05 X
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Select the phg file: | v

Cancel
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Click Browse.

A Select file dialog box appears.

Browse to the PKG file containing the OS that you are installing.

Click Open.

The Select file dialog box closes.

Click Finish.

A Password Management dialog box appears.

Enter the appropriate password. (For more information, refer to Password Management, page 5-8.)
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Step8  Click Apply.
The Password Management dialog box closes.
An Updating software to SCE progress bar appears.
The PQI fileisinstalled on the selected SCE.

Managing SM Devices

» How to Generate Tech Support Info Files for SM Devices, page 5-26
- How to Retrieve the Online Status of SM Devices, page 5-27
- How to Connect to SM Devices, page 5-28

How to Generate Tech Support Info Files for SM Devices

This operation generates the SM’s support file, for the use of Cisco technical support staff.

Stepl  Inthe Site Manager tree, right-click an SM device.
A popup menu appears (Figure 5-21).

Figure 5-21 Site Manager Tree Menu
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Step2  From the menu, select Generate Tech Support Info File.

The Generate Tech Support Info File dialog box appears.
Step3  Click Browse.

A Select File dialog box appears.
Step4  Browse to the folder where you want to save the tech support info file.
Step5  Inthe File name field, enter a new file name, or select an existing ZIP file.
Step6  Click Open to select thefile.

If the file exists, it will be overwritten.

The Select File dialog box closes.

Step7  (Optional) To add log files to the output tech support info file, check the Add GUI Console log files
check box.

Step8  Check the Open file after it is fetched check box.
Step9  Click Finish.
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The Generate Tech Support Info File dialog box closes.

A Password Management dialog box appears.

Enter the appropriate password. (For more information, refer to Password Management, page 5-8.)
Click Generate.

The Password Management dialog box closes.

A Generate tech support info file progress bar appears.

Thefileis generated.

How to Retrieve the Online Status of SM Devices

Step 1

Step 2

Step 3
Step 4

This operation provides information about the SM’s current software version and operational status.

In the Site Manager tree, right-click an SM device.

A popup menu appears.

From the menu, select Online Status.

A Password Management dialog box appears.

Enter the appropriate password. (For more information, refer to Password Management, page 5-8.)
Click Extract.

The Password Management dialog box closes.

An Extracting info progress bar appears.

The SCMS-SM online status is retrieved (Figure 5-22).

Figure 5-22 SCMS-SM Online Status
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How to Connect to SM Devices

~

Note

Step 1
Step 2

Step 3
Step 4

In order to manage subscribers using the SM GUI tool, you must connect to an SM device.

The SM GUI tool performs authentication on the SCMS-SM by opening a PRPC connection to port
14374 and attempting to log in using the username and password that you entered in the Password
Management dial og box. If aPRPC server with this user is not running on the SCM S-SM, authentication
will fail.

If you have changed the PRPC port on the SCMS-SM, see User Authentication, page 5-39.

In the Site Manager tree, right-click an SM device.

A popup menu appears.

From the menu, select M anage Subscribers.

A Password Management dialog box appears.

Enter the appropriate password. (For more information, refer to Password Management, page 5-8.)
Click Connecting.

The Password Management dialog box closes.

A Connecting to progress bar appears.

You connect to the SM, and the Consol e switches to the SM GUI tool.

For an explanation of how to proceed, see Using the Subscriber Manager GUI Tool, page 11-1.

Managing CM Devices

You can configure CM devices using a wizard. (See How to Configure SCE and CM Devices Using a
Wizard, page 5-10.)
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Howv to Retrieve the Online Status of CM Devices

This operation provides information about the CM’s current software version and operational status.

Stepl  Inthe Site Manager tree, right-click a CM device.
A popup menu appears (Figure 5-23).

Figure 5-23 Site Manager Tree Menu
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Step2  From the menu, select Online Status.

A Password Management dialog box appears.
Step3  Enter the appropriate password. (For more information, refer to Password Management, page 5-8.)
Step4  Click Extract.

The Password Management dialog box closes.

An Extracting info progress bar appears.

The SCMS-CM online status is retrieved.

For an example of aretrieved online status window (for an SCE platform), see How to Retrieve the
Online Status of SCE Devices, page 5-19.

Cisco Service Control Application for Broadband User Guide
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Managing Database Devices

How to Make Databases Accessible to the SCA Reporter

» TheReporter DB Configuration wizard allows you to connect the Reporter to asingle database. (See
How to Use the Reporter DB Configuration Wizard, page 4-62.)

» An alternative procedure is described in “ Configuring Properties” section in the “Using the Cisco
Service Control Application Reporter” chapter of the Cisco Service Control Application Reporter
User Guide.

Stepl  Inthe Site Manager tree, right-click a database device.
A popup menu appears (Figure 5-24).

Figure 5-24 Site Manager Tree Menu
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Step2  From the menu, select Add to Reporter.
The Preferences dialog box appears (Figure 5-25).

Figure 5-25 Preferences
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Step3  Click Add.
The Add Database wizard appears (Figure 5-26).
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Figure 5-26 Add Database
Database connection definition mode [j
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(®)5imple - default values for driver, port, etc
() Advanced - specify all values
u
Step4  Select one of the Choose definition mode radio buttons.
- Simple
« Advanced
Step5  Click Next.
The Define new database connection page of the Add Database wizard opens:
« If you selected Simple in Step 4, the Define new database connection page looks like Figure 5-27.
Figure 5-27 Define New Database Connection - Simple
¥ - BX]
Define new database connection [j
Database bype and location
Database bype:
Database IP address: I:l
Activate this database
s
b
« If you selected Advanced in Step 4, the Define new database connection page looks like Figure 5-28.
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Figure 5-28 Define New Database Connection - Advanced
3 |:|®
Define new database connection [j

Database connection attributes

URL: |
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User: | |

Password:

activate this database
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Step6  Fill inall thefields.
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Step7  Click Finish.
The Add Database wizard closes.
The definition of the database is added to the list in the Preferences dialog box.
Step8  Repeat Steps 3 to 7 for other databases.
Step9 I required, delete databases from the list in the Preferences dialog box.
Step10 Make sure that the correct database is activated.
Step11 Click OK.

The Preferences dialog box closes.

Cisco Service Control Application for Broadband User Guide
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Working with Network Navigator Configuration Files

After you add sites and devices to the Network Navigator, you can export this datato a file to back up
your settings and to share them with other users, who can import your Network Navigator settings into
their Console.

If you use the Site Master Password to store the passwords of the network devices, the passwords are
also exported, in encrypted form. This meansthat other users who import this dataneed only provide the
Site Master Password to access the devices.

- How to Export a Network Navigator Configuration, page 5-34
- How to Import a Network Navigator Configuration, page 5-36

How to Export a Network Navigator Configuration

Stepl  From the Console main menu, choose File > Export.
The Export dialog box appears (Figure 5-29).

Figure 5-29 Export
3 Export |Zl@@
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/

hoose export destination. E 5

Select an export destination:

type Filker text

= Metwork Mavigator
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Service Configuration

Export service configuration parts ko a CSY file

Cancel

150845

Step2  From the export destination list, select Network Navigator Configuration to afile.
Step3  Click Next.

The Export Network Navigator Configuration to afile dialog box appears (Figure 5-30).
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Step 8

Note

Step 9

Working with Network Navigator Configuration Files

Figure 5-30 Import Network Navigator Configuration from File
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The Available sites pane lists all of the sites in the configuration.
Select the sites to export, using the check boxes and the select buttons.
In the Select the export destination area, click Browse.
An Open dialog box appears.

Browse to the folder where you want to save the configuration file.

In the File name field, enter a new file name, or select an existing site_xml file.

Click Open to select thefile.

If the file exists, it will be overwritten.

The Open dialog box closes.
Click Finish.
The Export Network Navigator Configuration dialog box closes.

The configuration is saved to thefile.

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter5  Using the Network Navigator |

M Working with Network Navigator Configuration Files

How to Import a Network Navigator Configuration

Stepl  From the Console main menu, choose File > Import.
The Import dialog box appears (Figure 5-31).

Figure 5-31 Import
F Import |Z|®
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Select an import source:
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Step2  From the import source list, select Network Navigator Configuration from file.

Step3  Click Next.
The Import Network Navigator Configuration from file dialog box appears (Figure 5-32).

Cisco Service Control Application for Broadband User Guide



| Chapter5 Using the Network Navigator

Working with Network Navigator Configuration Files

Figure 5-32 Import Network Navigator Configuration from File
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This wizard imports a Network Navigator configuration from a file
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Cancel
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Step4  Click Browse.
An Open dialog box appears.
Step5  Browseto the folder containing the file to import, and select asite xml file.
Step6  Click Open to select thefile.
The Open dialog box closes.
Step7  Click Finish.
The Import Network Navigator Configuration dialog box closes.
The configuration isimported from the file.
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Network Settings Requirements

« Firewall/NAT Requirements, page 5-38

» User Authentication, page 5-39
- How to Disable PRPC Authentication, page 5-39

Firewall/NAT Requirements

Table 5-1 lists the firewal|/NAT open port settings required for the Network Navigator to operate

properly.

The portslisted in the table are the default values. If you change aport in adevice, you must modify the
firewall/NAT settings accordingly. (Modifying the Console settings to connect to a different PRPC port
is described in the following section.)

Table 5-1

Required Firewall/NAT Settings

Source

Destination

Comments

Workstation

SCE port 14374/TCP

PRPC—Required for all SCE
operations

SCE

Workstation port 21/TCP

FTP—Required for the
following SCE operations:

« Install OS

« Generate Tech Support Info
File

SCE

Workstation ports 21000/TCP to
21010/TCP

FTP—AIlternative to port
21/TCP, required if port 21/TCP
is already used by another
application on the workstation

Workstation

SM port 14374/TCP

PRPC—Required for all SM
operations

Workstation

CM port 14375/TCP

PRPC—Required for the CM
Online Status operation and for
CM authentication

The SCA Reporter may have additional requirements for connecting to the database. For more
information, see the Cisco Service Control Application Reporter User Guide.

[l Cisco Service Control Application for Broadband User Guide
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User Authentication

Note

Note

User authentication is performed when a PRPC connection is made to an SCE platform, aCM, or an SM.
For authentication to succeed, a PRPC server must be running at the destination, and you must know the
username and password of a user of the server.

If you change a PRPC server port in adevice (SM/CM/SCE), you must add a line to the configuration
file engage.ini:

<IP address of device>.rpc.port=<port number>

For example;

10.56.216.37.rpc.port=222

Add one line for each (non-default) port that you use.

Thefile engage.ini is located in the folder Program files\Cisco SCA\SCA BB Console
3.5.5\plugins\policy.contribution_3.5.5\config\.

You define the username and password using the user/password mechanism in the SCE platform or a
command-line utility in the SM and CM.

For more information about defining users, see the following:

o SCE—See either the “TACACS+ Authentication, Authorization, and Accounting” section in the
“Configuring the Management Interface and Security” chapter of the Cisco SCES8000 10GBE
Software Configuration Guide or the “TACACS+ Authentication, Authorization, and Accounting”
section in the “ Configuring the Management Interface and Security” chapter of the Cisco SCE8000
GBE Software Configuration Guide

- CM—"Managing Users” section in the “Managing the Collection Manager” chapter of the Cisco
Service Control Management Suite Collection Manager User Guide

- SM—"“Information About the p3rpc Utility” section in the “Command-Line Utilities” appendix of
the Cisco Service Control Management Suite Subscriber Manager User Guide

PRPC authentication from the SCA BB Console to any CM/SM/SCE |P address other then the device's
real |P addressisnot supported. Thisisespecially important when the CM/SM/SCE resides on theinside
interface of a NATing router or firewall

Workaround:

Redesign your network so that the SCA BB Console is given the real |P address of the CM/SM/SCE.
Disable PRPC authentication on the SCE/CM/SM/SCE as described in the following sections.

How to Disable PRPC Authentication

« How to Disable PRPC Authentication on an SCE Platform, page 5-40
« How to Disable PRPC Authentication on a CM, page 5-40
» How to Disable PRPC Authentication on an SM, page 5-40

| oL-7205-19
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Howv to Disable PRPC Authentication on an SCE Platform

Stepl1  Usethe CLI to disable PRPC authentication.

Run the following CLI in config mode:

ip rpc-adapter security-level none

Howv to Disable PRPC Authentication on a CM

Stepl  Edit the CM configuration file.
Edit the cm/um/config/p3cm.cfg configuration file:

[RPC. Server]
security_level=none

Step2  Reload the CM process.

How to Disable PRPC Authentication on an SM

Stepl  Edit the SM configuration file.
Edit the ~pcube/sm/server/root/config/p3sm.cfg configuration file:

[RPC. Server]
security_level=none

Step2  Load the configuration.
Run the following CLU:

p3sm --load-config

Cisco Service Control Application for Broadband User Guide
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Introduction

To configure a Service Control Engine (SCE) platform to handle traffic, you must define a service
configuration and apply it to the platform. Use the Service Configuration Editor tool to create, define,
and manage service configurations.

This modul e describes how to use the Service Configuration Editor tool.
- Service Configurations, page 6-1
- Managing Service Configurations, page 6-2

Service Configurations

A service configuration is a data structure that defines how the SCE platform analyses network traffic,
what rules apply to the traffic, and what actions the SCE platform takes to enforce these rules.

A service configuration consists of the following two main elements:

« Services—Define the categories to which transactions are classified

» Packages—Define how the SCE platform acts upon transactions from different services
Service configurations are stored as PQB files.

Cisco Service Control Application for Broadband User Guide
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Managing Service Configurations

This section explains how to:
- Manage service configurations
- Export and import service configuration data

» Apply service configurations to SCE platforms and retrieve them

Opening the Service Configuration Editor Tool

If no service configurations are open when you open or switch to the Service Configuration Editor tool,
a No Service Configuration I's Open dialog box appears as shown in Figure 6-1.

Figure 6-1 No Service Configuration Is Open

# No Service Configuration Is Open

Mo service configuration is currently open,
- Would you like to edit a new service configuration?

-

158888

« Tocreateanew service configuration (see How to Add New Service Configurations, page 6-3), click
Yes.

» To open an existing service configuration (see How to Open Existing Service Configurations,
page 6-5), click No.

The Configuration option is included in the main menu only when at least one service configuration is
open.

You can have many service configurations open at one time; each is displayed in its own view, and you
click aview to make that view's service configuration active.

When a service configuration has unsaved changes, an asterisk precedes its name on the view.
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How to Add New Service Configurations

You can add a new service configuration whenever necessary.

S

Note  You cannot add a second new service configuration until you have saved the first one.

When anew service configuration opens, it contains the default service configuration supplied with SCA
BB. Thisincludes a default package, which contains a default service rule.

Stepl  Inthe Console toolbar, click j (New Service Configuration).
A New Service Configuration Settings dialog box appears (Figure 6-2).

Figure 6-2 New Service Configuration Settings

New Service Configuration Settings

~System Cperational Mode

Select the system's operational mode For handling the network traffics
() Transparent
(&3 Report Cnly

() Full Functionality

Routing Classification Mode -

Enable Asymmetric Routing Classification Mode in topologies
with high rate of unidirectional Aows, In this mode, the system is
better tuned for classifying traffic according to just one side of the
Flows, but some control capabilities are disabled.

[] Enable the Asymmetric Routing Classification Made

l OF H Cancel J

210500

Step2  Select an operational mode for the service configuration.
Step3  Select arouting classification mode for the system.

Selecting asymmetric routing classification mode gives more accurate protocol classification in
topologies with ahigh rate of unidirectional flows. Several classification, reporting, and control features
are not supported when this mode is enabled (see Asymmetric Routing Classification Mode,

page 10-45).

Step4  Click OK.

If you have set a default DSS file (see The Default DSS File, page 7-46), a Default Signature message
appears (Figure 6-3).

Cisco Service Control Application for Broadband User Guide
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Figure 6-3 Default Signature
3 Default Signature
<P Would you like to set the default signature script?
e ] )
H Yes ﬂ [ Mo J §
wo
L

» (Recommended) Click Yes to import the default DSS file.
« Click No to continue without importing the default DSSfile.

The new service configuration is added to the Console window, open on the Network Traffic tab, and

becomes the active service configuration (Figure 6-4).

Figure 6-4 Service Configuration Editor

¥ Service Configuration Editor - snew service configurations - SCA BB Console

Fle Tock Preferences Window Hélp
& W
[T | dgf s Comiapumation Eiter | %8 Neetwork Bavigator

& <rew service configurstion> 1

o Pobirs | B Classiication |

G o X Conliguin -

St Piered Traff icad Astae
j Service Sacurky Dt aul Riis wantrodled
el Pobey

5 [ Subricriber Pokonrs

é Undncswn Subscriber Traffic

e S T
Cofole

274088
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How to Open Existing Service Configurations

Step 1

Step 2
Step 3

You can open a saved service configuration for viewing or for editing, or to apply it to an SCE platform.

Service configuration files have the extension PQB.

In the Console toolbar, click [E (Open A Service Configuration File). (Or, from the Console main
menu, choose File > Open Service Configuration.)

An Open dialog box appears.

Browse to a service configuration file.
Click Open.

The Open dialog box closes.

If the default DSS file has not been imported into the service configuration, a Default Signature message
appears (Figure 6-5).

Figure 6-5 Default Signature

3 Default Signature

<P Would you ke to set the default signature script?

158795

If the default DSSfile has not been imported into the service configuration, a Default Signature message
appears.

» (Recommended) Click Yesto import the default DSS file.
« Click No to continue without importing the default DSS file.
The service configuration is loaded into the Console;
« This service configuration becomes the active service configuration.
» Thetitle of the Console window includes the name of the service configuration.

| oL-7205-19
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How to Save the Current Service Configuration

You can save the active service configuration.
- How to Save the Current Service Configuration to a Service Configuration File, page 6-6
« How to Save the Current Service Configuration to the File from Which it Was L oaded, page 6-6

How to Save the Current Service Configuration to a Service Configuration File

Stepl  From the Console main menu, choose File > Save As.
A Save As dialog box appears.
» Enter your password if prompted.
Step2  Browse to the folder where you want to save the file containing the service configuration.
Step3  Inthe File name field, enter a new file name, or select an existing PQB file.
Step4  Click Save.
The service configuration is saved to the selected file. If the file exists, it is overwritten.

During processing, a Saving Service Configuration File message appears.

How to Save the Current Service Configuration to the File from Which it Was Loaded

Step1  Inthe Console toolbar, click L&/ (Save).

If the current service configuration was not loaded from aPQB file (that is, if itisnew, or it wasretrieved
from an SCE platform), the Save As dialog box opens as in the previous procedure.
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How to Close Service Configurations

Step1  On the service configuration view, click E (Close).
- If there are no unsaved changes, the service configuration view closes.
- If there are unsaved changes a Save Resource message appears (Figure 6-6).

Figure 6-6 Save Resource

3£ Save Resource

<P "wnew service configuration ' has been madified. Save changes?

Mo Cancel

I
211749

« Click Yes:

— If thisis an existing edited service configuration, the changes are saved and the service
configuration view closes.

— If thisisanew service configuration, a Save As dialog box opens.
Enter a name for the service configuration and click Save.
The Save As dialog box closes, the changes are saved, and the service configuration view closes.

Cisco Service Control Application for Broadband User Guide
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How to Export Service Configuration Data

You can export service configuration data from the current service configuration to CSV files. The CSV
file formats are described in the “CSV File Formats” chapter of the Cisco Service Control Application
Suit for Broadband Reference Guide.

Each type of service configuration element is exported to a separate file.

Stepl  From the Console main menu, choose File > Export.

The Export dialog box appears (Figure 6-7).

Figure 6-7 Export
3£ Export |:|®
Select /—‘

hoose export destination, I g 5 i

Select an export destination:

|type filker bext |

(= Wetwork Mavigator
== Reparter

Service Configuration

Export service configuration parts to a C5Y file

(e ] fe
b

Step2  From the export destination list, select Export service configuration partsto CSV file.
Step3  Click Next.
The Export Service Configuration Parts dialog box appears (Figure 6-8).
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Figure 6-8 Export Service Configuration Parts to File

3 Export Service Configuration Parts

Export Service Configuration Part to File

This wizard exports service configuration parts to a file

Select service configuration element to export:

™ Service Elements
" Protocol Elements
~

" Flavors

SN, e O el SR el Rl T el s i e

| | | Cancel |

211743

Step4  Select one of the Select service configuration element to export radio buttons.
The radio buttons are:
» Service Elements
» Protocol Elements
e Zones
- Flavors

If you select Flavors, the flavors in the flavor area of the dialog box are enabled.

Note  Only those flavors for which a flavor type is defined in this service configuration are enabled.

Step5  If you selected Flavors, select one of the flavor type radio buttons.
Step6  Click Next.
The second screen of the Export Service Configuration Parts dialog box opens (Figure 6-9).

Cisco Service Control Application for Broadband User Guide
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Step 7
Step 8

Step 9

Step 10
Step 11

Step 12

Figure 6-9 Export Service Configuration Parts to File

3 Export Service Configuration Parts

Export Service Configuration Parts to File
At least one element should be selected for export

Available elements:

(] Skype

[] sittorrent

|:| DirectConnect

[] eDonkey

JFre

[] FastTrack KaZaA File Transfer
[] FastTrack KaZaA Networking

[ Generic 1P

] Gnutella File Transfer

[ Gnutella Netwaorking

|:| HTTP Browsing

[] Hotline

7 rms

] Manalito
1 aa

fanad

|,
|

[ Select All ] [ Deselect Al ] [ Invert Selection

Select the export destination:

b | Browse...

Service Configuration file: .

Cancel

158819

The Available elements pane lists all elements in the service configuration of the selected type.

Select the elements to export, using the check boxes and the select buttons.

In the Select the export destination area, click Browse.
An Open dialog box appears.

Browse to the folder where you want to save the file containing the service configuration elements.

In the File name field, enter a new file name, or select an existing CSV file.

Click Open to select thefile.

If thefile exists, it will be overwritten.

The Open dialog box closes.

Click Finish.

The selected service configuration elements are exported to the file.

An Export Complete message appears (Figure 6-10).

[l Cisco Service Control Application for Broadband User Guide
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Figure 6-10 Export Complete

3 Export Complete

\j‘) Export completed successfully, 3 elements have been exported,

158816

Step13 Click OK.
The Export Service Configuration Parts dialog box closes.

Cisco Service Control Application for Broadband User Guide
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How to Import Service Configuration Data

You can import service configuration datato the current service configuration from CSV files. The CSV
file formats are described in the “CSV File Formats” chapter of the Cisco Service Control Application
Suit for Broadband Reference Guide.

Each type of service configuration element isimported from a separate file.

Stepl  From the Console main menu, choose File > Import.

The Import dialog box appears (Figure 6-11).

Figure 6-11 Import
H Import |:|@®
Select

Y

hoose import source, I E - 5

Select an import source:

|type filker bext |

= Hetwork Mavigator
E-[= Service Configuration
Import content filkering database settings From an =ML file

Import service configuration parts From a 3 file
(= Signature Editor

&
o ] |8
b

Step2  From the Select an import source list, select Import service configuration partsfrom CSV file.
Step3  Click Next.
The Import Service Configuration Parts dialog box appears (Figure 6-12).
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Figure 6-12 Import Service Configuration Parts from File

3 Import Service Configuration Parts

Import Service Configuration Part from File

This wizard imports service configuration parts from a file

Select service configuration element to import:

™ Service Elements
" Protocol Elements
" Zones

" Flavors

SN, e O el SR el Rl T el s i e

| | | Cancel |

211748

Step4  Select one of the Select service configuration element to import radio buttons.
The radio buttons are:
» Service Elements
« Protocol Elements
e Zones
- Flavors
If you select Flavors, the flavors in the flavor area of the dialog box are enabled.
Step5  If you selected Flavors, select one of the flavor type radio buttons.
Step6  Click Next.

The second screen of the Import Service Configuration Parts dialog box opens (Figure 6-13).

Cisco Service Control Application for Broadband User Guide
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Figure 6-13 Import Service Configuration Parts from File

3 Import Service Configuration Parts

Import Service Configuration Part from File

This wizard imports service configuration parts from a file

Select a C5V file: bt [Browse. = ]

Cancel

158861

Step7  Click Browse.

An Open dialog box appears.
Step8  Browse to the folder containing the file to import, and select a CSV file.
Step9  Click Open to select thefile.

The Open dialog box closes.
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Step10  Click Finish.
The configuration elements are imported from the file.

An Import Complete message appears (Figure 6-14).

Figure 6-14 Import Complete

2£ Import Complete

\i) Import completed successfully, 2 elements have been imparted.

158855

Step11 Click OK.
The Import Service Configuration Parts dialog box closes.

Applying and Retrieving Service Configurations

For anew or edited service configuration to take effect, you must apply it to the SCE platform. Until you
do, the SCE platform continues to enforce the previous service configuration.

You can use the Service Configuration Editor to apply a service configuration to an SCE platform, but
not to retrieve a service configuration.

You can apply or retrieve a service configuration using:
« The Network Navigator Tool, page 5-2

» servconf, the SCA BB Service Configuration Utility (see The SCA BB Service Configuration
Utility, page 13-1)

« How to Validate the Current Service Configuration, page 6-15
- How to Apply a Service Configuration to SCE Platforms, page 6-16

How to Validate the Current Service Configuration

Use the Validate option to validate the new or updated service configuration currently displayed. The
validation process checks for overall service configuration coherence, and points out possible pitfallsin
the service configuration.

The Validate process runs automatically when you select Apply Service Configuration to SCE devices.
The Validation Results dialog box appears only if the procedure found errors or issued warnings about
the current service configuration.

Cisco Service Control Application for Broadband User Guide
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Step1  From the Console main menu, choose File > Validate.
The Validation Results dialog box appears (Figure 6-15 or Figure 6-16).

Figure 6-15 Validation Results - Service Configuration is valid

3 Validation Results

i ) Service Configuration is valid.

210987

Figure 6-16 Validation Results - Service Configuration has errors

3£ Validation Results

0 Service Configuration has errors,
Errors and Warnings are listed in the Problem View,
.

210986

Any problems with the service configuration are listed in the Problems view.
Step2  Click OK.
The Service Configuration Validation dialog box closes.

How to Apply a Service Configuration to SCE Platforms

When you click Apply Service Configuration to SCE Devices, the validation process runs
automatically on the current service configuration.

Note  You can use the Validate menu command to manually validate the service configuration.

Caution  If anomaly-based detection of malicious traffic is enabled, any access control list (ACL) that is
configured on the Service Control Engine (SCE) platform but is not applied to anything (for example,
an interface, an access map, or an SNMP community string) might be deleted when a service
configuration is applied to the platform.

Wor karound:

Disable anomaly-based detection of malicious traffic.

In the Network Traffic tab, select Service Security.

In the Service Security Dashboard, clear the Enable anomaly detection check box.
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Step 4
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In the Console toolbar, click 'ﬂ' (Apply Service Configuration to SCE Devices).
The Select SCE Devices dialog box appears (Figure 6-17).

Figure 6-17 Select SCE Devices

3 Select SCE Devices

| sCE1[172.2.5.31]
SCE2 [172.2.5.127]
SCE3 [172.2.5.83]

I Ok ][ Cancel ]

158967

All SCE platforms defined in the Network Navigator are listed in the dialog box.

Select one or more SCE platforms from the list.

Click OK.

A Password Management dialog box appears for each platform selected.

Enter the appropriate password.

Click Apply.

The Password Management dialog box closes.

An Applying service configuration to SCE progress bar appears for each SCE platform selected.
The validation process runs on the service configuration.

- If thereisaproblem and the validation process ends with awarning or error, the Validation Results
dialog box appears. Click OK, modify the service configuration based on the information provided
in the Problems view, and then repeat this procedure.

- If the validation process runs successfully, the service configuration is applied to the selected SCE
platforms.

| oL-7205-19
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Introduction

Traffic classification is the first step in creating a Cisco Service Control Application for Broadband
(SCA BB) service configuration. Traffic is classified according to services.

For each commercial service that providers offer to their subscribers, a corresponding service is defined
in the Cisco Service Control solution. You can use this service to classify and identify the traffic, report
on its usage, and control it.

This module explains how to work with services and their elements and subelements.
- How to Search Traffic Classification Settings, page 7-2
- Managing Services, page 7-3
« Managing Protocols, page 7-22
- Managing Zones, page 7-33
« Managing Protocol Signatures, page 7-39
- Managing Flavors, page 7-51
- Managing Content Filtering, page 7-63
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How to Search Traffic Classification Settings

Step 1

Step 2

Note

Step 3

You can search for any classification detail by name or numeric ID, such as services, protocols, port number,
or counter assignments. You can aso search for protocols or signatures that are not assigned to a service.

In the Classification tab, click "

(Search Classification Settings).

The Search Classification Settings dialog box appears (Figure 7-1).

Figure 7-1 Search Classification Settings

# Search Classification Settings

Tvpe text ko filker classification elements:

= EJ Default Service [id=0; global-counter=0; subscriber-counter=0]
=-E Browsing [id=7; global-counter=0; subscriber-counter=1]
Bl HTTP [id=16; global-counter=9; subscriber-counter=1]
EJ HTTPS [id=17; global-counter=10; subscriber-counter=1]
EJ Location Based Services [id=48; global-counter=31; subscriber-counter=1]
Bl servicel [id=99; global-counter=0; subscriber-counter=1]
E| E-Mail [id=4; global-counker=0; subscriber-counter=2]
EJ File Sharing [id=49; global-counter=0; subscriber-counter=0]
EJ Gaming [id=29; global-counter=0; subscriber-counter=4]
EJ Instant Messaging [id=28; global-counter=0; subscriber-counter=5]
B Internet Privacy [id=94; global-counter=0; subscriber-counter=e]
EJ Internet Wideo [id=70; global-counter=0; subscriber-counter=0]
EJ Met Admin [id=33; global-counter=0; subscriber-counter=3]
EJ Mewsgroups [id=8; global-counter=S; subscriber-counter=10]
B voice and video Calls [id=12; global-counter=0; subscriber-counter=9]
H| other [id=1; global-counker=0; subscriber-counter=0]
1=F Unassigned Signature-Based Protocols
1=F Cther Unassigned Protocols
= Unassigned Zones

53 3 R R = R A= S 2R

CE

l [ Cancel

|

Enter the text to search.

243374

You can include the following wildcards in the search:
e ?—any character
e e *—any string

The dialog box is populated with the search results.

Double-click the item to take you to the screen where you can edit it. For example, if you double-click

a protocol, the protocol dialog box opens on the selected protocol.

Cisco Service Control Application for Broadband User Guide

0L-7205-19 |



| Chapter7 Using the Service Configuration Editor: Traffic Classification

Managing Services W

Managing Services

Services are used to classify controlled traffic.

A service consists of one or more service elements; different network traffic transaction types are
mapped to different service elements.

Traffic is classified on the basis of some or all of the following:

» Protocol—The protocol used by the transaction, as identified by the Service Control Engine (SCE)
platform

« Initiating side—Where the transaction was initiated
« Zone—IP address of the network-side host of the transaction

» Flavor—Specific Layer 7 properties of the transaction; for example, host names of the network-side
host of the transaction

A service configuration can contain up to 500 services and 10,000 service elements. Every service
element in a service configuration must be unique.

Cisco Service Control Application for Broadband User Guide
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Service Parameters

A service is defined by the following parameters:
» General parameters:
— Name—A unique name
— Description—(Optional) A description of the service
« Hierarchy parameters:;
— Parent Service

The default service, which is the base of the service hierarchy, does not have a parent.

Note  The parent service isimportant when services share usage counters (see next parameter).

— Service Usage Counters—Used by the system to generate data about the total use of each
service. A service can use either its own usage counters, or those of the parent service.

Each usage counter has:
— A name assigned by the system (based on the service name).

Note  An asterisk is appended to a service usage counter name whenever the counter applies to more than one
service.

— A unique counter index—A default value of the counter index is provided by the system. Do not
modify this value.

» Advanced parameter:

— Service Index—A unique number by which the system recognizes the service (changing the
service name does not affect SCE platform activity). A default value of the service index is
provided by the system. Do not modify this value.

These parameters are defined when you add a new service (see How to Add a Service to a Service
Configuration, page 7-5). You can modify them at any time (see How to Edit Services, page 7-9).

Adding and Defining Services

A number of services are predefined in the Console installation. You can add additional servicesto a
service configuration, subject to the limit of 500 services (including predefined services) per service
configuration.

After you have added and defined a new service, you can add service elements to the service (see How
to Add Service Elements, page 7-12).

» How to Add a Service to a Service Configuration, page 7-5
- How to Define Hierarchical Settings for a Service, page 7-6
- How to Set the Service Index, page 7-7

- How to View Services, page 7-8
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How to Add a Service to a Service Configuration

Stepl  Inthe Servicestab, select a service from the service tree. This service will be the parent of the service
you are adding.

Step2  Intheleft pane, click ':E:' (Add Service).
The Service Settings dialog box appears (Figure 7-2).

Figure 7-2 Service Settings

Service Settings for ""

General | Higrarchy | Advanced

Bame:
| Servicel

Description:

[ QF H Cancel ]

158976

Step3  Inthe Name field, enter a unique and relevant name for the service.
Step4  Inthe Description field, enter a meaningful and useful description of the service.

Step5  To set exclusive usage countersfor this service, or to change the parent service you selected when adding
the service, continue with the instructions in the section How to Define Hierarchical Settings for a
Service, page 7-6.

Step6  (Optional) To specify an index for this service, continue with the instructions in the section How to Set
the Service Index, page 7-7.

Note  The system automatically assigns a free number for the new service. Maodify this number only where a
specific index value must be assigned to a specific service.

Step7  Click OK.
The Service Settings dialog box closes.
The service is added to the service tree as a child to the service you selected in the hierarchy.

Cisco Service Control Application for Broadband User Guide
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How to Define Hierarchical Settings for a Service

Stepl  Inthe Service Settings dialog box, click the Hierarchy tab.
The Hierarchy tab opens (Figure 7-3).

Figure 7-3 Hierarchy Tab

Service Settings for ""

| ‘General | ' Advanced

Parent Service

Parent Service: | SMTP w |

Service Lsage Counters

Per usage accounting scope (global accounting and subscriber accounting),
a service can either be mapped ko an exclusive usage counter, or share a
usage counter with its ancestor service,

[] Map this Service ta an exclusive Global usage counter
Global counter used by this service: E-Mail Cognter*
Counter Index: 3 v |

[] Map this Service ta an exclusive Subscriber usage counter

Subscriber counter used by this service; |E-Mail Counter®

Counter Index:

Ok Cancel
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Step2  To set adifferent parent service, select the desired parent from the Parent Service drop-down list.

Step3 By default, anew service uses its parent’s global usage counter. To define an exclusive global usage
counter, check the Map this Service to an exclusive Global usage counter check box.

The name in the read-only Global counter of this service field changes to reflect your choice.
The Counter Index drop-down list is enabled.
(Optional) Select a value for the counter index from the Counter Index drop-down list.

Note A default value of the counter index is provided by the system. Do not modify this value.

Step4 By default, a new service uses its parent’s subscriber usage counter. To define an exclusive subscriber
usage counter, check the Map this Service to an exclusive Subscriber usage counter check box.

The name in the read-only Subscriber counter of this service field changes to reflect your choice.
The Counter Index drop-down list is enabled.
(Optional) Select avalue for the counter index from the Counter Index drop-down list.

Note A default value of the counter index is provided by the system. Do not modify this value.
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Step5  To specify an index for this service, continue with the instructions in the section How to Set the Service
Index, page 7-7.

Note  The system automatically assigns a free number for the new service. Modify this number only where a
specific index value must be assigned to a specific service.

Step6  Click OK.
The Service Settings dialog box closes.

The service isadded to the service tree as a child to the service selected in the Parent Service drop-down
list.

How to Set the Service Index

Step1  Inthe Service Settings dialog box, click the Advanced tab.
The Advanced tab opens (Figure 7-4).

Figure 7-4 Advanced Tab

Service Settings for ""

General || Hierarchy | nced |

rService Index -

Set the Index For this Service: |40 v

QF ] ’ Cancel
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Step2  From the Set the Index for this Service drop-down list, select a service index.

The service index must an integer in the range 1 to 499; zero is reserved for the default service.

Note  The system automatically assigns a free number for the new service. Modify this number only where a
specific index value must be assigned to a specific service.

Step3  Click OK.
The Service Settings dialog box closes.

The service isadded to the service tree as achild to the service selected in the Parent Service drop-down
list.

How to View Services

You can view a hierarchy tree of all existing services and see their associated service elements.

Stepl  Inthe current service configuration, click the Classification tab.
The Classification tab appears (Figure 7-5).

Figure 7-5 Classification Tab
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A list of all servicesis displayed in the service tree (Ieft pane).
Step2  Click aservice in the hierarchy to display its service elements.

A list of all service elements defined for this service is displayed in the right (Service Elements) pane
(Figure 7-6).
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Figure 7-6 Service Elements

I | & Smrvice Condique ation Exiber | 9 Network Navigstar
] = anew service configurstions 1 =0

9 Pokies | B8 Clagsfication

4 % K 1 Configastion =

B By
B EMal

B 5 Push Mal
B PoFd
B e
B Fis Shoeirgy
Bl Gaming
B Dok Messagng
B Inkernet Privacy
I prnernet Vidso
B nest sk
B Newiipiagns
i 188 voice and Vides Cals
& Other

B

B Cormale . [1] Proties m LB = B - PY-
Cinmcle

T4

Fieport Ordy

Step3  To view more information about a service, select a service from the service tree and click l (Edit
Service).

The Service Settings dialog box appears.
Step4  Click OK.
The Service Settings dialog box closes.

How to Edit Services

You can modify the parameters of a service, even those included in the Console installation.
To add, modify, or delete service elements, see Managing Service Elements, page 7-12.

Stepl  Inthe Services tab, select a service from the service tree.
Step2  Intheleft pane, click l (Edit Service).
The Service Settings dialog box appears.
Step3  (Optional) Give a new name to the service.
Enter a new name in the Name field.
Step4  (Optional) Give a new description for the service.
Enter a new description in the Description field.

Cisco Service Control Application for Broadband User Guide
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Step 5

N

Note

Note

Step 6

Note

Step 7

To change hierarchical settings, click the Hierarchy tab.

The Hierarchy tab opens.

a.

b.

To set a different parent service, select the desired service from the Parent Service drop-down list.

To share a global usage counter with the parent service, uncheck the Map this Service to an
exclusive Global usage counter check box.

The name of the parent service’s counter isdisplayed in the Global counter used by this servicefield.

To define an exclusive global usage counter, check the Map this Service to an exclusive Global
usage counter check box.

The name in the read-only Global counter of this service field changes to reflect your choice.
The Counter Index drop-down list is enabled.

A default value of the counter index is provided by the system. Do not modify this value.

d.

To share a subscriber usage counter with the parent service, uncheck the Map this Serviceto an
exclusive Subscriber usage counter check box.

The name of the parent service’s counter is displayed in the Subscriber counter used by this service
field.

To define an exclusive subscriber usage counter, check the Map this Service to an exclusive
Subscriber usage counter check box.

The name in the read-only Subscriber counter of this service field changes to reflect your choice.
The Counter Index drop-down list is enabled.

A default value of the counter index is provided by the system. Do not modify this value.

To change the service index:

a.

In the Service Settings dialog box, click the Advanced tab.
The Advanced tab opens.
From the Set the Index for this Service drop-down list, select a service index.

The service index must an integer in the range 1 to 499; zero is reserved for the default service.

A default value of the service index is provided by the system. Do not modify this value.

Click OK.
The Service Settings dialog box closes.

The changes to the service are saved.
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You can delete all services, even those in the Console installation, with the exception of the default
service.

158951

Stepl  Inthe Services tab, select a service from the service tree.
Step2  Intheleft pane, click ﬁ (Delete Service).
Step3 A Service Warning message appears (Figure 7-7).

Figure 7-7 Service Warning

3 Service Warning

\?(J Are you sure you want to remove Service "SMTP Outgoing™?
L Yes ﬂ [ Mo

Step4  Click Yes.

- If any package has arule for this service (see Managing Rules, page 9-55), a second Service
Warning message appears (Figure 7-8).

Figure 7-8 Service Warning

¥ Service Warning

<P All references to the Service "SMTP Outgoing”™ will be removed.
L] Are you sure you want to continue?

I
1589383

e Click Yes.

The service is deleted and is no longer displayed in the service tree. Any rules for the service are also
deleted.

Children of the deleted service are not deleted; they move up one level in the service tree.
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Managing Service Elements

A serviceisacollection of service elements; to complete the definition of a service, you must define its
service elements. A service element maps a specific protocol, initiating side, zone, and flavor to the
selected service.

For more information, see Managing Protocols, page 7-22, Managing Zones, page 7-33, and Managing
Flavors, page 7-51.

A service configuration can contain up to 10,000 service elements. Every service element must be
unique.

A traffic flow is mapped by a service element to the service element’s service if it meets all five of the
following criteria:

» The flow uses the specified protocol of the service element.

- Theflow isinitiated by the side (network, subscriber, or either) specified for the service element.
- The destination of the flow is an address that belongs to the specified zone of the service element.
» The flow matches the specified flavor of the service element.

« The service element is the most specific service element satisfying the first four criteria.

How to Add Service Elements

Note

When necessary, you can add new service elements to a service. (The most useful service elements are
included in the Consoleinstallation.) A service may have any number of service elements (subject to the
limit of 10,000 service elements per service configuration).

Every service element must be unique; if, at any stage, the new service element isthe same as an existing
one, an error message is displayed in the dialog box and the Finish button is dimmed. If this occurs,
modify the value in at least one field.
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Stepl  Inthe Services tab, select a service from the service tree.
Step2  Intheright (Service Elements) pane, click ':::' (Add Service Element).
The New Service Element dialog box appears (Figure 7-9).

Figure 7-9 New Service Element

3£ New Service Element

Create Service Element

Create & new service element and assodiate it with a service

Assign the service element to service:

Service: [ sne | ISEIect... ]

Choose which flows will be mapped to the service by setting the following flow properties:

Protocol: | *. | [Select... ]

Initiating Side: nih’ated by either side vi

Zone: | = | ISEIect... ]
Flavor: | ¥ | [Select... ]
[ Einish l ’ Cancel ]

158887

Step3  To change the service to which this service element is assigned, click the Select button next to the
Service field.

The Select a Service dialog box appears (Figure 7-10), displaying alist of all services.

Figure 7-10 Select a Service
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Step4  Select aservice from the list.
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Step5  Click OK.

The Select a Service dialog box closes.

The selected service is displayed in the Service field of the New Service Element dialog box.
Step6  Click the Select button next to the Protocol field.

Note  The default value (an asterisk, *) means that no protocol checking is performed when testing if a flow
maps to this service element.

The Select a Protocol dialog box appears (Figure 7-11), displaying alist of all protocols.

Note  If you select aflavor (Step 15) before you select aprotocol, only protocols relevant to the selected flavor
are displayed.

Figure 7-11 Select a Protocol
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Step7  Select aprotocol from the list. You can type in the field at the top of the dialog box to help locate the
desired protocol.

Step8  Click OK.

The Select a Protocol dialog box closes.

The selected protocol is displayed in the Protocol field of the New Service Element dialog box.
Step9 IntheInitiating Side field (Figure 7-12), click the drop-down arrow.
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Figure 7-12 Initiating Side Field
Choose which flows will be mapped to the service by setting the following flow properties:
Protocol: * | Select...
Initiating Side: [fnitated by cither =]
Subscriber-Initiated i .
Flavor: i | Select... §
Step10  Select the appropriate initiating side from the drop-down list.
The following options are available;
- Subscriber-Initiated —Transactions are initiated at the subscriber side towards (a server at) the
network side.
» Network-Initiated —Transactions are initiated at the network side towards (a server at) the
subscriber side.
- Initiated by either side
Step11  Click the Select button next to the Zone field.
S
Note  Thedefault value (an asterisk, *) means that no zone checking is performed when testing if aflow maps
to this service element.
The Select a Zone dialog box appears (Figure 7-13), displaying alist of all zones.
Figure 7-13 Select a Zone
- BX
Europe
Local
Private Address Space
[ OK ] [ Cancel §
Step12  Select a zone from the list.
Step13 Click OK.
The Select a Zone dialog box closes.
The selected zone is displayed in the Zone field of the New Service Element dialog box.
Cisco Service Control Application for Broadband User Guide
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Step14  Click the Select button next to the Flavor field.

Note  Thedefault value (an asterisk, *) meansthat no flavor checking is performed when testing if aflow maps
to this service element.

The Select a Flavor dialog box appears (Figure 7-14), displaying alist of all flavors relevant to the
protocol selected in Step 7.

Note  You canonly select aToSflavor if you select the default value (*, meaning any protocol) for the protocol.

Figure 7-14 Select a Flavor

(=13

Flavor 1
HTTP Streaming Agents
Vonage as Destination

I OK ] [ Cancel
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Step15 Select aflavor from the list.
Step16 Click OK.

The Select a Flavor dialog box closes.

The selected flavor is displayed in the Flavor field of the New Service Element dialog box.
Step17  Click Finish.

The New Service Element dialog box closes.

The new service element is added to the service.

A new row, representing the service element, is added to the service element list in the Service Elements
pane.
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How to Duplicate Service Elements

Note

Step 1

Step 2
Step 3

Step 4

S

Note

Duplicating an existing service element is a useful way to add a new service element similar to an
existing service element. It isfaster to duplicate a service element and then make changes than to define
the service element from scratch.

Every service element must be unique; if, at any stage, the new service element isthe same as an existing
one, an error message is displayed in the dialog box and the Finish button is dimmed. If this occurs,
modify the value in at least one field.

In the Services tab, select a service from the service tree.

A list of associated service elements is displayed in the Service Elements pane.
In the Service Elements pane, select a service element to duplicate.

Click EE!' (Duplicate Service Element).

The Copy Service Element dialog box appears (Figure 7-15).

Figure 7-15 Copy Service Element

3 Copy Service Element

Copy Service Element

Create a new service element using the selected service element as template

Assign the service element to service:

Service: | 5MTR | |select...

Choose which flows will be mapped to the service by setting the following flow properties:

Protocol: SMTP Select...

Initiating Side: [nitiat=d by either side g0y

=

Zone: Select...

Flavor: Select...

GG

158793

Cancel

Modify the service element (see How to Edit Service Elements, page 7-18).

Before you can save the new service element, you must change the value in at least one field.
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How to Edit Service Elements

You can modify all service elements, even those included in the Console installation.

Y
Note  Every service element must be unique. If, at any stage, the modified service element is the same as an

existing one, an error message is displayed in the dialog box and the Finish button is dimmed. If this
occurs, modify the value in at least one field.

Stepl Inthe Services tab, select a service from the service tree.

A list of associated service elements is displayed in the Service Elements pane.
Step2  Inthe Service Elements pane, select a service element to edit.
Step3  Inthe Service Elements pane, click l (Edit Service Element).

The Edit Service Element dialog box appears (Figure 7-16).

Figure 7-16 Edit Service Element

3¢ Edit Service Element X]

Edit Service Element

Edit any of the service element's fields or assodate it with a different service

Assign the service element to service:

Service: -SMTP Select...

Choose which flows will be mapped to the service by setting the following flow properties:
Protocol: SMTP Select...

Fritiated by either side] v

Initiating Side:

Zone: = Select...

Flavor: F Select...

’ Einish l ’ Cancel ]

158811

Step4  To change the service to which this service element is assigned, click the Select button next to the
Service field.

The Select a Service dialog box appears, displaying alist of all services.
Step5  Select aservice from thelist.
Step6  Click OK.
The Select a Service dialog box closes.
The selected service is displayed in the Service field of the Edit Service Element dialog box.
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Step 8

Step 9

Step 10

Step 11

Step 12

Note

Step 13
Step 14

Step 15

Note

Step 16
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To change the protocol of this service element, click the Select button next to the Protocol field.

An asterisk (*) means that no protocol checking is performed when testing if aflow mapsto this service
element.

The Select a Protocol dialog box appears, displaying alist of all protocols.

Select a protocol from the list; you can type in the field at the top of the dialog box to help locate the
desired protocol.

Click OK.
The Select a Protocol dialog box closes.
The selected protocol is displayed in the Protocol field of the Edit Service Element dialog box.

To change the initiating side of this service element, click the drop-down arrow in the Initiating Side
field.

Select the appropriate initiating side from the drop-down list.
The following options are available:

« Subscriber-Initiated—Transactions are initiated at the subscriber side towards (a server at) the
network side.

« Network-Initiated—Transactions are initiated at the network side towards (a server at) the
subscriber side.

« Initiated by either side

To change the zone of this service element, click the Select button next to the Zone field.

An asterisk (*) means that no zone checking is performed when testing if a flow maps to this service
element.

The Select a Zone dialog box appears, displaying alist of all zones.

Select a zone from the list.

Click OK.

The Select a Zone dialog box closes.

The selected zone is displayed in the Zone field of the Edit Service Element dialog box.

To change the flavor of this service element, click the Select button next to the Flavor field.

An asterisk (*) means that no flavor checking is performed when testing if a flow maps to this service
element.

The Select a Flavor dialog box appears, displaying alist of all flavors.
Select aflavor from the list.
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Step17 Click OK.
The Select a Flavor dialog box closes.
The selected flavor is displayed in the Flavor field of the Edit Service Element dialog box.
Step18 Click Finish.
The Edit Service Element dialog box closes.
The changes to the service element are saved.
The changes to the service element appear in the service element list in the Service Elements pane.

How to Delete Service Element

You can delete all service elements, even those included in the Console installation.

Stepl  Inthe Servicestab, select a service from the service tree.

A list of associated service elements is displayed in the Service Elements pane.
Step2  Inthe Service Elements pane, select a service element to delete.
Step3  Inthe Service Elements pane, click ¥ (Delete Service Element).

A Service Warning message appears (Figure 7-17).

Figure 7-17 Service Warning

3 Service Warning

I’ Are you sure you want to remaove this Service Element?

158952

Step4  Click Yes.
The service element is deleted and is no longer part of the selected service.
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How to Move Service Elements

You can move an existing service element from one service to a different service.

Stepl  Inthe Services tab, select a service from the service tree.
A list of associated service elements is displayed in the Service Elements pane.
Step2  Inthe Service Elements pane, select a service element to move.
Step3  Click Iﬁ' (Move Service Element to Another Service).
The Move Service Element dialog box appears (Figure 7-18), displaying the complete service tree.

Figure 7-18 Move Service Element
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Step4  From the service tree, select a service.
Step5  Click OK.
The Move Service Element dialog box closes.
The service element is moved to the selected service.
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Managing Protocols

A protocol iscomposed of an application protocol signature, the destination port or ports, a unique name,
and an optional description.

Protocols are used to define service elements (see Managing Service Elements, page 7-12).

You can add new protocols (for example, to classify a new gaming protocol that uses a specific port).
You can also edit or delete existing ones.

A service configuration can contain up to 10,000 protocols elements.

Note  Each of the protocol elements may consume more than one service configuration entry.

SCA BB supports many commercial and common protocols. For a complete list of protocols included
with the current release of SCA BB, see the “Information About Protocols” section in the “Default
Service Configuration Reference Tables” chapter of the Cisco Service Control Application for
Broadband Reference Guide. As new protocols are released, Cisco provides files containing the new
protocol signatures so that you can add the signatures to your service configuration. (See How to Import
a Dynamic Signature Script into a Service Configuration, page 7-44.)

» Viewing Protocols, page 7-22

- How to Add Protocols, page 7-25

- How to Edit Protocols, page 7-26

- How to Delete Protocols, page 7-27

« Managing Protocol Elements, page 7-28

Viewing Protocols

- How to View Protocols, page 7-22
- How to Filter the Protocols List, page 7-24

How to View Protocols

You can view alist of all protocols and their associated protocol elements.
The protocols are listed in ASCII sort order (that is, 0... 9, A... Z, a... 2).

The protocol elements are not sorted; they are listed in the order in which they were added to the
protocol.
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Managing Protocols

From the Classification tab in the left pane, choose Configuration > Protocols.

The Protocol Settings dialog box appears (Figure 7-19).

Figure 7-19 Protocol Settings

Protacol Settings
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The Protocols tab displays alist of existing protocols.

Double-click a protocol to view its description and ID.

The Protocol Settings dialog box appears (Figure 7-20), displaying the protocol name, description, and

ID.

Figure 7-20 Protocol Settings

Protocol Settings

General |

MHame:
S |

Description:

Protocol IDy 788 W

[ oK H Cancel ]
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Click Cancel.
The Protocol Settings dialog box closes.
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Step4  Toview alist of protocol elements, select a protocol in the list in the Protocol Settings dialog box.
Protocol elements are displayed in the Protocol Elements tab.

Step5  Click Close.
The Protocol Settings dialog box closes.

How to Filter the Protocols List

You can filter the protocols by type, so that the Protocols tab displays only the selected type of protocol.
There are ten categories of protocols:

» Generic Protocols—Generic IP, Generic TCP, and Generic UDP protocols, used for transactions that
are not specifically mapped to a protocol by any other protocol type.

« |P Protocols—Protocols (such as ICMP), other than TCP and UDP protocols, identified according
to the IP protocol number of the transaction.

» Port-Based Protocols—TCP and UDP protocols, classified according to their well-known ports. The
default service configuration includes more than 750 common port-based protocols.

- Signature-Based Protocols—Protocols classified according to a Layer 7 application signature.
Includes the most common protocols, such as HTTP and FTP, and a large group of popular P2P
protocols.

» P2P Protocol s—Peer-to-peer file-sharing application protocols classified according to a Layer 7
application signature.

» VOIP Protocols—Voice-over-1P application protocols classified according to a Layer 7 application
signature.

» SIP Protocols—Protocols classified according to a Layer 7 application signature that is SIP or has
SIP characteristics.

» Worm Protocols—Protocols classified according to a Layer 7 application signature that is based on
traffic patterns of Internet worms.

» Packet Stream Pattern Based Protocols—Protocols classified according to a Layer 7 application
signature that is based on the pattern of the packet stream (for example, the stream’s symmetry,
average packet size, and rate) rather than on the packet’s payload content.

« Unidirectionally Detected Protocols—Protocols having a unidirectional signature.
N

Note  Some protocols belong to more than one category. In particular, all predefined P2P, VOIP, SIP, Worm,
and Packet Stream Pattern-Based Protocols are also defined as Signature-Based Protocols.
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Step 2

Step 3

Note

Managing Protocols

From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

From the drop-down list in the Protocols tab, select the type of protocol to display.
The protocols of the selected type appear in the Protocols tab.

Click Close.

The Protocol Settings dialog box closes.

The setting in the drop-down list is not saved. The next time you open the Protocol Settings dialog box,
all protocols will be displayed.

How to Add Protocols

Step 1

Step 2

Step 3

You can add new protocol s to a service configuration, subject to the limit of 10,000 protocols per service
configuration.

From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

In the Protocols tab, click = (Add Protocal).

The Protocol Settings dialog box appears (Figure 7-21).

Figure 7-21 Protocol Settings
General

Mame:
| Protocal 1

Description:

Protocol ID: 5000 w

[ O ” Cancel ]
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In the Name field, enter a unique name for the new protocol.
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Step4  (Optional) From the Protocol ID drop-down list, select an ID for the protocol.

The protocol ID must be an integer in the range 5000 to 9998; lower values are reserved for protocols
provided by SCA BB.

Note  Thevalue of the protocol 1D is supplied automatically by the system. Do not modify this field.

Step5  Click OK.
The Protocol Settings dialog box closes.

The new protocol is displayed in the Protocols tab. You can now add protocol elementsto it. See How
to Add Protocol Elements, page 7-29.

How to Edit Protocols

You can modify the parameters of a protocol, even those included in the Console installation.

To add, modify, or delete protocol elements, see Managing Protocol Elements, page 7-28.

Stepl  From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

Step2  Inthe Protocols tab, double-click a protocol.
A second Protocol Settings dialog box appears (Figure 7-22).

Figure 7-22 Protocol Settings
General |

L=
| 3PC

Description:

Protocal ID: 738 v |

K ] [ Cancel

158924
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Step3  Modify fields in the Protocol Settings dialog box.
« Inthe Namefield, enter a new name for the protocol.
» From the Protocol 1D drop-down list, select an ID for the protocol.

The protocol 1D must be an integer inthe range 5000 to 9998; lower values are reserved for protocols
provided by SCA BB.

N

Note  Thevalue of the protocol 1D is supplied automatically by the system. Do not modify thisfield.

Step4  Click OK.

The Protocol Settings dialog box closes.

The new values of the protocol parameters are saved.
Step5  Click Close.

The Protocol Settings dialog box closes.

How to Delete Protocols

You can delete all protocols, even those included in the Console installation.

Stepl  From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

Step2  Inthe Protocols tab, select a Protocol.

Step3  Inthe Protocolstab, click ﬁ (Delete Protocol).
A Protocol Warning message appears (Figure 7-23).

Figure 7-23 Protocol Warning

3 Protocol Warning

€p | Are yousure you want to delete Protocol "3PC™7

158924
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Step4  Click Yes.

- If any service element maps the selected protocol to a service (see Managing Service Elements,
page 7-12), asecond Protocol Warning message appears as shownin Figure 7-24 (evenif the service
is not used by any package).

Figure 7-24 Protocol Warning

2 Protocol Warning

<P All references to the Protocol "3PC” will be deleted.
_:/ Are you sure you want to continue?

158928

» Click Yes.
The Protocol is deleted from the Protocols tab.
Step5  Click Close.
The Protocol Settings dialog box closes.

Managing Protocol Elements

A protocol is acollection of protocol elements.

To complete the definition of aprotocol, you must define its protocol elements. A protocol element maps
a specific signature, IP protocol, and port range to the selected protocol. Every protocol element in a
service configuration must be unique.

A traffic flow is mapped to a specific protocol if it meets all four of the following criteria:
- Theflow belongs to the specified signature of the protocol element.
« Theflow protocol is the specified IP protocol of the protocol element.

« (If theIP protocol is TCP or UDP) The destination port is within the specified port range of the
protocol element.

« The protocol element is the most specific protocol element satisfying the first three criteria.
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How to Add Protocol Elements

A

Note

Step 1

Step 2
Step 3

Step 4

Note

You can add any number of protocol elements to a protocol.

When you set the parameters of the protocol element, the values of the parameters are saved as you enter
them.

From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

In the Protocols tab, select a protocol.

In the Protocol Elements tab, click ':::' (Add Protocol Element).

A protocol element is added to the protocol.

A new row, representing the protocol element, is added to the protocol element list in the Protocol
Element tab.

Click in the Signature cell of the protocol element, and then click the Browse button that appearsin the
cell.

The default value (an asterisk, *) means that no signature checking is performed when testing if a flow
maps to this protocol element.

The Select a Signature dialog box appears (Figure 7-25), displaying alist of all signatures.

Figure 7-25 Select a Signature

3 Select a Signature

Select a signature for the service element

x ~
AntsP2P ]
AntsP 2P - Unidirectional Client Request
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BaiBao Download - Unidirectional Server Response

BaiBao Metwarking

BaiBao Metworking - Unidirectional Client Request

Behavioral Upload/Download

Behavioral Upload/Download - Unidirectional Client Request

Behavioral Upload,Download - Unidirectional Server Response
Behavioral Upload/Download Host Based TCP

Behavioral Upload/Download Host Based UDP

Bittorrent

Bittorrent Aged Flow Continuation

Bittorrent Aged Flow Centinuation - Unidirectional Client Request

! | Cancel
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Step 5

Note

Step 6

Step 7

Note

Step 8
Step 9

Select a signature from the list.

Select the Generic signature to allow a flow that has no matching signature in the protocol signature
database to be mapped to this protocol element (if the flow also matches the I P protocol and port range
of the protocol element).

Click OK.
The Select a Signature dialog box closes.
The selected signature is displayed in the Signature cell of the Protocol Settings dialog box.

Click in the IP Protocol cell of the protocol element, and then click the Browse button that appearsin
the cell.

The default value (an asterisk, *) means that no I P protocol checking is performed when testing if aflow
maps to this protocol element.

The Select an IP Protocol dialog box appears (Figure 7-26), displaying alist of all 1P protocols.

Figure 7-26 Select an IP Protocol
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Select an IP protocol from the list.

Click OK.

The Select an IP Protocol dialog box closes

The selected | P protocol is displayed in the IP Protocol cell of the Protocol Settings dialog box.

[l Cisco Service Control Application for Broadband User Guide
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Step 10  Inthe Port Range cell, enter aport or range of ports. (For arange of ports, use a hyphen between the first
and last ports in the range.)

Note  Specifying a port range is only possible when the specified I P protocol is either TCP or UDP (or
undefined, taking the wild-card value, *).

Only a flow whose port matches one of these ports will be mapped to this protocol element.
The protocol element is defined.

Step11 Click Close.
The Protocol Settings dialog box closes.

» Instead, if the protocol element that you have defined is not unique in this service configuration, a
Protocol Error message appears (Figure 7-27).

Figure 7-27 Protocol Error
# Protocol Error @

Errors must be rezolved:

Item unigueness violation error: duplicate Protocal Element <Generic, TCP,
529>

This Protocol Element is contained in protocol '3com-tsmu’ and in protocol

'3com-amp 3
a. Click OK.
b. Modify or delete the protocol element.
c. Click Close

The Protocol Settings dialog box closes.

How to Edit Protocol Elements

You can modify all protocol elements, even those included in the Console installation.

A

Note  All changes to the protocol element are saved as you make them.

Stepl1  From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

Step2  Inthe Protocolstab, select a protocol.

Step3  Inthe Protocol Elements tab, select a protocol element.

Step4  Click in the Signature cell of the protocol element, and then click the Browse button that appearsin the
cell.

The Select a Signature dialog box appears.

Cisco Service Control Application for Broadband User Guide
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Step5  Select asignature from the list.
Step6  Click OK.
The Select a Signature dialog box closes.

Step7  Click in the IP Protocol cell of the protocol element, and then click the Browse button that appearsin
the cell.

The Select an IP Protocol dialog box appears.
Step8  Select an IP protocol from the list.
Step9  Click OK.
The Select an IP Protocol dialog box closes.
Step 10  In the Port Range cell of the protocol element, enter a port or range of ports.
Changes to the protocol element are saved as you make them.
Step11 Click Close.
The Protocol Settings dialog box closes.

» Instead, if the protocol element that you have modified is not unique in this service configuration, a
Protocol Error message appears.

a. Click OK.
b. Modify or delete the protocol element.
c. Click Close.

The Protocol Settings dialog box closes.

How to Delete Protocol Elements

You can delete all protocol elements, even those included in the Console installation.

Stepl  From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

Step2  Select aprotocol in the Protocols tab.

Step3  Inthe Protocol Elements tab, select a protocol element.

Step4  Inthe Protocol Elements tab, click ﬁ (Delete Protocol Element).
A Protocol Warning message appears (Figure 7-28).

Figure 7-28 Protocol Warning

2 Protocol Warning

<P Are you sure you want to delete this Protocol Element?

158927
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Step5  Click Yes.

The protocol element is deleted from the Protocol Elements tab.
Step6  Click Close.

The Protocol Settings dialog box closes.

Managing Zones

A zoneis acollection of destination | P addresses; usually the addresses in one zone will be related in
some way.

Zones are used to classify network sessions; each network session is assigned to a service element based
on its destination | P address.

A service configuration can contain up to 10,000 zone items. Every zone item must be unique.
- How to View Zones, page 7-34
- How to Add Zones, page 7-35
« How to Edit Zones, page 7-36
- How to Delete Zones, page 7-37
- Managing Zone Items, page 7-37

Cisco Service Control Application for Broadband User Guide
[ oL-7205-19 .EI



Chapter 7 Using the Service Configuration Editor: Traffic Classification |

M Managing Protocols

How to View Zones

You can view alist of all zones and their associated zone items.

Stepl  From the Classification tab in the left pane, choose Configuration > Zones.
The Zone Settings dialog box appears (Figure 7-29).

The Zones tab displays alist of all zones. The first zone in the list is selected, and its zone items are
displayed in the Zone Items tab.

Figure 7-29 Zone Settings

Zone Settings

Zone [kems i

172.16.0.0
192.163.0.0

Close

210058

Step2  Click azoneinthe list to display its zone items.

The zone items of the selected zone are displayed in the Zone Items tab.
Step3  Click Close.

The Zone Settings dialog box closes.
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How to Add Zones

Step1  From the Classification tab in the |left pane, choose Configuration > Zones.
The Zone Settings dialog box appears.

Step2  Inthe Zonestab, click ' (Add Zone).
The Zone Settings dialog box appears (Figure 7-30).

Figure 7-30 Zone Settings
General L

hame:
| Zone 1

Description:

Zone ID: 4| |

[ oF H Cancel ]
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Step3  Inthe Name field, enter a unique name for the new zone.
Step4  (Optional) From the Zone ID drop-down list, select an ID for the zone.
The zone ID must be a positive integer in the range 1 to 32767.

Note  The value of the zone ID is supplied automatically by the system. Do not modify this field.

Step5  Click OK.
The Zone Settings dialog box closes.

The new zone is added to the Zones tab. You can now add zone items. (See How to Add Zone Items,
page 7-38.)

Cisco Service Control Application for Broadband User Guide
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How to Edit Zones

Step 1

Step 2
Step 3

Step 4

Note

Step 5

Step 6

You can modify zone parameters at any time.

To add, modify, or delete zone items, see Managing Zone Items, page 7-37.

From the Classification tab in the left pane, choose Configuration > Zones.
The Zone Settings dialog box appears.
In the Zones tab, select a zone.
Click _* (Edit Zone).
The Zone Settings dialog box appears.
Modify fields in the dialog box.

« Inthe Namefield, enter a new name for the zone.

e From the Zone ID drop-down list, select an ID for the zone.

The zone ID must be a positive integer in the range 1 to 32767.

The value of the zone ID is supplied automatically by the system. Do not modify this field.

Click OK.

The Zone Settings dialog box closes.

The new values of the zone parameters are saved.
Click Close.

The Zone Settings dialog box closes.

[l Cisco Service Control Application for Broadband User Guide
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How to Delete Zones

You can delete any or all zones.

Stepl  From the Classification tab in the left pane, choose Configuration > Zones.
The Zone Settings dialog box appears.

Step2  Inthe Zones tab, select a zone.

Step3  Inthe Zonestab, click i (Delete Zone).
A Zone Warning message appears (Figure 7-31).

Figure 7-31 Zone Warning

3 Zone Warning

N7

Are you sure you want to delete Zone "Europe™?

I
210060

Step4  Click OK.

- If any service element references the selected zone, a second Zone Warning message appears
(Figure 7-32).

Figure 7-32 Zone Warning

3 Zone Warning

<P All references to the Zone "Europe” will be deleted.
- Are you sure you want to continue?

I
210061

« Click Yes.
Every service element that references the selected zone is deleted.
The zone is deleted and is no longer displayed in the Zones tab.
Step5  Click Close.
The Zone Settings dialog box closes.

Managing Zone Items

A zoneisacollection of related zone items.
A zoneitem is an IP address or arange of |P addresses.

A service configuration can contain up to 10,000 zone items. Every zone item must be unique.

Cisco Service Control Application for Broadband User Guide
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How to Add Zone Items

You can add any number of zone items to a zone (subject to the limitation of 10,000 zone items per
service configuration).

Stepl  From the Classification tab in the left pane, choose Configuration > Zones.
The Zone Settings dialog box appears.

Step2  Inthe Zones tab, select a zone.

Step3  Inthe Zone Items tab, click ':::' (Add Zone Item).
A new lineis added to the Zone Items table.

Step4  Double-click the new list item and enter avalid value.

A valid value s either asingle |P address (for example, 63.111.106.7) or a range of IP addresses (for
example, 194.90.12.0/24).

Step5  Repeat Steps 3 and 4 for other |P addresses that will be part of this zone.
Step6  Click Close.
The Zone Settings dialog box closes.

« Instead, if the zone item that you have defined is not unique in this service configuration, a Zone
Error message appears (Figure 7-33).

Figure 7-33 Zone Error

3 Zone Error

Errors must be resolved:
Item unigueness violation error: duplicate Zone Item 172,16.0.0
This Zone Item is contained in zone ‘Local’ and in zone ‘Private Address Space’

210057

a. Click OK.
b. Modify or delete the zone item.
c. Click Close.

The Zone Settings dialog box closes.
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How to Edit Zone Items

Step 1

Step 2

Step 3
Step 4

Step 5

From the Classification tab in the left pane, choose Configuration > Zones.
The Zone Settings dialog box appears.

In the Zones tab, select a zone.

In the Zone Items tab, double-click a zone item.

Enter a new value for the zone item.

A valid value is either asingle |P address (for example, 63.111.106.7) or arange of |P addresses (for
example, 194.90.12.0/24).

Click Close.
The Zone Settings dialog box closes.

« Instead, if the zone item that you have modified is not unique in this service configuration, a Zone
Error message appears.

a. Click OK.
b. Modify or delete the zone item.
c. Click Close.

The Zone Settings dialog box closes.

How to Delete Zone Items

Step 1
Step 2
Step 3

Step 4

Step 5

From the Classification tab in the left pane, choose Configuration > Zones.
The Zone Settings dialog box appears.

In the Zones tab, select a zone.

In the Zone Items tab, select a zone item.

In the Zone Items tab, click ﬁ (Delete Zone Item).

The zone item is deleted.

Click Close.

The Zone Settings dialog box closes.

Managing Protocol Signatures

A protocol signature is a set of parameters that uniquely identify a protocol.
- Viewing Signatures, page 7-40
» Dynamic Signatures, page 7-41

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter 7 Using the Service Configuration Editor: Traffic Classification |

M Managing Protocol Signatures

Viewing Signatures

- How to View Signatures, page 7-40
- How to Filter the Signatures List, page 7-41

How to View Signatures

You can view alist of all signatures and the protocol to which each is assigned.

Stepl  From the Classification tab in the left pane, choose Configuration > Signatures Settings.

The Signatures Settings dialog box appears (Figure 7-34).

Figure 7-34 Signatures Settings

¥ Signatures Settings @

Signatures Settings Dialog
This page lists the signatures supported by the Service Configuration
General ] Signatures Script 1
l =
Name I D Assigned to Protocols ] A
& Hotline aver HTTP 117765216 Hotiine
'EQ Hotline aver HTTP - Unidirectional Client Request 117770496 Hotiine
EQ Hotline over HTTP - Unidirectional Server Response 117770240 Hotline
(EQ Hotline Tracker 117763960 Hotine
'EQ Hotline Tracker - Unidirectional Client Request 117769984 Hotine
HTTR 50397184 HTTP Browsing
E@H’I‘I’P—GEI’ 201392128 HTTP-GET
HTTP-Tunnel 234946560 HTTP Tunnel
'*EQHI'I'P—TunneI - Unidirectional Client Request 234947072 HTTP Tunnel
'EQI—FI‘I‘P—TunneI - Unidirectional Server Response 2349496816 HTTP Tunnel
'EQH‘I‘I‘P - Unidirectional Client Request 50357696 HTTP Browsing =
Enm'nv - Unidirectional Server Response 50357440 HTTP Browsing
'EQ 1CO File Transfer 184877568 1cQ
EQICQ File Transfer - Unidirectional Client Request 184873848 cQ
EQICQ File Transfer - Unidirectional Server Response 184879360 1cQ
"1CQ Networking 184877312 jlole]
EQICQ Metworking - Unidirectional Client Request 184875552 ICQ
'EQ 1CQ Metworking - Unidirectional Server Response 184873104 jilele]
Hicq P 184877324 10
?QICQ VoIP 54733048 ICQ VoIP
[ P . ~
2
L]

Step2  Click Close.
The Signatures Settings dialog box closes.
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How to Filter the Signatures List
You can filter the signature by type, so that the Signatures Settings dialog box lists only the selected type
of signature.
There are eight categories of signatures:
» DSS Contributed Signatures
« Not Assigned to any Protocol
« P2P Signatures
« VOIP Signatures
» SIP Signatures
- Worm Signatures
» Packet Stream Pattern Based Protocols Signatures
« Unidirectionally Detected Signatures

Note  Some signatures belong to more than one category.

Stepl  From the Console main menu, choose Configuration > Signatures Settings.
The Signatures Settings dialog box appears.

Step2  From the drop-down list, select the type of signature to display.
The signatures of the selected type appear in the dialog box.

Step3  Click Close.
The Signatures Settings dialog box closes.

Dynamic Signatures

New protocols are being introduced all the time. Dynamic signatures is a mechanism that allows new
protocols to be added to the protocol list and, from there, to service configurations. Thisis especially
useful for classifying the traffic of a new protocol (for example, a new P2P protocol in a P2P-Control
solution).

- Installing new signatures to an active service configuration is described in Working with Protocol
Packs, page 4-19.

» Creating and modifying signatures is described in Using the Signature Editor, page 12-1.

» Using servconf, the SCA BB Server Configuration Utility, to apply signatures is described in The
SCA BB Service Configuration Utility, page 13-1.

The following sections describe working with dynamic signatures in the Service Configuration Editor.
- Dynamic Signature Script Files, page 7-42
» The Default DSS File, page 7-46

Cisco Service Control Application for Broadband User Guide
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Dynamic Signature Script Files

Note

Note

Dynamic signatures are provided in special Dynamic Signatures Script (DSS) files that you can add to
a service configuration using either the Console or the Service Configuration API. After aDSSfileis
imported into a service configuration, the new protocols it describes:

- Appear in the protocol list
» May be added to services
« Are used when viewing reports

To simplify the configuration of new protocols added by a DSS, the DSS may specify a Buddy Protocol
for anew protocol. If, when loading a DSS, the application encounters the Buddy Protocal, it
automatically duplicates the set of service elements that use the Buddy Protocol, and replaces all
references to the Buddy Protocol with references to the new protocol. The association of the new
protocol to services will match that of the Buddy Protocol.

The following configuration actions are performed automatically when you import aDSS into a service
configuration:

- Signatures are updated and new signatures are loaded

» Protocol elements are created for new signatures of existing protocols

» New protocols are added to the protocol list, and protocol elements are created for them

« Service elements are created for new protocols according to the configuration of Buddy Protocols
The import procedure preserves all service and protocol settings.

After importing a DSS, associate the newly added protocols with services.

DSS files are periodically released by Cisco or its partners in accordance with customer requirements
and market needs. DSS files contain new protocols and signatures, and update previously defined
signatures. Updating a service configuration with the new DSSis explained in How to Import a Dynamic
Signature Script into a Service Configuration, page 7-44.

You can create your own DSS files or modify the Cisco release DSS file using the Signature Editor tool
(see Managing DSS Files, page 12-1).

- How to View Information About the Current Dynamic Signatures, page 7-43
» How to Import a Dynamic Signature Script into a Service Configuration, page 7-44
» How to Remove Dynamic Signatures, page 7-45
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How to View Information About the Current Dynamic Signatures

Stepl  From the Classification tab in the left pane, choose Configuration > Signatures Settings.
The Signatures Settings dialog box appears.

Step2  Click the Signatures Script tab.
The Signatures Script tab opens (Figure 7-35).

« If no DSSfile was imported into the current service configuration, the Signatures Settings dialog
box displays a message informing you of this.

Figure 7-35 Signature Settings

3£ Signatures Settings @

Signatures Settings Dialog

Use this page to import a DSS to the Service Configuration
or to remave the attached 0SS

General [ Signatures Script

D55 File Information:

[ No Dynamic signatures Script has been imported.

[ Import from Fike... |

Close

158997

- If aDSSfilewasimported into the current service configuration, the Signatures Settings dial og box
displays information about the current dynamic signatures and the DSS file from which they were
imported (Figure 7-36).
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Figure 7-36 Signature Settings

3£ Signatures Settings

Signatures Settings Dialog
Use this page to import a DSS to the Service Configuration
or to remave the attached DSS

General Signatures Script l

D55 File Information:

Secript Mame: MewPocoScript

Version: 1.0 buid 1

Created for 5CA BB version: 3.1.0

Source File: Loco.dss

Imported On: Thu Apr 19 20:24:06 GMT+02:00 2007

Description:
Secript.description

MNew Protocols: O (1) LOCOO
Enhanced Protocols: none.|

Import from File. .. port De | Remove |

Close

211034

Step3  Click Close.
The Signatures Settings dialog box closes.

How to Import a Dynamic Signature Script into a Service Configuration

You can import signatures into a service configuration from a DSS file provided by Cisco or one of its
partners (described in this section), or from a DSS file that you have created or modified using the
Signature Editor tool (see Managing DSS Files, page 12-1).

Note  Itisrecommended that you import the latest default DSS file (see How to Import the Default DSS File
Automatically, page 7-49) when creating a service configuration, and that you use this option only to
apply a new DSS to existing service configuration.

Stepl  From the Classification tab in the left pane, choose Configuration > Signatures Settings.
The Signatures Settings dialog box appears.

Step2  Click the Signatures Script tab.
The Signatures Script tab opens.

Step3  Click Import from File.
An Import Warning message appears (Figure 7-37).
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Step 5

Step 6

Note
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Step 2

Step 3

Step 4
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Figure 7-37 Import Warning

3 Import Warning

158863

Click Yes.

The Import from file dialog box appears.

Browse to the DSS file and click Open.

The Import from file dialog box closes.

The signatures in the DSS file are imported into the service configuration.

Information about the imported signatures and their DSS file is displayed in the Signatures Settings
dialog box.

Click Close.
The Signatures Settings dialog box closes.

How to Remove Dynamic Signatures
You can remove the installed dynamic signatures from a service configuration.

The DSSfile is not deleted.

From the Classification tab in the left pane, choose Configuration > Signatures Settings.
The Signatures Settings dialog box appears.

Click the Signatures Script tab.

The Signatures Script tab opens.

Click Remove.

A Dynamic Signature Script Confirmation message appears (Figure 7-38).

Figure 7-38 Dynamic Signature Script Confirmation

3 Dynamic Signature Script Confirmation

Remaving the script NewPocoScript” may affect traffic dassification.
! Press OK to continue.,

Cancel

158802

Click OK.

« If any service element references a protocol whose signature isincluded in the imported DSSfile, a
Dynamic Signature Script Removal Error message appears (Figure 7-39).

| oL-7205-19
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Figure 7-39 Dynamic Signature Script Removal Error

2 Dynamic Signature Script Removal Error

<P The script NewPocoSoript”™ which you are trying to replace or remove
‘-'f’ contributes a protocol assigned to a service.
! Press OK to remove the protocol from services and proceed with script
remaval,

Cancel

158803

« Click Yes.

Every service element that references a protocol whose signature is included in the imported DSS
fileis deleted.

The dynamic signatures are removed from the service configuration.
The Remove button is dimmed.

If the dynamic signatures were imported from the default DSS file, the Import Default DSS button is
enabled.

Step5  Click Close.
The Signatures Settings dialog box closes.

The Default DSS File

Whenever a protocol pack becomes available from Cisco (or one of its partners), you should update
offline service configurations (stored as PQB files on the workstation). The protocol pack (see Protocol
Packs, page 4-19) is provided as either an SPQI file or aDSS file.

You can either offer updates automatically to every service configuration created or edited at the
workstation, or apply them from the workstation to the SCE platform. You make the latest update
available by installing the most recent DSS or SPQI file as the default DSS file. You can install the file
on the workstation either from the Console or by using The SCA BB Signature Configuration Utility,
page 13-7.

- Thedefault DSSfileisautomatically offered for import when you perform any service configuration
operation (such as creating a new service configuration or editing an existing one) from the Console
on a service configuration that was not yet updated.

« The default DSSfile is imported by default when any service configuration operation (such as
applying an existing service configuration) is performed using servconf, The SCA BB Signature
Configuration Utility, page 13-7. You can disable this option.

N
Note  Users are expected to update the default DSS on their management workstation whenever they obtain a
new protocol pack, as explained in the following section.

» Setting and Clearing the Default DSS File, page 7-47
- Importing Dynamic Signatures from the Default DSS File, page 7-49

Cisco Service Control Application for Broadband User Guide



| Chapter7 Using the Service Configuration Editor: Traffic Classification
Managing Protocol Signatures Il
Setting and Clearing the Default DSS File
The default DSS file should normally be the latest protocol pack provided by Cisco (or one of its
partners). If necessary, modify the protocol pack using the Signature Editor tool (see How to Edit DSS
Files, page 12-14) to add signatures of new protocols until they become available from Cisco.
Whenever anew protocol pack becomes available, set it asthe default DSSfile. Thereisno need to clear
the current default DSSfile; it will be overwritten by the new protocol pack.
» How to Set a Protocol Pack as the Default DSS File, page 7-47
» How to Clear the Default DSS File, page 7-48
How to Set a Protocol Pack as the Default DSS File
Stepl  From the Console main menu, choose Window > Preferences.
The Preferences dialog box appears (Figure 7-40).
Step2  From the menu tree in the left pane of the dialog box, choose Service Configuration > Default DSS.
The Default DSS area opens in the right pane of the dialog box.
Figure 7-40 Preferences
H Preferences |:|@@
Default DSS (Sl
Help
InstalfUpdate Always add the Default DSS to service configurations without asking
Metwork Connections
Reparter D35 File Information:
=) Service Configuration Mo Default 0SS has been set,
SCA BB
Web Browser
[Clear Default DSS] [ Apply ]
3
[ (o4 l [ Cancel ] g
Step3  Click Choose File.
An Open dialog box appears.
Step4  From the Files of type drop-down list, select the file type of the protocol pack.
Step5  Browse to the protocol pack.
Cisco Service Control Application for Broadband User Guide
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Step6  Click Open.
The Open dialog box closes.

Information about the default DSSfile is displayed in the Default DSS area of the Preferences dialog
box (Figure 7-41).

Figure 7-41 Preferences - Default DSS

3 Preferences I: |@

type filter text - Default DSS

[#-Help
Install fUpdate
[+ Reporter D55 File Information:

=1 Service Configuration Seript Name: NewPocoSaript
Default D55 Version: 1.0 build 1
Created for SCA BB version: 3.1.0
Source File: Loco.dss
Imported On: Thu Apr 19 20:26: 18 GMT+02:00 2007

Description:
Sscript. description

Mew Protocols; O (1) LOCOO
Enhanced Protocals: none.

Clear Default DSS I Apply ‘

oK ‘ cancel |

211033

Step7  Click OK.

The DSSfileis copied to C:\Documents and Settings\<user name>\.p-cube\default3.1.7.dss as the
default DSS file.

The Preferences dialog box closes.

How to Clear the Default DSS File

Stepl  From the Console main menu, choose Window > Preferences.
The Preferences dialog box appears.

Step2  From the menu tree in the left pane of the dialog box, choose Service Configuration > Default DSS.
The Default DSS area opens in the right pane of the dialog box.
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Step 2

Step 1

Step 2
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Click Clear Default DSS.
The default DSS file, C:\Documents and Settings\<user name>\.p-cube\default3.5.5.dss is del eted.
All information is deleted from the Default DSS area.

Deleting the default DSS file does not remove the imported dynamic signatures from the current service
configuration.

Click OK.
The Preferences dialog box closes.

Importing Dynamic Signatures from the Default DSS File

If adefault DSS file isinstalled, the application offers to import the dynamic signatures from the file
when you create a new service configuration or when you open an existing service configuration that has
not imported the signatures. Alternatively, you can manually import the dynamic signatures.

» How to Import the Default DSS File Automatically, page 7-49
» How to Import the Default DSS File Manually, page 7-49

How to Import the Default DSS File Automatically

Open an existing service configuration or create a new one.

A Default Signature message appears (Figure 7-42).

Figure 7-42 Default Signature

3 Default Signature

<P Would you ke to set the default signature script?

158793

Click Yesto import the default DSSfile; click No to continue without importing the default DSSfile.

How to Import the Default DSS File Manually

From the Classification tab in the left pane, choose Configuration > Signatures Settings.
The Signatures Settings dialog box appears (Figure 7-43).

Click the Signatures Script tab.

The Signatures Script tab opens, with the Import Default DSS button enabled.

| oL-7205-19
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Figure 7-43 Signatures Settings

3£ Signatures Settings

Signatures Settings Dialog

Use this page to import a DSS to the Service Configuration
or to remave the attached 0SS

D55 File Information:

Mo Dynamic Signatures Script has been imported.

[Import from File... ] [Import Default 0SS

Close

210002

Step3  Click Import Default DSS.
An Import Warning message appears (Figure 7-44).

Figure 7-44 Import Warning
F Import Warning &l

2

Importing will override existing data. Are you sure you want to continue?

158863

Step4  Click Yes.
The signatures in the default DSS file are imported into the service configuration.
The Import Default DSS button is dimmed.

Information about the imported signatures and the default DSS file is displayed in the Signatures
Settings dialog box.

Step5  Click Close.
The Signatures Settings dialog box closes.
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Managing Flavors

Note

Flavors are advanced classification elements that are used to classify network sessions.

Flavors are based on specific Layer 7 properties. For example, users can associate an HTTP flow with a
service based on different parts of the destination URL of the flow.

Flavors are supported only for small nhumber of protocols, and for each such protocol there are different
applicable flavor types. Flavor types are listed in the table in the following section.

Thereis amaximum number of flavor itemsfor each flavor type (see Maximum Number of Flavor Items
per Flavor Type, page 7-59). For each flavor type, every flavor item must be unique.

If unidirectional classification is enabled in the active service configuration, flavors are not used for
traffic classification.

» Flavor Types and Parameters, page 7-51
« How to View Flavors, page 7-54

- How to Add Flavors, page 7-55

- How to Edit Flavors, page 7-57

- How to Delete Flavors, page 7-57

« Managing Flavor Items, page 7-58

Flavor Types and Parameters

Flavors are advanced classification elements that classify network sessions according to
signature-specific Layer 7 properties.

When Layer 7 application properties are used as session parameters, such aswith an HTTP User Agent,
They are treated as character strings.

Layer 7 parameter-based flavor items may apply to the Layer 7 prefix (parameter beginning), Layer 7
suffix (parameter end), or a combination of Layer 7 prefixes and suffixes. A partial string must be
followed by “*” in case of a prefix and preceded by “*” in case of a suffix.

Table 7-1 lists available flavor types.

| oL-7205-19
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Table 7-1 SCA BB Flavors
Flavor Type Matched Session Parameters Valid Values
HTTP Composite HTTP User Agent, H-TTP URL, HTTP Cookie  |<HTTP User Agent flavor, HTTP URL flavor,
and HTTP Referer flavors serve as session HTTP Cookie flavor, HTTP Referer flavor>
parameters. « Theflavors can be chosen using flavor
browsing.
HTTP User Agent HTTP User-Agent retrieved from the HTTP <User-Agent prefix>
<User-Agent prefix> Request header field, from Examples:
the beginning of the Request header until the first '
“pr - <Moz*> matches all HTTP sessions with
. A User-Agent field starting with “Moz”.
For example, if the HTTP Request header field is _ g g _ _
Mozilla/4.0, the HTTP User Agent retrievedis | * <Mozilla> matches all HTTP sessions with
Mozilla. User-Agent field equal to “Mozilla’.
» The maximum key length is 32 characters.
HTTP URL » Host—Retrieved either from the HTTP Host | <host suffix, path prefix, path suffix, URL parame-
header field or from the Request URL. Inthe |ters prefix>
latter case, the section from the beginning of | » At least one parameter must be specified.
the URL until the first “/” is considered the Unspecified parameters should be left as“*”.
Host. » For example:
) Pat?—l?\;etrle\t/ﬁd ]frostmt/het Htt:]p ‘L‘J,SL’ the <*cisco.com,*,* ,*> matches all HTTP
section from the fir othe . sessions with the Host ending with
« URL parameters—Any string following the “cisco.com”, regardless of the values of Path
“?" (You do not need to start the parameters and Parameters.
prefix with “ 7). « The maximum key length for all keysis 512
characters.
HTTP Cookie Cookie “Key-Value’ pairsthat areretrieved from |<key prefix, value prefix>

the HTTP Request header Cookie field.

A Cookie may consist of many “Key-Value”
pairs; however, only the first three pairs are
calculated. The Cookie flavor calculation stops
when one of the “Key-Value” pairs matches the
specification, or when it has exceeded the three
pair limit.

» For example: <act* ,*> matches any Cookie
pair where the Key begins with “act”,
regardless of the Value.

» A flavor can be configured so that the Value
field isrequired to be empty. Inthis case, this
field should be left empty in the flavor item.

» White spaces are not allowed, “=" is not
allowed, and “*” isonly allowed at the end of
the Key or Value.

« The maximum key length is 100 characters
for both the Key and Value fields

[l Cisco Service Control Application for Broadband User Guide
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Table 7-1 SCA BB Flavors (continued)
Flavor Type Matched Session Parameters Valid Values
HTTP Referer Similar to HTTP URL, but the parameters are <host suffix, path prefix, path suffix, URL parame-
retrieved from the Referer HTTP header field. ters prefix>
- At least one parameter must be specified.
Unspecified parameters should be left as“*”.
» For example: <*cisco.com,* ,* * > matchesall
HTTP sessions with the Host ending with
“cisco.com”, regardless of the values of Path
and Parameters.
» The maximum key length for all keysis 512
characters
HTTP Content Content Categories can be imported using the Value selected from Select a Content Category
Category Import dialog box or the HTTP Content Filtering |dialog box.
Settings dialog box.
RTSP User Agent RTSP User-Agent field that is retrieved from the |<RTSP User Agent prefix>

RT SP message header.

» For example: <abc*> matches all RTSP
sessions where the User-Agent starts with
“ abcl! .

- The maximum key length is 128 characters

RTSP Host Name

RTSP Host field that is retrieved from the RTSP
message header.

<RTSP Host suffix>

» For example: <*abc> matches all RTSP
sessions where the Host ends with “abc”.

« The maximum key length is 128 characters

RTSP Composite

RTSP User Agent and RTSP Host Name flavors
Sserve as session parameters.

<RTSP User Agent flavor, RTSP Host Name
flavor>

SIP Source Domain

SIP Source Host field that is retrieved from the
SIP message header.

<SIP Host suffix>
» For example: <*abc>

« The maximum key length is 128 characters

SIP Composite

SIP Source Host and SIP Destination Host serve
as session parameters.

<SIP source domain, SIP destination domain>

SIP Destination
Domain

SIP Destination Host field that is retrieved from
the SIP message header.

<SIP Host suffix>
» For example: <*abc>

» The maximum key length is 128 characters

SMTP Host Name

SMTP Host field that isretrieved from the SMTP
message header

e <SMTP Host suffix>
» For example: <*abc>
« The maximum key length is 128 characters

ToS DSCP value extracted from the | P header DSCP ToS (integer between 0 and 63)
A
Note  Composite Flavors are pairs of two defined flavors.
Cisco Service Control Application for Broadband User Guide
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How to View Flavors

You can view alist of all flavors and their associated flavor items.

Stepl  From the Classification tab in the left pane, choose Configuration > Flavors.

The Flavor Settings dialog box appears (Figure 7-45).

Figure 7-45 Flavor Settings

3£ Flavor Settings
Flavors Editing Dialog

e
HTTP Camposite;

= HTTP User Agent
&/ HTTP Streaming Agents
HTTP URL

HTTP Content Category
RTSP Composite

RTSP User Agent

RTSP Host Name

SIP Composite

SIP Source Domain

% ‘Vonage as Source
SIP Destination Domain
iga Yonage as Destination
SMTF Host Mame

Tos

Wpdd e s dsdededene ey

Revert I Accept ‘

OK | Cancel |

211747

The left area displays a tree showing all flavors of each flavor type.

Step2  Click aflavor in the tree to display its flavor items (Figure 7-46).

[l Cisco Service Control Application for Broadband User Guide
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Figure 7-46 Flavor Settings

3£ Flavor Settings @

Flavors Editing Dialog

4 B
L r— Compaste MName: ] HTTP Streaming Agents
= @ HTTP User Agent Index: | 100
& HTTP Streaming Agents
& HTTP URL
& HTTP Content Category g 3
& RTSP Composite i At [
& RTSP User Agent R o]
% RTSP Host Name NSPlayer
2 s5IP Composite Nullsoft
= ;' SIP Sgurce Domain qis
% Vonage as Source QuickTime
= ;‘ SIP Destination Domain RealPlayer
& Vonage as Destination RMA
¥ SI;U'ITP Host Mame Sc!nlque
Winamp
@ Tos WinampMPEG
Windows-Media-Player
Revert I Accept ‘

OK | Cancel |

211744

The flavor items are displayed in the right area.
Step3  Click OK.
The Flavor Settings dialog box closes.

How to Add Flavors

You can import flavors from a CSV file. CSV files can be created by exporting flavors or created
manually as described in the “CSV File Formats” chapter of the Cisco Service Control Application Suite
for Broadband Reference Guide.

You can add any number of flavors to a service configuration.

Stepl  From the Classification tab in the left pane, choose Configuration > Flavors.
The Flavor Settings dialog box appears (Figure 7-47).

Step2  Intheflavor tree, select aflavor type.

Step3  Click .
A new flavor of the selected type is added to the flavor tree.

Cisco Service Control Application for Broadband User Guide
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Figure 7-47 Flavor Settings
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Step4  Inthe Namefield, enter a name for the new flavor.

Note  You can use the default name for the flavor. It is recommended that you enter a meaningful name.

Step5  (Optional) In the Index field, enter a unique integer value.

Note SCA BB provides a value for the Index. There is no need to change it.

The flavor index must be a positive integer in the range 1 to 32767.
You have defined the flavor. You can now add flavor items. (See How to Add Flavor Items, page 7-59.)
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How to Edit Flavors

Step 1

Step 2

Step 3

Step 4

You can modify flavor parameters at any time.

To add, modify, or delete flavor items, see Managing Flavor Items, page 7-58.

From the Classification tab in the left pane, choose Configuration > Flavors.
The Flavor Settings dialog box appears.
In the flavor tree, select a flavor.
The name and index of the flavor (and its flavor items) are displayed in the right area.
Modify fields in the dialog box:

« Inthe Namefield, enter a new name for the flavor.

« Inthelndex field, enter a new, unique index for the flavor.

The flavor index must be a positive integer in the range 1 to 32767.

Click OK.
The Flavor Settings dialog box closes.

How to Delete Flavors

Step 1

Step 2

Step 3

Step 4

You can delete any or al flavors.

From the Classification tab in the left pane, choose Configuration > Flavors.
The Flavor Settings dialog box appears.

In the flavor tree, right-click aflavor.

A popup menu appears.

Click #% (Delete).

A Confirm Delete message appears (Figure 7-48).

Figure 7-48 Confirm Delete

3 Confirm Delete

€p | Are you sure you want to delete Flavor "Vonage as Source™

Ok i | Cancel

158789

Click OK.

- If any service element references the selected flavor, a Confirm References Delete message appears
(Figure 7-49).
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Figure 7-49 Confirm References Deletion

3 Confirm References Deletion

<P All references to the Flavor "Vonage as Source” will be deleted.
._f_/ Are you sure you want to continue?

OK. J [ Cancel

158790

« Click Yes.
Every service element that references the selected flavor is deleted.
The flavor is deleted and is no longer displayed in the flavor tree.
Step5  Click Close.
The Flavor Settings dialog box closes.

Managing Flavor Items

A flavor is acollection of related flavor items.

A flavor item is avalue of a property or properties of aflow. These properties depend on the flavor type
(see Flavor Types and Parameters, page 7-51).

There is a maximum number of flavor items for each flavor type (see the following section). For each
flavor type, every flavor item must be unique.

» Maximum Number of Flavor Items per Flavor Type, page 7-59
- How to Add Flavor Items, page 7-59

- How to Edit Flavor Items, page 7-61

« How to Delete Flavor Items, page 7-62
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Table 7-2 lists the maximum number of flavor items for each flavor type.

Table 7-2 Maximum Number of Flavor Items per Flavor Type
Flavor Type Maximum No. of Flavor Items
HTTP Composite 10,000

HTTP User Agent 128

HTTP URL 100,000

HTTP Cookie 100

HTTP Referer 100

HTTP Content Category —

RTSP Composite 10,000

RTSP User Agent 128

RTSP Host Name 10,000

SIP Composite 10,000

SIP Source Domain 128

SIP Destination Domain 128

SMTP Host Name 10,000

ToS 64

How to Add Flavor Items

Step 1

Step 2
Step 3

You can add any number of flavor itemsto aflavor (subject to the limitation of the total number of each
type of flavor item per service configuration, as listed in the previous section).

From the Classification tab in the left pane, choose Configuration > Flavors.

The Flavor Settings dialog box appears (Figure 7-50).

In the flavor tree, click aflavor.

Above the flavor item list, click 5 (Create New Flavor Item).

| oL-7205-19
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Figure 7-50 Flavor Settings
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A new flavor item is added to the flavor item list. The number and type of parametersin the flavor item
depend on the flavor type (see Flavor Types and Parameters, page 7-51).

The new flavor item has a default value of all wild cards (*, asterisks).
Step4  For each cell of the new flavor item, click the asterisk and then enter an appropriate value.
For composite flavors and for the HTTP Content Category flavor:
a. Click the asterisk.
A Browse button is displayed in the cell.
b. Click the Browse button.
A Select dialog box appears (Figure 7-51), displaying all valid values for the parameter.
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Figure 7-51 Select a HTTP User Agent

3£ Select a Hitp User Agent

Select

& HTTP Streaming Agents

[ OK H Cancel ]

158959

c. Select an appropriate value from the list.
d. Click OK.
The Select dialog box closes.
The selected value is displayed in the cell.
Step5  Repeat Steps 3 and 4 for other flavor items.
Step6  Click OK.
The Flavor Settings dialog box closes.

How to Edit Flavor Items

Stepl  From the Classification tab in the left pane, choose Configuration > Flavors.
The Flavor Settings dialog box appears.

Step2  Inthe flavor tree, select aflavor.

Step3  Intheflavor item list, select aflavor item.

Cisco Service Control Application for Broadband User Guide
[ oL-7205-19 .m



Chapter 7 Using the Service Configuration Editor: Traffic Classification |

M Managing Flavors

Step4  For each cell of the selected flavor item, click the asterisk and then enter an appropriate value.
For composite flavors and for the HTTP Content Category flavor:
a. Click the asterisk.
A Browse button is displayed in the cell.
b. Click the Browse button.
A Select dialog box appears, displaying all valid values for the parameter.
c. Select an appropriate value from the list.
d. Click OK.
The Select dialog box closes.
The selected value is displayed in the cell.
Step5  Click OK.
The Flavor Settings dialog box closes.

How to Delete Flavor Items

Stepl  From the Classification tab in the left pane, choose Configuration > Flavors.
The Flavor Settings dialog box appears.
Step2  Intheflavor tree, select aflavor.
Step3  Intheflavor item list, right-click anywhere in a flavor item.
A popup menu appears.
Step4  Click ¥ (Delete).
The flavor item is deleted and is no longer displayed in the flavor item list.
Step5  Click Close.
The Flavor Settings dialog box closes.

Example: How to Import a List of URLs and Block Them

The following example shows how to import a URL file and configure the SCE to block these URLs

Stepl  Create anew flavor under the HTTP URL flavor type, as described in How to Add Flavors, page 7-55.
Step2  Import aCSV file containing the URLS you wish to block.

For further information, see How to Import Service Configuration Data, page 6-12.

Y

Note  The CSV file formats are described in the “CSV File Formats” chapter of the Cisco Service
Control Application Suit for Broadband Reference Guide.
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Step 6

Managing Content Filtering 1l

Define a Service.

For further information, see How to Add a Service to a Service Configuration, page 7-5.

Within the defined Service, add a service element that uses the new Flavor.

For further information, see How to Add Service Elements, page 7-12.

Add arule to the package in which you want to block the URLSs, and associate it with the new Service.
For further information, see How to Add Rules to a Package, page 9-57.

Configure the rule to block the flow.

For further information, see How to Define Per-Flow Actions for a Rule, page 9-59.

Managing Content Filtering

Note

Content filtering involves classification and control of HTTP flows according to the requested URL. The
classification of the URL is performed by accessing an external database.

SCA BB provides content filtering by integrating with a SurfControl Content Portal Authority (CPA)
server.

Content filtering is not supported when unidirectional classification is enabled.

« Information About Content Filtering, page 7-63

« The Content Filtering CLI, page 7-64

« How to Configure the RDR Formatter, page 7-66

« How to Enter Line Interface Configuration Mode, page 7-66
» Managing Content Filtering Settings, page 7-67

Information About Content Filtering

The Cisco HTTP Content Filtering solution consists of:
» The SCE application
« The Cisco CPA client
» The SurfControl CPA server

The SCE application classifies each HTTP flow according to the category returned by the CPA server.
This classification is then used for SCA BB traffic control and reporting. For example, users can define
aruleto block browsing of the “Adult/Sexually Explicit” category or to generate reports on the volume
consumed by browsing the “Kids” or “ Shopping” categories.

- The SCE Application, page 7-64
« The Cisco CPA Client, page 7-64
« The SurfControl CPA Server, page 7-64
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The SCE Application

The Cisco service control application runs on the SCE platform. It forwards HTTP URL s that it extracts
from traffic to the CPA client and uses the categorization results to classify the original HTTP flow to a
service. This classification is then used for normal SCA BB traffic control and reporting.

The SCE application communicates with the CPA client using Raw Data Records (RDRs). See How to
Configure the RDR Formatter, page 7-66.

The Cisco CPA Client

The Cisco CPA client runs on the SCE platform. It sends URL queries to the CPA server for
categorization, and updates SCA BB with the categorization results.

The CPA client isinstalled as part of the SCA BB application (PQI) installation. Use the SCE platform
Command-Line Interface (CL1) (see The Content Filtering CLI, page 7-64) to configure and monitor the
client.

The SurfControl CPA Server

The CPA server runs on a dedicated machine. It receives categorization requests from the CPA client,
connects to the SurfControl Content Database, and responds with the category ID of the queried URL.

The SurfControl CPA Server isinstalled on a separate server that must be accessible from the SCE
platform. Details of the installation are not within the scope of this document.

The Content Filtering CLI

Use the SCE platform Command-Line Interface (CLI) to configure and monitor content filtering using
SurfControl CPA. For more information about the SCE platform CLI, see the Cisco SCE8000 CLI
Command Reference.

» CPA Client CLI Commands, page 7-64
» Description of CPA Client CLI Commands, page 7-65

CPA Client CLI Commands

The commands listed here are explained in the following section.
» Usethefollowing CLI commands to configure the Cisco CPA client:

[no] cpa-client
cpa-client destination <address> [port <port>]
cpa-client retries <number_of_retries>

» These commandsarelineinterface configuration commands. To run these commands you must enter
lineinterface configuration mode (see How to Enter Line Interface Configuration Mode, page 7-66).

« Usethefollowing CLI command in EXEC mode to monitor the status of the Cisco CPA client:

show interface LineCard <slot> cpa-client

Cisco Service Control Application for Broadband User Guide
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Description of CPA Client CLI Commands

Table 7-3 gives a description of the Cisco CPA client CLI commands listed in the previous section and
their default values.

Table 7-3 CPA Client CLI Commands
Command Description Default Value
[no]l cpa-client Enables or disables the CPA Disabled
client
cpa-client destination Enables the CPA client and sets | « Address—not defined
<address> [port <port>]
the CPA server |P address and - Port—9020
port
cpa-client retries Setsthe number of retriestosend |3
<number_of_retries> to the CPA server
show interface LineCard Monitors the CPA client status |—
<slot> cpa-client (See the following table)

Table 7-4 lists the information shown when monitoring the Cisco CPA client.

Table 7-4 CPA Client: Monitored Parameters
Parameter Description
Mode Enabled or disabled
CPA Address
CPA Port
CPA Retries
Status (If enabled) Active or error (and last error
description)
Counters « Number of successful queries
« Number of queries that failed because of no
server response
» Number of pending queries
» Rate of queries per second (average over the
last 5 seconds)
Timestamps - CPA started
e Last query

e Last response
e Lasterror
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How to Configure the RDR Formatter

To enablethe RDR formatter to issue HTTP categorization requests, configure the RDR formatter on the
SCE platform.

Stepl  Make the appropriate SCE platform CLI command.

#>RDR-formatter destination 127.0.0.1 port 33001 category number 4 priority 100

Related Info

For more information about configuring the RDR formatter, see either the “Raw Data Formatting: The
RDR Formatter and NetFlow Exporting” chapter of the Cisco SCE8000 10GBE Software Configuration
Guide or the “Raw Data Formatting: The RDR Formatter and NetFlow Exporting” chapter of the Cisco
SCE8000 GBE Software Configuration Guide.

How to Enter Line Interface Configuration Mode

To run line interface configuration commands you must enter line interface configuration mode and see
the sce(config if)# prompt displayed.

Stepl At the SCE platform CLI prompt (sce#), type configure.
Step 2 Press Enter.
The sce (config) # prompt appears.
Step3  Typeinterface LineCard 0.
Step4  Press Enter.

The sce(config if)# prompt appears.

Cisco Service Control Application for Broadband User Guide
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Managing Content Filtering Settings

Applying HTTP URL content filtering requires the following steps in the Service Configuration Editor:
1. Import the content filtering configuration file into your service configuration.

By default, SCA BB creates a separate flavor (of type HTTP Content Category) for each content
category and a service element for each new flavor. A new top-level service, “HTTP Browsing with
Categories’, is created, comprising these service elements.

2. Create new services and map the new category flavors to them.

3. Add content filtering rulesto existing packages or create new packages that include content filtering
rules.

4. Enable content filtering for selected packages.

5. Apply the service configuration.

« Importing Content Filtering Categories, page 7-67

» How to Configure Content Filtering, page 7-75

« How to View Content Filtering Settings, page 7-76

» How to Remove Content Filtering Settings, page 7-76

Importing Content Filtering Categories

Note

Before you can control HTTP flows based on content, you must import an XML file provided with the
installation.

After you unzip the installation package, thisfileislocated in the URL Filtering subfolder.

You cannot import content filtering categories when unidirectional classification is enabled.

« HTTP Content Category Flavors, page 7-68
« HTTP Browsing with Categories Service Elements, page 7-69
- How to Import Content Filtering Categories Using the Import Dialog Box, page 7-69

« How to Import Content Filtering Categories Using the HTTP Content Filtering Settings Dialog Box,
page 7-73
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HTTP Content Category Flavors

By default, SCA BB creates aseparate flavor (of type HTTP Content Category) for each content category
when importing the XML file (Figure 7-52).

Figure 7-52 Flavor Settings
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e7Y

[ Ok ][ Cancel ]
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You can create additional HTTP Content Category Flavors that include two or more content categories.
(See How to Add Flavors, page 7-55.)
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By default, SCA BB creates a service element for each flavor created when importing the XML file. A
new top-level service, HTTP Browsing with Categories, is created, comprising these service elements

(Figure 7-53).
Figure 7-53 Service Configuration Editor
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To view this new service you must save and close the service configuration and then reopen it.

How to Import Content Filtering Categories Using the Import Dialog Box

You can import content filtering categories using either the File > Import menu option or the

Configuration > Content Filtering menu option.

This procedure explains how to import using the File > Import menu option.

Thisis equivalent to the following procedure.
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Stepl  From the Console main menu, choose File > Import.
The Import dialog box appears (Figure 7-54).

Figure 7-54 Import
F Import |Z|®
Select \

Choose import source, |' g -

Select an import source:

|type filker bext |

= [MEE ar

=+ [ Service Configuration
Import content filkering database settings From an XML file
Import service configuration parts fram a CSW file

(== Signature Editar

< Back Mext = Finish Ig
b

Step2  From the import source list, select Import content filtering database settings from XML file.

Step3  Click Next.
The Import Content Filtering Database Settings dialog box appears (Figure 7-55).
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Figure 7-55 Import Content Filtering Database Settings
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Step4  Click the Browse button next to the Select a XML filefield.
An Open dialog box appears.
Step5  Browse to the folder containing the file to import, and select it.

Note For SurfControl’s CPA, the file is named surfcontrol.xml.

Step6  Click Open to select thefile.
The Open dialog box closes.

Information about the content of the XML file is displayed in the Database Settings pane of the Import
Content Filtering Database Settings dialog box.

Step7 By default, SCA BB creates aseparate flavor (of type HTTP Content Category) for each content category
when importing the XML file.

» To disable this option, uncheck the Create a distinct Flavor for each Content Category check box.

Note It isrecommended that you do not disable this option.

Cisco Service Control Application for Broadband User Guide
[ oL-7205-19 .m



Chapter 7 Using the Service Configuration Editor: Traffic Classification |

M Managing Content Filtering

Step8 By default, SCA BB creates a service element for each flavor created in the previous Step. A new
top-level service, HTTP Browsing with Categories, is created, comprising these service elements.

- To disable this option, uncheck the Create a Service Element for each Content Category Flavor
in Service ' HTTP Browsing with Categories’ check box.

Note  Itisrecommended that you do not disable this option.

Step9  Click Finish.
The Import Content Filtering Database Settings dialog box closes.

Information from the imported file is displayed in the Database Settings tab of the HTTP Content
Filtering Settings dialog box (Figure 7-56).

Figure 7-56 HTTP Content Filtering Settings
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Step10 Click OK.
The HTTP Content Filtering Settings dialog box closes.
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How to Import Content Filtering Categories Using the HTTP Content Filtering Settings Dialog Box

You can import content filtering categories using either the File > Import menu option or the
Configuration > Content Filtering menu option.

This procedure explains how to import using the Configuration > Content Filtering menu option.

Thisis equivalent to the previous procedure.

From the Classification tab in the left pane, choose Configuration > Content Filtering.
The HTTP Content Filtering Settings dialog box appears.

Click the Database Settings tab.

The Database Settings tab opens.

Click Import.

The Import Content Filtering Database Settings dialog box appears.

Click the Browse button next to the Select a XML file field.

An Open dialog box appears.

Browse to the folder containing the file to import, and select it.

For SurfControl’s CPA, the file is named surfcontrol.xml.

Click Open to select thefile.
The Open dialog box closes.

Information about the content of the XML file is displayed in the Database Settings pane of the Import
Content Filtering Database Settings dialog box.

By default, SCA BB creates a separate flavor (of type HT TP Content Category) for each content category
when importing the XML file.

- To disable this option, uncheck the Create a distinct Flavor for each Content Category check box.

It is recommended that you do not disable this option.

By default, SCA BB creates a service element for each flavor created in the previous Step. A new
top-level service, HTTP Browsing with Categories, is created, comprising these service elements.

- To disable this option, uncheck the Create a Service Element for each Content Category Flavor
in Service 'HTTP Browsing with Categories’ check box.

It is recommended that you do not disable this option.

Click Finish.
The Import Content Filtering Database Settings dialog box closes.

Information from the imported file is displayed in the Database Settings tab of the HTTP Content
Filtering Settings dialog box (Figure 7-57).
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Figure 7-57 HTTP Content Filtering Settings
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Step10 Click OK.
The HTTP Content Filtering Settings dialog box closes.
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How to Configure Content Filtering

You can specify the packages where content filtering will be enabled. For packages where content
filtering is disabled, HTTP flows will be classified normally.

Stepl  From the Classification tab in the left pane, choose Configuration > Content Filtering.
The HTTP Content Filtering Settings dialog box appears (Figure 7-58).
The Package Settings tab displays alist of all packages defined for the current service configuration.

Figure 7-58 HTTP Content Filtering Settings
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Step2  Check the Enable HT TP content filtering check box.
Step3  Check the check box next to each package for which content filtering is to be applied.
Step4  Click OK.

The HTTP Content Filtering Settings dialog box closes.
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How to View Content Filtering Settings

Step 1

Step 2

Step 3

You can view whether content filtering is enabled and to which packages content filtering is applied, and
information about the content filtering vendor and the vendor’s content categories.

From the Classification tab in the left pane, choose Configuration > Content Filtering.
The HTTP Content Filtering Settings dialog box appears.

The Package Settingstab displaysalist of all packages defined for the current service configuration, and
shows for which packages content filtering is enabled.

Click the Database Settings tab.

The Database Settings tab opens.

This tab displays information about the content filtering vendor and the vendor’s content categories.
Click OK.

The HTTP Content Filtering Settings dialog box closes.

How to Remove Content Filtering Settings

Step 1

Step 2

Step 3

You can remove all content filtering settings at any time.
Removing the settings:
« Removes content category flavor items from flavors
« Deletes all the content category flavor items
» Disables content filtering

From the Classification tab in the left pane, choose Configuration > Content Filtering.
The HTTP Content Filtering Settings dialog box appears.

Click the Database Settings tab.

The Database Settings tab opens.

Click Remove.

A Confirm Content Filtering Settings Removal dialog box appears (Figure 7-59).
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Figure 7-59 Confirm Content Filtering Settings Removal
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Step4  Click OK.
All content filtering settings are removed.

Vendor Name, Vendor Information, and Content Categories are deleted from the HTTP Content Filtering
Settings dialog box.

Step5  Click OK.
The HTTP Content Filtering Settings dialog box closes.

~

Generic Protocols—Generic | P, Generic TCP, and Generic UDP protocols, used for transactions that
are not specifically mapped to a protocol by any other protocol type.

IP Protocols—Protocols (such as ICMP), other than TCP and UDP protocols, identified according
to the IP protocol number of the transaction.

Port-Based Protocols—TCP and UDP protocaols, classified according to their well-known ports. The
default service configuration includes more than 750 common port-based protocols.

Signature-Based Protocols—Protocols classified according to a Layer 7 application signature.
Includes the most common protocols, such as HTTP and FTP, and a large group of popular P2P
protocols.

P2P Protocol s—Peer-to-peer file-sharing application protocols classified according to a Layer 7
application signature.

VOIP Protocols—Voice-over-1P application protocols classified according to a Layer 7 application
signature.

SIP Protocols—Protocols classified according to a Layer 7 application signature that is SIP or has
SIP characteristics.

Worm Protocols—Protocols classified according to a Layer 7 application signature that is based on
traffic patterns of Internet worms.

Packet Stream Pattern Based Protocols—Protocols classified according to a Layer 7 application
signature that is based on the pattern of the packet stream (for example, the stream’s symmetry,
average packet size, and rate) rather than on the packet’s payload content.

Unidirectionally Detected Protocols—Protocols having a unidirectional signature.

Note  Some protocols belong to more than one category. In particular, all predefined P2P, VOIP, SIP, Worm,
and Packet Stream Pattern-Based Protocols are also defined as Signature-Based Protocols.

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter 7 Using the Service Configuration Editor: Traffic Classification |

M Managing Content Filtering

Stepl  From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

Step2  From the drop-down list in the Protocols tab, select the type of protocol to display.
The protocols of the selected type appear in the Protocols tab.

Step3  Click Close.
The Protocol Settings dialog box closes.

Note  The setting in the drop-down list is not saved. The next time you open the Protocol Settings dialog box,
all protocols will be displayed.
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Using the Service Configuration Editor: Traffic
Accounting and Reporting
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Introduction

This chapter explains how to work with usage counters and Raw Data Records (RDRS).

Traffic Accounting and Reporting is the second step in creating a Cisco Service Control Application for
Broadband (SCA BB) service configuration.

» Usage Counters, page 8-1

- Raw Data Records, page 8-2

» NetFlow records, page 8-2

» Managing RDR Settings, page 8-3

Usage Counters

The SCA BB collects and maintains various network metrics (such as volume and number of sessions)
per service. This accounting takes place per subscriber, per group of subscribers (package or group of
packages), and for the entire link.

Service usage counters are used by the system to generate data about the total use of each service. A
service can use either its own usage counters, or those of the parent service. For example, in the default
service configuration the SMTP and POP3 services share the E-Mail service usage counters. The
assignment of services to usage counters is determined by the service hierarchy. How to Edit Services,
page 7-9, explains how to configure the service hierarchy.

The SCA BB also collects and maintains various network metrics per package.

Package usage counters are used by the system to generate data about the total use of each package. A
package can use either its own usage counters, or those of the parent package. The assignment of
packages to usage counters is determined by the package hierarchy. How to Set Advanced Package
Options, page 9-51, explains how to configure the package hierarchy.
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Raw Data Records

Service Control Engine (SCE) platforms generate and transmit Raw Data Records (RDRs) that contain
information relevant to the service provider. These RDRs contain awide variety of information and
statistics, depending on the configuration of the system. The content and structure of each type of RDR
islisted in the “Raw Data Records: Formats and Field Contents” chapter of the Cisco Service Control
Application for Broadband Reference Guide.

- RDRs are not generated for filtered traffic (see Filtering the Traffic Flows, page 10-19).
- All RDR datais based on Layer 3 volume.

NetFlow records

» You enable and disable the export of NetFlow records using the CLI.

You can export records per supported RDR type. The datain the following RDR types can be
exported using NetFlow:

— Subscriber Usage RDR
— Package Usage RDR
— Link Usage RDR
- The NetFlow records can be sent to more than one collection device.

« NetFlow records can be generated concurrently with RDRs.
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Managing RDR Settings

This section explains how to configure the generation of the different types of RDRs.

The content and structure of each type of RDR islisted in the “Raw Data Records: Formats and Field
Contents” chapter of the Cisco Service Control Application for Broadband Reference Guide.

RDRs are not generated for filtered traffic (see Filtering the Traffic Flows, page 10-19).
All RDR datais based on Layer 3 volume.

The RDR Settings Dialog Box

The RDR Settings dialog box allows you to control the generation of RDRs for an entire service
configuration. This dialog box contains seven tabs:

N

Usage RDRs tab—Allows you to enable the generation each type of Usage RDR, and define their
generation intervals

Transaction RDRs tab—Allows you to enable the generation of Transaction RDRs and define their
maximum rate of generation

Quota RDRs tab—Allows you to enabl e the generation of each type of Quota RDR, and define their
generation parameters

Transaction Usage RDRs tab—Allows you to specify the packages and services for which
Transaction Usage RDRs will be generated

Log RDRs tab—Allows you to specify the packages and services for which Log RDRs will be
generated

Real-Time Subscriber RDRs tab—Allows you to enable the generation of Real-Time Subscriber
Usage RDRs, and define their generation intervals and maximum rate of generation

Real-Time Signaling RDRs tab—Allows you to specify the packages and services for which
Real-Time Signaling RDRs will be generated

Note  MediaFlow RDRsand Malicious Traffic Periodic RDRs are enabled and configured in the How to Edit
Advanced Service Configuration Options, page 10-50.
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How to Manage Usage RDRs

Note

Step 1

The four types of Usage RDRs contain data about total usage of all servicesincluded in a service usage
counter:

» Link Usage RDRs—For the entire link

» Package Usage RDRs—For all subscribers to a particular package
» Subscriber Usage RDRs—For a particular subscriber

« Virtual Links Usage RDRs—For a particular group of virtual links

You can enable or disable the generation of each type of Usage RDR, and set the generation interval for
each type of Usage RDR. You can limit the generation rate of Subscriber Usage RDRs. Thisisadvisable
when there are a large number of subscribers.

By default, all four types of Usage RDRs are enabled. (Virtual Links Usage RDRs are enabled by default
only if Virtual Links mode was enabled when you created the service configuration.)

Usage RDRs are not generated for blocked sessions. A session is blocked if the service to which the
session is mapped is blocked for this user’s package (see How to Define Per-Flow Actions for a Rule,
page 9-59), or if the user has exceeded the allowed quota for this service (see Managing Quotas,

page 9-75).

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the following sections in the Cisco Service Control Application for Broadband
Reference Guide:

- Link Usage RDR

» Package Usage RDR

- Subscriber Usage RDR
« Virtual Link Usage RDR

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears (Figure 8-1).
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Step 2

Step 3

Step 4

Step 5

Managing RDR Settings

Figure 8-1 RDR Settings
RDR Settings
Trangaction Usaae RORs ] I”Lc-g RDRs ) 'ReaI.-.Time Egu.l.sscriber RDFs Rn.aaI-Timq_S'ignaling RDRs
Usage RORs i Transaction RORs Quota RDRs

Link [Jsage RDRs

Link IUsage RDRs are generated at fixed intervals, They report the bokal usage of a particular service counter For the

entire link,
Generate Link Usage RDRs once every | 5 | minutes, For each service

Package Usage RDRs-

Package Usage RDRs are generated at fized intervals. They repart the total usage of a particular service caunter,
generated by all subscribers in a group of packages.

Generate Package Usage RDRs once every : 5 . minukes, for each service

Subscriber Usage RDRs

Subscriber Usage RDRs are generated at fixed intervals, They report the amount of usage consumed by an
individual subscriber for each service counter,

Generate Subscriber Usage RDRs once every. | 5 | minutes, For each service

Limit the total rate of Subscriber Usage RDRs to | 10 | RDRS per second

Wirtual Links Usage RDRs-

‘irtual Links Usage RDRs are generated at Fixed intervals, They report the total usage of a particular service
counter, generated by all subscribers in a group of virkual links,

[] Gererate Virkual Links Usage RORs once every | . minutes, for each service

I ok J[ Cancel ‘

210801

To enable the generation of aselected type of Usage RDR, check the appropriate Gener ate Usage RDRs
check box.

To disable the generation of a selected type of Usage RDR, uncheck the appropriate Gener ate Usage
RDRs check box.

To change the generation interval for a selected type of Usage RDR, enter the interval in minutes
between each generation of this type of Usage RDRs in the appropriate Generate Usage RDRs field.

To limit the generation rate of Subscriber Usage RDRs, enter the maximum number of Subscriber Usage
RDRs to be generated per second in the Limit the Total Rate of Subscriber Usage RDRs field.

Click OK.
The RDR Settings dialog box closes.

The new configuration for the generation of Usage RDRs is saved.
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How to Manage Transaction RDRs

Each Transaction RDRs contains data about a single network transaction. The SCE platform can
generate Transaction RDRsfor selected servicetypes. You can use these RDRs, for example, to generate

statistical histograms that help understand the traffic traversing the network.

You can enable or disable the generation of Transaction RDRs, set the maximum number of Transaction
RDRs generated per second, and select for which servicesthese RDRs are generated. You can also assign
arelative weight to each service. The relative weight determines the relative number of Transaction

RDRs that will be generated for this service, compared to other services.

By default, at most 100 Transaction RDRs are generated per second, and all services are given the same

weight.

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the “ Transaction RDR” section in the Cisco Service Control Application for

Broadband Reference Guide.

Step1  From the Classification tab in the left pane, choose Configuration > RDR Settings.

The RDR Settings dialog box appears.
Step2  Click the Transaction RDRs tab.
The Transaction RDRs tab opens (Figure 8-2).

Figure 8-2 Transaction RDRs Tab

RDR Settings

Log RORs _Real-Time Subscriber RDRs
Usage RORs || TransactionRDRs 1 Quoka RORs

Transaction RDRs

Generate Transaction RORsS

Real-Time Signaling RDRs
Transackion Usage RDRs

Transaction RORs represent single nebwork transactions. They can be used to generate statistical
histograms that help understand what kind of traffic is traversing the network.

Limit the total rate of Transaction RDRs to | 100 RDRs per second

The relative weight of Transaction RDR rate, for a certain service, determines the relative number
of RDRs per second that will be generated For this service, compared with other services,

; Enabled = Service Relative Weight
V]  |Default Service 10]A |
V]  |Generic 10| = |
[¥]  |Generic TCP 10
[#]  |Generic LDP 10
]  [E-Mai 10
7]  |mach 10
[#]  |Generic IP 10
g Browsing 10 =
] Rt enrni . ini—

Reset all Weights

QF H Cancel I

274110
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Step 4

Step 5

Step 6

Step 7

Managing RDR Settings

To enable the generation of Transaction RDRs, check the Generate Transaction RDRs check box.
To disable the generation of Transaction RDRs, uncheck the Generate Transaction RDRs check box.

To change the maximum generation rate for Transaction RDRs, enter the desired rate in the Limit the
Total Rate of Transaction RDRs field.

To disable the generation of Transaction RDRs for a selected service, uncheck the Enabled check box
next to the service name.

To set the relative weight for a selected service, double-click in the appropriate cell in the Relative
Weight column, and enter the desired weight.

Click OK.
The RDR Settings dialog box closes.

The new configuration for the generation of Transaction RDRs is saved.

How to Manage Quota RDRs

Each Quota RDR contains data for a single subscriber. There are four types of Quota RDRs:

» Quota Breach RDRs—Generated when a quota breach occurs, that is, when services that try to
consume from a depleted quota bucket.

A breached service is handled according to its breach-handling settings. For example, when the
guota for a service is consumed, you can block its flows.

» Remaining Quota RDRs—Generated as quota is consumed, but only if a bucket state has change
since the last Remaining Quota RDR was generated.

« Quota Threshold Breach RDRs—Generated when the remaining quotain a bucket falls below a
threshold. External systems can treat this RDR as a quota request and provision the subscriber with
an additional quota before the bucket is depleted.

» Quota State Restore RDRs—Generated when a subscriber isintroduced. When a subscriber logs out,
their remaining quotais stored in the Cisco Service Control Management Suite (SCM S) Subscriber
Manager (SM). When the subscriber logs in again, this quotais restored from the SM.

You can enable or disable the generation each type of Quota RDR and define the rate of generation of
these RDRs.

« For Remaining Quota RDRs, you can set the generation interval, and limit the generation rate
(advisable when there are alarge number of subscribers).

» For Quota Threshold RDRs, you can configure the threshold.
By default, all Quota RDRs are disabled.

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the following sections in the Cisco Service Control Application for Broadband
Reference Guide:

» QuotaBreach RDR

» Remaining Quota RDR

» Quota Threshold Breach RDR
« Quota State Restore RDR
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Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears.

Click the Quota RDRs tab.

The Quota RDRs tab opens (Figure 8-3).

Figure 8-3 Quota RDRs Tab

Log RDRs Real-Time Subscriber RDRS | RealTime Signaling RDRs
Usage RDRs Transaction RDRs | Transackion Usage RDRs

Quota Breach RDRs

[ Generate Quota Breach RDRs

Remaining Quota RDRs
|:| Generate Remaining Quota RORs every i I minukes

Limit the tatal rate of Remaining Quota RORS to ' | RORs pet second

Cuiota Threshold RORs

[[] Generate Quata Threshold RORs when remaining quata is less than | MBiytes

I QF H Cancel I

274107

To enable the generation of Quota Breach RDRs, check the Generate Quota Breach RDRs check box.

To enable the generation of Remaining Quota RDRs, check the Generate Remaining Quota RDRs
check box.

To change the generation interval of Remaining Quota RDRs, in the Generate Remaining Quota RDRs
field, enter the interval in minutes between each generation of the RDR.

To limit the maximum generation rate of Remaining Quota RDRs, in the Limit the Total Rate of
Remaining Quota RDRs field, enter the maximum number of Remaining Quota RDRs to be generated
per second.

To enable the generation of Quota Threshold RDRs, check the Gener ate Quota Threshold RDRs check
box.

To change the Threshold for Quota Threshold RDRs, in the Generate Quota Threshold RDRs field, enter
the threshold for which Quota Threshold RDRs will be generated.
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Step 9

Step 10

Managing RDR Settings

To enable the generation of Quota State Restore RDRs, check the Gener ate Quota State Restore RDRs
check box.

Click OK.
The RDR Settings dialog box closes.
The new configuration for the generation of Quota RDRs is saved.

How to Manage Transaction Usage RDRs

A

Transaction Usage RDRs are generated for all transactions of selected packages or for selected services
per package. Each Transaction Usage RDR contains data about a single network transaction. You can
use these RDRs, for example, to build detailed usage logs for specific services and subscribers for
transaction-based billing.

Caution

Note

Step 1

Step 2

Generating and collecting an RDR for each transaction can compromise performance. Enable
Transaction Usage RDR generation only for services and packages that must be monitored or controlled.

You can select the packages and services for which Transaction Usage RDRs are generated. The
following RDRs will also be generated for these packages and services:

« HTTP Transaction Usage RDR
e RTSP Transaction Usage RDR
- VoIP Transaction Usage RDR
By default, no Transaction Usage RDRs are generated.

MediaFlow RDRs are enabled in the How to Edit Advanced Service Configuration Options, page 10-50.
(When enabled, Media Flow RDRs are generated at the end of every SIP and Skype mediaflow; you can
use them to distinguish between SIP voice and video calls.)

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the following sections in the Cisco Service Control Application for Broadband
Reference Guide:

» Transaction Usage RDR

e HTTP Transaction Usage RDR
» RTSP Transaction Usage RDR
- VoIP Transaction Usage RDR

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears.

Click the Transaction Usage RDRs tab.

The Transaction Usage RDRs tab opens (Figure 8-4).
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Step 3

Step 4

Figure 8-4 Transaction Usage RDRs Tab

2£ RDR Settings

Usage RDREs Transaction RDRs Quoka RDRs
Transaction sage RDRs Lag RORs Real-Time Subscriber RORs Real-Time Signaling RORs

Transaction Usage RDRs

Transaction Usage RDRs represent single network kransactions, They can be used to generate detailed usage logs
far specific services and subscribers of specific packages.

Generate the following types of Transaction Usage RDRs (TURS):
Generic TUR,

[ Protocal specific TURs (include pratocol specific information)

[] Extended TURs {include extended protocol specific information)

Packages and services For which Transaction Usage RDRs should be generated:

[ Select/Deselect Al
-] Default Package
+-[] (L) Unknown Subscriber Package

Transaction Usage RDRs can be fitered according to the session's volume

[] Generate TUR: only For sessions exceeding Bytes

Transaction Usage RDRs can be generated at Fixed intervals, during long Flows

[] Enable Interim TUR to be generated every Minutes {From 5 minutes up to 2880 minutes)

X

€ I Ok ] [ Cancel

]

Check one or more of the following types of Transaction Usage RDRs to generate:

- Generic TUR
« Protocol Specific TURSs (include protocol specific information)
» Extended TURs (include extended protocol specific information)

158936

If you check Extended TURS, the Anonymize - Encrypt Personally I dentifiable I nfor mation

checkbox is enabled. Check this box to anonymize the data.

(Optional) To enable the generation of Transaction Usage RDRsfor a selected package, check the check

box next to the package name in the package tree.

The package expands to show all component services of the package; all services are checked.
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Step 5

Step 6

Step 7

Step 8

Managing RDR Settings

Enable the generation of Transaction Usage RDRs for selected services of a package.
a. Expand the node of the desired package.

b. Check the check box next to the service name of each service for which a Transaction Usage RDR
isto be generated.

(Optional) Limit the generation of Transaction Usage RDRs by session size.
a. Check the Generate TUR only for sessions exceeding check box.
The Bytesfield is enabled.

b. Enter the minimum session size in bytes for which a Transaction Usage RDR should be generated
for the session.

(Optional) Enable the generation of additional, interim Transaction Usage RDRs for long flows.
(Usually, a Transaction Usage RDR is generated only when a flow closes.)

a. Check the Enable Interim TUR to be generated every check box.
The Minutesfield is enabled.

b. Enter the required time in minutes between each generation of a Transaction Usage RDR for each
flow.

Click OK.
The RDR Settings dialog box closes.

The new configuration for the generation of Transaction Usage RDRs is saved.

How to Manage Log RDRs

Note

Log RDRs, which provide information about system events, are generated in response to specific actions
or state changes. There are two types of Log RDRs:

» Blocking RDRs—Generated each time a transaction is blocked
» Breach RDRs—Generated each time a bucket exceeds the global threshold

You can set the maximum number of Log RDRs generated per second. You can select the packages and
services for which Blocking RDRs are generated.

By default:
- Blocking RDRs are generated for all packages
- Breach RDRs are always generated

At most 20 Log RDRs are generated per second.

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the following sections in the Cisco Service Control Application for Broadband
Reference Guide:

- Blocking RDR
» QuotaBreach RDR
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Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears.

Click the Log RDRs tab.

The Log RDRs tab opens (Figure 8-5).

Figure 8-5 Log RDRs Tab

Transaction RORS Quata RORs Transaction Usage RORS

LDgRDRS Real-Time Subscriber RDRs I Real-Time Signaling RORs

Log RDRs-

Log RDRs are generated in response to specific application actions or state changes. Log RORs
include Blocking RDRs and Breach RDRs.

Limit the total rate of Log RDRS ko | 20 | RORs per second
EBlocking RODRs

Packages and services For which Blacking RORs should be generated:
[C] 24 Selectipeselect Al

| - [#]__| Default Package

| =[] Unknown Subscriber Traffic

I QF H Cancel I
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To change the maximum generation rate for Log RDRs, enter the desired rate in the Limit the Total Rate
of Log RDRs field.

To enable the generation of Blocking RDRs for selected packages, check the check box next to the
package name in the package tree.

The package expands to show all component services of the package; all the services are checked.
Enable the generation of Blocking RDRs for selected services of a package.

a. Expand the node of the desired package.

b. Check the check box next to the service name of each desired service.

Click OK.

The RDR Settings dialog box closes.

The new configuration for the generation of Log RDRs is saved.
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Managing RDR Settings

How to Manage Real-Time Subscriber Usage RDRs

A

Real-Time Subscriber Usage RDRs, which report subscriber usage, are generated for each individual
subscriber for each service used, at specified intervals. These RDRs permit a more granular monitoring
of selected subscribers when necessary.

For more information about selecting subscribers to be monitored, see Selecting Subscribers for
Real-Time Usage Monitoring, page 13-13.

Caution

Step 1

Step 2

Generating and collecting Real-Time Subscriber Usage RDRs for many subscribers can compromise
performance. Enable Real-Time Subscriber Usage RDR generation only for subscribers that must be
monitored.

You can enable or disable the generation of Real-Time Subscriber Usage RDRs, set the generation
interval for these RDRs, and set the maximum number generated per second.

By default, Real-Time Subscriber Usage RDRs:
« Areenabled (but only for selected subscribers)
« Aregenerated for each subscriber once every minute
« Arelimited to 100 RDRs generated per second

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the “Real-Time Subscriber Usage RDR” section in the Cisco Service Control
Application for Broadband Reference Guide.

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears.

Click the Real-Time Subscriber RDRs tab.

The Real-Time Subscriber RDRs tab opens (Figure 8-6).
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Figure 8-6 Real_Time Subscriber RDRs Tab
RDR Settings
Llsa_ge '_RIZ_)RS I Transaction RORs | QugtaRDRs Transaction 'Llsage RDRs
LogRORs Real-Time Subscriber RDRs Real-Time Signaling RORs

Real-Time Subscriber Usage RORs

Rezal-Time Subscriber Usage RDRs are generated at fixed intervals, They repork the amount of
usage consumed by an individual subscriber For each service (which was actually used), ta allow
more granular monitoring of selected subscribers.

Generate Real-Time Subscriber Usage RDRs once every | 1 1 minutes, For each service

Lirnit the kotal rate of Real-Time Subscriber Usage RDRs ko -IDD RDRs per second

I o H Cancel I

274109

Step3  To enable the generation of Real-Time Subscriber Usage RDRs, check the Generate Real-Time
Subscriber Usage RDRs check box.

Step4  To change the generation interval for Real-Time Subscriber Usage RDRs, enter the desired interval in
minutes between each generation of the RDRs in the Generate Real-Time Subscriber Usage RDRs field.

Step5  To limit the generation rate of Real-Time Subscriber Usage RDRs, enter the maximum number of
Real-Time Subscriber Usage RDRs to be generated per second in the Limit the total rate of Real-Time
Subscriber Usage RDRs field.

Step6  Click OK.
The RDR Settings dialog box closes.
The new configuration for the generation of Real-Time Subscriber Usage RDRs is saved.
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Managing RDR Settings

How to Manage Real-Time Signaling RDRs

Note

Step 1

Step 2

Real-Time Signaling RDRs, which are generated at the beginning and end of aflow, at specified intervals
after the beginning of the flow, and at the beginning and end of a network attack, can be used to signal
external systems concerning events detected by the SCE platform, allowing real-time actionsto be taken
across the network.

There are two groups of Real-Time Signaling RDRs:
« Flow Signaling RDRs:
— Flow Start Signaling RDRs
— Flow Stop Signaling RDRs
— Flow Interim Signaling RDRs
- Attack Signaling RDRs:
— Attack Start Signaling RDRs
— Attack Stop Signaling RDRs

You can enable or disable the generation of Flow Signaling RDRs for selected packages, or for selected
services per package. You can set the generation interval for Flow Interim Signaling RDRs, which can
be generated only if Flow Start and Flow Stop Signaling RDRs are enabled.

You can enable or disable the generation of Attack Signaling RDRs for selected packages.

Malicious Traffic Periodic RDRs are enabled and configured in the How to Edit Advanced Service
Configuration Options, page 10-50.

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the following sections in the Cisco Service Control Application for Broadband
Reference Guide:

- Flow Start RDR
- Flow End RDR
« Ongoing Flow RDR
- Attack Start RDR
- Attack End RDR
By default, no Real-Time Signaling RDRs are generated.

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears.

Click the Real-Time Signaling RDRs tab.

The Real-Time Signaling RDRs tab opens (Figure 8-7).
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Step 3

Note

Step 4

Step 5

Step 6

Figure 8-7 Real-Time Signaling RDRs Tab
RDR Settings
'.Llsa_ge 'RIZ_)Rs Tr.ansact.ion"RD__Ré .Quo'ta RORs | Transaction Usage RDRs
LogRDRs || Real-Time Subscriber RORs Real-Time Signaling RCRs

Feal-Time Signaling

Rezal-Time Signaling RORs are generated at the beginning and end of a flow, at specified intervals
during the flow's life cycle, or at the beginning and end of a network attack,

These RDRs signal events detected by the SCE to external systemns (such as PCMM compliant
systems), to enable real-time actions across the network,

Flows Signaling | atkack Signaling |

[ Enable Flow Start and Flaw Stop Signaling RDRs

Packages and services For which to generate Realtime Signaling RDRs:
[[7 -3 Select/Deselect Al i
&[] Default Package
| - ] ] Unknown Subscriber Traffic

I o H Cancel I

274108

To enable the generation of Flow Start and Flow Stop Signaling RDRs, check the Enable Flow Start
and Flow Stop Signaling RDRs check box.

Generation of Flow Start and Flow Stop Signaling RDRs is not supported when unidirectional
classification is enabled. If you try to check the Enable Flow Start and Flow Stop Signaling RDRs check
box when unidirectional classification is enabled, an RDR Settings Error message appears.

Click OK, and continue at Step 8.

The Enable Flow Interim Signaling RDRs check box is enabled.

To enable the generation of Flow Interim Signaling RDRs, check the Enable Flow Interim Signaling
RDRs check box.

The Enable Flow Interim Signaling RDRs field is enabled.

To change the generation interval for Flow Interim Signaling RDRs, enter the interval in minutes
between each generation of the RDRs in the Enable Flow Interim Signaling RDRs field.

To enable the generation of Flow Interim Signaling RDRs for selected packages, check the check box
next to the package name in the package tree.

The package expands to show all component services of the package; all the services are checked.
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Step7  To enable the generation of Flow Interim Signaling RDRs for selected services of a package:
a. Expand the node of the desired package.
b. Check the check box next to the service name of each desired service.
Step8  To enable the generation of Attack Signaling RDRs:
a. Inthe body of the Real-Time Signaling RDRs tab, click the Attack Signaling tab (Figure 8-8).

Figure 8-8 Attack Signaling Tab

| Flm_n\l Sigljaling -‘7\

[1Enable Attack Start and Attack Stop Signaling RDRs

Packages For which to generate Attack Signaling RDRs:

[] Default Package
[ Unknown Subscriber Traffic

158933

b. Check the Enable Attack Start and Attack Stop Signaling RDRs check box.

Step9  To enable the generation of Attack Signaling RDRs for selected packages, check the check box next to
the package name in the package list.

Step10 Click OK.
The RDR Settings dialog box closes.
The new configuration for the generation of Real-Time Signaling RDRs is saved.
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Using the Service Configuration Editor: Traffic
Control

Revised: December 14, 2011, OL-7205-19

Introduction

The Traffic Control capabilities of the Service Control Engine (SC platform and the Cisco Service
Control Application for Broadband (SCA BB) are used to limit and prioritize traffic flows. Control of
traffic is based on parameters such as the service of the flow, the subscriber’s package, and the
subscriber’s quota state.

Managing Bandwidth, page 9-2
Managing Virtual Links, page 9-40
Managing Packages, page 9-46
Managing Rules, page 9-55

Managing Quotas, page 9-75

Unknown Subscriber Traffic, page 9-83
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Managing Bandwidth

The upstream and downstream interfaces are each assigned one default global controller. You can add
additional global controllers.

The number of global controllers a service configuration can contain varies based on the SCE hardware.
The maximum number of global controllers including the default global controllers are:

» Cisco SCE 2000—1024 upstream and 1024 downstream
» Cisco SCE 8000 multi-Gigabit Ethernet—1024 upstream and 1024 downstream
» Cisco SCE 8000 10 Gigabit Ethernet—2048 upstream and 2048 downstream

After you have defined global controllers, you can add subscriber BW controllers (BWCs) to packages,
and map these subscriber BWCs to different global controllers.

A

Caution If you enable or disable Virtual Links mode, all user-defined global controllers are deleted from the
service configuration. A subscriber BWC that pointed to a user-defined global controller now points to
the default global controller. (Other parameters of these subscriber BWCs remain unchanged.)

- Managing Global Bandwidth, page 9-2

« How to View Global Controller Settings, page 9-3

« How to Edit the Total Link Limits, page 9-5

» How to Add Global Controllers, page 9-6

» How to Set the Maximum Bandwidth of Global Controllers, page 9-9
- How to Delete Global Controllers, page 9-11

» How to Define Global Controllers, page 9-11

- Managing Subscriber Bandwidth, page 9-28

« Managing Bandwidth: a Practical Example, page 9-31

- How to Set BW Management Prioritization Mode, page 9-39

Managing Global Bandwidth

The upstream and downstream interfaces are each assigned one default global controller that, by default,
controls the total link traffic. Depending on the Cisco SCE hardware, you can add up to 1024 or 2048,
more global controllers for each interface, and assign a maximum bandwidth of the total link limit to
each global controller separately.

You can also define the bandwidth total link limit to be less than the physical capacity of the SCE
platform for each interface separately. When another device that has limited BW capacity is next to the
SCE platform on the IP stream, you can have this limitation enforced in a policy-aware manner by the
SCE platform, instead of having it enforced arbitrarily by the other device.
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How to View Global Controller Settings
N

Note  Global controller bandwidth is based on Layer 1 volume.
(Accounting, reporting, and subscriber bandwidth control in SCA BB is based on Layer 3 volume.)

Stepl  Inthe Policiestab, click Global Policy.
The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane (Figure 9-1).

Figure 9-1 Global Bandwidth Settings
gl v g i
S | kel iy
|l Puicss | W Cimabumoon Sdd g P
PP | | [ S oy -

T e 1] i Foci  {mrpEn

W S Sy Cof i gl Cordrolies wored fare i itk ed L Bandeaft L

;'M'i'- iy ol e i B ol el il P [ R e —_——

4 [of it Packnge

g Urdrsm fadw g bunage

LT RTT T AT ST S e—— - M

e e P g Jron

Donf il Cactal Zordraiie

T [ p————

e Gobal Froeeatoe Wate, Erforus b el st oo B s of de ik Tl 4 L Sl e Backisge

Py e——— [ Cortguntien_. |

274129

The two check boxes near the top of the Global Controllers tab are used only in dual-link systems (see
How to Define Global Controllers, page 9-11).

The main part of the pane contains the Upstream area listing upstream global controllers and the
Downstream area listing downstream global controllers. Each list has two columns;

» Upstream or Downstream—Displays the hierarchy of global controllers, bandwidth controllers,
and service rules. Each global controller has the bandwidth controllersthat are connected to it listed
as children. Each bandwidth controller has the service rules associated with it listed as children.

» Policy Description—Summarizes the details of the global controller, bandwidth controller, or
service rule in the corresponding column. In the rows containing the global controller details, the
maximum bandwidth value permitted to this global controller is displayed.

For each global controller you can set different values for the maximum bandwidth for each of the
four time frames defined by the default calendar (see Managing Calendars, page 9-68):

— A singlevaluein this field indicates that the maximum bandwidth for this global controller is
constant.

— If each time frame has adifferent maximum bandwidth, the maximum bandwidth for each time
frame is displayed, separated by commas (Figure 9-2).

Figure 9-2 Time Frame Display
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— If two time frames have the same maximum bandwidth, the value is not repeated (Figure 9-3).
(S0 40,,,100 means that the first three time frames have a maximum bandwidth of 40 percent of
the total link limit, and the fourth time frame has a maximum bandwidth equal to the total link
limit.)

Figure 9-3 Time Frame Details

PIR (L3 Kbps)
|Urlirnited |

Mame CIR (L3 Kbps)

Z-Primary Upstream B o

i--Default Upstreann BWC
Lo Priority
*--High Priarity

Unlimited
|Unlimited

|500000
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Above the area (Upstream or Downstream) of each interface, the total link limit is displayed
(Figure 9-4).

Figure 9-4 Total Link Time
Marme CIR{L3K... PIR{L3K... GlobalController AL [
E-Primaty Upstreann BWC 0 Unlirited

Diefaulk Upstream BWC Unlirnited Defaulk Global Controller
“ Lo Priarity ] Unlirited Default Global Controller 1
~High Priority 00000 [Unirited [DeFault Global Contraller Persistent Ig
| &
g

How to Filter Global Controllers

Step 1

Step 2

In the Policies tab, click Global Policy.

The Global Bandwidth Settings are displayed in the right (Rule) pane.
Click Configure Filters.

The Filter View dialog box appears (Figure 9-5).

[l Cisco Service Control Application for Broadband User Guide
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Figure 9-5 Filter View

Filter view

Flease select & Filker.
The filker is far the display only

() Mo Filker

(@ Filer Unknown Subscriber Package:
() Show only Global Controllers

() Filker Bandwidth Controllers

I Finish l ’ Cancel

278y

Step3  Choose one of the filter radio buttons:
- NoFilter
« Filter Unknown Subscriber Package
« Show only Global Controllers
» Filter Bandwidth Controllers
Step4  Click Finish.

The Filter View dialog box closes and the right (Rule) pane is filtered according to your selection.

How to Edit the Total Link Limits

You can limit the total bandwidth for each SCE link passing through the SCE platform.

~

Note  The total bandwidth here means the limit for each link and not the aggregated limit on all the links.

For example, if another device sitting next to the SCE platform on the | P stream has limited BW capacity,
you can limit the bandwidth for each SCE link passing through the SCE platform to match the capacity
of the other device.

The total link limits for upstream and downstream traffic are defined independently.

Stepl  Inthe Policiestab, click Global Policy.
The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.
Step2  Inthe Upstream or Downstream section, click Edit Rate Limit (Figure 9-6).

Cisco Service Control Application for Broadband User Guide
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Note The display appearance of Figure 9-6 depends on the global controller mode setting.

Figure 9-6 SCE Upstream Links - Total Rate Limit

3£ SCE Upstream Links - Total Rate Limit

SCE Upstream Links - Total Rate Limit

Configure the total rate limit For all SCE links.

Selecting ‘Unlimited' means limiting by the physical capacity of the link.

Tatal rate limit for each SCE link (kKbpsy: | |

s

[ oK ” Cancel ]I%

5]

Step3  Select the total rate limit in the Total rate limit for each SCE link (Kbps) field.
Step4  Click OK.

Your changes are saved.

The Global Controller Settings dialog box closes.

How to Add Global Controllers

Depending on the Cisco SCE hardware, you can add up to 1024 or 2048 upstream global controllers and
1024 or 2048 downstream global controllers to a service configuration.

Stepl  Inthe Policiestab, click Global Policy.
The Global Bandwidth Settings dialog box is displayed in the right (Rul€) pane.
Step2  Above the area (Upstream or Downstream) of the desired interface, click “E:' (Add).
The Select Addition mode dialog box appears (Figure 9-7).
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Figure 9-7 Select Addition Mode

Select addition mode

(#)add a new Global Controller:
() Add a Global Contraller and map a Rule and a BW.C ta it

[ Mext l[ Cancel ]

=1 Staret

Step3  Choose the Add a new Global Controller radio button.
Step4  Click Finish.
The Global Controller Settings dialog box appears (Figure 9-8).

Note  The display of Figure 9-8 depends on the global controller mode setting.

Cisco Service Control Application for Broadband User Guide
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Step 5
Step 6

Step 7

Figure 9-8 Upstream Global Controller Settings

3 Upstream Global Controller, Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce.

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links,
as well as a separate rate limit per SCE link.

agagregate Global Contraller

The global controller can enforce a different rate limit per time frame.

(#)iThe same rate limit For all time Frames;

() & different rate limit per time Frame
Single Rate Limit (Kbps)

i Global Controller  Rate Limit
| Agaregate Unlirmited

Per Link Global Contraller
The global controller can enforce a different rate limit per time frame.
(%) The same rate limit for all time frames
() & different rake limit per time frame
Single Rate Limit (Kbps)

| Global Controller  Rate Limit
| Far all Links Unlirnited

CK

] [ Cancel

l

In the Name field enter a meaningful name.

276020

To edit the maximum bandwidth of the global controller, continue with the instructions in the section
How to Set the Maximum Bandwidth of Global Controllers, page 9-9.

Click OK
Your changes are saved.
The Global Controller Settings dialog box closes.
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How to Set the Maximum Bandwidth of Global Controllers

Step 1

Step 2
Step 3

Step 4

Step 5

Note

You can edit the maximum bandwidth that a global controller can carry.
You can set a different maximum bandwidth for each of the four avail able time frames.

You can set different values for each link and for the aggregated BW of all links.

In the Policies tab, click Global Policy.

The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.
Select a global controller.

Click _* (Edit).

The Global Controller Settings dialog box appears (Figure 9-9).

The display of Figure 9-9 depends on the global controller mode setting.

Figure 9-9 Upstream Global Controller Settings

3£ Upstream Global Controller, Settings

Global Controller Settings

Configure the rate limit that this global contraller should enforce.

Marne: DOC

The global controller enforces a L1 rate limit on traffic that is mapped ta it
The global controller can enforce an aggregate rate limit acrass all SCE links,
as well as a separate rate limit per SCE link.

Per Link Global Controller

The global controller can enforce a different rate limit per time frame.

(%) The same rate limit For all bime frames:

() & different rate limit per time Frame
Single Rate Limit (Kbps)

Global Contraller  Rate Limit
| For all Links Unlimited

[ [ 4 H Cancel ]

275763

Set a single value for the maximum bandwidth limit that this global controller carries.

» Choose the The samerate limit for all time frames radio button, and in the Single Rate Limit
(Kbps) field, enter the desired value in Kbps for the maximum bandwidth.

Set the maximum limit that this global controller carries to vary according to time frame.

« Choosethe A different ratelimit per time frame radio button, and enter the desired value for each
time frame (Figure 9-10).

The display of Figure 9-10 depends on the global controller mode setting.
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Note

Step 6

Step 7

Figure 9-10 Upstream Global Controller Settings

3 Upstream Global Controller Settings

Global Controller Settin -k

Configure the rate limit that this global controller should enforce.

Marme: DO(E

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links,
as well as a separate rate limit per SCE link.

agaregate Global Contraller
The global controller can enforce a different rate limit per time frame.
() The same rate limit for all time frames
(%) & different rate limit per time Frame
Reate Limit per Time Frame (Kbps)
[ : o Time Frame T3
Urlimited

Time Frame T2
Urlimited

Global Contraller  Time Frame T1

| Aggregate Unlimited Unlirited

Per Link Global Contraller

The global controller can enforce a different rate limit per time frame.

) The same rate limit For all ime frames

(%) different rate limit per time Frame:

Reate Limit per Time Frame {Kbps)

' Global Contraller  Time Frame T1 | Time Frame T2 Time Frame T3

Time Frame T+

Time Frame T4

| For all Links Urlimited Urlimited Urlimited Unlimited
oK ] [ Cancel %
uy
~
(']

These values will be applied to the time frames of the default calendar.

Click OK
Your changes are saved.

The value in the Policy Description column changes to reflect the new bandwidth limits.

Repeat Step 2 through Step 6 for other global controllers.

[l Cisco Service Control Application for Broadband User Guide
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How to Delete Global Controllers

Step 1

Step 2
Step 3

Note

Step 4

You can delete unused global controllers at any time. The default global controller and the Total Link
Limit cannot be deleted.

In the Policies tab, click Global Palicy.

The Global Bandwidth Settings dialog box appears.
Select aglobal controller.

Click ¥ (Delete).

If asubscriber BWC is using the specified global controller (see How to Edit Package Subscriber BWCs,
page 9-29), aglobal controller cannot be removed messageis displayed. The global controller cannot be
deleted until you unassign it from all subscriber BWCs.

The global controller is deleted.

Click OK

Your changes are saved.

The Global Bandwidth Settings dialog box closes.

How to Define Global Controllers

Note

This section describes how to define global controllers in both dual-link and multi-gigabit Ethernet
systems.

In both systems, you can define each link separately with equal rates or you can define each link
separately with different rates.

Alternatively, you can apply bandwidth limitations as an aggregate for all links or as an aggregate with
individual control of each links.

You can:
1. Control each link separately with equal rate to all links.
2. Control each link separately without with different rate per link.

3. Control the links in aggregate and in addition maximum rate per-link which is equal between all
links.

4, Control the linksin aggregate and in addition maximum rate per-link which is different between the
links.

5. Control the linksin Virtual Link mode.

If Virtual Links mode is enabled, bandwidth limitations are applied to the sum of the all links.

| oL-7205-19
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A

Note  Any attempt to change the global controller bandwidth for invalid link will result in an error message
during apply policy, similar to the following:

“Invalid value set on Link ID 6 for upstream GC ‘ Default Global Controller ‘. Link ID 6 does not exist.
AvailableLink IDs: 1, 2, 3, 4”

The respective edit dialog of the Global Controller settings can be activated by (Figure 9-11):

- Doubleclicking on aglobal controller row inthe global controller table view on the right main panel
of the Global Policy setting.

« Clicking on the edit button that is located on the top right main panel of the Global Policy setting.

&

Note  The behavioral isthe same whether configure upstream or downstream GC.

Figure 9-11 Global Controller Settings Activation
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Refer to the following sections for configuration details:
- How to Set Global Controller Bandwidth Limits with Equal Rate for all Links, page 9-13

- How to Set Global Controller Bandwidth Limits Separately with a Different Rate Per Link,
page 9-15

» How to Set Global Controller Bandwidth Limitsasthe Sum of all Linkswith an Equal Rate per Link,
page 9-18

» How to Set Global Controller Bandwidth Limits as the Sum of all Links with a Different Rate per
Link, page 9-21

» How to Set Global Controller Bandwidth for Virtual Links, page 9-25

How to Set Global Controller Bandwidth Limits with Equal Rate for all Links

Step 1

Step 2
Step 3

Step 4
Step 5

Use the following procedure to configure the global controller with equal rate for all links.

In the Policies tab, click Global Palicy.

The Global Bandwidth Settings dialog box in the right (Rule) pane.

Add global controllers, as described in How to Add Global Controllers, page 9-6.
Click Edit Preferences.

The Global Controllers mode dialog box appears (Figure 9-12).

Figure 9-12 Global Controllers Mode

Global Controllers mode

Select the Global Contrallers mode

Link Modes

Ina dual link system, each G has a counterpart GC on the other link.,
It is possible to configure separate rate limits For each GC on each link, and to enforce a limit on the aggregated rate of this pair of GCs.
wirkual Links mode allows setting virkual links,

[C1Enforee B limitation on the sum of twa links
[1Enable separate BYW settings for sach link

wirtual Lirks
[C1Enable virtual Links Made

B Prioritization Mode

In Global Prioritization Mode, flaws that go through inkernal B contrallers get their Relative Priority From the B\W controller's Bssurance Level.
In Subscriber Prioritization Mode, the Fows' Relative Priarity is determined by the Relstive Priority of the subscriber,

(% Global Prioritization Made
() Subscriber Prioritization Mode

[. Finish_J[ Cancel J E

Verify that the Link Modes check boxes are unchecked.
Click Finish.

The Global Controllers mode dialog box closes.
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Step6  Inthe Policiestab, click Global Policy.

The Global Bandwidth Settings dialog box is displayed in the right (Rul€) pane.
Step7  Select aglobal controller.
Steps8  Click _ ™ (Edit).

The Global Controller Settings dialog box appears (Figure 9-13).

Figure 9-13 Upstream Global Controller Settings

3 Upstream Global Controller Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Marne: DO(E

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links,
as well as a separate rate limit per SCE link.

Per Link Global Contraller

The global controller can enforce a different rate limit per time frame.

(%) The same rate limit For all tme frames:

() & different rate limit per time Frame
Single Rate Limit (Kbps)
Global Contraller | Rate Limit
| For all Links Urlimited

oK ] [ Cancel

275787

Note  If theratelimit for all time framesisto be the same, use Step 9. If therate limit for all time framesisto
vary by time frame, use Step 10.

Step9  Set asingle value for the maximum bandwidth limit that this global controller carries.
a. Choose the The samerate limit for all time frames radio button.

b. Enter the desired value in Kbpsfor the maximum bandwidth in the Rate limit for the Per Link Global
Controller (in Kbps) field.

Step10  Set the maximum limit that this global controller carries to vary according to time frame.
a. Choosethe A different rate limit per time frame radio button.
b. Enter the desired value for each time frame (Figure 9-14).
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Figure 9-14 Upstream Global Controller Settings

3 Upstream Global Controller Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Marme: DO(E

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links,
as well as a separate rate limit per SCE link.

Per Link Global Contraller
The global controller can enforce a different rate limit per time frame.

() The same rate limit for all time frames

(%) different rake limit per time Frame:

Reate Limit per Time Frame (Kbps)
Global Contraller | Time Frame T1 | Time Frame T2 | Time Frame T3 Time Frame T4
| For all Links Urlimited Urlimited Urlimited Unlimited

Ok, H Cancel ]

275768

Step11 Click OK
Your changes are saved.

How to Set Global Controller Bandwidth Limits Separately with a Different Rate Per Link

Use the following procedure to configure the global controller with a different rate per link.

Stepl Inthe Policiestab, click Global Policy.

The Global Bandwidth Settings dialog box in the right (Rule) pane.
Step2  Add global controllers, as described in How to Add Global Controllers, page 9-6.
Step3  Click Edit Preferences.

The Global Controllers mode dialog box appears (Figure 9-15).
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Figure 9-15 Global Controller Mode

Global Controllers mode

Select the Global Controllers mode

Link Modes

In-a dual link system, each SC has a counterpart GC on the ather link.
1t is possible to configure separate rate limits for each GC on each link,and to enforce a limit on the aggregated rate of this pair of GCs.
Wirkual Links mode allows sekting wirtual links,

[CJEnforce B limikation on the sum of kwa links
Enable separate B\W settings For each link

Wirbual Links
[C]Enable Virkual Links Mode

B'W Prioritization Mode

In Global Prioritization Mode, Flows that go through internal BW controllers get their Relative Priority From the B'W controller's Assurance Level,
In Subscriber Prioritization Mode, the flows' Relative Priority is determined by the Relative Priority of the subscriber,

(3 Global Prioritization Mode
() subscriber Prioritization Mode

Finish J [ Cancel ‘

275769

Step4  Check the Enable separate BW setting for each link check box.
Step5  Click Finish.
The Global Controllers mode dialog box closes.
Step6  Inthe Policies tab, click Global Policy.
The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.
Step7  Select aglobal controller.
Steps  Click _ " (Edit).
The Global Controller Settings dialog box appears (Figure 9-16).
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Figure 9-16 Downstream Global Controller Settings

3 Upstream Global Controller Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Marme: DO(E

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links,
as well as a separate rate limit per SCE link.

Global Controllers

The global controller can enforce a different rate limit per time frame.

(%) The same rate limit For all tme frames:

() & different rate limit per time Frame

Single Rate Limit (Kbps)

Global Contraller  Rate Limit i
| For Link 1 Urlimited
For Link 2 Urlimited
For Link 3 Urlimited
For Link 4 Urilimited
For Link 5 Urlimited
For Link & Unlimited
For Link 7 Urlimited
For Link § Urlimited
| For Link 9 Urilimnited h
oK l [ Cancel E
2
(o]

Note  If theratelimit for all time framesisto be the same, use Step 9. If therate limit for all time framesisto
vary by time frame, use Step 10.

Step9  Set asingle value for the maximum bandwidth limit that this global controller carries for each link.
a. Choose the The samerate limit for all time frames radio button

b. Enter thedesired valuein Kbpsfor the maximum bandwidth in the Rate limit for the Per Link Global
Controller (in Kbps) field.

Step 10  Set the maximum limit that this global controller carries to vary according to time frame for each link.
a. Choosethe A different rate limit per time frame radio button.

b. Enter the desired value for each time frame (Figure 9-17).

Cisco Service Control Application for Broadband User Guide
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Figure 9-17 Upstream Global Controller Settings

3 Upstream Global Controller Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Marne: DOC :

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links,
as well as a separate rate limit per SCE link.

Global Controllers
The global controller can enforce a different rate limit per time frame.
() The same rate limit for all time frames

(%) different rake limit per time Frame:

Reate Limit per Time Frame (Kbps)

Global Controller Time Frame T1 - Time Frame T2 Time Frame T3 Time Frame T4 #

| For Link 1 Urlimited Urlimited Urlimited Unlimited
For Link 2 Urlimited Urlimited Urlimited Unlirnited
For Link 3 Urlimited Urlimited Urlimited Unlimited %
For Link 4 Urilimited Urlimited Urlimited Unlimited
For Link 5 Urlimited Urlimited Urlimited Unlirnited
For Link & Unlimited Unlimited Unlimited Unlimited
For Link 7 Urlimited Urlimited Urlimited Unlimited
For Link § Urlimited Urlimited Urlimited Unlimited
Far Link 2 Unlinnited Unlirnited Unlirnited Unlirnited ~
oK l [ Cancel ] I
Click OK

Your changes are saved.

275771

How to Set Global Controller Bandwidth Limits as the Sum of all Links with an Equal Rate per Link

Step 1

Step 2
Step 3

Inthislink control mode the maximum bandwidth limitation is configured as sum of all links. When you
create a GC in this mode you can configure the aggregate global controller of the link and in addition
you can configure the maximum rate per link. In this mode you can enforce bandwidth limitation on the
sum of all links and control the links in aggregate and in addition maximum per-link which is equal

between all links.

Use the following procedure to configure global controller as the sum of all links with an equal rate per

link.

In the Policies tab, click Global Palicy.
The Global Bandwidth Settings dialog box in the right (Rule) pane.

Add global controllers, as described in How to Add Global Controllers, page 9-6.

Click Edit Preferences.
The Global Controllers mode dialog box appears (Figure 9-18).
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Figure 9-18 Global Controllers Mode

Global Controllers mode

Select the Global Controllers made

Link Mades

In & dual link svstem, each GC has a counterpart GC on the other link.
It is possible to configure separate rate limits for each GC on each link, and to-enforce & limit on the aggregated rate of this pair of GCs,
Wirtual Links mode allows setting virtual links,

Enforce BW limitation on the sum of bwa links
[C1Enable separate BYW settings for each link

Wirbual Lirks
[1Enable Yirtual Links Mode

B Prioritization Mods

In Global Prioritization Mode, Fows that go throogh internal BW controllers get their Relative Priority from the BW controller's dssurance Level,
In Subscriber Prioritization Mode, the Flows' Relative Priority is determined by the Relative Priority of the subscriber,

() Global Prioritization Mode
() Subscriber Prioritization Mode

[ Finish ][ Canicel J

275772

Step4  Check the Enforce BW limitation on the sum of the links check box.
Step5  Click Finish.
The Global Controllers mode dialog box closes.
Step6  Inthe Policiestab, click Global Policy.
The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.
Step7  Select aglobal controller.
Step8  Click _ " (Edit).
The Global Controller Settings dialog box appears (Figure 9-19).
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Figure 9-19 Upstream Global Controller Settings

3 Upstream Global Controller Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Marne: DO(E

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links,
as well as a separate rate limit per SCE link.

agaregate Global Contraller

The global controller can enforce a different rate limit per time frame.

(%) The same rate limit For all ime Frames:

() & different rate limit per time Frame
Single Rate Limit (Kbps)

Global Contraller  Rate Limit
| Aggregate Unlimited

Per Link Global Contraller
The global controller can enforce a different rate limit per time frame.
(%) The same rate limit for all time frames
() & different rake limit per time Frame
Single Rate Limit (Kbps)

Global Contraller  Rate Limit
| For all Links Urlimited

oK ] [ Cancel

275773

Note  If theratelimit for all time framesisto be the same, use Step 9. If therate limit for all time framesisto
vary by time frame, use Step 10.

Step9  Set asingle value for the maximum bandwidth limit that this global controller carries.

a. Choosethe The samerate limit for all time frames radio button on the Aggregate Global
Controller tab.

b. Enter the desired value in Kbpsfor the maximum bandwidth in the Rate limit for the Per Link Global
Controller (in Kbps) field.

Step10  Set the maximum limit that this global controller carries to vary according to time frame.
a. Choosethe A different ratelimit per timeframeradio button the Aggregate Global Controller tab.
b. Enter the desired value for each time frame (Figure 9-20).
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Figure 9-20 Upstream Global Controller Settings

3 Upstream Global Controller Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Marne: DOC

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links,
as well as a separate rate limit per SCE link.

agaregate Global Contraller
The global controller can enforce a different rate limit per time frame.
() The same rate limit for all time frames
(%) & different rate limit per time Frame
Reate Limit per Time Frame (Kbps)

Global Contraller | Time Frame T1 | Time Frame T2 | Time Frame T3 Time Frame T4
| Aggregate Unlimited Unlimited Unlimited Unlirited

Per Link Global Contraller

The global controller can enforce a different rate limit per time frame.
() The same rate limit for all time frames

(%) different rate limit per time Frame:

Reate Limit per Time Frame {Kbps)

Global Contraller | Time Frame T1 | Time Frame T2 | Time Frame T3 Time Frame T4
For all Links Urlimited Urlimited Urlimited Unlimited

oK ] [ Cancel

275774

Click OK
Your changes are saved.

How to Set Global Controller Bandwidth Limits as the Sum of all Links with a Different Rate per Link

In thislink control mode the maximum bandwidth is the sum of links but bandwidth settings can be
configured for each link up the maximum bandwidth for all links. When you create a GC in this mode
you can configure the aggregate global controller of the link and in addition specify a bandwidth
limitation per link. This mode is used when the SCE serves multiple edge devices and you want to
enforcetwo rules: One aggregate rule on all the linkstogether and one rule per specific link. In thismode
you can enforce bandwidth limitation on the sum of all links and enabl e separate bandwidth settings for
each link. You can control the links in aggregate and set maximum rate per-link which is different
between the links.

Use the following procedure to configure global controller as the sum of all links with a different rate
per link.

| oL-7205-19
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Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7
Step 8

In the Policies tab, click Global Palicy.

The Global Bandwidth Settings dialog box in the right (Rule) pane.

Add global controllers, as described in How to Add Global Controllers, page 9-6.
Click Edit Preferences.

The Global Controllers mode dialog box appears (Figure 9-21).

Figure 9-21 Global Controllers Mode

Global Controllers mode

Select the Global Controllers mode

Lirk Modes

In-a dual link system, each GC has a counterpart GC on the ather link.
1t is possible to configure separate rate limits for each GC on each link,and to enforce a limit on the aggregated rate of this pair of GCs.
sirkual Links mode allows sekting wirtual links,

Enforce Bw limitation on the sum of bwo links
Enable separate B\ settings for each link

wirbual Lirks
[C]Enable virtual Links Made

B'W Prioritization Mode

In Global Prioritization Maode, Flows that go through inkernal BvW controllers get their Relative Priority from the BW contraller's Assurance Level,
In Subscriber Prioritization Made, the Flows' Relative Priotity is determined by the Relative Priority of the subscriber.

(#3 Global Priotitization Mode
{3 Subscriber Prioritization Mode

l_ Finish J[ Cancel

N3
&

Check the Enforce BW limitation on the sum of thelinks and Enable separate BW setting for each

link check boxes.

Click Finish.

The Global Controllers mode dialog box closes.

In the Policies tab, click Global Palicy.

The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.
Select a global controller.

Click _* (Edit).

The Global Controller Settings dialog box appears (Figure 9-22).
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Figure 9-22 Upstream Global Controller Settings

3 Upstream Global Controller Settings |Z|@

Global Controller Settings
CullFigure the rate limit that this global controller should enforce.

Marme: DO(E

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links,
as well as a separate rate limit per SCE link.

Agaregate Global Contraller

The global controller can enforce a different rate limit per time frame.

(%) The same rate limit For all bime Frames:

() & different rate limit per time frame
Single Rate Limit (Kbps)
Global Contraller | Rate Limit
| Aggregate Unlimited

Per Link Global Contraller
The global controller can enforce a different rate limit per time frame.
(%) The same rate limit for all time frames
() & different rate limit per time frame
Single Rate Limit (Kbps)

Global Controller  Rate Limit s
| Far Link 1 Urlimited
For Link 2 Unlimited
For Link 3 Urlimited
For Link 4 Urlimited
For Link 5 Unlirnited
For Link & Urlimited
For Link 7 Urlimited
For Link § Urlimited
| For Link 9 Urlimited bl
K l [ Cancel

275776

Managing Bandwidth 1l

If therate limit for all time framesisto be the same, use Step 9. If the rate limit for all time framesisto

vary by time frame, use Step 10.

Set asingle value for the maximum bandwidth limit that this global controller carries.

a. Choosethe Thesameratelimit for all timeframesradio button on the Per Link Global Controller

tab.

b. Enter the desired value in Kbps for the maximum bandwidth in the Rate limit for the Link 1 (in

Kbps) field.
c. Repeat Step 9b for each link.

| oL-7205-19
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Step 10

Step 11

Set the maximum limit that this global controller carries to vary according to time frame.

a. Choosethe A different rate limit per time frame radio button the Per Link Global Controller tab.

b. Enter the desired value for each time frame.
¢. Repeat Step 10b for each link (Figure 9-23).

Figure 9-23 Downstream Global Controller Settings

3£ Upstream Global Controller Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce,

Marne: DOC

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links,
as well as a separate rate limit per SCE link.

aggregate Global Contraller
The global controller can enforce a different rﬁe limit per time frame.
() The same rate limit For all time frames
(%) & different rate limit per time frame
Feate Limit per Time Frame (kbps)

Global Contraller | Time Frame T1 | Time Frame T2 | Time Frame T3 Time Frame T4
| Aggregate Unlirnited Unlirited Unlirited Unlirnited

Per Link Global Contrallzr

The global controller can enforce a different: rate limit per time frame.

) The same rate limit For all time: frames

() giferent rate Imit per time frame:
Feate Limit per Time Frame (kbps)

Global Controller  Time Frame T1 - Time Frame T2 Time Frame T3 Time Frame T4 #

| Far Link 1 Urlimited Urlimited Urlimited Unlirnited
For Link 2 Unlimited Unlimited Unlimited Unlirited
For Link 3 Urlimited Urlimited Urlimited Unlimited
For Link 4 Urlimited Urlimited Urlimited Unlirnited
For Link 5 Unlimited Unlimited Unlimited Unlirited
For Link & Urlimited Urlimited Urlimited Unlimited
For Link 7 Urlimited Urlimited Urlimited Unlimited
For Link 8 Unlirnited Unlirnited Unlirnited Unlirnited
| For Link 9 Unlirnited Unlirnited Unlirrited Unlirnited il
K l [ Cancel
Click OK

Your changes are saved.
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How to Set Global Controller Bandwidth for Virtual Links

Step 1

Step 2
Step 3

Step 4
Step 5

Step 6

Step 7
Step 8

In this mode you can control each link separately using configured rate templates and default rates. The
template rate limits are applied to newly created virtual links. The default rate limits are applied to the
default virtual link (virtual link 0).

Use the following procedure to configure Global Controller for Virtual links.

In the Policies tab, click Global Policy.

The Global Bandwidth Settings dialog box in the right (Rule) pane.

Add global controllers, as described in How to Add Global Controllers, page 9-6.
Click Edit Preferences.

The Global Controllers mode dialog box appears (Figure 9-24).

Figure 9-24 Global Controllers Mode

Global Controllers mode

Select the Global Controllers mode

Lirk Modes

In a dual link system, each GC has a counterpart GC on the other link.
1t is possible to configure sepatate rate limits for each GC on each link,and to enforce a limit on the aggregated rate of this pair of GCs.
Wirtual Links mode allows setting virtual links.

Wirbual Links
Enable virtual Links Mode

B'W Prioritization Mode

In Global Prioritization Made, flaws that go through inkernal B contrallers get their Relative Prioricy From the BW controller's Assurance Level,
In Subscriber Prioritization Maode, the Flows' Relative Priority is determined by the Relative Priority of the subscriber.

(#) clobal Prioritization Mode

(3 Subscriber Prioritization Mode

[__ Firish J[ Cancel

275778

Check the Enable Virtual Links Mode check box.

Click Finish.

The Global Controllers mode dialog box closes.

In the Policies tab, click Global Policy.

The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.
Select a global controller.

Click _* (Edit).

The Global Controller Settings dialog box appears (Figure 9-25).

| oL-7205-19
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Figure 9-25 Upstream Global Controller Settings

3 Upstream Global Controller Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Mame: ..Déf.;au.lt 'Glnlz;i:-éi'(:-'nllﬂltréller I s
The global controller enforces a L1 rate limit on traffic that is mapped to ik,

The global controller enforces an aggregate rate limit across all SCE links
belonging to the same virtual link.

In wirtual links mode, rate limits for each virtual link are provisioned
dynamically to the SCE, vet Template' and 'Default’ values allovs static
Proviosioning:

‘Template' rate limits apply to newly-created virtual links,

‘Default’ rate limits apply to the default virbual link (virtual link 03,

Termplate Yirtual Link

The global controller can enforce a different rate limit per time frame.

(%) The same rate limit Ffor all tme frames:

() & different rake limit per time Frame
Single Rate Limit (Kbps)

Wirtual Link | R.ate Limit
Template Unlimited

Default Virkual Link
The global controller can enforce a different rate limit per time frame.
(%) The same rate limit For all time: Fframes
() & different rake limit per time frame
Single Rate Limit (Kbps)

Wirtual Link | Rate Limit
Default Unlimited

oK l [ Cancel

275779

Note  If theratelimit for all time framesisto be the same for the Template Virtual Link, use Step 9. If therate
limit for all time framesisto vary by time frame for the Template Virtual Link, use Step 10.

Step9  Set asingle value for the maximum bandwidth limit that this global controller carries.
a. Choosethe The samerate limit for all time framesradio button on the Template Virtual Link tab.

b. Enter the desired value in Kbps for the maximum bandwidth in the Rate limit for the Link 1 (in
Kbps) field.

Step10  Set the maximum limit that this global controller carries to vary according to time frame.

a. Choosethe A different rate limit per time frame radio button the Template Virtual Link tab.
b. Enter the desired value for each time frame.

Cisco Service Control Application for Broadband User Guide
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Note  If theratelimit for all time framesisto be the same for the Default Virtual Link, use Step 11. If therate
limit for all time framesisto vary by time frame for the Default Virtual Link, use Step 12.
Step 11  Set asingle value for the maximum bandwidth limit that this global controller carries.
a. Choosethe The samerate limit for all time frames radio button on the Default Virtual Link tab.
b. Enter the desired value in Kbps for the maximum bandwidth in the Rate limit for the Link 1 (in
Kbps) field.
Step 12 Set the maximum limit that this global controller carriesto vary according to time frame.
a. Choosethe A different rate limit per time frame radio button the Default Virtual Link tab.
b. Enter the desired value for each time frame (Figure 9-26).
Figure 9-26 Upstream Global Controller Settings
3£ Upstream Global Controller, Settings
Global Controller Settings
Configure the rate limit that this global contraller should enfarce,
Marne: ..Dél’nau-lt .Glu.:;i:ua.i .Cu.al.w.trﬁller
The global controller enforces a L1 rate limit on traffic that is mapped ta ik,
The global controller enforces an aggregate rate limit across all SCE links
belonging to the same virtual link.
In wirtual links mode, rate limits for each virtual link are provisioned
dynamically ko the SCE, wet ‘Template' and 'Default’ values allow static
proviosioning:
‘Termplate' rate limits apply to newly-created virtual links,
‘Diefault’ rate limits apply to the default virbual link (virtual link 07,
Template Yirbual Link
The global controller can enforce a different rate limit per time frame,
) The same rate limit For all time frames %
(%) & different rate limit per time frame
Rate Limit per Time Frame {Kbps)
Wirkual Link | Time Frame T1 | Time Frame T2 | Time Frame T3 | Time Frame T4
Template Unlimited Unlimited Unlimited Unlimited
Default Virkual Link
The global controller can enforce a different rate limit per time frame.,
() The same rate limit For all time frames
(%) different rake limit per time Frame!
Feate Limit per Time Frame {Kbps)
Wirtual Link | Time Frame T1 | Time Frame T2 | Time Frame T3 | Time Frame T4
Diefault Unlimited Unlimited Unlimited Unlimited
s[4 l [ Cancel ] §
&
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Step13  Click OK

Your changes are saved.

Managing Subscriber Bandwidth

After you have defined global controllers, you can add subscriber BWCs to packages and map these
subscriber BWCs to different global controllers.

A Subscriber BWC controls subscriber bandwidth consumption for upstream or downstream flows. It
controls and measures the bandwidth of an aggregation of traffic flows of a service or group of services.

Each package has its own set of BWCs that determine the bandwidth available per package subscriber
for each available service.

The two Primary BWCs, one for upstream traffic and one for downstream traffic, allocate bandwidth to
specific subscribers, depending upon the Committed I nformation Rate (CIR), the Peak Information Rate
(PIR), and the Subscriber relative priority settings. You can configure these parameters, but the Primary
BWCs cannot be deleted.

There are two default BWCs, one for upstream traffic and one for downstream traffic. By default, all
services are mapped to one of these two BWCs. The BWC mechanism controls rate subpartitioning
within the default BWC rate control, based on the CIR, PIR, and AL. You can configure these
parameters, but the default BWCs cannot be del eted.

You can add up to 32 user-defined BWCs per package:

» Subscriber BWCs operate at the service-per-subscriber level. They allocate bandwidth for each
subscriber’s service, based upon the CIR, PIR, global controller and Assurance Level (AL) set for
the BWC. Each rule defines a link between the service's flows and one of the BWCs (unless the
flows are to be blocked). See How to Define Per-Flow Actions for a Rule, page 9-59.

« ExtraBWCs also operate at the subscriber level. Extra BWCs (based on the CIR, PIR, global
controller, and AL) can be allocated for services that are not included in the Primary BWC. These
are services that are not often used but have strict bandwidth requirements, for example, video
conference calls. The ExtraBWCs are BWCsthat control asingle service (or service group). BWCs
cannot borrow bandwidth from Extra BWCs and vice versa.

Each user-defined BWC controls either downstream or upstream traffic.

The Cisco SCE supports a maximum of 2000 BWCs. You cannot apply a PQB file to an SCE if thefile
contains more than 2000 BWCs. But, the Subscriber BWCs with same values for GC Index, AL Level,
PIR, and CIR are considered as a single BWC; even if the BWCs are mapped to different flows. So, in
effect, Cisco SCA BB may support more than 2000 BWCs.

A

Caution  If you enable or disable Virtual Links mode, all user-defined global controllers are deleted from the
service configuration. A BWC that pointed to a user-defined global controller now points to the default
global controller. (Other parameters of these BWCs remain unchanged.)

» Subscriber BWC Parameters, page 9-29
» How to Edit Package Subscriber BWCs, page 9-29
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Subscriber BWC Parameters
The Subscriber BW Controllers tab of the Package Settings dialog box has the following configuration
parameters:
- Name—A unique name for each BWC.
e CIR (L3 Kbps)—The minimum bandwidth that must be granted to traffic controlled by the BWC.
e PIR (L3 Kbps)—The maximum bandwidth allowed to traffic controlled by the BWC.

Note  The minimum bandwidth for a subscriber BWC is 16 Kbps with a granularity of 1 Kbps and the
maximum bandwidth is 500000 K bps.

» Global Controller—Theglobal controller with which thisBWC isassociated. The global controllers
are virtual queues that are part of the bandwidth control mechanism. Direct traffic with similar
bandwidth control properties to the same global controller.

» AL—How fast bandwidth either decreases from the PIR to the CIR as congestion builds or else
increases from the CIR to the PIR as congestion decreases. A higher AL ensures a higher bandwidth
compared to asimilar BWC with alower AL. The lowest assurance value is 1, the highest is
Persistent.

Assurance Level 10 (persistent) never goes below the relevant CIR, unless the total line rate cannot
sustain this.

» Subscriber relative priority—Assurance Level given to the Primary BWC of the subscriber. It
determines the assurance given to all the subscriber traffic when competing for bandwidth with
subscribers to other packages. The lowest value is 1; the highest is 10.

Note  Subscriber bandwidth control (and accounting and reporting) is based on Layer 3 volume.
Global controller bandwidth is based on Layer 1 volume.

How to Edit Package Subscriber BWCs

Stepl  Inthe Policies tab, click Global Policy.
The Global Bandwidth Settings dialog box in the right (Rule) pane.

Step2  Intheright (Rule) pane, select aBWC and click _*. (Edit).
The Package Settings dialog box appears.

Step3  In the Package Settings dialog box, click the Subscriber BW Controllers tab.
The Subscriber BW Controllers tab opens (Figure 9-27).

Cisco Service Control Application for Broadband User Guide
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Figure 9-27 Subscriber BW Controllers Tab

Package Settings for "Basic Package”

General | Quota Management |; Subscriber BW Controllers || Advanced |

Subscriber B\W Controllers limit the B\ of transaction groups and prioritize between transactions of different services
for a single subscriber. They are also used For linking services to Global Controllers,

rUpskream

Subscriber relative priarity (upstream): 1 v ! @ @ b4

lame CIR (kbps)  PIR (kbps) = Global Contraller AL |

B Primary Upstream B 0 Unlimited

~-Default Upstream BWC 0 nlirnited Default Global Controller 1

rDownstream

Subscriber relative priarity (downstream): |1 v! @ @l >4

! Mame CIR (kbps)  PIR (kbps) = Global Contraller Al |

Unlimited

~--Digfault Dawnstreann BwC o Unlimited Default Global Controller 1

[ QK ][ Cancel ]
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Step4  Set your requirements for upstream bandwidth control in the Upstream area of the dialog box.
a. Select avalue from the Subscriber relative priority drop-down list.
b. Set the parameters for the Primary Upstream BWC.
— Inthe CIR field, enter the BWC CIR in Kbps.
— InthePIR field, select Unlimited from the drop-down list, or enter the BWC PIR in Kbps.
c. Toadd BWCsto the package, click @ (Add asub BW Controller) once for each additional BWC.

d. To add Extra BWCs to the package, click @I (Add an extra BW Controller) once for each
additional BWC.

e. Set the parameters for each BWC (including the Primary and Default BWCs).

— (Optional) In the Name field, enter a meaningful name for each BWC. (You cannot rename the
Primary or Default BWCs.)

— Inthe CIR field, enter avalue for the BWC CIR in Kbps.

— InthePIRfield, select Unlimited from the drop-down list, or enter avalue for the BWC PIR in
Kbps.

— To set the global controller with which this BWC is associated:
Click in the Global Controller cell of the BWC, and then click the Browse button that appears.
The Select a Global Controller dialog box appears (Figure 9-28).
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Figure 9-28 Select a Global Controller

3£ Select a Global Controllers |Z|@@

Select a global controllers for the service element

Default Global Contraller
uz2
Upstream Controller 1

Cancel

210585

— Select aglobal controller and click OK.
— Select avalue from the AL drop-down list.
Step5  Repeat Step 3 for downstream bandwidth control in the Downstream area of the dialog box.
Step6  Click OK.
The Package Settings dialog box closes.
All changes to the BWC settings are saved.

Managing Bandwidth: a Practical Example

This section explains how to achieve effective bandwidth control by combining the configuration of
global controllers and subscriber BWCs, and gives a practical example.

« How to Configure Total Bandwidth Control, page 9-32
» Example: How to Limit P2P and Streaming Traffic Using the Console, page 9-32
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How to Configure Total Bandwidth Control

Step 1

Step 2

Step 3

Configure the necessary global controllers.

Ascertain which services are likely to be problematic, and what the maximum total bandwidth should be
for each. You do not need to configure services and packages that are unlikely to be problematic; you
can include them in the default global controllers.

Configure the subscriber BWCs for the package.

a. Add asubscriber BWC for each type of upstream or downstream traffic that you want to limit, and
configure the CIR and the PIR accordingly.

b. Select an appropriate global controller for each subscriber BWC.

For each service that is to have its own BWC, create a rule and select appropriate upstream and
downstream BWCs.

Example: How to Limit P2P and Streaming Traffic Using the Console

~

Note

Y

Note

Step 1

Step 2

This example assumes that the traffic flow isbidirectional; you may decide that you only need upstream
controllers or downstream controllers.

The P2P Traffic Optimization wizards allow you to create a simple model of devices, connect to them,
and limit P2P traffic to a specified bandwidth. (See How to Use the P2P Traffic Optimization Wizards,
page 4-47.)

In the Policies tab, click Global Palicy.
The Global Bandwidth Settings dialog box in the right (Rule) pane.

Add two upstream global controllers and two downstream global controllers and assign the desired
bandwidth to each global controller (Figure 9-29).

Figure 9-29 Global Bandwidth Settings
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(Here, Upstream Controller 1 and Downstream Controller 1 will be used for P2P traffic, and Upstream

Controller 2 and Downstream Controller 2 will be used for streaming traffic.)

Step3  In aPackage Settings dialog box (Figure 9-30), add two upstream BWCs and two downstream BWCs,
map them to the appropriate global controllers, and set their parameters (CIR, PIR, AL).

Figure 9-30 Package Settings

Package Settings for, "Gold®

General | Quota Managementl Subscriber BW Controllers | Advanced

Subscriber BW Controllers limit the BW of transaction groups and prioritize between transactions of different services
for a single subscriber, They are also used for linking services to Global Controllers,

Upstream
Subscriber relative priority (upstream): @ @l x
Mame CIR{L3EK,.. PIR(L3K... Global Controller Al
ry pstream BWC Unlimited
-Diefault Upstream B 0 Unlinited Default Global Contraller 1
B 1 0 nlinited Upstrean Global Contraller 1 1
B 2 1] Unlimited Upstrean Global Contraller 2 1
Downstream
Subscriber relative priority (downstream): @ @l x
Mame CIR{L3EK,.. PIR(L3K... Global Controller Al

B Primary Downstream Unlimited
Lnlinnited Default Glabal Contraller 1

--Defaulk Downstream BWC a
EBWC 3 0 Unlimited Downstreamn Glabal Contraller 1|1
BT 4 1] Unlimited Downstream Global Cantraller 2 (1

[ 9 ” Cancel ]

274077

(Here, BWC1 will be for upstream P2P traffic and BWC3 will be for downstream P2P traffic; BWC2
will be for upstream streaming traffic and BWC4 will be for downstream streaming traffic.)

Step4  Add arule for the P2P service (Figure 9-31).
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Figure 9-31 Add New Rule to Package

Add New Rule to Package “Gold™

General | Control | Usage Limits | Ereach Handling

Service

Select the Service to which the Rule will relate:

Rule State
Define the state of this Rule:

() Enable reporting and active actions

() Disable reporting and active actions

’ K ” Cancel ]

274075

Step5  Inthe Control tab (Figure 9-32), assigh BWC 1 as the upstream BWC and BWC 3 as the downstream
BWC.
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Figure 9-32 Control Tab

| Genen;l-i ontrol | Usage Limits | Breach Handing|

Define the per-Flow action to be performed by this Rule:

() Block the Flow

(%) Control the flow's characteristics:

Select an upstream Bandwidth Contraller !BWC 1

Select a downstream Bandwidth Controller !BWC 3

[ Limit the Flow's upstream bandwidth ko |7| Khips
[ Limit the Flow's downstream bandwidth to |—‘ bps
[] 5et the Flow's upstream packets ToS (DSCP) ko

[] 5et the flaw's dawnstream packets TaS (DSCPYta 7o 1 [0]

[ Limit concurrent Flows of this Service to | |

Set Cos far Flows of this Service to IBE W |

[ Redirect profile Far this service:

[ Mirrar traffic bo server group:  Server Group

[ O, ][ Cancel ]
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[
-

Repeat Step 4 and Step 5 for the Streaming service, using BWC 2 as the upstream BWC and BWC 4 as

Step 6
the downstream BWC.
All subscriber traffic using these services will be added to the virtual queue total for these queues. In
turn, the bandwidth available to the subscriber for these protocols will fluctuate, depending on how
“full” these queues are.

Step7  Click Global Policy to view the hierarchy of the GCs, BWCs, and rules (Figure 9-33).
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Figure 9-33 Rule Hierarchy
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How to Configure a Rule, Bandwidth Controller, and Global Controller Using the

Wizard

Step 1

Step 2

Step 3
Step 4

You can configure arule, BWC, and GC together from the Global Policy window.

In the Policies tab, click Global Palicy.
The Global Bandwidth Settings are displayed in the right (Rule) pane.

Above the area (Upstream or Downstream) of the desired interface, click .:::. (Add).

The Select addition mode dialog box appears.

Choose the Add a Global Controller and map a Rule and BWC to it radio button.

Click Finish.

The GC Selection dialog box appears (Figure 9-34).
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Figure 9-34 Upstream GC Selection

Upstream GC selection

@ Please choose a GC {existing or a new GZ name)

Please select a Global Contraller,
The contraller can be an existing one of you can create one.
Select the button to choose an existing GC or bype the name of a new GC.

GC | | [Select...]

PIR: | Unlimited |

273440

Step5  Inthe GC field, enter anew GC name, or click Select to choose an existing GC.

Step6  (Optional) In the PIR field, enter the maximum bandwidth limit that this global controller carriesin
Kbps.

Step7  Click Next.
The Service and Packages selection dialog box appears (Figure 9-35).
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Figure 9-35 Upstream Service and Packages Selection

Upstream Service and Packages selection

3 Please chonse an existing Service

“lease select a Service and the Packages.
A Service Rule will be crated For them, if one is not already defined.
The directional pre-breach B\WContraller will be defined in the next page

Service:

Packages:

[] Default Package

[] Bronze Package

7 silver Package

[] Gold Package

] Unknown Subscriber Traffic

Select al... ] [Deselect all...

Cancel

243355

Step8  Inthe Service field, select an existing service.
Step9  Inthe Packages section, select one or more packages for the rule to apply to.

If arule does not exist for the service, it is created. The new, or existing rule is then mapped to the
selected package or packages.

Step10  Click Next.
The BWC selection dialog box appears (Figure 9-36).
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Figure 9-36 Upstream BWC Selection

Upstream BWC selection
@ Please choose an Upstreanm BWiC (existing or a new BWC name)
Please select a BwiContraller,
The contraller can be an existing one of you can create one.
Select the button to choose an existing BWC o type the name of a new B,
swc ]
@
2
2
o

Enter a new BWC name, or click Select to choose an existing BWC.
Click OK.

How to Set BW Management Prioritization Mode

Step 1

Step 2

Relativepriority isthelevel of assurance that an internal BWC (iBWC) receives when competing against
other iBWCs for bandwidth.

The relative priority of the flow that goes through an iBWC is determined by the relative priority of one
of:

e TheiBWC—In Global Prioritization Mode
e The subscriber—In Subscriber Prioritization Mode

In the Policies tab, click Global Policy.

The Global Bandwidth Settings are displayed in the right (Rule) pane.
Click Edit Preferences.

The Global Controllers mode dialog box appears (Figure 9-37).
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Step 3

Step 4

Figure 9-37 Global Controllers Mode

Global Controllers mode

Select the Global Controllers mode

Link Mades

In a dual link system, each GC has a counterpart GC on the other link,
It is possible to configure separate rate limits for each @C on each link, and to enforce & limit on the aggregated rate of this pair of GCs,
Yirtual Links mode allows setting virtual links,

[C1Enforce B limitation on the sum of twa links
[C1Enable separate BYW settings for each link

Wirtual Links
[C1Enable Yirtual Links Made

B Prioritization Mods

In Global Prioritization Mode, Fows that go through internal BW controllers get their Relative Priority From the B controller's Assurance Level,
In Subscriber Prioritization Mode, the flows' Relative Priority is determined by the Relative Priority of the subscriber.

(&) Global Prioritization Maode

() Subscriber Prioritization Mode

Finish ] |_ Cancel

|
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Select one of the BW Prioritization M ode radio buttons.
- Global Prioritization Mode
- Subscriber Prioritization M ode

Click OK.

The Global Controllers mode dialog box closes.

The selected BW management parameter is saved.

Managing Virtual Links

In Virtual Links mode, template bandwidth controllers are defined for packages. Actual bandwidth
parameters are assigned when a subscriber enters the system and depend on the subscriber's package

(which defines the template controllers) and the physical link assigned to the subscriber.

For each service configuration that has Virtual Links mode enabled, thereis one default upstream virtual
link and one default downstream virtual link. The upstream and downstream interfaces are each assigned

one default template global controller.

You can add additional template global controllers. You can add, modify, and delete virtual links using

a command-line interface (CLI).

Depending on the Cisco SCE harware, a service configuration can contain up to 1024 or 2048 upstream
global controllers and 1024 or 2048 downstream global controllers (including the default global
controllers). The maximum number of virtual linksis limited by the number of directional template
global controllers: the number of template global controllers times the number of virtual links cannot

exceed 1024 or 2048.

[l Cisco Service Control Application for Broadband User Guide

0L-7205-19 |



| Chapter9

Using the Service Configuration Editor: Traffic Control

A

Managing Virtual Links 1l

Caution

~

Note

If you enable or disable Virtual Links mode, all user-defined global controllers are deleted from the
service configuration. A subscriber BWC that pointed to a user-defined global controller now points to
the default global controller. (Other parameters of these subscriber BWCs remain unchanged.)

While applying a policy in virtual link mode, if the new template includes a different number of global
controllers than the currently applied template, you must choose the Reset all Virtual Linksto Template
Rate Limits. Otherwise, selecting apply will result in en error message, similar to the following:

“Template Upstream Virtual Link differ from the one in the SCE - cannot apply without the force
template virtual link option.”

The following steps outline configuring a service configuration in Virtual Links mode. The procedureis
similar to that for configuring any service configuration, but virtual links must be added using the CLI.

1. Create a new service configuration.

2. Open the Global Bandwidth Settings dialog box and check the Enable Virtual Links Mode check
box.

3. Create template global controllers.
4. Create packages.

Add subscriber BW controllers to the packages and associate them with appropriate global
controllers.

5. Apply the service configuration.

The bandwidth values of the default global controllers are set; the values of all other global
controllers are not set — these global controllers are templates.

6. Add virtual links using the CLI.

Each virtual link getsaset of global controllerswith the PIR values of the template global controller
configuration.

If necessary, you can use the CLI to change the global controllers' PIR values.

7. A subscriber isintroduced to the SCE platform. Upstream and downstream virtual links are
associated with the subscriber as well as a package.

8. Ruleresolution for each flow of the subscriber is according to the subscriber’s package and the
virtual links' global controller configuration.

Collection Manager Virtual Links Names Utility

The Collection Manager (CM) includes a command-line utility for managing the names of virtual links.

For more information about the CM Virtual Links Names Utility, see the “Managing Virtual Links’
section in the “Managing the Collection Manager” chapter of the Cisco Service Control Management
Suite Collection Manager User Guide.
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How to Enable Virtual Links Mode

A

To use virtual links, you must enable Virtual Links mode.

Caution

Step 1

Step 2

Step 3

Note

Step 4

If you enable or disable Virtual Links mode, all user-defined global controllers are deleted from the
service configuration.

In the Policies tab, click Global Palicy.

The Global Bandwidth Settings are displayed in the right (Rule) pane.
Click Edit Preferences.

The Global Controllers mode dialog box appears.

Check the Enable Virtual Links M ode check box.

If you have already added global controllers or if you selected asymmetric routing classification mode,
awarning message appears. To continue, click OK.

The Virtual Links Global Controllers tab opens.
Click Finish.
The Global Bandwidth Settings dialog box closes.

How to View Virtual Links Global Controller Settings

a~

Note

Step 1

Step 2

Global controller bandwidth is based on Layer 1 volume.
(Accounting, reporting, and subscriber bandwidth control in SCA BB is based on Layer 3 volume.)

In the Policies tab, click Global Policy.
The Global Bandwidth Settings are displayed in the right (Rule) pane.

The maximum amount of bandwidth that can be used by any global controller is displayed at the top of
the Global Bandwidth Settings:

e Total Link Upstream Bandwidth Limit: Link 1
- Total Link Downstream Bandwidth Limit: Link 1
Select a global controller, and click _ ™. (Edit).
The Global Controller Settings dialog box appears (Figure 9-38).
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Figure 9-38 Upstream Global Controller Settings

Managing Virtual Links 1l

3 Upstream Global Controller Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Mame: | Virtual-Link Global Controller

The global controller enforces a L1 rate limit on kraffic that is mapped to ik,
The global controller enforces an aggregate rate limit across all SCE links
belonging to the same virtual link.

In wvirtual links mode, rate limits for each virtual link are provisioned
dynamically to the SCE, vet 'Template' and 'Default’ values allove static
proviosioning:

‘Template' rate limits apply to newly-created virtual links,

‘Default’ rate limits apply to the default virtual link (virtual link 03,

Termplate Yirtual Link

The global controller can enforce a different rate limit per time frame.

(%) The same rate limit For all time Frames:

() & different rake limit per time frame
Single Rate Limit (Kbps)

Wirtual Link | Rate Limit
Template Unlirited

Default Virkual Link
The global controller can enforce a different rate limit per time frame.
(%) The same rate limit for all time Frames
() & different rake limit per time frame
Single Rate Limit (Kbps)

Wirtual Link | Rate Limit
Default Unlimited

K l [ Cancel

|

252000

The values of the global controllers defined in the dialog box depends on the values displayed in the
Global Bandwidth Settings. So, for example, if the Total Link Upstream Bandwidth Limit: Link 1 hasa
value of 10 Mbps then the upstream default global controller value cannot exceed 10 Mbps.

The Name field contains a unique name assigned to the global controller. The system automatically

assigns the names Controller 1, Controller 2, and so on.
The dialog box contains the following two tabs:

- Template Virtual Link—The default maximum value of the total link limit permitted to global
controllers of any created virtual links, either for all time frames or per time frame.

» Default Virtual Link—The maximum value of the total link limit permitted to global controllers of
the default virtual link, either for all time frames or per time frame.

Click OK.
The Global Bandwidth Settings dialog box closes.
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Managing Virtual Links Global Controllers

Virtual link global controllers can be added edited and deleted in the same way as regular global
controllers. For more information, refer to the following sections:

- How to Add Global Controllers, page 9-6

» How to Set the Maximum Bandwidth of Global Controllers, page 9-9
« How to Delete Global Controllers, page 9-11

- Managing Subscriber Bandwidth, page 9-28

How to Edit the Virtual Links Total Link Limits

You can limit the total bandwidth passing through the physical link.
Thetotal link limits for upstream and downstream traffic are defined independently.
In Virtual Links mode, bandwidth limitations are applied to the sum of all links.

Step1l  Inthe Policies tab, click Global Policy.

The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.
Step2  Inthe Upstream or Downstream section, click Edit Rate Limit.

The Total Rate Limit dialog box appears.

Step3  Inthe Total Rate Limit for each SCE link (Kbps) field, enter the maximum bandwidth of the SCE
platform capacity that the platform will carry, or enter Unlimited.

Step4  Click OK.
The Total Rate Limit dialog box closes.
The Total Link Bandwidth Limit: Link 1 field is updated.

Managing Virtual Links with CLI Commands

You can configure, enable and disable virtual links using the SCE platform Command-Line Interface
(CL1). For more information about the SCE platform CLI, see the Cisco SCE8000 CLI Command
Reference.

« Usethefollowing CLI commands to manage virtual links:

virtual-links index <index> direction [upstream | downstream]

virtual-links index <VL index> direction [upstream | downstream] gc <gc index> set-PIR
value <PIR 1, PIR2, PIR3, PIR4>

virtual-links index <VL index> direction [upstream \ downstream] gc <gc index> set-PIR
value <PIR for all timeframes>

virtual-links index <VL index> direction [upstream | downstream] gc <gc index>
reset-PIR

no virtual-links index <index> direction [upstream \ downstream]

These commands are line interface configuration commands. To run these commands see How to
Enter Line Interface Configuration Mode, page 9-45.
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» Usethefollowing CLI command to set the virtual links index of a subscriber:

subscriber name <name> property name [v1Up \ v1Down] value <vl index>

This commands is aline interface configuration command. To run this command see How to Enter

Line Interface Configuration Mode, page 9-45.

» Usethefollowing CLI command in EXEC mode to monitor the status of virtual links:

show interface LineCard 0 virtual-links [all | changed]

Description of Virtual Links CLI Commands

Table 9-1 gives a description of the virtual links CLI commands.

Table 9-1 Virtual Links CLI Commands

Command

Description

virtual-links index <index> direction [upstream |
downstream]

Add avirtual link

virtual-links index <VL index> direction
[upstream | downstream] gc <gc index> set-PIR
value <PIR 1, PIR2, PIR3, PIR4>

Update the global controller PIR values of a
virtual link - separate values for each time frame

virtual-links index <VL index> direction
[upstream | downstream] gc <gc index> set-PIR
value <PIR for all timeframes>

Update the global controller PIR values of a
virtual link - one value for all time frames

virtual-links index <VL index> direction
[upstream | downstream] gc <gc index> reset-PIR

Update the global controller PIR values of a
virtual link - take the values defined in the
template global controller

no virtual-linksindex <index> direction [upstream
| downstream]

Delete avirtual link

subscriber name <name> property name [vIUp |
viDown] value <vl index>

Set a subscriber’s virtual links index

show interface LineCard O virtual-links all

Show information about all virtual links

show interface LineCard 0 virtual-links changed

Show information about virtual links whose PIR
differs from the value defined in the template
global controller

How to Enter Line Interface Configuration Mode

Step 1
Step 2

Step 3
Step 4

At the SCE platform CLI prompt (sce#), type configure.

Press Enter.

The scE (config) # prompt appears.
Typeinterface LineCard 0.

Press Enter.

The sce (config if)# prompt appears.

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter 9  Using the Service Configuration Editor: Traffic Control |

M Managing Packages

Managing Packages

A package is a description of subscriber policy. It is a collection of rules that defines the system’s
reaction when it encounters flows that are mapped to the service to which therule isrelated. It is
recommended that you first define services (see Managing Services, page 7-3) and only then add and
define packages.

Every SCA BB service configuration contains a package, the default package, which isthe root package
and cannot be deleted.

A subscriber is mapped to the default package if no other package is specifically assigned to the
subscriber, or if a nonexistent package is assigned to the subscriber.

A service configuration can contain up to 5000 packages.
» Package Parameters, page 9-46
« How to View Packages, page 9-48
» How to Add Packages, page 9-49
- How to Set Advanced Package Options, page 9-51
- How to Duplicate Packages, page 9-52
- How to Edit Packages, page 9-53
« How to Delete Packages, page 9-54

Package Parameters

A package is defined by the following parameters:
» General parameters:
— Package Name—A unique name for the package
— Description—(Optional) A description of the package
- Quota Management parameters:

— Quota Management Mode—Specifies whether subscriber quotas are managed by an external
guota manager or replenished periodically by SCA BB.

— Aggregation Period Type—The quota aggregation period used when quotas are replenished
periodically.

— Quota Buckets—16 resource buckets used for quota management.
» Subscriber BW Controllers parameters:

— Subscriber relative priority—The relative priority given to subscribers of the package at times
of network congestion.

Separate priorities are defined for upstream and downstream flows.

— Subscriber Bandwidth Controllers—A list of BW controllers (BWCs) that are available to
services that are part of the package. Various parameters are defined for each BWC, including
amapping to a global controller.

Separate BWCs are defined for upstream and downstream flows.
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» Advanced parameters:

Package |ndex—The unique number by which the system recognizes a packages. (Changing the
package name does not affect SCE platform activity.) A default value of the package index is
provided by the system. Do not modify this value.

Parent Package—The package one level higher in the package hierarchy. The parent package is
important when packages share usage counters. The default package is the base of the package
hierarchy, and does not have a parent.

Package Usage Counter—Used by the system to generate data about the total use by each
package. A package can use either an exclusive package usage counter or the package usage
counter of the parent package.

Each usage counter has:
A name assigned by the system (based on the package name).

An asterisk is appended to a package usage counter name whenever the counter applies to more than one
package.

A unique counter index—A default value of the counter index is provided by the system. Do not
modify this value.

Calendar—The calendar used as the basis for the time-based rules of the package.
VAS Traffic Forwarding Table—The forwarding table used by the package.

These parameters are defined when you add a new package (see How to Add Packages, page 9-49). You
can modify them at any time (see How to Edit Packages, page 9-53).
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How to View Packages

You can view a hierarchy tree of all existing packages, and you can see alist of services for which
specific rules are defined for any selected package.

Stepl  Inthe current service configuration, click the Policies tab (Figure 9-39).

Figure 9-39 Policies Tab
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A list of all packages is displayed in the package tree.

Note  To view more information about a package, open the Package Settings dialog box (see How to Edit
Packages, page 9-53).

Step2  Click a package in the hierarchy to display the rules of the package.
A list of all rules of this package is displayed in the right (Rule) pane (Figure 9-40).
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How to Add Packages

A default package is predefined in the Console installation. You can add additional packagesto aservice
configuration, subject to the limit of 5000 packages per service configuration.

After you have added a new package, you can define rules for the package (see How to Add Rulesto a
Package, page 9-57).

Stepl InthePoliciestab, select apackage from the package tree. This package will be the parent of the package
you are adding.

Step2  InthePoliciestab, click ':::' (Add Package).
The Package Settings dialog box appears (Figure 9-41).
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Figure 9-41 Package Settings

Package Settings for ""

General :_“Qul.:.ta Managemel;t__f_.gub'scﬁber B .C.onf;'nlznllers_: Advancel&_l_f

Package name:
| Packagel

Description:

[ QK ” Cancel ]
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Step3  In the Package name field, enter a unique and relevant name for the package.
Step4  (Optional) In the Description field, enter a meaningful and useful description of the package.
Step5  To configure parameters in the Advanced tab, continue with the instructions in the following section.
Step6  Click OK.
The Package Settings dialog box closes.
The new package is added as a child to the package sel ected in the package tree and becomes the sel ected
package. The default service rule is displayed in the right (Rule) pane.
To edit the default service rule, and to add new rules to the package, see Managing Rules, page 9-55.
What to Do Next

To configure parametersin the Quota Management tab see How to Edit Quota Management Settings for
Packages, page 9-75.

To configure parameters in the Subscriber BW Controllers tab, see How to Edit Package Subscriber
BW(Cs, page 9-29.
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How to Set Advanced Package Options

Step 1

Step 2

Note

Step 3

You can change the index for the package, specify an exclusive usage counter, or select a calendar for
the package in the Advanced tab.

In the Package Settings dialog box, click the Advanced tab.
The Advanced tab opens (Figure 9-42).

Figure 9-42 Advanced Tab

2 Package Settings for, "Default Package™

General | Quota Management | Subscriber Bw Controllers | Advanced

Package Index

Set the Indesx Far this Package:

Parent Package

Select Parent Package (for sharing usage counters):

Package Usage Counters

& package can either be mapped to exclusive package usage counters, or share usage counters with its
ancestor package.

Package usage counter name For this package: Default Package Counter

Counker Index:

Calendar

Select Calendar For this Package: | Default Calendar

@ [ o [ cancel |

274100

To change the package index for this package, from the Set the Index for this Package drop-down list,
select a package index.

A default value of the index is provided by the system. Do not modify this value unless a specific index
value must be assigned to the package.

To set adifferent parent package for this package, select the desired parent from the Select Parent
Package drop-down list.

| oL-7205-19
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Step 4

Step 5

Note

Step 6

Step 7

Note

Step 8

By default, a new package uses an exclusive usage counter. To share the parent package usage counter,
uncheck the M ap this Service to exclusive package usage counter s check box.

The name in the read-only Package usage counter name for this package field changes to reflect your
choice.

The Counter Index drop-down list is dimmed.

To change the counter index (if you are using an exclusive package usage counter), select avalue for the
index from the Counter Index drop-down list.

A default value of the index is provided by the system. Do not modify this value.

To set acalendar for this package (to use itstime frames for time-based rules), select the desired calendar
from the Select Calendar for this Package drop-down list.

To set a VAS traffic-forwarding table for this package, select the desired traffic-forwarding table from
the Select Traffic Forwarding Table for this Package drop-down list.

If VAS traffic forwarding is disabled (the default), the drop-down list is dimmed. To enable VAS traffic
forwarding, see How to Enable VAS Traffic Forwarding, page 10-54.

Click OK.
The Package Settings dialog box closes.

The new package is added as a child to the selected parent package and becomes the selected package.
The default service rule is displayed in the right (Rule) pane.

To edit the default service rule, and to add new rules to the package, see Managing Rules, page 9-55.

How to Duplicate Packages

Step 1
Step 2

Step 3

Duplicating an existing package is a useful way to create a new package similar to an existing package.
It is faster to duplicate a package and then make changes than to define the package from scratch.

A duplicated package is added at the same level in the package tree as the original package.

In the Policies tab, select a package from the package tree.
In the Policies tab, click g (Duplicate Package).

A duplicate package is created with all the same attributes as the original package. The name of the new
package is the name of the selected package followed by “(1)” (or “(2)”, and so on if a package is
duplicated many times).

Modify the package parameters (see How to Edit Packages, page 9-53).
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How to Edit Packages

Step 1
Step 2

Step 3

Step 4
Step 5

Step 6
Step 7

Note

N

Note

You can modify the parameters of a package (including the default package) at any time.

In the Policies tab, select a package from the package tree.
In the Policies tab, click _* (Edit Package).
The Package Settings dialog box appears.

In the Package name field, enter a new name for the package.

In the Description field, enter a new description of the package.

(Optional) Change quota management settings, see Editing Package Quota Management Settings (Using
the Quota Management Tab (Packages) How to Edit Quota Management Settings for Packages,
page 9-75.

(Optional) Change bandwidth control settings, see How to Edit Package Subscriber BWCs, page 9-29.
To change advanced settings, click the Advanced tab.

The Advanced tab opens.

a. To change the package index for this package, from the Set the Index for this Package drop-down

list, select a Package Index.

A default value of the counter index is provided by the system. Do not modify this value unless a specific
index value must be assigned to the package.

b.

To change the parent package of this package, select the desired parent from the Select Parent
Package drop-down list.

To share the parent package usage counter, uncheck the Map this Service to exclusive package
usage counter s check box.

The namein the read-only Package usage counter name for this package field changesto reflect your
choice.

The Counter Index drop-down list is dimmed.

To use an exclusive package usage counter, check the M ap this Service to exclusive package usage
counters check box.

Thenamein the read-only Package usage counter name for this package field changesto reflect your
choice.

The Counter Index drop-down list is dimmed.

To change the counter index if you are using the exclusive package usage counter, select avalue for
the index from the Counter Index drop-down list.

A default value of the counter index is provided by the system. Do not modify this value.

f.

To change the calendar used by this package, select the desired calendar from the Select Calendar
for this Package drop-down list.

To change the VAS traffic-forwarding table for this package, select the desired traffic-forwarding
table from the Select Traffic Forwarding Table for this Package drop-down list.

| oL-7205-19
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A

Note

Step 8

If VAS traffic forwarding is disabled (the default), the drop-down list is dimmed. To enable VAS traffic

forwarding, see How to Enable VAS Traffic Forwarding, page 10-54.

Click OK.
The Package Settings dialog box closes.
All changes to the package parameters are saved.

How to Delete Packages

Step 1
Step 2

Step 3

You can delete user-defined packages. The default package cannot be del eted.

In the Policies tab, select a package from the package tree.
In the Policies tab, click * (Delete Package).
A Package Warning message appears (Figure 9-43).

Figure 9-43 Package Warning

¥ Package Warning

|l

This Package might be mapped to a Subscriber.
& Are you sure you want to remove Package Basic Package™

158897

Click Yes.
The package is deleted and is no longer displayed in the package tree.
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Managing Rules

After you have defined services and basic packages, you can define rules for the package.

You can configure rules to do some or all of the following:

Block the service

Define maximum bandwidth for the service

Change the DSCP ToS value of aflow's packets

Set a quota for the service

Define behavior when the quota for this service is breached

A rule usually applies at all times. To allow additional flexibility, you can divide the week into four
separate time frames. You can define subrules—time-based rules—for each time frame.

The Default Service Rule, page 9-55

Rule Hierarchy, page 9-55

How to View the Rules of a Package, page 9-56

How to Add Rules to a Package, page 9-57

How to Define Per-Flow Actions for a Rule, page 9-59
How to Edit Rules, page 9-61

How to Delete Rules, page 9-63

How to Display the Services Affected by a Rule, page 9-63
Managing Time-Based Rules, page 9-64

How to Manage DSCP ToS Marker Values, page 9-73

The Default Service Rule

A default service rule is assigned to every package. It cannot be deleted or disabled.

The default values of thisrule are:

Rule Hierarchy

Admit (do not block) traffic.
Map traffic to the default BWCs.
Do not limit quotas for either upstream or downstream traffic.

The SCE platform will apply the most specific rule to any flow.

For example, if you define rules for E-Mail and POP3, any flow mapped to the POP3 service will be
handled according to the POP3 rule—any flow mapped to the SMTP or IMAP service will be handled
according to the E-Mail rule. This means, for example, that POP3 can have its own usage limits, whereas
SMTP and IMAP must share usage limits.

| oL-7205-19
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N

Note

If you add arule for a child service, the settings for the parent rule are not copied to the new rule. All
new rules start with default values.

Any rule that also applies to child servicesisindicated by “? Rules that do not apply to any child
services are shown by 1% .

Time-based rules are shown as Childr_ of thjg.elevant rule. The icon for atime-based rule also shows
if the rule applies to child services (@l> or #&1%).

See also How to Display the Services Affected by a Rule, page 9-63.

How to View the Rules of a Package

Step 1

You can view alist of the rules of a package.

The listing for each rule includes an icon, the name of the service or group of servicesto which therule
applies, whether the rule is enabled or disabled, and a brief description of the rule.

In the Policies tab, select a package from the package tree.

A list of all rules defined for this package is displayed in the right (Rule) pane (Figure 9-44).

Figure 9-44 Service Configuration Editor

T | ¥ Service Configuration Editor
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5 Flkeres el T """"’_ futkn
B Service Seourty i ‘-r Coef ok Pude (enntrnlled ; undmded quoka
i Bobal Policy L gavaing \ ed; ke of ¢ 3
L& Subserber Poleies 5 Fep Combrulled ; ki ed quola
- v
l:-}"‘: Default Package - o Werkend (enntrnlled ; unbeked quata
(B kv Subeariben Pachage 'J-h -l rcontrolled ; undeked quots
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B consols | [2 Probiems
0 erroes, O warniges, O nfos
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What to Do Next

To see more information about arule, open the Edit Rule for Service dialog box (see How to Edit Rules,
page 9-61).

To see more information about atime-based rule, open the Edit Time-Based Rule for Service dialog box
(see How to Edit Time-Based Rules, page 9-66).

How to Add Rules to a Package

Step 1
Step 2

Step 3

A default service rule is assigned to every package. You can add additional rules to a package.
Adding time-based rulesis described in the section How to Add Time-Based Rules to a Rule, page 9-64.

In the Policies tab, select a package from the package tree.
In the right (Rule) pane, click .y (Add Rule).
The Add New Rule to Package dialog box appears (Figure 9-45).

Figure 9-45 Add New Rule to Package

Add New Rule to Package "Default Package™

General | Control | Usage Limits || Breach Handling|

Service
Select the Service to which the Rule will relate:

| aenetic bl

Rule State
Defing the state of this Rule:

() Enable reporting and active actions

(") Disable reporting and active actions

[ O ” Cancel ]

158747

In the Service area of the Add New Rule to Package dialog box, select a service from the Select the
Service to Which the Rule will Relate drop-down list.

N

Note  Servicesfor which aruleis already defined for this package are dimmed.
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Step 4

Step 5

Step 6

In the Rule State area, select one of the Define the State of this Rule radio buttons.
- Enablereporting and active actions
- Disablereporting and active actions

~

Note  You can enable or disable arule at any time (see How to Edit Rules, page 9-61).

(Optional) Set behavior per traffic flow for this rule, continue with the instructions in the section How
to Define Per-Flow Actions for a Rule, page 9-59.

Click OK.
The Add New Rule to Package dialog box closes.
The new rule is added to the list of rules displayed in the right (Rule) pane.

What to Do Next

Usage limits and breach handling are part of quota management (see Managing Quotas, page 9-75):

« To configure parameters in the Usage Limits tab see How to Select Quota Buckets for Rules,
page 9-77.

» To configure parameters in the Breach Handling tab, see How to Edit Breach-Handling Parameters
for a Rule, page 9-78.
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How to Define Per-Flow Actions for a Rule

Step 1

Step 2

Step 3

Step 4

The Control tab of the Add New Rule to Package dialog box allows you to set behavior per traffic flow
for sessions that are mapped to the current service.

In the Add New Rule to Package dialog box, click the Control tab.
The Control tab opens (Figure 9-46).

Figure 9-46 Control Tab

2 Add New Rule to Package "Default Package” E|

General | Contral | Usage Limits | Breach Handling

Define the per-flow action to be performed by this Rule:

() Block the Flow

() Control the flow's characteristics:
Select an upstream Bandwidth Controller | Default Upstream Bbw'C A
Select a downstream Bandwidth Contraller | Default Downstream BwC R
[ Limit the Flow's upstream bandwidth ko
[ Limit the flow's downstream bandwidth to
[] 5et the flow's upstream packets ToS (DSCP) to
[] 5et the Flaw's downstream packets TaS (DSCP) ta
[ Limit camcurrent Flows of this Service to

Set CoS for Flows of this Service to |BE %

[] Redirect profile For this service:

[ Mirrar Eraffic to server group:

Ok H Cancel ]

274148

To control flows that are mapped to the service of thisrule, continue at Step 3.

To block flows that are mapped to the service of thisrule, select the Block the flow radio button and
continue at Step 12.

Select the Control the flow’s characteristics radio button.
The options in the Flow Characteristic area are enabled.

From the upstream Bandwidth Controller drop-down list, select an upstream BWC. This sets up

bandwidth metering of all concurrent flows mapped to this rule, based on the characteristics of the
selected BWC.
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The BWCs in this drop-down list are defined when creating or editing the package.

Note  Important Notefor time-based rules: If you need different global controller settings for different time
frames, define maximum bandwidths per time frame for one global controller. Do not create a separate
global controller for each time frame.

When the mouse is placed over the drop-down list, atooltip appears (Figure 9-47) containing the
properties of the selected BWC (Peak Information Rate (PIR), Committed Information Rate (CIR),
Global Controller, and Assurance Level).

Figure 9-47 Drop-Down List Tips

Select an upstream Bandwidth Controller | Default Upstrearn BWC L

Select a downstream Bandwidth ControlleiDefault Upstream BWC:

PIF. = Unlirmited

ICIR = 0 kbps

falobal Controller = Defaulk Global Contraller|
lssurance Level = 1

[ Limit the Flow's downstream bandwidth to

[ Limit the flow's upstream bandwidth b

158746

Step5  From the downstream Bandwidth Controller drop-down list, choose a downstream BWC.

Step6  (Optional) To set a per-flow upstream bandwidth limit, check the Limit the flow’s upstream bandwidth
check box and enter avalue in the Kbps field.

N

Note  Per-flow bandwidth has a granularity of 1 Kbps up to 57 Mbps.

Step7  (Optional) To set a per-flow downstream bandwidth limit, check the Limit the flow’s downstream
bandwidth check box and enter a value in the Kbps field.

Step8  (Optional) To change the DSCP ToS marker of all packets in upstream flows, check the Set the flow's
upstream packets ToS (DSCP) to check box and select a value from the drop-down list (Figure 9-48).

Figure 9-48 Drop Down List Values
Set the flow's upstream packets TaS (DSCP) bo v
[] et the fow's downstream packets Tas (DSCR) HTaS 2 [0]
Tos 3 [0]
‘g : . ; Tos 4 [0]
[ Limit concurrent: Flaws of this Service to Tos 5 [0]
. : Tos 6 [0] I
Sek CoS For Flows of this Service to |[BE % Tos 7 [0] =~
i ™

Step9  (Optional) To change the DSCP ToS marker of all packetsin downstream flows, check the Set theflow's
downstream packets ToS (DSCP) to check box and select a value from the drop-down list.

Step 10  (Optional) To set the maximum number of concurrent flows (mapped to this rule) permitted to a
subscriber, check the Limit concurrent flows of this Service check box and enter avalue in the
associated field.

Step11 From the Set CoS for flows of this Service drop-down list, select a class-of-service.

Step 12  (Optional) To enable subscriber redirection, check the Redirect profile for this service check box and
choose aredirect profile from the drop-down list.
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Step 13  (Optional) To enable traffic mirroring, check the Mirror traffic to server group check box and choose
a server group from the drop-down list.
N
Note  The Mirror traffic to server group check box is only enabled when Traffic Mirroring is enabled
in the VAS Settings dialog box.
Step14 Click OK.
The Add New Rule to Package dialog box closes.
The new rule is added to the list of rules displayed in the right (Rule) pane.
How to Edit Rules
You can edit any rule, including the default service rule.
A
Note  You cannot disable the default service rule.
N
Note  Thetabsof the Edit Rulefor Service dialog box are the same as the tabs of the Add New Rule to Package
dialog box, except for the General tab—you cannot change the service to which the rule applies.
Stepl Inthe Policiestab, select a package from the package tree.
Step2  Intheright (Rule) pane, select arule.
Step3  Click _ " (Edit Rule).
The Edit Rule for Service dialog box appears (Figure 9-49).
Cisco Service Control Application for Broadband User Guide
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Figure 9-49 Edit Rule for Service

Edit Rule for Service "P2P"

General | Cantral | Usage Limits || Breach Handling|

-Rule State
Define the state of this Rule:

(%) Enable reparting and active actions

() Disable reporting and active actions

[ OF ” Cancel ]

158508

Step4  Inthe Rule State area, select one of the Define the State of this Rule radio buttons.
- Enablereporting and active actions
- Disablereporting and active actions
Step5  Change behavior per traffic flow.
a. Click the Control tab.
The Control tab opens.
b. Follow theinstructionsin How to Define Per-Flow Actions for a Rule, page 9-59.
Step6  Change usage limits.
a. Click the Usage Limits tab.
The Usage Limits tab opens.
b. Follow theinstructionsin How to Select Quota Buckets for Rules, page 9-77.
Step7  Define behavior when a quota is breached.
a. Click the Breach Handling tab.
The Breach Handling tab opens.
b. Follow the instructionsin How to Edit Breach-Handling Parameters for a Rule, page 9-78.
Step8  Click OK.
The Edit Rule for Service dialog box closes.

All changes to the rule are saved.
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How to Delete Rules

S

Note

Step 1
Step 2
Step 3

Step 4

You can delete any user-defined rule. The default service rule cannot be del eted.

You can disable arulewithout losing its profile (see Step 4 of How to Edit Rules, page 9-61). Thisallows
you to enable the rule again later, without having to reset all its parameters. You cannot disable the
default servicerule.

In the Policies tab, select a package from the package tree.
In the right (Rule) pane, select arule.

In the Rule pane, click ﬁ (Delete Rule).

A Rule Warning message appears (Figure 9-50).

Figure 9-50 Rule Warning

# Rule Warning

2

Are you sure you want to remove Rule "SMTP™?

158948

Click Yes.
The selected rule is del eted.

How to Display the Services Affected by a Rule

You can define a service as the child of another service (the parent service is a service group). Until you
define a separate rule for a child service, the child service is governed by the rule of the parent service.
A rulethat affectsany of aservice'schildrenisindicated intheruleslist by adifferenticon, asillustrated
for the P2P rule and the FTP rule in Figure 9-51.

Figure 9-51 Rules
-Rule A_ction
%% Default Rule |controlled ; unlimited quota |
S FTP controlled ; unlimited quota

controlled ; unlimited quoka

276017

You can display all (child) services that are affected by arule.

The default service rule applies to all services for which a specific rule is not defined.

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter 9  Using the Service Configuration Editor: Traffic Control |

M Managing Rules

Step1  Intheright (Rule) pane of the Policiestab, select arule and click ?’E (Show All Services Affected By
ThisRule).

The Services Affected dialog box appears (Figure 9-52).

Figure 9-52 Services Affected

F€ Services Affected by ‘P2P Rule
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I
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Step2  Click OK.
The Services Affected dialog box closes.

Managing Time-Based Rules

The Console allows you to divide the week into four time frames (see Managing Calendars, page 9-68).
A time-based rule is arule that applies to one time frame.

You can add time-based rulesto any rule. If atime-based rule is not defined for atime frame, the parent
ruleis enforced.

Often, you will want the rules for the different time frames to be similar. When you add a time-based
rule, the settings of the parent rule are copied to the new time-based rule; you can make any needed
changes. Subsequent changes to the parent rule do not affect the time-based rule.

You must define the calendar before defining the related time-based rules.

How to Add Time-Based Rules to a Rule
Adding atime-based rule to arule allows you to specify alternate rule parameters applicable only for a
specific time frame. If atime-based rule is not defined for atime frame, the parent rule is enforced.

« When you add atime-based rule, all parameters are initially set to the values defined for the parent
rule. Subsequent changes to the parent rule do not change the time-base rule.

» Thetabs of the Add New Time-Based Rule dialog box are the same as the tabs of the Add New Rule
to Package dialog box, except for the General tab. In the Add New Rule to Package dialog box, you
select a service; in the Add New Time-Based Rule dialog box, you select atime frame.

A service whose time-based rule affects any of its child servicesisindicated in the ruleslist by a
modified icon, asillustrated for the Weekend time-based rule of the P2P rule in Figure 9-53.
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Figure 9-53 P2P Weekend Based Time Rule
Rule Action
controlled ; urlimited quaota
=% P2P controlled [Default Upstream BWC; Defaulk Downstreann BWC]; quata replenished ..
‘E_." Weekend controlled [Default Upstream B'WC; Defaulk Downstrearn BWC]; quata replenished ..
----- % ¥ahoo Messenger YoIP controlled [Cefault Upstream BwC; Defaulk Downstream BwC]; unlimited quota
=55 Mintendo Wi controlled [Default Upstream BWC; Defaulk Downstream BYWC]; unlimited quota -
: ;3‘ Weekend controlled [Cefault Upstream BWC; Defaulk Downstream BWC]; unlimited quota g
3'_" MECP controlled [Default Upstream BWC; Defaulk Downstream BWC]; unlimited quota 5

Stepl  Inthe Policiestab, select a package from the package tree.
Step2  Intheright (Rule) pane, select arule.
Step3  Click rr‘ﬁl_-ﬁi' (Add Time-Based Rule).
The Add New Time-Based Rule dialog box appears (Figure 9-54).

Figure 9-54 Add New Time-Based Rule

Add New Time-Based Rule to Package "Default Package”

General | Control | Usage Limits | Breach Handling|

~Time Frame

Select the Time Frame For this Rule:

Peak. v

~Rule State—
Define the state of this Rule:

(#) Enable reparting and active actions

(") Disable reporting and active actions

[ OF ” Cancel ]
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Step4  Inthe Time Frame area, from the Select the Time Frame for this Rule drop-down list, select one of the
four time frames.

Step5  Inthe Rule State area, select one of the Define the State of this Rule radio buttons.
- Enablereporting and active actions
- Disablereporting and active actions
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Step6  Define behavior per traffic flow.
a. Click the Control tab.
The Control tab opens.
b. Follow theinstructionsin How to Define Per-Flow Actions for a Rule, page 9-59.
Step7  Change usage limits.
a. Click the Usage Limits tab.
The Usage Limits tab opens.
b. Follow the instructionsin How to Select Quota Buckets for Rules, page 9-77.
Step8  Define behavior when a quota is breached.
a. Click the Breach Handling tab.
The Breach Handling tab opens.
b. Follow theinstructionsin How to Edit Breach-Handling Parameters for a Rule, page 9-78.
Step9  Click OK.
The Add New Time-Based Rule dialog box closes.
The new time-based rule is displayed as a child of the rule in the Rule pane.

How to Edit Time-Based Rules

You can edit time-based rules.

N

Note  The tabs of the Edit Time-Based Rule for Service dialog box are the same as the tabs of the Add New
Time-Based Rule dialog box, except for the General tab. You cannot change the time frame to which the
rule applies.

Stepl  Inthe Policiestab, select a package from the package tree.
Step2  Intheright (Rule) pane, select atime-based rule.
Step3  Click _ " (Edit Rule).
The Edit Time-Based Rule for Service dialog box appears (Figure 9-55).
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Figure 9-55 Edit Time-Based Rule for Service

Edit Time-Based Rule for Service "P2P" at Weekend

General | Cantral | Usage Limits || Breach Handling|

-Rule State
Define the state of this Rule:

(%) Enable reparting and active actions

() Disable reporting and active actions

[ OF ” Cancel ]

158514

Step4  Inthe Rule State area, select one of the Define the State of this Rule radio buttons.
- Enablereporting and active actions
- Disablereporting and active actions
Step5  Define behavior per traffic flow.
a. Click the Control tab.
The Control tab opens.
b. Follow theinstructionsin How to Define Per-Flow Actions for a Rule, page 9-59.
Step6  Change usage limits.
a. Click the Usage Limits tab.
The Usage Limits tab opens.
b. Follow theinstructionsin How to Select Quota Buckets for Rules, page 9-77.
Step7  Define behavior when a quota is breached.
a. Click the Breach Handling tab.
The Breach Handling tab opens.
b. Follow the instructionsin How to Edit Breach-Handling Parameters for a Rule, page 9-78.
Step8  Click OK.
The Edit Time-Based Rule for Service dialog box closes.
All changes to the time-based rule are saved.
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How to Delete Time-Based Rules

You can delete any time-based rule.

N
Note  You can disable arule without losing its profile (see How to Edit Time-Based Rules, page 9-66). This
allows you to enable the rule again later, without having to reset all its parameters.

Stepl  Inthe Policiestab, select a package from the package tree.
Step2  Intheright (Rule) pane, select atime-based rule.
Step3  Inthe Rule pane, click ﬁ (Delete Rule).

A Rule Warning message appears (Figure 9-56).

Figure 9-56 Rule Warning

¥ Rule Warning

<P Are you sure you want to remove Rule "P2P : Weekend™

155949

Step4  Click Yes.
The selected rule is del eted.

Managing Calendars

Calendars are used to divide the hours of the week into four time frames.

After you have configured a calendar, you can add time-based rules to a package that uses the calendar.
A time-based rule is arule that applies to only one time frame. Time-based rules allow you to set rule

parameters that will apply only at specific times. You might, for example, want to define different rules
for peak, off-peak, nighttime, and weekend usage.

Each service configuration includes one default calendar. You can add nine more calendars, each with a
different time-frame configuration. You can use different calendars for different packages. You can also
use different calendars where a service provider has customers in more than one time zone by
configuring calendars with a one-hour offset from each other.

» How to View Calendars, page 9-69

- How to Add Calendars, page 9-69

» How to Rename the Time Frames, page 9-70

« How to Delete Calendars, page 9-71

« How to Configure the Time Frames, page 9-72

Cisco Service Control Application for Broadband User Guide
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Step 2
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Managing Rules

How to View Calendars
You can view alist of existing calendars and their time frames.

From the Policies tab of the left pane, choose Configuration > Weekly Calendars.
The Calendar Settings dialog box appears (Figure 9-57).

Figure 9-57 Calendar Settings

Calendar Settings

Calendars | Calendar Parameters |

Calendar Mame: | Dfaile Colene

B Default Calendar

Define Time Frames for this Calendar!

6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

) @ | @ | [ | (] |

Close

158765

The Calendars tab displays alist of existing calendars. Click a calendar in the list to display its
time-frame settings.

The time frames for the selected calendar are displayed and configured in the Calendar Parameters tab.
Click Close.
The Calendar Settings dialog box closes.

How to Add Calendars
Each service configuration includes one default calendar. You can add up to nine more calendars.

From the Policies tab of the left pane, choose Configuration > Weekly Calendars.
The Calendar Settings dialog box appears.

In the Calendar tab, click " (Add).

A new calendar is added with the name Calendar (1).

In the Calendar Parameters tab (Figure 9-58), click in the Calendar Name field and enter the name for
this calendar.

| oL-7205-19
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Step 4

s

Note

Step 1

Step 2

Calendar Parameters Tab

Figure 9-58

Calendar Settings

Calendar Parameters |

Calendars |

+ X

Calendar Mame: | Basic Package Calendar|

|55 Default Calendar
B Calendar (1)

Define Time Frames for this Calendar!

6 7 8§ 9

1 11 12 13 14 15 16 17

13 19 20 21 22 23 24

| @

| [

| @]+ |

Close

158766

Click Close.

The Calendar Settings dialog box closes, and the new calendar name is saved.

How to Rename the Time Frames

By default, the time framesare named T1, T2, T3, and T4. You can change these names at any time; for
example, you may want to name the time frames Peak, Off Peak, Night, and Weekend.

Although you can configure the time frames differently in each calendar, the names of the time frames

arethe samein al of the calendars. If you change the name when configuring
are also changed for all other calendars.

one calendar, the names

From the Policies tab of the left pane, choose Configuration > Weekly Calendars.

The Calendar Settings dialog box appears.

In the Calendar Parameters tab (Figure 9-59), below the grid, each of the four
field next to a colored square.

Click in aTime Frame Name field, and enter a new name for the time frame.

time framesislisted in a

[l Cisco Service Control Application for Broadband User Guide
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Figure 9-59 Calendar Parameters Tab

Calendar Parameters |

Calendar Mame; i Basic Package Calendar

Define Time Frames For this Calendar:

6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

(W] Peak | [ off Pesk | ] | | [F] 74

158767

Step3  Repeat Step 2 for the other three time frames.
Step4  Click Close.

The Calendar Settings dialog box closes, and the changes to the names of the time frames are saved.

How to Delete Calendars
You can delete any user-added calendar. The default calendar cannot be del eted.

Note A calendar used by a package cannot be deleted. (When you select the calendar, the Deleteicon is
dimmed.) To delete the calendar, you must first select a different calendar for each package using the
calendar that will be deleted.

See How to Set Advanced Package Options, page 9-51 for information about changing the calendar
associated with a package.

Stepl  From the Policies tab of the left pane, choose Configuration > Weekly Calendars.
The Calendar Settings dialog box appears.

Step2  Inthe Calendar tab, select a calendar and click i (Delete).
A Calendar Removal Confirmation message appears (Figure 9-60).

Figure 9-60 Calendar Removal Confirmation

3£ Calendar Removal Confirmation

2

Are you sure you want to delete this calendar?

158764
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Step 3

Step 4

Step 1

Step 2

Step 3
Step 4

Click Yes.

The calendar is deleted.

Click Close.

The Calendar Settings dialog box closes.

How to Configure the Time Frames

By default, all the hours of the week belong to one time frame. The Console allows you to assign each
of the 168 (24x7) hours of the week to one of four separate time frames. These time frames allow you
to supply time-dependent differentiated services and to impose constraints on any service.

You might want, for example, to divide the week as follows:
» Peak
» Off Peak
« Night
»  Weekend
You can define different time frames for each calendar.

From the Policies tab of the left pane, choose Configuration > Weekly Calendars.
The Calendar Settings dialog box appears.
In the Calendars tab, select a calendar to configure.

In the Calendar Parameters tab, the selected calendar’s Define Time Frames for this Calendar gridis
displayed. The grid, representing one week, islaid out in aformat of 24 hours x 7 days. Each cell
represents one hour.

Below the grid, the name of each time frame appears next to a colored button.
Click one of the colored buttons.
Select al the cellsin the grid that represent hours that will be part of the selected time frame.

You can select a group of cells by holding down the mouse button and dragging across the cells
(Figure 9-61).

Figure 9-61 Calendar Parameters Tab

Calendar Parameters |

Calendar Mame: | Diefault Calendar

Defing Time Frames for this Calandar:

6 7 & 9 10 11 12 13 14 15 16 17 18 19 =20 21 22 23 24

@| Peak | | Off Peak | E]! Might | ! wieekend |

210037

The changes are written to the service configuration as you make them.
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Repeat Steps 3 and 4 for the other time frames until you have mapped the entire grid.

You have now mapped the week into four different time frames. Figure 9-62 illustrates a possible time
partition plan.

Figure 9-62 Time Partition Plan Example

Calendar Parameters |

Calendar Mame: | D=faul

Define Time Frames for this Calendar:

o 1 2 3 4 5 &6 7 8 9 10 11 12 13 14 15 16 17 15 19 20 21 22 23 24

(| r
Tasl] E
Wed| |
[ i
(Er| E

| - =

@| Peak | @! OFf Peak, | @! Might | ! ‘Weekend | 2

w

Click Close.

The Calendar Settings dialog box closes.

How to Manage DSCP ToS Marker Values

SCA BB can change the value of the DSCP ToS marker of packets of flows that match a filter rule (see
Step 11 of How to Add Filter Rules, page 10-22) or a service rule (see Steps 10 and 11 of How to Define
Per-Flow Actions for a Rule, page 9-59 and Step 9 of How to Edit Breach-Handling Parameters for a
Rule, page 9-78).

SCA BB supports seven ToS Marker Classes. You assign each class a specific value to apply to aflow's
packets.

N
Note  If you have used DSCP marking on a SCA BB release prior to 3.1.5 and you are converting your old
service configurations, you must reconfigure the service configurations to obtain the same network
behavior asin the former release.
DSCP ToS Marking

A

DSCP ToS marking is used in | P networks as a means to signal the type and priority of aflow between
network elements.

The default marking option is not to mark the packet. Since classification may take a few packets to
finalize, itisimportant to note that if ToS marking is enabled, the first few packets may still be processed
under the default option and therefore may not be marked.

Caution

In an MPLS environment, the SCE platform does not map the DSCP bits to the EXP bits of the MPLS
header.

| oL-7205-19
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Step 1

Step 2

Step 3

Step 4

Note

Step 5

Note

Step 6

From the Policies tab of the left pane, choose Configuration > ToS Marking Settings.
The ToS Marking Settings dialog box appears (Figure 9-63).

Figure 9-63 ToS Marking Settings

ToS Marking Settings

ToS Matking allows setting the DSCP ToS value of the Flaw,
To5 Marking are enabled per direction.

[ Enable Upstream ToS Marking

[ Enable Downstream Tos Marking

To3 Marking allows sekting seven DSCP To3 values as an action of the Package rules or for Flow Filter rules,
The values allowed are between 0 and 63 and are given as an integer.

Tos Markers

Tos Marker Class DCP Yalue
ToS 1
Tas 2
ToS 3
ToS 4
TasS S
ToS &
ToS 7

olo|lo|lojlolo o

’ Qk, H Cancel ]
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(Optional) To enable DSCP ToS marking on upstream flows, check the Enable Upstream ToSMarking
check box.

If Upstream ToS Marking is disabled, it overrides filter rule and service rule settings.

(Optional) To enable DSCP ToS marking on downstream flows, check the Enable Downstream ToS
Marking check box.

If Downstream ToS Marking is disabled, it overrides filter rule and service rule settings.

Give unique names to the ToS Marker Classes.

You can use the default names for the ToS Marker Classes, but it is recommended that you provide
meaningful names.

Assign values to the ToS Marker Classes.
Values must be in the range from 0 to 63.

When defining filter rules and service rules, the names and values of ToS Marker Classes are displayed
in drop-down listsin the format “name [value]”. For example, “ToS 1 [23]” or “My P2P ToS [1]”

Click OK.
Your changes are saved.

The ToS Marking Settings dialog box closes.
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« How to Edit Quota Management Settings for Packages, page 9-75
- How to Select Quota Buckets for Rules, page 9-77
- How to Edit Breach-Handling Parameters for a Rule, page 9-78

How to Edit Quota Management Settings for Packages

You can define whether quota management for a package is performed by an external quota manager or
by SCA BB.

You also define the quota buckets associated with the package. Rules can use quota buckets to set limits
to the consumption of particular service groups (see How to Select Quota Buckets for Rules, page 9-77).

Quota Replenish Scatter

Step 1

Step 2

By default, if subscriber quotais replenished using periodical quota management, the quota of all
subscribersis replenished at the same time. To smooth quota replenishment, you can scatter the time of
guota replenishment.

To activate thisfeature, enter anon-zero value for the Length of the time frame for quotareplenish scatter
(minutes) property of the Advanced Options tab of the Systems Settings dialog box (see Managing
Advanced Service Configuration Options, page 10-47). By default, this property has avalue of zero, that
is, all quotais replenished at the same time.

Each subscriber’s quota replenishment occurs at a random time within the quota replenish scatter time
frame, with replenish events split evenly before and after the quota aggregation time.

Best results are obtained if the scatter time frame is the same length as the quota aggregation period,
which should completely smooth replenish events. (Do not enter a value larger than the quota replenish
period.) In the case of hourly quota replenish period, the scatter should therefore be set to 60 minutes.

The quota replenish scatter function is independent of all other quota management parameters.

In the Policies tab, select a package from the package tree, and click _"« (Edit Package).
The Package Settings dialog box appears.

In the Package Settings dialog box, click the Quota M anagement tab.

The Quota Management tab opens (Figure 9-64).
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Step 3

Note

Note

Step 4

Figure 9-64 Quota Management Tab

Package Settings for "Basic Package”
| ‘General | i :
Select quota management mode;
() External - replenished on external request
(%) Periodical - replenished automatically at the end of the aggregation period
Aogregation Period
() Hourly - ends on the hour

(%) Daily - ends at midnight

Quota Buckets
Buckets define limits on the volume and session consumption of a subscriber,

Bucket ID Marne Type Quata Lirnit
1|Bucket 1 Wolume (L3 KBytes) 250000000 A
2|Bucket 2 Wolume (L3 KByvtes) 250000000] = |
3|Bucket 3 Wolume (L3 KBytes) 250000000
4|Bucket 4 Wolume (L3 KBytes) 250000000, |
I 5|Bucket 5 wolurne (L3 KBytes) I 250000000 V

[ QK ] [ Cancel

158895

Select one of the Select quota management mode radio buttons.

» External —Replenishes quota on external request

External quota management is not supported when unidirectional classification is enabled. If you try to
select the External radio button when unidirectional classification is enabled, a Package Error message

appears.

Click OK to continue.

» Periodical —Replenishes quota automatically at the end of the aggregation period

Using periodical quota management, you can scatter quota replenishment so that the quota of all
subscribers is not replenished at the same time. (See Quota Replenish Scatter, page 9-75.)

If you selected the Periodical radio button, select one of the Aggregation Period radio buttonsto specify
when the quotais renewed for the package:

« Hourly Resolution —Replenishes quota at each hour change
» Daily Resolution —Replenishes quota at midnight
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Configure the quota buckets.

Make sure that the configuration is appropriate to the rules that you will apply to the package. For
example, if you do not configure abucket with Type = Number of sessions, you cannot define arule with
usage limits defined in number of sessions.

a. (Optional) In the Name cell, enter a name for the bucket.

You can use the default name for the bucket. It is recommended that you enter a meaningful name.

b. Click inthe Type cell, click the drop-down arrow that appears in the cell, and then select either
Volume (L3 Kbytes) or Number of sessions from the drop-down list.

c. Inthe QuotaLimit cell, enter the actual limit for this bucket in kilobytes or number of sessions,
depending on the selected Type.

In the Quota Limit cell, enter the actual limit for this bucket in kilobytes or number of sessions,
depending on the selected Type.

Quota limits can be set only if you selected the Periodical radio button in Step 4 above.

Click OK.
The Package Settings dialog box closes.
All changes to the quota management settings are saved.

How to Select Quota Buckets for Rules

Step 1
Step 2
Step 3

Step 4

You can select the quota buckets that the flows mapped to a rule will use. The quota buckets in the
drop-down lists were defined during package setup (see How to Edit Quota Management Settings for
Packages, page 9-75). If no quota bucket is appropriate for the rule, add a new quota bucket to the
package or edit an existing bucket.

In the Network Traffic tab, select a package from the package tree.
In the right (Rule) pane, select arule.

Click _* (Edit Rule).

The Edit Rule for Service dialog box appears.

Click the Usage Limits tab.

The Usage Limits tab opens (Figure 9-65).
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Figure 9-65 Usage Limits Tab

Edit Rule for Service "SMTP"

_gl_Breach Handling_
Set the Quota Buckets that the Service's traffic will consure.

Select Quota Bucket For upstream traffic | Mane (Unlimited) |

Select Quota Bucket For downstream traffic | Mone (Unlimited) s

Select Quota Bucket For sessions iI'\Ione {Unlimited) '
[
[ oK ] ’ Cancel =
[ul
n

Step5  Select the desired bucket from each drop-down list.
» Select Quota Bucket for upstream traffic
» Select Quota Bucket for downstream traffic

» Select Quota Bucket for sessions

Note  For unlimited quota, select None (Unlimited).

Step6  To define behavior when a quotais breached (not relevant if all quota buckets have unlimited quota),
continue with the instructions in the following section.

Step7  Click OK.
The Edit Rule for Service dialog box closes.

All changes to the rule are saved.

How to Edit Breach-Handling Parameters for a Rule

You can define the SCE platform behavior when an aggregated volume limit or the total
number-of-sessions limit is exceeded. You can also notify subscribers when they exceed their quotas.
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Breach-Handling Parameters

The following are the configuration parameters in the Breach Handling tab of the Edit Rule for Service
Settings dialog box.

» You determine what happens to flows identified as belonging to this rule when a quota is breached:

— No changes to active control—Flows mapped to this rule are not affected when quotais
breached. SCA BB can generate Quota Breach RDRs even when this option is selected (see How
to Manage Quota RDRs, page 8-7).

— Block the flow—Flows mapped to this rule are blocked when quotais breached.

Redirect to—Redirect the flow to a specified, protocol-dependent URL, where a posted web
page explains the reason for the redirection. URL redirection sets are defined in the System
Settings dialog box. (See How to Add a Set of Redirection URLS, page 10-41.) Only three
protocol types support redirection: HTTP, HTTP Streaming, and RTSP. Redirection is not
supported when unidirectional classification is enabled.

— Control the flow characteristics—The behaviors of flows mapped to this rule change when
guotais breached:

Select an upstream Bandwidth Controller—Map this rule’s traffic flows to a specific upstream
BW controller (BWC). This sets up bandwidth metering of all concurrent flows mapped to this
rule, based on the characteristics of the selected BWC.

Select adownstream Bandwidth Controller—The same functionality as the previous option, but
for downstream flow.

Limit the flow’s upstream bandwidth—Set a per-flow upstream bandwidth limit (for flows
mapped to the service of thisrule).

Limit the flow’s downstream bandwidth—Set a per-flow downstream bandwidth limit.

Set the flow's upstream packets ToS—Set the DSCP ToS marker of all packets of upstream
flows.

Set the flow's downstream packets ToS—Set the DSCP ToS marker of all packets of downstream
flows.

Limit concurrent flows of this Service—Set the maximum number of concurrent flows (mapped
to this rule) permitted to a subscriber.

» Activate aSubscriber Redirect—A ctivate a Subscriber Redirect when subscribers exceed their quota
limit.
« Activate a Subscriber Notification—Activate a Subscriber Notification when subscribers exceed

their quota limit. This notification can, for example, convey the quota breach situation to the
subscriber and explain how to obtain additional quota.

N

Note  Subscriber notification is not supported when unidirectional classification is enabled.

To define Subscriber Notifications, see Managing Subscriber Notifications, page 10-30.
« Activate Traffic Mirroring—Activate traffic mirroring when subscribers exceed their quota limit

Step1  Inthe Policies tab, select a package from the package tree.
Step2  Intheright (Rule) pane, select arule.

Cisco Service Control Application for Broadband User Guide
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Step3  Click ™ (Edit Rule).

The Edit Rule for Service dialog box appears.
Step4  Click the Breach Handling tab.

The Breach Handling tab opens (Figure 9-66).

Figure 9-66 Breach Handling Tab

2 Add New Rule to Package "Default Package”

General | Control | Usage Limits | Breach Handling

In case a subscribet's usage exceeded the volurme or number of sessions limits:

() Mo changes ta active contral
() Block the flow

(%) Contral the flow's characteristics:

Select an upstream Bandwidth Controller | Default Upstream BwWiC A
Select a downstream Bandwidth Controller | Default Downstrearn BWC A
[ Limit the fow's upstream bandwidth ta

[ Limit the flaw's downstream bandwidth ta

[] 5et the Flow's upstream packets ToS (DSCP) ko

[] Set the Flow's dowinstream packets ToS (DSCP) to

[ Limit concurrent flaws of this Service ta

[] Redirect profile for this service:
[] motification redirect profile For this service:

[ Mirrar traffic to server group:

Ok H Cancel ]
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Step5  Set the flow's behavior when quotais breached.

- To block the flow when quota is breached, continue at Step 6.

« To change the flow’s characteristics when quota is breached, continue at Step 10.

- Toleavethe flow unchanged when quotais breached, select the No changesto active control radio

button and continue at Step 11.
Step6  To block the flow, select the Block the flow radio button.
Step7  Continue at Step 10, page 350.

Cisco Service Control Application for Broadband User Guide
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Step8  Change the flow’s characteristics.
Select the Control the flow’s characteristics radio button.
The options in the Flow Characteristic area are enabled:
» From the upstream Bandwidth Controller drop-down list, select an upstream BWC
The BWCsin this drop-down list are defined when creating or editing the package.

When the mouse is placed over the drop-down list, atooltip appears containing the properties of the

selected BWC (Peak | nformation Rate (PIR), Committed Information Rate (CIR), Global Controller, and

Assurance Level).

» From the downstream Bandwidth Controller drop-down list, select a downstream BWC.
» (Optional) Check the Limit the flow’s upstream bandwidth check box and enter avalue in the
Kbps field.
» (Optional) Check the Limit the flow’s downstream bandwidth check box and enter avalue in the
Kbps field.
« (Optional) Check the Set the flow'supstream packets ToS (DSCP) to check box and select avalue
from the drop-down list.
» (Optional) Check the Set the flow's downstream packets ToS (DSCP) to check box and select a
value from the drop-down list.
» (Optional) Check the Limit concurrent flows of this Service check box and enter avalue in the
associated field.(Optional) To enable subscriber
Step9  (Optional) To enable subscriber redirect, check the check box and select a redirect profile from the
drop-down list.
Step 10  (Optional) To enable subscriber notification, check the Notification redirect profile for this service check
box and select a notification redirect profile from the drop-down list.

~

Note A subscriber notification can be activated in addition to any of the three breach-handling options.

)

Note  Subscriber notification is not supported when unidirectional classification is enabled. If you try
to check the Activate a Subscriber Notification check box when unidirectional classification is
enabled, a Rule Error message appears.

Step11 Click OK to continue.
Step 12  (Optional) To enable mirror traffic to a server group, check Mirror traffic to server group and choose a
server group to send the mirror traffic to.

Y

Note  The Mirror traffic to server group check box is only enabled when Traffic Mirroring is enabled
in the VAS Settings dialog box.

Step13 Click OK.
The Edit Rule for Service dialog box closes.
All changes to the rule are saved.
Cisco Service Control Application for Broadband User Guide
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Example: Creating Tiered Subscriber Services

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Tiered subscriber services can be implemented using the SCA BB Console. Because the definition of
such services is open ended, this section describes how to define two of the tiers outlined in the value
proposition description. The two tiers are defined as follows:

e Silver
— Weekly bandwidth limited to 4.2 GB (corresponds to adaily limit of 600 MB)
Email and browsing services are limited to 256 kbps

Audio and video streaming services are limited to 64 kbps
— P2P services are limited to 28 kbps
» Gold
— Weekly bandwidth limited to 5.6 GB (corresponds to a daily limit of 800 MB)
— Email and browsing services are not bandwidth limited
— Audio and video streaming services are limited to 128 kbps
— P2P services are limited to 28 kbps
The following steps are applicable to both the 'Silver' and 'Gold' packages.

Create a new package as described in How to Add Packages, page 9-49.

Enable periodical (internal) quota management.

a. Set the aggregation period to Daily

b. b) Set the quota limit to the desired value and give the quota bucket a meaningful name
For further information, see How to Edit Quota Management Settings for Packages, page 9-75.
Add the bandwidth controllers for the required services and set the PIR to the desired rate.

~

Note  Each service that is bandwidth limited requires a sub bandwidth controller that is a child of the
primary bandwidth controller, not an extra bandwidth controller.

For further information, see How to Edit Package Subscriber BWCs, page 9-29.
Add arule to the package for each bandwidth limited service.
For further information, see How to Add Rules to a Package, page 9-57.

Configure the rule to control the flow's characteristics with the bandwidth controller for the relevant
service.

For further information, see How to Define Per-Flow Actions for a Rule, page 9-59.
Set the usage limit for the package to use the quota bucket defined in Step 2, page 351.
For further information, see the How to Select Quota Buckets for Rules, page 9-77 section.
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Unknown Subscriber Traffic

A traffic flow that does not match any filter rule (see Filtering the Traffic Flows, page 10-19) is
processed by the SCE platform, which triesto identify the subscriber responsible for thetraffic flow. The
SCE platform checks its internal database for a subscriber identified by the IP address or VLAN tag of
thetraffic flow. If no such subscriber exists, the traffic flow is mapped to the Unknown Subscriber Traffic
category.

The Unknown Subscriber Traffic category isincluded in the tree in the Network Traffic tab but is not
part of the package hierarchy. The Unknown Subscriber Traffic category cannot be deleted.

Note  Traffic of one unknown subscriber cannot be distinguished from traffic of other unknown subscribers.
Therefore you cannot set either per-subscriber usage limits or subscriber-level metering with subscriber
BW(Cs. You can use subscriber BWCs only to link a selected service to a global controller.

The Unknown Subscriber Traffic category behaves like a package with the following parameters:
» Package Name = Unknown Subscriber Traffic
» Package Index = 4999
» One package usage counter:
— Counter Name = Unknown Subscriber Traffic Counter
— Counter Index = 1023
You can:
« Edit the Unknown Subscriber Traffic package settings:
— Add extraBWCs (see How to Edit Package Subscriber BWCs, page 9-29)
— Select acalendar (see How to Set Advanced Package Options, page 9-51)
- Edit the default service rule for the Unknown Subscriber Traffic category:
— Change the Rule State (see How to Edit Rules, page 9-61)

— Change per-flow actions for the rule (see How to Define Per-Flow Actions for a Rule,
page 9-59)
« Add rules to the Unknown Subscriber Traffic package:

— Add rules (see How to Add Rules to a Package, page 9-57); edit (see How to Edit Rules,
page 9-61) and delete (see How to Delete Rules, page 9-63) these rules

— Add time-based rules (see How to Add Time-Based Rules to a Rule, page 9-64); edit (see How
to Edit Time-Based Rules, page 9-66) and delete (see How to Delete Time-Based Rules,
page 9-68) these rules
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CHAPTER 10

Using the Service Configuration Editor:
Additional Options

Revised: December 14, 2011, OL-7205-19

Introduction

This chapter explains how to use additional, advanced functionality available in the Service
Configuration Editor.

» The Service Security Dashboard, page 10-2

» Filtering the Traffic Flows, page 10-19

- Managing Subscriber Notifications, page 10-30
- Managing the System Settings, page 10-45

« Managing VAS Settings, page 10-53

Cisco Service Control Application for Broadband User Guide
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The Service Security Dashboard

A

The Service Security Dashboard allows you to view and control all SCA BB security functionality.

The Dashboard is a gateway to a set of features that help you protect your network from security threats
such as worms, DDoS attacks, and spam zombies. It allows configuration of the detection mechanisms
(for example, attack thresholds) and of the actions to be taken when an attack is detected.

The Dashboard also allows you to access malicious traffic reports in the Reporter tool.

Caution

If anomaly-based detection of malicious traffic is enabled, any access control list (ACL) that is
configured on the Service Control Engine (SCE) platform but is not applied to anything (for example,
an interface, an access map, or an SNMP community string) might be deleted when a service
configuration is applied to the platform.

Wor karound:

Disable anomaly-based detection of malicioustraffic. (Clear the Enable anomaly detection check box.)

» How to View the Service Security Dashboard, page 10-3
- Managing Worm Detection, page 10-3

« Managing Anomaly Detection, page 10-4

- Managing Spam Detection, page 10-15

« Viewing Malicious Traffic Reports, page 10-18
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The Service Security Dashboard

How to View the Service Security Dashboard

Stepl  Inthe Network Traffic tab, select Service Security.
Step2  The Service Security Dashboard is displayed in the right pane (Figure 10-1).

Figure 10-1 Service Security Dashboard
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Managing Worm Detection

SCA BB uses three mechanisms for detecting worms:

» Signature based detection—The SCE platform'’s stateful Layer 7 capabilities can detect malicious
activity that is not easily detectable by other mechanisms. You can add signatures for new worms.

» Anomaly based detection—Overall traffic analysis can detect anomalies that might indicate worm
activity. See Managing Anomaly Detection, page 10-4.

» Mass-mailing based detection—E-mail traffic analysis can detect anomalies that might indicate
e-mail-based worms. See How to Configure Spam Detection Settings, page 10-16.

How to View Supported Worm Signatures

Stepl  Inthe Service Security Dashboard, click View Signatures.

The Signatures Settings dialog box appears, with Worm Signatures selected in the Signature Type
drop-down list.

Cisco Service Control Application for Broadband User Guide
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All supported worm signatures are listed.
Step2  Click Close.
The Signatures Settings dialog box closes.

How to Add New Worm Signatures to a Service Configuration

Stepl  Either import the latest DSS or SPQI file provided by Cisco or create a DSS file containing any worm
signatures that you wish to add to the service configuration.

Related Info

For more information, see Managing Protocol Signatures, page 7-39.

Managing Anomaly Detection

The most comprehensive threat detection method is anomaly detection.
« Anomaly Detection, page 10-4
« Anomaly Detection Parameters, page 10-5
» How to View Anomaly Detection Settings, page 10-6
- How to Add Anomaly Detectors, page 10-8
- Editing Anomaly Detectors, page 10-11
« How to Delete Anomaly Detectors, page 10-14

Anomaly Detection

The basic principle of anomaly detection is monitoring successful (correctly established for TCP,
bi-directional for other protocols) and unsuccessful (not properly established for TCP, unidirectional for
other protocols) connection rates both to and from any IP address viewed by the system, and triggering
an anomaly detection condition based of one of the following criteria:

« Thetotal connection rate exceeds a predefined threshold.

» The suspicious connection rate exceeds a predefined threshold and the ratio of suspicious to
unsuspi cious connections exceeds a predefined threshold.

The ratio metric isaparticularly robust indicator of malicious activity, and together with arate qualifier
serves as areliable identifier for malicious activity.

Anomaly detection is divided into three categories based on the directional nature of the detected
anomaly condition. The concepts used for the three categories areidentical, but the nature of the detected
malicious activity is different for each category.

- Scan/Sweep detector—Detects malicious activity based on an anomaly in connection rates from an
IP address.

Cisco Service Control Application for Broadband User Guide



| Chapter10  Using the Service Configuration Editor: Additional Options

Note

The Service Security Dashboard

- DoS detector—Detects an anomaly in the connection rate between a pair of |P addresses: one of
them is attacking the other. This can be either anisolated attack or part of alarger scale DDoS attack.

» DDoS detector—Detects an anomaly in the connection rate coming to an |P address, which means
that it is being attacked. The attack can be by either a single IP address (DoS) or multiple IP
addresses.

For all kinds of anomaly detection conditions, maximum flexibility is provided by the ability to define
detection thresholds and the trigger actions to be taken for each:

- Flow direction
» Flow protocol
» (Optional) Port uniqueness for TCP and UDP

The GUI configuration described here replacesthe CLI command set for configuring the Attack Filtering
Module of the SCE platform, which was available in previous rel eases.

Anomaly Detection Parameters

~

Note

For each anomaly detector category (Scan/Sweep, DoS, DDoS) there is one default detector. You can
add additional detectorsof each category. Detectorsin each category are checked in order; thefirst match
(according to the detector’s threshold settings) triggers detection. You set the order in which detectors
are checked; the default detector is checked last.

Anomaly detectors can contain up to 12 anomaly types associated with malicious traffic:
» Network initiated—Malicious traffic initiated from the network side:
TCP—Aggregate TCP traffic on all ports
— TCP Specific Ports—TCP traffic on any single port
— UDP—Aggregate UDP traffic on all ports
— UDP Specific Ports—UDP traffic on any single port
- ICMP—Aggregate ICMP traffic on all ports
— Other—Aggregate traffic using other protocol types on all ports
» Subscriber initiated—Malicious traffic initiated from the subscriber side:
- TCP
— TCP Specific Ports
- UDP
— UDP Specific Ports
- ICMP
— Other

ICMP and Other anomaly types are not available for DoS attack detectors.

Each anomaly type on a detector has the following attributes associated with it:

» Detection thresholds—There are two thresholds, crossing either of them means that an attack is
defined to be in progress:

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter 10 Using the Service Configuration Editor: Additional Options |

M The Service Security Dashboard

— Session Rate threshold—The number of sessions (per second) over specified portsfor asingle

IP address that trigger the anomaly detection condition.

Suspected sessions threshold— Suspected sessions are sessions that are not properly
established (for TCP), or that are unidirectional sessions (for other protocols). Exceeding both
the Suspected Session Rate and the Suspected Session Ratio will trigger the anomaly detection
condition. (A relatively high session rate with alow response rate typically indicates malicious
activity.)

Suspected Session Rate—The number of suspected sessions (per second) over specified ports
for asingle IP address.

Suspected Session Ratio—The ratio (as a percentage) between the suspected session rate and
the total session rate. A high ratio indicates that many sessions received no response, an
indication of malicious activity.

» Actions—Zero or more of the following actions may be taken when an anomaly detection condition
istriggered (by default, no action is enabled):

N

Note L ogging of the anomaly to an on-devicelog file and generation of RDRsis not configurable per anomaly

type.

— Alert User—Generate an SNMP trap (seethe “ SCA BB Proprietary MIB Reference” chapter of

the Cisco Service Control Application for Broadband Reference Guide for information about the
Cisco proprietary MIB) indicating the beginning and end of an anomaly.

Notify Subscriber—Notify the relevant subscriber of the malicious activity, by redirecting his
browsing sessions to a captive portal. To configure network attack subscriber notification, see
Managing Subscriber Notifications, page 10-30.

Block Attack—Block the relevant sessions. Blocking is performed based on the specification of
the malicious traffic that triggered the anomaly detection condition. If subscriber notificationis
enabled for the anomaly type, blocking is not applied to the port relevant for browsing (by
default, thisis TCP port 80; see Managing Advanced Service Configuration Options,

page 10-47).

User defined detectors can also have one or more of the following attributes:

« [P address list—Limit detection to the listed I P address ranges. This applies to the source IP when
detecting IP sweeps and port scans. It applies to the destination IP when detecting DoS and DDoS
attacks.

« TCP port list—Limit detection to the listed destination TCP ports. Thislist is applied to TCP
Specific Ports anomaly types only.

» UDP port list—Limit detection to the listed destination UDP ports. Thislist is applied to UDP
Specific Ports anomaly types only.

How to View Anomaly Detection Settings

You can view alist of all anomaly detectors. The anomaly detectors are displayed in atree, grouped
according to detector category (Scan/Sweep, DoS, or DDoS).

For each anomaly detector you can view its associated parameters and see alist of all anomaly types
included in the detector, together with their parameters.
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Step 1

Step 2

The Service Security Dashboard

In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.
The detector tree is displayed in the left area of the dialog box; the right area is empty (Figure 10-2).

Figure 10-2 Detector Tree

Add, remove and set the order of the detectors,
Detectors are checked from the bottom up and
the first match triggers detection.

The Default Detector is checked last.

%

=9

¥ scan/sweep Default Detector
= #g Dos

¥J DoS Default Detector
=-¥J DDo3

¥l DDos Default Detector

158752

In the detector tree, select a detector.
The detector parameters are displayed in the upper right area of the dialog box (Figure 10-3).

Figure 10-3 Detector Parameters

MName: SI'~"I'I'P éervers

Apply this detectar to the following IP addressesfranges {enter up to 100 comma-separated IP ranges)
10.99.99.1/32

[ Apply this detector to the follawing TCP ports {enter up to 15 comma-separated part numbers)

[ apply this detector to the following UDP parts (enter up to 15 comma-separated port numbers)

158751

The detector’s defined anomaly types are listed in the lower right area of the dialog box, together with
the value of each parameter. The following screen capture shows the default parameter values for the
Scan/Sweep default detector (Figure 10-4).
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Figure 10-4 Detector Defined Anomaly Types
[+ 1
Initiating Side | Session Rate | Suspected Session Rate | Suspected Session Ratio | Alert User | Notify Subscriber | Block Attack | -
=|-Netwaork
TCP 1000 500 50 Dizable Disable Disable
TCP Spedfic Ports 1000 500 50 Disable Disable Disable
uop 1000 500 50 Disable Disable Diszble
UDP Specific Ports 1000 500 50 Disable Disable Disable
ICMP 500 250 50 Disable Disable Disable
Other 500 250 50 Disable Disable Disable
=] Subscriber
TCP 1000 500 50 Disable Disable Disable
TCP Spedific Ports 1000 500 50 Disahle Disable Disable
uDp 1000 500 50 Disable Disable Disable
UDF Spedfic Ports 1000 500 50 Disable Disable Disable w

210799

If unidirectional classification is enabled, the Suspected Session Rate is set equal to the Session Rate,
which effectively disables anomaly detection by the suspected session trigger (Figure 10-5).

Figure 10-5 Session Rate to Suspected Session Rate Comparison
Initiating Side | Session Rate | Suspected Session Rate
=} Metwork

TCP 1000 1000
TCP Specific Ports 1000 1000
LUoP 1000 1000
UDP Spedfic Ports 1000 1000
ICMP 500 500
Other 500 500

=} Subscriber
TCP 1000 1000
TCP Spedific Ports 1000 1000 -
upp 1000 1000 o
UDP Spedific Ports 1000 1000 E

Step3  Click OK.
The Anomaly Detection Settings dialog box closes.

How to Add Anomaly Detectors

You can add new anomaly detectors. A service configuration can contain up to 100 anomaly detectors.
You define I P address ranges and TCP and UDP ports for the new detector, and one anomaly type.

After you have defined the detector, you can add other anomaly types (see Editing Anomaly Detectors,
page 10-11).

Stepl  Inthe Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.
Step2  Inthe detector tree, select a detector category.
Step3  Click " .
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The Anomaly Detector Creation wizard appears (Figure 10-6), open to the Malicious Traffic Detector

page.
Figure 10-6 Anomaly Detector Creation Wizard - Malicious Traffic Detector
3£ Anomaly Detector Creation Wizard

Malicious Traffic Detector
3 Detector Detector 1 has no lists set

Mame: | Detector 1

[ apply this detector to the following IP addresses/ranges (enter up to 100 comma-separated IP ranges)
[ !

[ Apply this detector to the following TCP ports {enter up to 15 comma-separated port numbers)

[ apply this detector to the following UDP ports {enter up to 15 comma-separated part numbers)

Cancel

155754

Step4  Inthe Name field, enter a meaningful name for the detector.

Step5  Check one or more of the check boxes to limit the scope of the detector.
The relevant fields are enabled.

Step6  Enter lists of IP addresses or portsin the relevant fields.

Step7  Click Next.

The Malicious Traffic Characteristics for a WORM attack page of the Anomaly Detector Creation
wizard opens (Figure 10-7).
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Step 8

Step 9
Step 10

Step 11

Figure 10-7

3 Anomaly Detector Creation Wizard

Malicious Traffic Characteristics for a WORM attack
Define the type of attack you wish to create

Malicious Traffic Originator
() Subscriber () Metwork

Malicious Traffic Transport

@ TCP (O TCP-SpedificPorts () UDP () UDP-Spedific Ports () ICMP () Other

Malicious Traffic Characteristics for a Worm Attack

[ <Back || mext> || Emsh

][ Cancel ]

158755

Depending on the detector type that you are defining, select the originating side or the target side.
» If you are defining a Scan/Sweep detector or a DoS detector, select the originating side for the

anomaly type you are defining.

« If you are defining a DDoS detector, select the target side for the anomaly type you are defining.

Select a transport type for the anomaly type that you are defining.

Click Next.

The Anomaly Detection Thresholds page of the Anomaly Detector Creation wizard opens (Figure 10-8).

Figure 10-8 Anomaly Detection Thresholds

3 Anomaly Detector Creation Wizard

Anomaly Detection Thresholds

Define attack detection thresholds, or use the Default Detector's
values

Malicious Traffic Detection Thresholds
[ Use the Default Detector's settings

An anomaly will be detected once flow rate exceeds this threshold,

Flow Open Rate (lows/sec) . 50

an anomaly will be detected once suspected flow rate exceeds threshold AND
suspected flows ratio exceeds threshold.

Suspected Flows Rate (flowsfzec) _5E|

Ratio of Suspected Flow Rate {%6) 50

’ < Back ]| Next > H Finish H Cancel

155756

Set the detector settings for this anomaly type.
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Step 12

Step 13
Step 14

What to Do Next

The Service Security Dashboard

Do one of the following:

» To use the default detector’s settings, check the Use the Default Detector’s settings check box.

- Enter valuesin the Flow Open Rate, Suspected Flows Rate, and Ratio of Suspected Flow Rate fields.
Click Next.

The Anomaly Detection Action Settings page of the Anomaly Detector Creation wizard opens
(Figure 10-9).

Figure 10-9 Anomaly Detection Action Settings

3 Anomaly Detector Creation Wizard @

Anomaly Detection Action Settings

Choose the actions to perform upon detecting malidous
attack

Block
Block malidious traffic

(%) Use the Default Detector's settings () Enable () Disable

Alert

Generate an SNMP trap

(%) Use the Default Detector's settings () Enable () Disable

Motify Subscriber

Motify the subscriber through browser redirect

(%) Use the Default Detector's settings (JEnable () Disable

[ Einish ” Cancel ]

158757

Select Block, Alert, and Notify Subscriber actions.
Click Finish.

The Anomaly Detector Creation wizard closes.
The new detector is added to the detector tree.

You can now add additional anomaly types to the detector. (See Editing Anomaly Detectors,
page 10-11.)

Editing Anomaly Detectors

You can perform the following actions on a user-defined anomaly detector:
» Edit detector parameters.
- Edit anomaly types.
» Add anomaly types.

» Delete anomaly types.

| oL-7205-19
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Step 1

Step 2
Step 3
Step 4

Step 5
Step 6

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6
Step 7

- Change the order of the detectors in the detector tree.

For each detector category, detectors are checked, bottom-up, in the order that they are listed in the
detector tree; the default detector is checked last.

You can edit the anomaly types of the three default detectors.

How to Edit Detector Parameters

In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.

In the detector tree, select a detector.

The detector parameters are displayed in the upper right area of the dialog box.
In the Name field, enter a new name for the detector.

Check or uncheck the IP address range and ports check boxes.

Enter or modify lists of |P addresses or ports in the relevant fields.

Click OK.

The Anomaly Detection Settings dialog box closes.

Your changes are saved.

How to Edit Anomaly Types

In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.

In the detector tree, select a detector.

Information about the anomaly types is displayed in the lower right area of the dialog box.
Double-click an anomaly type.

The Anomaly Detector Creation wizard appears, open to the Anomaly Detection Thresholds page (see
How to Add an Anomaly Type, page 10-13).

Set the detector settings for this anomaly type.
Do one of the following:
» To use the default detector’s settings, check the Use the Default Detector’s settings check box.

» Changethevaluesin the Flow Open Rate, Suspected Flows Rate, and Ratio of Suspected Flow Rate
fields.

Click Next.

The Anomaly Detection Action Settings page of the Anomaly Detector Creation wizard opens.
Change Block, Alert, and Notify Subscriber actions.

Click Finish.

The Anomaly Detector Creation wizard closes.
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Step 8
Step 9

Step 1

Step 2

Step 3

Step 4
Step 5
Step 6

Step 7

Step 8

Step 9
Step 10

Step 11
Step 12

Step 1

The Service Security Dashboard

The anomaly type is updated with your changes.

Repeat Steps 3to 7 (or Steps 2 to 7) for other anomaly types.
Click OK.

The Anomaly Detection Settings dialog box closes.

How to Add an Anomaly Type

In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.

In the detector tree, select a detector.

The anomaly types are listed in the lower right area of the dialog box.
Click 5 (Create New Detector Item Under Detector |tems Feature).

The Anomaly Detector Creation wizard appears, open to the Malicious Traffic Characteristics for a
WORM attack page (see How to Add Anomaly Detectors, page 10-8).

Select an origin for the anomaly type you are defining.

Select a transport type for the anomaly type you are defining.

Click Next.

The Anomaly Detection Thresholds page of the Anomaly Detector Creation wizard opens.

Set the detector settings for this anomaly type.

Do one of the following:
- To use the default detector’s settings, check the Use the Default Detector’s settings check box.
- Enter valuesin the Flow Open Rate, Suspected Flows Rate, and Ratio of Suspected Flow Rate fields.

Click Next.

The Anomaly Detection Action Settings page of the Anomaly Detector Creation wizard opens.

Select Block, Alert, and Notify Subscriber actions.

Click Finish.

The Anomaly Detector Creation wizard closes.

The new anomaly type is added to the anomaly type list.

Repeat Steps 3 to 10 (or Steps 2 to 10) for other anomaly types.

Click OK.

The Anomaly Detection Settings dialog box closes.

How to Delete an Anomaly Type

In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.
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Step 2

Step 3
Step 4

Step 5
Step 6

Step 1

Step 2

Step 3
Step 4
Step 5

In the detector tree, select a detector.
The anomaly types are listed in the lower right area of the dialog box.

In the anomaly type list, select an anomaly type.
Click 9% .

The selected anomaly type is deleted from the anomaly type list.
Repeat Steps 3 and 4 (or Steps 2 to 4) for other anomaly types.
Click OK.

The Anomaly Detection Settings dialog box closes.

How to Change the Order in which Detectors are Checked

In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.
In the detector tree, select a detector.

The move up arrow, the move down arrow, or both are enabled, depending on the detectors location in
the tree (Figure 10-10).

Figure 10-10 Detector Tree

Add, remove and set the order of the detectors,
Detectors are checked from the bottom up and
the first match triggers detection.

The Default Detector is checked last.

i = X

=¥ Scan/sweep

¥ scanjsweep Default Detector
=My DoS

®J Dos Default Detector
=-M§ DDos

¥ DDoS Default Detector

E_lj DINS Servers

o

158753

Using these navigation arrows, move the detector to its desired location.
Repeat Steps 2 and 3 for other detectors.

Click OK.

The Anomaly Detection Settings dialog box closes.

Your changes are saved.

How to Delete Anomaly Detectors

You can delete any or all user-defined detectors.
You cannot delete the three default detectors.
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Step 1

Step 2
Step 3

Step 4

Step 5

The Service Security Dashboard

In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.
In the detector tree, select one or more user-defined detectors.

Click % .

A Confirm Delete message appears (Figure 10-11).

Figure 10-11 Confirm Delete

# Confirm Delete

€p | Are yousure you want to delete Detector "SMTP Servers™

Ok i | Cancel

1587858

Click OK.

The selected detectors are deleted and are no longer displayed in the detector tree.
Click OK.

The Anomaly Detection Settings dialog box closes.

Managing Spam Detection

The anomal ous e-mail detection method monitors SM TP session rates for individual subscribers. A high
rate of SMTP sessions from an individual subscriber is usually an indicator of malicious activity that
involves sending e-mail (either mail-based viruses or spam-zombie activity).

This method will work only if the system is configured in subscriber-aware or anonymous subscriber
mode. Thisallowsthe SCE to accurately account the number of SM TP sessions generated per subscriber.

The detection method is based on the following:

« Typical broadband subscribers generate a small number of SMTP sessions (at most a single session
each time they send an e-mail message).

» Typical broadband subscribers normally use the ISP's SMTP server (as configured in their mail
client) astheir only mail relay, and do not communicate with off-net SMTP servers.

» Spam zombies create many SMTP sessions, mainly to off-net servers (the mail servers of the
destined recipient of the messages).

When configuring spam detection, you select an appropriate service to monitor. By default, thisis the
built-in SMTP service. To improve detection sensitivity, you can create amore specific service to narrow
the scope of detection. Two possible services are:

e “Outbound SMTP"—SMTP sessions generated by the subscriber.

- “OffNet SMTP'—SMTP sessions that are not targeted to the SMTP server of the subscriber’s ISP.
Limiting the service to OffNet can avoid accounting for legitimate sessions.

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter 10 Using the Service Configuration Editor: Additional Options |

M The Service Security Dashboard

N

Note

Prominent non-1SP e-mail providers (for example, Google and Yahoo!) now provide SMTP-based
service, so OffNet isno longer avery good differentiator between legitimate and illegitimate activity. To
refine the OffNet service, you must includean SMTP server listinthe“OnNet SMTP” service definition;
all other SMTP servers will be OffNet.

How to Configure Spam Detection Settings

Step 1

Step 2

Step 3

Note

Step 4

In the Service Security Dashboard, in the Spam Zombies and Email Viruses Detection pane, click
Configure.

The Spam Detection and Mitigation settings dialog box appears (Figure 10-12).

Figure 10-12 Spam Detection and Mitigation Settings

3£ Spam Setting

Spam Detection

This Wizard helps you configure detection and mitigation settings for Spam zombies and email based viruses
activity.
Enable Spam detection

Spam is detected based on exceeding & predefined quota of sessions for SMTP.
For best accuracy, detect Spam/email virus activity on a service that indudes "outbound SMTP™ or "outbound off-net SMTP™,

Service to moritor for Spam: | NG
Define Spam as | 10 _| sessions over | 30 | seconds.

Select the action to take upon detection of Spam Zombie f email virus activity.

Action upon detection EIgnore v |

Subscriber Notification

[ Einish ][ Cancel l

210012

(Optional) To disable spam detection, uncheck the Enable Spam detection and mitigation check box.
All other fields are disabled.

Continue at Step 7.
From the Service to monitor for Spam drop-down list, select the monitored service.

Leave the default value for the monitored service (SMTP), unless you have defined a more specific
service, such as “Outbound SMTP” or “OffNet SMTP”.

For each package, do the following:

a. Define the quotato be used for indicating anomal ous email activity. The quotais defined as a
number of sessionsfor agiven period—number of sessions and period length are both configurable.
It is suggested to base the values for these fields on some baseline monitoring of subscriber activity.
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Click in the Detection threshold column.

A More button () appears.

Click the More button.

Define the threshold e-mail session rate for anomalous behavior (Figure 10-13).
Click OK.

Figure 10-13 Spam Detection Threshold

* Spam detection threshold gl

Spam detection threshold for package Default Package

Spam is detected when a subscriber exceeds a predefined SMTP session rate.

Enable spam detection for this package

Define spam as | 1000000 | sessions over | 1 seconds,

[ Ok, H Cancel ]

250823

b. Define one or more actions to be taken upon detecting mass-mailing activity.

Available actions are:

Note

S

Note

Send RDR—A Raw Data Record (RDR) is sent from the SCE to the Collection Manager (CM),
and a second RDR is sent when the subscriber's status as a spammer is removed. The CM
collectsthese RDRs in CSV files for logging purposes. Alternatively, you can implement your
own RDR collectors to receive these RDRs and respond in real-time.

Block selected service Traffic—Block the spam SMTP traffic.

Notify Subscriber (HTTP)—Redirect the subscriber browsing sessions to a captive portal
presenting a message from the operator. This is done using “ subscriber notification”.

Mirror SMTP traffic—Divert spam SMTP traffic to an inline spam detection service.

For the send RDR action, one RDR is sent when the subscriber is marked as a spammer and a
second RDR is sent once the subscriber is no longer considered a spammer. However, when
using the block, notify, and mirror actions, the action begins when the subscriber is marked asa
spammer and is maintained until the subscriber is no longer considered a spammer.

Block selected service Traffic and Mirror SMTP traffic cannot both be selected

Step5  If you selected Notify Subscriber (HTTP), choose or enter a notify subscriber.

Step6  If you selected Mirror SMTP traffic, choose a server group.

Step7  Click Finish.
The Spam Detection and Mitigation settings dialog box closes.
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Viewing Malicious Traffic Reports

Information about detected traffic anomaliesis stored in the Collection Manager database. You can use
this information for network trending, detection of new threats, and tracking of malicious hosts or

subscribers.
- Malicious Traffic Reports, page 10-18
« How to View a Service Security Report, page 10-18

Malicious Traffic Reports

A number of reports dealing with malicious traffic can be displayed in the Reporter tool:

» Global reports:
— Global Scan or Attack Rate
— Global DoS Rate
— Infected Subscribers
— Infected Subscribers versus Active Subscribers
— DoS Attacked Subscribers
— Top Scanned or Attacked ports
« Individual subscriber or hosts reports:
— Top Scanning or Attacking hosts
Top DoS Attacked hosts
Top DoS Attacked Subscribers
— Top Scanning or Attacking Subscribers

How to View a Service Security Report

Step 1

Step 2
Step 3

Step 4

In the Service Security Dashboard, in the relevant pane, click View Report.
A Choose areport dialog box appears, displaying atree of relevant reports.
Select a report from the report tree.

Click OK.

The Choose areport dialog box closes.

The Reporter tool opens in the Console, and displays the requested report.

For information about manipulating and saving the report, see the “Working with Reports” chapter of

the Cisco Service Control Application Reporter User Guide.
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0L-7205-19 |


http://www.cisco.com/en/US/docs/cable/serv_exch/serv_control/broadband_app/rel355/reporterug/05_SCA_Reporter_UG.html
http://www.cisco.com/en/US/docs/cable/serv_exch/serv_control/broadband_app/rel355/reporterug/reporterug.html

| Chapter 10

Using the Service Configuration Editor: Additional Options

Filtering the Traffic Flows

Filtering the Traffic Flows

Note

Filter rules are part of service configurations. They allow you to instruct the Service Control Engine
(SCE) platform, based on aflow’s Layer 3 and Layer 4 properties, to:

- Bypass—Ignore the flow and transmit it unchanged.

» Quick forward—Duplicate the flow and send one copy directly to the transmit queue to ensure
minimal delay. The second copy goes through the normal packet path.

When atraffic flow entersthe SCE platform, the platform checkswhether afilter rule appliesto this flow.

If afilter rule appliesto thistraffic flow, the SCE platform passes the traffic flow to its transmit queues.
No RDR generation or service configuration enforcement is performed; these flows will not appear in
any records generated for analysis purposes and will not be controlled by any rule belonging to the active
service configuration.

It is recommended that you add filter rules for OSS protocols (such as DHCP) and routing protocols
(such as BGP) that might traverse the SCE platform. These protocols usually should not be affected by
policy enforcement, and their low volume makes them insignificant for reporting.

A number of predefined filter rules are included in every new service configuration.

By default, some, but not all, of the predefined filter rules are active.

Flows of certain protocols can also be filtered according to the flow’s Layer 7 characteristics. (See
Managing Advanced Service Configuration Options, page 10-47.) Like other filtered flows, Layer 7
filtered flows are not controlled, but can be classified and reported. The flows of the protocols that can
befiltered are typically short and their overall volumeis negligible, so filtering these protocols has little
effect on network bandwidth and on the accuracy of the SCA BB reports.

- Information About Traffic Filtering, page 10-19

« How to View Filter Rules for a Package, page 10-21

- How to Add Filter Rules, page 10-22

- How to Edit Filter Rules, page 10-27

» How to Delete Filter Rules, page 10-28

- How to Activate and Deactivate Filter Rules, page 10-28

Information About Traffic Filtering

Note

For certain types of traffic, service providers may need to reduce the latency and jitter introduced by the
SCE platform or even to bypass the SCE platform to avoid traffic control as well. Typically, such
decisions are made for a portion of the traffic, to reduce latency for delay sensitive applications, such as
voice, and to bypass mission-critical traffic, such as routing protocols. The SCA BB Filtered Traffic
mechanism is used to address this need.

Most voice traffic is handled automatically by the SCE platform to reduce latency (see Automatic Quick
Forwarding of Media Flows, page 10-21).

» The SCA BB Filtered Traffic Mechanism, page 10-20
» Filter Rule Actions, page 10-20
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» Filter Rules and Service Rules, page 10-21
» Automatic Quick Forwarding of Media Flows, page 10-21

The SCA BB Filtered Traffic Mechanism

Note

Note

Note

The SCA BB Filtered Traffic mechanism reduces latency or completely bypasses portions of the traffic
by defining filter rules that match relevant flows and assign the correct action to them. A filter rule
matches a packet according to its Layer 3 and Layer 4 properties, such as |P address, port number, and
DSCP ToS, aswell asthe SCE platform interface (subscriber or network) from which the packet arrived.
For packets that match afilter rule, the following actions can be applied:

» Bypassthe current packet (to reduce latency and avoid traffic control).

When thisaction is applied, the current packet isdirectly transmitted from the SCE platform without
going through any service configuration processing or reporting. You must map the bypassed packet
to a Class of Service (CoS) to assign it to one of the transmit queues of the SCE platform.

Possible values for CoS are BE, AF1, AF2, AF3, AF4, and EF; where EF implies high processing
priority and the other classes imply normal processing priority.

e Quick forward the flow (to reduce latency).

When this action is applied, the current packet and all subsequent packets belonging to the same
flow are duplicated and sent through two different paths: the original packet goes directly to the
transmit queue, and thus has only a minimal delay, while a copy of the packet goes through the
normal service configuration processing path for classification and reporting, and is then discarded.

» Assign the flow to the high priority processing input queue (to reduce latency).

Not all platforms support this option.

« When this action is applied, the current packet and all subsequent packets belonging to the same
flow enter the high priority processing input queue. They go through the normal service
configuration processing path ahead of other packetsthat arrive simultaneously. You should map the
flow to the EF CoS to assign it to the high processing priority transmit queue of the SCE platform.

In an MPLS environment, the SCE platform does not map the DSCP bits to the EXP bits of the MPLS
header.

A filter rule can perform DSCP ToS marking (by changing the DSCP ToS field of the packet) of the
matched traffic in conjunction with any of the above actions.

DSCP ToS marking and the assignment to CoS only take place when the operational mode of the system
is Full Functionality (see System Operational Mode, page 10-45).

Filter Rule Actions

The Bypass and Quick forward actions apply to different scopes of traffic:
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» The Bypass action only bypasses the current packet; every subsequent packet of the same flow goes
through the Filtered Traffic mechanism. This means, for example, that when traffic isto be bypassed
based on its destination port number, two rules should be created in order to match packets from
both sides of a bidirectional flow.

For example, to bypass all traffic to destination port 23, two filter rules are needed, one for packets
arriving from the subscriber side addressed to network side port 23, and another for packets arriving
from the network side addressed to subscriber side port 23.

- The Quick forward action is applied to the entire flow; once identified, all subsequent packets do
not go through the filter rule mechanism, instead going through normal service configuration
processing.

A packet may match more than one filter rule. If both Bypass and Quick forward are matched, the
packet/flow will be bypassed with minimum delay. Furthermore, if only Bypass is matched, the
packet/flow will also be bypassed with minimum delay.

Filter Rules and Service Rules

Filter rule actionsto reduce latency allow the flow to be controlled by the SCE platform. This means that
the flow can be blocked or given limited bandwidth if it matches a service rule. For example, if afilter
ruleis applied to reduce latency, but a service configuration rule is applied to block the same traffic, the
traffic will be blocked.

The Bypass action is designed to avoid service configuration processing; bypassed traffic is not affected
by service rules.

Automatic Quick Forwarding of Media Flows

The SCE platform reduces the latency of delay-sensitive voice and video media flows by applying the
quick-forwarding action to SIP, MGCP, H323, Skinny, and RT SP mediaflows during classification. That
is, when amediaflow is classified as being of one of these types, it will be subject to quick forwarding
immediately. The SCE platform does this automatically, regardless of filter rule configuration. These
media flows might still be blocked or given limited bandwidth if they match a service rule.

How to View Filter Rules for a Package

Step 1

You can view alist of the filter rules included in a service configuration.

The listing for each filter rule includes the name, the status, and a brief description (generated by the
system) of therule.

To see more information about a filter rule, open the Edit Filter Rule dialog box (see How to Edit Filter
Rules, page 10-27).

In the Policies tab, select the Filtered Traffic node.
A list of all filter rulesis displayed in the right (Rule) pane (Figure 10-14).
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Figure 10-14 Filter Rules
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How to Add Filter Rules

The Add Filter Rule wizard guides you through the process of adding afilter rule.

Stepl Inthe Policiestab, select the Filtered Traffic node.
Step2  Click 2 (Add Rule) in theright (Rule) pane.
The Add Filter Rule wizard appears (Figure 10-15).

Figure 10-15 Add Filter Rule

Add Filter Rule

Constructing a Filker Rule consists of defining the parameters
of packets that are to be bypassed with no processing.

The system will aukomatically bypass packets that match one of
the Filter Rules definitions. Mote that Filker Rules anly apply
to packets that do not have an open flow context,

Construct a Filter Rule by defining the filter walues far a
variety of packet properties.

274072

Step3  Click Next.
The Transport Type and Direction page of the Add Filter Rule wizard opens (Figure 10-16).
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Step 4

Step 5

Figure 10-16 Transport Type and Direction

Add Filter Rule

Apply to packets where the transport byvpe is: i(.ﬂny) w |

Apply to packets that arrive Fram:
() the netwark side

() the subscriber side

(%) either side

Moke: In most cases, 'either side’ should be selected, When filkering one side only, a response
packet atriving From the opposite side will nok match the rule, kence a flow context would be
created for it, and all consecutive flow packets will be processed instead of being bypassed,

[ Close ] [ < Back J’_ Mewt = ] Firisti

Select the transport type and initiating side and click Next.
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Filtering the Traffic Flows

The Subscriber-Side |P Address page of the Add Filter Rule wizard opens (Figure 10-17).

Figure 10-17 Subscriber-Side IP Address

Add Filter Rule

Apply bo packets where the subscriber-side IP address is;
() Any IP address

() Equalto ,_ .0

) other than | 0000 '

() In the range of [D00.0 | =Tooo

()Mot inthe range of |0 ] |-

I Close ] [ < Back ][ Mext = ] Finish

158738

Define the subscriber-side | P address and click Next.

The Network-Side |P Address page of the Add Filter Rule wizard opens (Figure 10-18).
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Figure 10-18 Network-Side IP Address
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Step 6

Define the network-side | P address and click Next.

If the transport type selected in Step 4 was hot TCP or UDP, the ToS page of the Add Filter Rule wizard

opens. Go to Step 9.

If the transport type selected in Step 4 was TCP or UDP, the Subscriber-Side Port page of the Add Filter

Rule wizard opens (Figure 10-19).

Figure 10-19 Add Filter Rule

Add Filter Rule

Apply bo packets where the subscriber-side port is:
(%) Any port

OEqualta |

() Other than |0 '

() In the range of [

()Mot in the range of || [I=]

I Close ]

[ < Back ][ Mext = ] Finish

158740

Step 7

Define the subscriber-side port and click Next.

The Network-Side Port page of the Add Filter Rule wizard opens (Figure 10-20).
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Figure 10-20 Network-Side Port

Filtering the Traffic Flows

Add Filter Rule

Apply bo packets where the nebwork-side port is:
(%) Any port

(O Equalts  |© |

() Other than |0 |
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()Mot in the range of || [I=]

I Close ]
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Step8  Define the network-side port and click Next.
The ToS page of the Add Filter Rule wizard opens (Figure 10-21).
Figure 10-21 ToS
apply ko packets where the TaS is:
() Any value
() Equalta i_ |
) Cther than |0 |
() In the range of [1 |-[o |
()Mot in the range of | | JI= |
I Close ] [ < Back ] [ Mexk = ] Finish %
Step9  Define the ToS and click Next.
~
Note  Acceptable values for ToS are 0 to 255.

The Action and Class-of-Service page of the Add Filter Rule wizard opens (Figure 10-22).
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Figure 10-22 Action and Class-of-Service
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Step 10  Select the radio button for the required action.

« Bypass —Packets that match thisfilter rule are not passed to SCA BB.

» Quick Forward —The SCE platform ensures low latency for packets that match thisfilter rule (use
for delay sensitive flows). Packets are duplicated and passed to SCA BB for processing.

Step11 Select a Class-of-Service value, and click Next.

The ToS Marking page of the Add Filter Rule wizard opens (Figure 10-23).

Figure 10-23 ToS Marking

Add Filter Rule

[[] Remark Upstream ToS with ToS Marker ' |
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Ta5 Marking allaws to set the ToS value of the filkered traffic,
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I Close ] [ < Back ][ Mext = ]

Help
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Step12 (Optional) To change the DSCP ToS marker of packets in the filtered traffic, check the Remark
Upstream ToSwith ToS Marker and Remark Downstream ToS with ToS Marker check boxes, as
required, select the required ToS marker from the drop-down list, and click Next.

» Disabling directional DSCP ToS marking in the ToS Marking Settings dialog box (see How to
Manage DSCP ToS Marker Values, page 9-73) overrides DSCP ToS marking in that direction by a
filter (that is, the DSCP ToS value will not be changed). In this case, the Problems View will display

a Warning.
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- If youfilter for aflow in onedirection in Step 4 but select ToS marking in the other direction in this
Step, thefilter rulewill be created, but no DSCP ToS remarking will occur. In this case, the Problems

View will display a Warning.

» If you select Quick Forward in the previous Step, SCA BB receives the original package and
processesit. That is, the original DSCP ToS value is seen by the application regardless of the ToS

marking action selected in the filter rule.

The Finish page of the Add Filter Rule wizard opens (Figure 10-24).

Figure 10-24 Finish

Add Filter Rule

Applies to TCP packets,
The packets bypass the policy engine, and are mapped to CoS BE

Rule Name
| Filter Rule 1

[] Activate this Rule

[ Close ] [ < Back ] %
N
Step 13  Inthe Rule Name field, enter a unique name for the new filter rule.
Y
Note  You can use the default name for the filter rule. It is recommended that you enter a meaningful name.
Step 14  (Optional) To activate thefilter rule, check the Activatethisrule check box. Trafficisfiltered according
to the rule only when it is activated.
Step15 Click Finish.
The Add Filter Rule wizard closes.
Thefilter rule is added and is displayed in the Filter Rule table.
How to Edit Filter Rules
You can view and edit the parameters of afilter rule.
Stepl  Inthe Policies tab, select the Filtered Traffic node.
A list of all filter rulesis displayed in the right (Rule) pane.
Step2  Select arulein the Filter Rule table.

Cisco Service Control Application for Broadband User Guide
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Step3  Click ™ (Edit Rule).

The Introduction page of the Edit Filter Rule wizard appears.

The Edit Filter Rule wizard is the same as the Add Filter Rule wizard.
Step4  Follow theinstructions in the section How to Add Filter Rules, page 10-22, Steps 4 to 14.
Step5  Click Finish.

Thefilter rule is changed and relevant changes appear in the Filter Rule table.

How to Delete Filter Rules

You can delete filter rules. Thisis useful, for example, when you want the system to resume handling
the I P addresses and their attributes according to the individual rules that were previously defined for
each subscriber |P address.

Stepl Inthe Policiestab, select the Filtered Traffic node.

A list of all filter rulesis displayed in the right (Rule) pane.
Step2  Select arulein the Filter Rule table.
Step3  Click #% (Delete Rule).

A Filter Rule Warning message appears (Figure 10-25).

Figure 10-25 Filter Rule Warning

3 Filter Rule Warning

158825

Step4  Click Yes.
Thefilter rule is deleted and is no longer displayed in the Filter Rule table.

How to Activate and Deactivate Filter Rules

You can activate or deactivate filter rules at any time. Deactivating afilter rule has the same effect as
deleting it, but the parameters are retained in the service configuration, and you can reactivate the filter
rule at alater date.

Stepl Inthe Policiestab, select the Filtered Traffic node.
A list of all filter rulesis displayed in the right (Rule) pane.
Step2  Select arulein the Filter Rule table.
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Step3  To activate the rule, check the Active check box.
Step4  To deactivate the rule, uncheck the Active check box.

Step5  Repeat Steps 3 and 4 for other rules.

Cisco Service Control Application for Broadband User Guide
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Managing Subscriber Notifications

The subscriber notification feature pushes web-based messages to a subscriber by redirecting the
subscriber HTTP traffic to relevant web pages. These web pages contain information relevant to the
subscriber, such as notifications of quota depletion. HTTP redirection starts when the subscriber
notification is activated and ceases when the notification is dismissed.

Note  Subscriber notification is not supported when unidirectional classification is enabled.

Each set of subscriber redirection parameters comprises a notification redirect profile. The Cisco Service
Control Application for Broadband (SCA BB) supports a maximum of 128 redirect profiles, including
notification and redirect profiles. There are 3 default redirect profiles that cannot be deleted: Default
Notification, Network Attack Notification and Default Redirection. You configure which notification
redirect profile to use when defining rules

» Subscriber Notification Parameters, page 10-30

« Network Attack Notification, page 10-31

» How to Add a Notification Redirect Profile, page 10-33
- How to Add a Set of Redirection URLS, page 10-41

Subscriber Notification Parameters

Each redirect profile of type notification contains the following subscriber notification parameters:

Note  The Activation trigger configuration options are only available for redirect profile of type redirect.

» Name—Each profile must have a unique name.

Note  You cannot change the name of the Default Notification or the Network Attack Notification.

- Redirect profile type—Each profile must be one of two types:
— Notification
— Redirect

» Set of Redirection URLs—A configurable set of destination URLSs, to which the subscriber’sHTTP
flows are redirected after redirection is activated. This web page usually contains the message that
needs to be conveyed to the subscriber. The redirection set can optionally include one, or several
parameters appended to the destination URL including the redirect reason and subscriber ID.

The destination web server can use these parameters to carry a more purposeful message to the
subscriber.

« Activation frequency—Indicates when to activate the notification redirect. The activation frequency
is one of the following:

N

Note  The Periodically option is only available for redirect profile of type redirect.
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Only once—The subscriber isredirected to the notification only thefirst time the conditions are met.

For example, if a quota was exceeded, the subscriber browses to the destination URL that informs
them of this fact, only once (even though the subscriber still remains in a breach state).

Always—The subscriber is redirected to the notification every time the conditions are met.

For example, if a quota was exceeded, the subscriber is continuously redirected to the notification
until the subscriber completes the procedure to refresh their quota.

Until the subscriber browses to—Every time the conditions are met, the subscriber is redirected to
the notification, until the subscriber proceeds from the destination URL to a different, final URL.

For example, if a quota was exceeded, the web page at the destination URL may ask the subscriber
to press an Acknowledge button after reading the message. The acknowledge URL would be defined
as the dismissal URL and would deactivate further notifications.

The dismissal URL is composed of the URL hostname and the URL path, separated by a colon, in
the following format:

[*]<hostname>:<path>[*]
— <hostname> may optionally be preceded by a wildcard (*), to match all hostnames with the
same suffix.
— The path element must always start with “/”.
— <path> may be followed by awildcard (*), to match all paths with a common prefix.
For example, the entry *.some-isp.net:/redirect/* matches all the following URLSs:
» www.some-isp.net/redirect/index.html
* support.some-isp.net/redirect/info/warning.asp
* noquota.some-isp.net/redirect/acknowledge.aspx?ie=UTF-8

List of Allowed URLs—A list of URLsthat will not be blocked and redirected even though
redirection is activated.

After redirection is activated, all HTTP flows, except flows to the destination URL and to the
dismissal URL, are blocked and redirected to the destination URL. However, subscribers can be
permitted to access an additional set of URLSs. Thisisuseful, for example, to give subscribers access
to additional support information.

Allowed URLSs have the same format as the dismissal URL.

These parameters are defined when you add a new notification redirect profile (see How to Add a Set of
Redirection URLSs, page 10-41). You can modify them at any time.

Network Attack Notification

Subscriber notification informs a subscriber in real-time about current attacks involving | P addresses
mapped to that subscriber. (Enabling these notificationsis described in The Service Security Dashboard,
page 10-2.) SCA BB notifies the subscriber about the attack by redirecting HT TP flows originating from
the subscriber to a server that supplies information about the attack.

One subscriber notification, Network Attack Notification, is dedicated to providing these notifications;
it cannot be deleted. A Network Attack Notification is not dismissed at the end of an attack; subscribers
must respond to it.

To alow redirection when blocking traffic, the system is configured to leave open one specified TCP
port (by default, port 80). See Managing Advanced Service Configuration Options, page 10-47.
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A

Caution

In earlier releases of SCA BB, configuring network attack notifications was performed using CLI

commands. CLI commands should no longer be used for this purpose.

» Network Attack Notification Parameters, page 10-32

» Example of URL with Description Tail, page 10-33

Network Attack Notification Parameters

When a network attack is detected, HTTP flows of the subscriber are redirected to a configurable
destination URL. Thisweb page should display the warning that needs to be conveyed to the subscriber.

Optionally, the destination URL can include a query part containing notification parameters. The
destination web server can use these parameters to create a more specific warning to the subscriber.

The query part of the URL has the following format:

?ip=<ip>&side=<side>&dir=<dir>&prot=<protocol>&no=<open-flows>&nd=<suspected-flows>&to=<op
en-flows-threshold>&td=<suspected-flows-threshold>&ac=<action>&nh=>handled-flows>

The meaning of each field in the tail is described in Table 10-1:

Table 10-1 Description Tail Fields
Field Description Possible Values
ip Detected IP address
side » s—Subscriber
+ n—Network
dir - s—Source
e d—Destination
protocol - TCP
- UDP
e ICMP
- OTHER
open-flows Number of open flows
suspected flows Number of attack-suspected
flows
open-flows-threshold Threshold for open flows
suspected-flows-threshold Threshold for attack-suspected
flows
action « R—Report
« B—Block and report
handled-flows Number of flows handled since

the attack began

(Non-zero only during and at the
end of an attack)
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Example of URL with Description Tail

http://www.some-isp.net/warning?ip=80.178.113.222&side=s&proto=TCP&no=34&nd=4&to=34&td=10&
ac=B&nh=100

How to Add a Notification Redirect Profile
~

Note  Creating a notification redirect profile does not activate the subscriber notification feature. After the
notification redirect profile is defined, it must be activated for a particular package

Stepl  .From the Policiestab in the left pane, choose Configuration > Subscriber Redirection.

The Redirect Actions Settings dialog box appears (Figure 10-26).

Figure 10-26 Redirect Action Settings - General Tab

3€ Redirect Actions Settings [‘S__<|
Create and edit Redirect Profiles
Configure the redirection parameters
General v ati
DeFault Redirectian | Activation | alowed URLs
Tame: | Metwork Attack Motification
Select redirection profile type:
Manage redirect sets:
Select URL set: |DeFauIt sek [htkp v, y-http-server, comfredirect.cai) A
[ Ok l ’ Cancel ] g
5]

Step2  Click Add.

A new redirection profile containing the default redirection URL set is added to the redirection profile
list.

Step3  Inthe Name field, enter a unique name for the new notification redirect profile.

Cisco Service Control Application for Broadband User Guide
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Y
Note  You can use the default name for the notification redirect profile. It is recommended that you enter a
meaningful name

Step4  Inthe Select redirection profile type field, select Notification.

Do not skip this step or aredirect profile will be created instead of a notification redirect profile.
Step5  Choose a URL set.
Step6  Click the Activation tab.

The Activation tab opens (Figure 10-27).

Figure 10-27 Activation Tab

F Redirect Actions Settings [‘S__<|
Create and edit Redirect Profiles
Configure the redirection parameters
Network Attack Motification
Default Motification P
Activation
Diefault Redirection BAEE Gloped|URLS
Redirection Profile 1 Activation brigger*
Activate upon:
(%) Subscriber dicks
O Erowse ko a new site
O any
Activation frequency
(& orly once
) Always
() Periodically*:
Every | |
(O Until the subscriber browses ko
* These configuration options are available only For redirect profile of tvpe "redirect”.
2
[ QK ] ’ Cancel ] 3
b

Step7  Configure the frequency in which the redirection is triggered. Choose one of the Activation frequency
radio buttons:

« «Only once
« ¢ Always
« < Until the subscriber browsesto

Step8  If you chose the Until the subscriber browses to radio button, enter the dismissal URL host-suffix and
path-prefix in the fields provided.

Step9  Click the Allowed URLs tab.
The Allowed URL s tab opens (Figure 10-28).
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Figure 10-28 Allows URLs Tab

X

3 Redirect Actions Settings

Create and edit Redirect Profiles

Configure the redirection parameters

Network Attack Motification
Default Notification General | Activation | Alowed URLs
Default Redirection

tedirection Profile 1 Allowed URLs

List of URLs that are allowed to browse to overriding the redirection conditions

The aAllowed URLs should be in a Format *hast-suffixpath-prefix* (For example *.my-hosk. com: fredir™),
Type one URL per Line:

* . mywebserver,.com:path™

CK ][ Cancel ]

273586

Step10 (Optional) Enter any allowed URLS, one per line.
Step11 Click OK.
The Redirect Actions Settings dialog box closes.
The notification redirect profile is added to the profile list.

Cisco Service Control Application for Broadband User Guide
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Managing Subscriber Redirection

The rules for a package may deny access to selected protocols. When a subscriber to the package tries
to access a blocked protocol, the traffic flow can be redirected to a server where a posted web page
explains the reason for the redirection (for example, a*“Silver” subscriber trying to access a service
available only to “Gold” subscribers). This web page can offer subscribers the opportunity to upgrade
their packages. You configure which redirection profile to use when defining rules.

Note  Redirection is not supported when unidirectional classification is enabled.

Each redirect profile consists of a set of redirect parameters. The Cisco Service Control Application for
Broadband (SCA BB) supports a maximum of 128 redirect profiles, including notification redirect and
redirect profiles.

Subscriber Redirect Parameters

Each redirect profile of type redirect contains the following parameters:
» Name—Each profile must have a unique name.

N

Note  You cannot change the name of the Default Redirection Profile.

» Redirect profile type—Each profile must be one of two types:
— Notification
— Redirect

» Set of Redirection URLs—A configurable set of destination URLSs, to which the subscriber’'sHTTP
flows are redirected after redirection is activated. The redirection set can optionally include one, or
several parameters appended to the destination URL including the redirect reason or subscriber ID.

» Activation trigger—The action that initiates the redirect. The activation trigger is one of the
following:

— Subscriber clicks—When the redirect is activated through a subscriber clicking alink.
— Browse to a new site—When the redirect is activated through browsing.
— Any—When the redirect is activated either viaalink or browsing.

« Activation frequency—Indicates when to activate the redirect. The activation frequency isone of the
following:

— Only once—The subscriber is redirected only the first time the conditions are met.
— Always—The subscriber is redirected every time the conditions Seconds

— Triggering events

- KBytes

— Until the subscriber browsesto—Every time the conditions are met, the subscriber isredirected,
until the subscriber proceeds from the destination URL to a different, final URL.

The dismissal URL is composed of the URL hostname and the URL path, separated by a colon,
in the following format:
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[*]<hostname>:<path>[*]
— <hostname> may optionally be preceded by a wildcard (*), to match all hostnames with the
same suffix.
— The path element must always start with “/”.
— <path> may be followed by awildcard (*), to match all paths with a common prefix.
For example, the entry *.some-isp.net:/redirect/* matches all the following URLSs:
* www.some-isp.net/redirect/index.html
* support.some-isp.net/redirect/info/warning.asp
* noquota.some-isp.net/redirect/acknowledge.aspx?ie=UTF-8

« List of Allowed URLs—A list of URLs that will not be blocked and redirected even though
redirection is activated.

After redirection is activated, all HTTP flows, except flows to the destination URL and to the
dismissal URL, are blocked and redirected to the destination URL . However, subscribers can be
permitted to access an additional set of URLs. Thisisuseful, for example, to give subscribers access
to additional support information.

Allowed URLSs have the same format as the dismissal URL.

These parameters are defined when you add a new notification redirect profile. You can modify them at
any time.

Cisco Service Control Application for Broadband User Guide
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How to Add a Redirect Profile

A redirect profile contains a set of redirection URLs as well as conditions in which to use the redirect
feature, such as the action that triggers the redirect, or the frequency in which the redirect occurs.

Stepl  From the Policies tab in the left pane, choose Configuration > Subscriber Redirection.

The Redirect Actions Settings dialog box appears (Figure 10-29).

Figure 10-29 Redirect Actions Settings - General Tab

3 Redirect Actions Settings E|
Create and edit Redirect Profiles
Configure the redirection parameters
Iebwork Attack Notification
Default Matification General —
DeFault Redirectian Activation | alowed URLs
Mame: | Mebwork attack Motification
Select redirection profile type:
Manage redirect sets:
Select URL set: | Default set [htbp:/ fwww . my-htkp-server, com/redirect.cgi] A
[ Ok l ’ Cancel ] %
&

Step2  Click Add.
A new redirect profile containing the default redirection URL set is added to the redirect profile list.
Step3  Inthe Name field, enter a unique name for the new redirect profile.

Note  You can use the default name for the redirect profile, but it isrecommended that you enter a meaningful
name.

Step4  Choose a URL set.
Step5  Click the Activation tab.
The Activation tab opens (Figure 10-30).
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Figure 10-30 Activation Tab
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2
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Step6  Configure the activity that triggers the redirection. Choose one of the Activation trigger radio buttons:
- Subscriber clicks
- Browseto anew site
 Any

Step7  Configure the frequency in which the redirection is triggered. Select one of the Activation frequency
radio buttons:

« Only once

e Always

» Periodically

« Until the subscriber browsesto

Step8  If you selected the Periodically radio button, enter a number and an increment in the Every fields, to
specify the frequency in which the redirection occurs.

Step9  If you selected the Until the subscriber browses to radio button, enter the dismissal URL in the fields
provided.

Step10  Click the Allowed URL s tab.
The Allowed URL s tab opens (Figure 10-31).

Tip Enter all configured redirection URLs to the Allowed URLs list to prevent a redirection loop.

Cisco Service Control Application for Broadband User Guide
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Figure 10-31 Allowed URLs Tab

3 Redirect Actions Settings [5__(|
Create and edit Redirect Profiles
Configure the redirection parameters
Network Attack Motification
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Redirection Profile 1 Allowed URLs
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Type one URL per Line:
* . mywebserver,.com:path™
[ K ] [ Cancel ] §
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Step 11  (Optional) Enter a URL, or multiple URLSs that can be browsed, overriding the redirect conditions.
Step12 Click OK.

The Redirect Actions Settings dialog box closes.

The Redirection profile is added to the redirection profile list.

How to Delete a Redirection Profile

You cannot delete the Default Redirection Profile.

Step1  From the Policies tab in the left pane, choose Configuration > Subscriber Redirection.
The Redirect Actions Settings dialog box appears.

Step2  Click the name of the profile.

Step3  Click Remove.

Step4  Click OK.
The Redirect Actions Settings dialog box closes.
The Redirection settings are saved.
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How to Add a Set of Redirection URLS

The Console Redirection feature supports only three protocols:
- HTTP Browsing
e HTTP Streaming
e RTSP Streaming

Each redirection set contains one redirection option for each of these three protocols. The system
provides a default redirection set, which cannot be deleted. You can add up to 127 additional sets.

Each redirection URL includes the URL specified name, the Subscriber ID, and the Service ID in the
following format:

<URL>?n=<subscriber-ID>&s=<service-ID>

Optionally, the URL can contain one or multiple parameters appended to it.

Step1  From the Policies tab of the left pane, choose Configuration > Subscriber Redirection.
The Redirect Actions Settings dialog box appears.

Step2  Inthe General tab, click Edit.
The Redirect Set Settings dialog box appears (Figure 10-32).
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Figure 10-32 Redirect Set Settings
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Step3  Click Add.
A new redirection set containing the default redirection URLs is added.
Step4  Inthe Redirection Set Name field, enter unique name for the new redirection set.
A
Note  You can usethe default namefor the redirection set, but it isrecommended that you provide a meaningful
name.
Step5  Enter new values in the Redirection destination URLS section of the new redirection set.
Timesaver  Enter all configured redirection URLs to the Allowed URLs list to prevent aredirection loop.
Step6  (Optional) To include aresponse code, check the Response code check box, and choose a response code
from the drop-down list. Refer to Table 10-2 for alisting and description of the redirection parameters.
Step7  (Optional) To include a cookie, check the Cookie check box, and enter a value. Refer to Table 10-2 for

alisting and description of the redirection parameters.
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Step 8

Step 9

Step 1

Managing Subscriber Redirection

(Optional) Check the check boxes of any parameters you wish to append to the destination URL Refer
to Table 10-2 for alisting and description of the redirection parameters.

If you check the Free text to append check box, enter text into the text box to append to the URL. Refer
to Table 10-2 for a listing and description of the redirection parameters.

a

Note  “<” and“>" do not appear in redirect URL.

Maximal length of destination URL including parameters is 500 characters.

Cookie and Referer parameters are allowed only for HTTP traffic.

Table 10-2 Redirection Parameters

Parameter Description

Reason In case of notification - notification number.
In case of DDOS attack - DDOS attack ID.
In case of redirect - not valid.

Subscriber ID Subscriber name as it appearsin SCE.

Service ID The ID of the service as was classified by the

SCE.

Distinct Number

Unique identifier of redirected flow, in format
<redirected flow number:cpu number>.

Time Stamp Time in seconds, in Unix format.
Free text to append Free text.
Referer Referer asit appears in the original flow request.

In case of no referer is presented, “* will appear.

Original Cookie

Cookie string as it appears in the original flow
request. In case of no cookieis presented, “* will

appear.

Original Host Host name as it appears in the original flow
request.
Original URL URL it appearsin the original flow request.

Original Parameters

URL parameters as they appear in the original
flow request. In case of no parameters are
presented, ““ will appear.

Click OK.

Your settings are saved and the Redirect Set Settings dialog box closes.

From the Policies tab of the left pane, choose Configuration > Subscriber Redirection.

The Redirect Actions Settings dialog box appears.
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Step 2

Step 3
Step 4
Step 5

In the General tab, click Edit.

The Redirect Set Settings dialog box appears.
Click the name of the redirection set.

Click Remove.

Click OK.

The Redirect Set Settings dialog box closes.
The Redirection settings are saved.
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Managing the System Settings

The Console allows you to determine various system parameters that control

- The operational state of the system
- Enabling and disabling asymmetric routing classification mode

- Advanced service configuration options

Setting the System Modes

From the Console you can select:
- The operational mode of the system

» Asymmetric routing classification mode

Information About the System Modes

Note

» System Operational Mode, page 10-45
- Asymmetric Routing Classification Mode, page 10-45

System Operational Mode
The operational mode of the system defines how the system handles network traffic.

Each rule has its own operational mode (state). If this differs from the system mode, the “lower” of the
two modes is used. For example, if aruleis enabled, but the system mode is report-only, the rule will
only generate RDRs.

The three operational modes are:

« Full Functionality—The system enforces active rules on the network traffic and performs reporting
functions (that is, generates RDRS).

» Report Only—The system generates RDRs only. No active rule enforcement is performed on the
network traffic.

» Transparent—T he system does not generate RDRs and does not enforce active rules on the network
traffic.

Asymmetric Routing Classification Mode

Enabling unidirectional classification significantly improves classification accuracy when the SCE
platform is deployed in an environment with a high rate of unidirectional flows.

» Unsupported Features, page 10-45

» Protocol Classification, page 10-46

» Switching to Asymmetric Routing Classification Mode, page 10-46

« Switching from Asymmetric Routing Classification Mode, page 10-46

Unsupported Features
The following SCA BB features are not supported when unidirectional classification is enabled:

| oL-7205-19
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- Flavors

- External quota provisioning
» Subscriber notification

« Redirection

» Flow Signaling RDRs

« Content filtering

- VAStraffic forwarding

When unidirectional classificationisenabled, the service configuration editor indicates (in the Problems
View) if the service configuration is consistent with the features that are supported in this mode.

The following features, which are not part of the service configuration, are also affected when
unidirectional classification is enabled:

» Subscriber-Aware Mode (a mode in which subscriber information is dynamically bound to the IP
address currently in use by the subscriber) is not supported.

« Enhanced flow open mode must be enabled.

The system gives no indication if the state of the above featuresis consistent with the state of the routing
classification mode.

Protocol Classification

When unidirectional classification is enabled, protocol classification is performed in the normal way

with the exception of unidirectional UDP flows. Because it isimpossible to know the server side of a
unidirectional UDP flow, SCA BB tries to classify the protocol using the destination port of the first

packet; if no exact match is found, SCA BB tries to classify the protocol using the source port.

Switching to Asymmetric Routing Classification Mode

If you create a service configuration in symmetric mode and switch to asymmetric routing classification
mode:

» Flavors are not used for classification.
» Periodic quota management mode is used.

- Datais not lost when you switch to asymmetric routing classification mode, but you cannot apply
the service configuration to an SCE platform until all unsupported features are removed from the
service configuration.

Switching from Asymmetric Routing Classification Mode
If you create a service configuration in asymmetric routing classification mode;

» The Suspected Session Rate is set equal to the Session Rate for all anomaly detectors.

« No flavors are created in the default service configuration, and no service elements have specified
flavors.

» The quota management mode is periodic, with a daily aggregation period.

» Asymmetric routing classification mode limitations remain if you switch to symmetric mode. To
change them, you must edit the service configuration.
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How to Set the Operational and Topological Modes of the System

Stepl  From the Policies tab of the left pane, choose Configuration > System Settings.
The System Settings dialog box appears (Figure 10-33).

Figure 10-33 System Settings

£ System Settings @|

g

{| Advanced Optians

System Operational Mode

Select the system's operational mode For handling the netwaork Eraffic:
() Transparent

(%) Repart Only

() Full Functionality

Routing Classification Mode

Enable Asymmetric Routing Classification Mode in topologies
with high rate of unidirectional flows, In this mode, the system is
better tuned for classifying traffic according to just one side of the
Flows, but some contral capabilities are disabled.

)] [ oK ” Cancel ]
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Step2  Select one of the System Operational M ode radio buttons:
« Transparent
» Report Only
« Full Functionality

Step3  To change the routing classification mode, check or uncheck the Enable the Asymmetric Routing
Classification M ode check box.

Step4  Click OK.
The System Settings dialog box closes.
The new System Mode setting is saved.

Managing Advanced Service Configuration Options

Advanced service configuration options control the more sophisticated and less frequently changed
attributes of the system. It is recommended that you do not change these options.

- The Advanced Service Configuration Properties, page 10-48
- How to Edit Advanced Service Configuration Options, page 10-50

Cisco Service Control Application for Broadband User Guide
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The Advanced Service Configuration Properties
Table 10-3 lists the advanced service configuration properties:

Table 10-3 Advanced Service Configuration Properties

Property Default Value Description

Classification

Guruguru detailed inspection |FALSE The Guruguru protocol is used by the Guruguru file-sharing application
mode enabled popular in Japan. SCA BB provides two inspection modes for
classification of this protocol:

» Default—Suitable for networks where little Guruguru traffic is
expected. Thisis usual in all countries except Japan.

» Detailed—Suitable for networks where Guruguru traffic is expected
to be common. This should occur in Japanese networks only.

Kuro detailed inspection FALSE The Kuro protocol is used by the Kuro file-sharing application popular
mode enabled in Japan. SCA BB provides two inspection modes for classification of
this protocol :

- Default—Suitable for networks wherelittle Kuro traffic is expected.
Thisisusual in all countries except Japan.

» Detailed—Suitable for networkswhere Kuro traffic is expected to be
common. This should occur in Japanese networks only.

Soribada detailed inspection |FALSE The Soribada protocol is used by the Soribada file-sharing application
mode enabled popular in Japan. SCA BB provides two inspection modes for
classification of this protocol:

- Default—Suitable for networks where little Soribada traffic is
expected. Thisisusual in al countries except Japan.

» Detailed—Suitable for networks where Soribada traffic is expected
to be common. This should occur in Japanese networks only.

TCP destination port 1720:H323 TCP destination port numbers for signatures that require a port hint for
signatures correct classification.

Valid values are comma-separated items, each item in the form
<port-number>:<signature-name>.

Applicable signature names are: H323, Radius Access, Radius
Accounting, and DHCP.

UDP destination port 67:DHCP, UDP destination port numbers for signatures that require a port hint for
signatures 68:DHCP, correct classification.

i\iﬁgad' us Valid values are comma-separated items, each item in the form

' < - >:<si >,

1645 Radius port-number>:<signature-name

Access, Applicable signature names are: H323, Radius Access, Radius

1813:Radius Accounting, and DHCP.

Accounting,

1646:Radius

Accounting

Cisco Service Control Application for Broadband User Guide
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Advanced Service Configuration Properties (continued)

Property

Default Value

Description

UDP ports for which flow
should be opened on first
packet

5060, 5061, 67,

68, 69, 1812,

1813, 1645, 1646,
2427, 2727, 9201,
9200, 123, 1900,

Enhanced flow-open mode is disabled on the specified UDP ports, to
allow classification according to the flow’s first packet.

5190, 10000
UDP source port signatures  |1812:Radius UDP source port numbers for signatures that require a port hint for
Access, correct classification.
i\iﬁgad' us Valid values are comma-separated items, each item in the form
! < - >:<si >
1813-Radius port-number>:<signature-name
Accounting, Applicable signature names are: H323, Radius Access, Radius
1646:Radius Accounting, and DHCP.
Accounting
V-Share detailed inspection  |[FALSE The V-Share protocol is used by the V-Share file-sharing application
mode enabled popular in Japan. SCA BB provides two inspection modes for
classification of this protocol:
» Default—Suitable for networks where little V-Share traffic is
expected. Thisisusual in al countries except Japan.
- Detailed—Suitable for networks where V-Share traffic is expected
to be common. This should occur in Japanese networks only.
Winny detailed inspection FALSE The Winny P2P protocol is used by the Winny file-sharing application
mode enabled popular in Japan. SCA BB provides two inspection modes for
classification of this protocol:
» Default—Suitable for networks where little Winny traffic is
expected. Thisis usual in all countries except Japan.
» Detailed—Suitable for networks where Winny traffic is expected to
be common. This should occur in Japanese networks only.
Malicious Traffic
Malicious Traffic RDRs TRUE Specifies whether to generate Malicious Traffic RDRs.
enabled
Number of seconds between |60 A Malicious Traffic RDR is generated when an attack is detected.
Malicious Traffic RDRs on Malicious Traffic RDRs are then generated periodically, at
the same attack user-configured intervals, for the duration of the attack.
TCP port that should remain |80 You can choose to block flows that are part of any detected network
open for Subscriber attack, but this may hinder subscriber notification of the attack.
Notification The specified TCP port will not be blocked to allow notification of the
attack to be sent to the subscriber.
Multi stage Classification
Blocking FALSE Specifies whether to block the sub services under the main service.
Cisco Service Control Application for Broadband User Guide
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Table 10-3 Advanced Service Configuration Properties (continued)

Property Default Value Description

Enable TRUE Specifies whether to enable the sub service classification of a service.
Multi stage classification describesthe application level servicesthat can
be enabled or disabled. By default sub service classification of the
servicesis enabled.
For example, Google talk service contains Google talk file transfer,
Google talk Networking, Google talk Vol P as sub services.

Policy Check

Ongoing policy check mode |TRUE Specifies whether policy changes affect flows that are already open.

enabled

Time to bypass between 30 Maximum time (in seconds) that may pass before policy changes affect

policy checks flows that are already open.

Quota M anagement

Grace period before first 2 The time (in seconds) to wait after a quota limit is breached before the

breach breach action is performed.
Policy servers should use this period to provision quotato a subscriber
that just logged in.

Length of the time framefor |0 The size of the window across which to randomly scatter the periodic

guota replenish scatter quota replenishment.

(minutes)

Time to bypass between 30 Maximum time (in seconds) that may pass before a quota breach affects

policy checks for quota flows that are already open.

limited flows

Volume to bypass between 0 Maximum flow volume (in bytes) that may pass before a quota breach

policy checks for quota affects flows that are already open.

limited flows Fmi
A value of zero means that unlimited volume may pass.

Reporting

Media Flow RDRs enabled TRUE Specifies whether to generate Media Flow RDRs.

Subscriber Accounting RDR |FALSE Specifies whether to generate Subscriber Accounting RDRs.

enabled

The Subscriber Accounting RDR is used for SM-ISG integration. For
more information, see either the ISG documentation in the “Managing
the SCMP” chapter of the Cisco SCE8000 10GBE Software
Configuration Guide or the “Managing the SCMP” chapter of the Cisco
SCE8000 10GBE Software Configuration Guide.

How to Edit Advanced Service Configuration Options

Step 1

From the Policies tab of the left pane, choose Configuration > System Settings.

The System Settings dialog box appears.

Step 2

Click the Advanced Options tab.

The Advanced Options tab opens (Figure 10-34).
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Step 3

Figure 10-34 Advanced Options Tab
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Managing the System Settings

The Advanced Service Configuration Options dialog box opens (Figure 10-35).
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Figure 10-35 Advanced Service Configuration Options
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Winmy detailed inspection mode ¢ False
= Malicious Traffic
Malicious Traffic RDRs enabled  true
Murmber of seconds between Mal 60
TCP port: that should remain oper 80
= Multi Stage Classification ;I

I
~
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Step4  Make your changes to the configuration options.

Step5  Click OK.
The Advanced Service Configuration Options dialog box closes.
The changes to the advanced options are saved.

Step6  Click OK.
The System Settings dialog box closes.
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Managing VAS Settings

Value Added Service (VAS) settings includes the following features:

Traffic mirroring—Traffic mirroring allows using the SCE to mirror a portion of the traffic based on
its application and subscriber awareness. Traffic to be mirrored continues forwarding asis, and
copies of the packets are sent to the corresponding VAS vlan, thereby minimizing traffic.

Traffic forwarding—Traffic forwarding servers allows you to use an external expert system (VAS
server) for additional traffic processing, such as intrusion detection and content filtering to
subscribers. After processing, flows are sent back to the SCE platform, which then sends them to
their original destinations.

The flows to be forwarded are selected based on the subscriber package and the flow type (IP
protocol type and destination port number).

VAS mirroring has the following limitations:

The SCE 2000 and SCE8000 both support traffic mirroring.

Traffic mirroring is supported on any SCE platform that has at least 2 ports.
An SCEB8000 can contain 64 distinct VLANS.

An SCE 2000 supports 8 distinct VLANS.

VAS forwarding has the following limitations:

Only the SCE 2000 4xGBE platform supports VAS traffic forwarding.
A single SCE platform can support up to eight VAS servers.

A service configuration can contain up to 64 traffic-forwarding tables.
A traffic-forwarding table can contain up to 64 table parameters.

VAS traffic forwarding is not supported when unidirectional classification is enabled.

Note  Because of the complexity of the VAS settings features, VAS flows are not subject to global bandwidth
control.

To use VAS traffic forwarding, you must also configure VAS services on the SCE platform. Additional
information is available in the “Value Added Services (VAS) Traffic Forwarding” chapter of the Cisco
SCE2000 and SCE1000 Software Configuration Guide.

How to Enable VA S Traffic Forwarding, page 10-54

How to Rename VAS Server Groups, page 10-55

How to View VAS Traffic-Forwarding Tables, page 10-57
How to Delete VAS Traffic-Forwarding Tables, page 10-58
How to Add VAS Traffic-Forwarding Tables, page 10-59
Managing VAS Table Parameters, page 10-60

| oL-7205-19
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How to Enable VAS Traffic Forwarding

By default, VAS traffic forwarding is disabled. You can enable it at any time.

S

Note  VAStraffic forwarding is not supported when unidirectional classification is enabled.

Stepl  From the Policies tab of the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears (Figure 10-36).

Figure 10-36 VAS Settings

3£ VS Settings §|
Select Yas Mode:
(%) Enable Traffic Mirroring
() Enable Traffic Forwarding
Traffic Mirraring Groups
Server Groups Table
The Server Groups Table lisks the names of YAS server groups, A YAS server group is a
collection of physical WAS servers that provides the same service as configured in the SCE.
Server Group ID Serwver Group Mame Flow Wolume to Mirror (KB
0 Server Group O 0 s
1 Server Group 1 0
Z Server Group 2 0
3 Server Group 3 0
4 Server Group 4 0
S Server Group S5 0
] Server Group 6 0
7 Server Group 7 0 e
s
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Step2  Choose the Enable Traffic Forwarding radio button.

Note  VAS traffic forwarding is not supported in asymmetric routing classification mode. If you try to check
the Enable Traffic Forwarding radio button when asymmetric routing classification mode is enabled, a
VAS Error message appears.
Click OK, and continue at Step 4.

A VAS warning message appears.
Step3  Click OK.
Step4  Click Close.

The VAS Settings dialog box closes.
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How to Enable VAS Traffic Mirroring

Step 1

Step 2

Step 3
Step 4

Traffic Mirroring in enabled and configured in the VAS Setting dialog box. However, you configure
which server group to use when defining rules.

From the Policies tab of the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears.

Choose the Enable Traffic Mirroring radio button.

A VAS warning message appears.

Click OK.

Click Close.

The VAS Settings dialog box closes.

How to Rename VAS Server Groups

Step 1

Step 2
Step 3
Step 4

An SCE platform can forward flows to up to eight different VAS server groups. By default, the eight
server groups are named “ Server Group n”, where n takes a value from 0 to 7. Give the server groups
meaningful names; the names you give will appear in the drop-down list in the Control and Breach
Handling tabs of the Add Rule to Package dialog box (see How to Set Advanced Package Options,
page 9-51) and in the Server Group field of the table parameters added to each traffic-forwarding table
(see Managing VAS Table Parameters, page 10-60).

From the Policies tab of the left pane, choose Configuration > VAS Settings.

The VAS Settings dialog box appears (Figure 10-37).

In the table in the Server Groups Table area, double-click in a cell containing a server group name.
Enter a meaningful name in the cell.

Repeat Step 2 and Step 3 for other server groups you wish to rename.

| oL-7205-19
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Step 5

Figure 10-37 Traffic Forwarding Groups Tab
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Click Close.
The VAS Settings dialog box closes.
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How to Configure VAS Traffic-Mirroring

Step1  From the Policies tab of the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears (Figure 10-38).

Figure 10-38 Traffic Mirroring Groups Tab
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Step2  Click the Enable Traffic Forwarding radio button.

Step3  For each server group, in the Flow Volumeto Mirror (KB) column, enter the maximum amount of
volume to mirror, in KB.

Step4  Click Close.
The VAS Settings dialog box closes.

How to View VAS Traffic-Forwarding Tables

SCA BB decides whether aflow passing through an SCE platform should be forwarded to a VAS server
group based on a traffic-forwarding table. Each entry (table parameter) in a traffic-forwarding table
defines to which VAS server group the specified flows should be forwarded.

Stepl  From the Policies tab of the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears.
Step2  Click the Enable Traffic Forwarding radio button.
Step3  Click the Traffic Forwarding Tables tab.
The Traffic Forwarding Tables tab opens.
A list of all traffic-forwarding tables is displayed in the Traffic Forwarding Tables area.

Cisco Service Control Application for Broadband User Guide
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Step4  Click atablein the list of traffic-forwarding tables to display its table parameters.

A list of all table parameters defined for this traffic-forwarding table opens in the Table Parameters tab
(Figure 10-39).

Figure 10-39 Traffic Forwarding Tables Tab

3£ VAS Settings g|
Seleck Yas Mode:
() Enable Traffic Mirroring
(%) Enable Traffic Forwarding
Traffic Forwarding Groups | Traffic Forwarding Tables
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:
N

Step5  Click Close.
The VAS Settings dialog box closes.

How to Delete VAS Traffic-Forwarding Tables

You can delete all user-created traffic-forwarding tables. The default traffic-forwarding table cannot be
deleted.
N

Note A traffic-forwarding table cannot be deleted while it is associated with a package.

Stepl  From the Policies tab of the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears.
Step2  Click the Enable Traffic Forwarding radio button.
Step3  Click the Traffic Forwarding Tables tab.
The Traffic Forwarding Tables tab opens.
Step4  From thelist of traffic-forwarding tables in the Traffic Forwarding Tables area, select atable.
Steps  Click #% (Delete).
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A VAS Warning message appears (Figure 10-40).

Figure 10-40 VAS Warning

3 VAS Warning

I
210054

Step6  Click Yes.

The selected table is deleted and is no longer displayed in the list of traffic-forwarding tables.
Step7  Click Close.

The VAS Settings dialog box closes.

How to Add VAS Traffic-Forwarding Tables

A default traffic-forwarding table is included in the service configuration. You can add up to 63 more
traffic-forwarding tables, and then assign different traffic-forwarding tables to different packages.

Stepl  From the Policiestab in the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears.

Step2  Click the Enable Traffic Forwarding radio button.

Step3  Click the Traffic Forwarding Tables tab.
The Traffic Forwarding Tables tab opens.

Step4  Inthe Traffic Forwarding Tables area, click ='J= (Add).

A new table named Table (n), where nis a value between 1 and 63, is added to the list of
traffic-forwarding tables in the Traffic Forwarding Tables area.

The table name is also displayed in the Item Name box in the Table Parameters tab.
Step5  Inthe Iltem Name field, enter a unique and relevant name for the traffic-forwarding table.

You can now add table parameters to the new traffic-forwarding table, see How to Add VAS Table
Parameters, page 10-60.

Cisco Service Control Application for Broadband User Guide
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Managing VAS Table Parameters

A table parameter is an IP protocol type, an associated TCP/UDP port (where applicable), and a VAS
server group or arange of |P addresses.

A traffic-forwarding table is a collection of related table parameters.
A traffic-forwarding table can contain up to 64 table parameters.

« How to Add VAS Table Parameters, page 10-60

« How to Edit VAS Table Parameters, page 10-60

- How to Delete VAS Table Parameters, page 10-62

How to Add VAS Table Parameters

You can add up to 64 table parameters to a traffic-forwarding table.

Stepl  From the Policies tab in the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears.
Step2  Click the Enable Traffic Forwarding radio button.
Step3  Click the Traffic Forwarding Tables tab.
The Traffic Forwarding Tables tab opens.
Step4  From thelist of traffic-forwarding tables in the Traffic Forwarding Tables area, select atable.
Step5  Inthe Traffic Parameters tab, click & (Add).
A new table parameter is added to the list of table parameters in the Table Parameters tab.

N

Note  Each new table parameter has the default values as listed in Table 10-4.
Table 10-4 Table Parameter Default Values
Parameter Default value
IP Protocol TCP Port
TCP/UDP Port 80
Server Group Server Group O

You can now edit the new table parameter, as described in the following section.
Step6  Click Close.
The VAS Settings dialog box closes.

Howv to Edit VAS Table Parameters

Stepl  From the Policies tab in the |l eft pane, choose Configuration > VAS Settings.
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Step 2
Step 3

Step 4
Step 5

A

Note

The VAS Settings dialog box appears.

Managing VAS Settings W

Click the Enable Traffic Forwarding radio button.

Click the Traffic Forwarding Tables tab.
The Traffic Forwarding Tables tab opens.
From the list of traffic-forwarding tables i

n the Traffic Forwarding Tables area, select a table.

In the table in the Table Parameters tab select a protocol, port, and server group.

a. Clickinacell inthe IP Protocol column, and, from the drop-down list that opens, select an |P

protocol type (Figure 10-41).

Figure 10-41 Table Parameters Tab

Table Parameters

Item Mame: | Gold

w K

IP Protocal TCPIUDP Paort Server Group
|TCP Port HTTP content Filt...
PZP tache

TCP Port

LIDP Port
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If you select All, All TCP, All UDP, or All Non TCP/UDP, “N/A” will appear in the TCP/UDP Port

cell when you move to another cell in

b. If you selected TCP Port or UDP Port
enter the port number.

the table.
, double-click in the cell in the TCP/UDP Port column, and

You cannot enter arange of portsin the TCP/UDP Port cell; you must add a separate table parameter for

each port.

c. Clickinthecell inthe Server Group column, and, from the drop-down list that opens, select a server

group (Figure 10-42).
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Figure 10-42 Tables Parameters Tab
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Click Close.
The VAS Settings dialog box closes.

Step 6

How to Delete VAS Table Parameters

Stepl  From the Policies tab in the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears.
Step2  Click the Enable Traffic Forwarding radio button.
Step3  Click the Traffic Forwarding Tables tab.
The Traffic Forwarding Tables tab opens.
Step4  From thelist of traffic-forwarding tables in the Traffic Forwarding Tables area, select atable.
Step5  From thelist of table parameters in the Table Parameters tab, select a table parameter.
Steps  Click #% (Delete).
The selected table parameter is deleted and is no longer displayed in the list of table parameters.
Step7  Click Close.

The VAS Settings dialog box closes.
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Managing the Protected URL Database

The SCE Protected URL Database is a database that contains a“blacklist,” alist of websites that are
considered off limits or dangerous. You can configure the SCE to apply a specific action, such as
blocking a site, when a subscriber attempts to access a site listed on the blacklist.

The database is encrypted so that no one, including the operator, can view the blacklist. The blacklist is
managed on the SCE and cannot be withdrawn to the management PC.

RDRs are created when a subscriber attempts to access a link included in the blacklist. However, the
RDRs do not contains the URL or Host information of the site.

In order to enable the blacklist feature, you must do the following:
« Definean HTTP flavor
- Create ablacklist service
« Assignthe HTTP flavor to the blacklist service
- Create arule for the blacklist service
- Assign black list entries to the flavor, using the CLI

For more information about the Protected URL Database, see the Cisco Service Control URL
Blacklisting Solution Guide.

Cisco Service Control Application for Broadband User Guide
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Using the Subscriber Manager GUI Tool

Revised: December 14, 2011, OL-7205-19

Introduction

This chapter describes how to use the Subscriber Manager (SM) GUI tool to configure subscribersin the
Cisco Service Control Management Suite (SCMS) Subscriber Manager (SM) database.

The SM GUI tool is especially useful when the SCMS-SM holds a static list of subscribers. It is not
applicable when the Cisco Service Control Application for Broadband (SCA BB) is operating in
subscriberless mode (a mode in which control and analysis functions are available only at a global
platform resolution) or in anonymous subscriber mode (a mode in which entities defined as | P addresses
or VLANS are treated as subscribers).

- Using the SM GUI Tool, page 11-1
» Working with Subscriber CSV Files, page 11-6
» Managing Subscribers, page 11-8

Using the SM GUI Tool

Note

The SM GUI tool allows you to manage subscribers on an SCMS-SM. The SCMS-SM functions as
middleware software that bridges between the OSS and the Service Control Engine (SCE) platforms.
SCE platforms use the subscriber information to provide subscriber-aware functionality, per-subscriber
reporting, and policy enforcement. Subscriber information is stored in the SCMS-SM database and can
be distributed between multiple platforms according to actual subscriber placement.

You can use the SM GUI tool to import and export subscriber files, and to perform operations on
individual subscribers, such as adding a new subscriber, editing parameters of an existing subscriber, and
deleting a subscriber.

To access an SCMS-SM from the SM GUI tool, you must first add the SCMS-SM to the Site Manager
tree in the Network Navigator tool (see How to Add SM Devicesto a Site, page 5-5).

The SM GUI tool provides only a subset of the functionality that is provided by the SM Command-Line
Utility. For more information about the SCMS-SM, see the Cisco Service Control Management Suite
Subscriber Manager User Guide.

| oL-7205-19
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Connecting to an SCMS-SM

You can connect to an SCM S-SM:
» From the Network Navigator tool
e From anywhere else in the Console
» From the Subscriber Manager GUI tool

S

Note ~ The SM GUI tool performs authentication on the SCMS-SM by opening a PRPC connection to port
14374 and attempting to log in using the username and password that you entered in the Password
Management dialog box. If aPRPC server with this user is not running on the SCM S-SM, authentication
will fail.

If you have changed the PRPC port on the SCMS-SM, see User Authentication, page 5-39.

How to Connect to an SCMS-SM from the Network Navigator

Stepl  Inthe Site Manager tree in the Network Navigator tab, right-click an SM device.
A popup menu appears (Figure 11-1).

Figure 11-1 SM Device Popup Menu

¢ Manage Subscribers

(@) Orline Status. ..
il Generate Tech Support Info File. ..

Advanced ’
Configuration Wizards 4
Editing L4 2
Show Properties \isw E

Step2  From the menu, select Manage Subscribers.

A Password Management dialog box appears.
Step3  Enter the appropriate password. (For more information, refer to Password Management, page 5-8).
Step4  Click Connecting.

The Password Management dialog box closes.

A Connecting to progress bar appears.

The system connects to the SCMS-SM.

'E? (Import subscribersfrom CSV file), = (Export subscriberstoCSV file), and -l--l- (Disconnect
from SM) are enabled (Figure 11-2).
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Figure 11-2 Subscriber Manager
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How to Connect to an SCMS-SM from the Console

S

Note  (If you are already in the SM GUI tool, start at Step 3.)

Stepl  From the Console main menu, choose Tools > Subscriber Manager.
The SM GUI tool opens.

A Subscriber Manager is not connected message appears (Figure 11-3).

Figure 11-3 Subscriber Manager is not Connected

B

Subscriber Manager is not connected to any SM,
Please connect to an S,

210017

Step2  Click OK.
The Subscriber Manager is not connected message closes.
Step3  Inthe SM GUI toolbar, click 3 (Connect to an SM).

If more than one SCMS-SM device is configured in the Network Navigator, the Choose SM Devices
dialog box appears (Figure 11-4).
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Figure 11-4 Choose SM Devices
o/ x|
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Step4  Select adevice and click OK.

A Password Management dialog box appears.
Step5  Enter the appropriate password. (For more information, refer to Password Management, page 5-8.)
Step6  Click Connecting.

The Password Management dialog box closes.

A Connecting to progress bar appears.

The system connects to the SCMS-SM.

@ (Import subscribersfrom CSV file), (Export subscribersto CSV file), and 1-x-b (Disconnect
from SM) are enabled.

How to Disconnect from the Current SCMS-SM

Stepl  Inthe SM GUI toolbar, click 1-“-& (Disconnect from SM).
The Console disconnects from the SCMS-SM, but the SM GUI tool remains open.

[g (Import subscribersfrom CSV file), (Export subscribersto CSV file), and 1-“-! (Disconnect
from SM) are dimmed.

The subscriber list is empty (Figure 11-5).
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Figure 11-5 Subscriber Manager List
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Working with Subscriber CSV Files

Because of the large number of subscribers that must be introduced into the system, it is not feasible to
enter subscriber information manually. Subscriber information isusually generated by aRADIUS server
(or some similar source) and imported into the SM GUI tooal.

You can also export updated subscriber information to a CSV file.

The format of subscriber CSV filesis described in the“ CSV File Formats” chapter of the Cisco Service
Control Application for Broadband Reference Guide.

- How to Import Subscriber Information from a CSV File, page 11-6
» How to Export Subscriber Information to a CSV File, page 11-6

How to Import Subscriber Information from a CSV File

Step 1

Step 2

Step 3

You can import subscriber data that was exported to a CSV file into the SM GUI tool.

In the SM GUI toolbar, click 'EF;' (Import subscribersfrom CSV file).
An Import from File dialog box appears.

Browse to the file that is to be imported and click Open.

An Import Warning message appears (Figure 11-6).

Figure 11-6 Import Warning
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Click Yes.
The Import from File dialog box closes.

The selected file isimported into the SM GUI tool; the imported subscribers are listed in the subscriber
list.

How to Export Subscriber Information to a CSV File

Step 1
Step 2

You can export subscriber information to aCSV file (for example, when datain the SCMS-SM database
is updated).

Select the subscribers whose data you want to save (see Selecting Subscribers, page 11-9)
In the SM toolbar, click = (Export subscribersto CSV file).
An Export to File dialog box appears.
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Step3  Browse to the folder in which you want to save the exported file.
Step4  Inthe File namefield, enter afile name.
Step5  Click Save.

The Export to File dialog box closes.

The selected subscribers are saved to the CSV file.

Cisco Service Control Application for Broadband User Guide
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Managing Subscribers

After importing subscribers into the system, you can maintain and update the database.
You can perform the following operations:

« Add subscribers

- Edit information for existing subscribers
« Delete subscribers

Subscriber Information

All subscribers currently introduced into SCA BB are displayed in alist in the SM GUI tool as shown
in Figure 11-7. Use this list to manage individual subscribers or groups of subscribers. Use the Find
function to display a subset of the subscribers (see How to Find a Subscriber or Group of Subscribers,
page 11-9).

The subscriber list has the following columns:

Subscriber ID—Name of the subscriber in the system.

Subscriber Domain—Domain to which the subscriber is assigned. The names of the SCE platforms
that belong to each domain appear in square brackets.

Network Mappings—IP address, range of 1P addresses, or VLAN tag mapped to the subscriber.

Package—Package I1D assigned to the subscriber. The name of the package is shown in square
brackets.

Figure 11-7 Subscriber Manager - Subscriber List
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Finding and Selecting Subscribers

For ease of use, the SM GUI tool incorporates two standard features:
» Find—Search for a specific subscriber.

« Multiple Select—Select arange of subscribers or a number of individual subscribers.

How to Find a Subscriber or Group of Subscribers

Step 1

Step 2

Usethisfeatureto find a specific subscriber or agroup of subscribers according to asubscriber ID prefix.
Thisis useful for editing the parameters of either a specific subscriber or a group of subscribers (see
Editing Subscriber Details, page 11-12)

In the Find field (Figure 11-8), enter the prefix to be matched.

Figure 11-8 Find Field

G XN i

Click # (Find subscribers).
Only those subscribers that match the specified prefix are displayed in the subscriber list.

Selecting Subscribers

Step 1
Step 2

You can edit, export, or delete a group of subscribers at one time by selecting subscribers displayed in
the subscriber list. The group may be either of the following:

» A range of contiguous subscribers

« A number of noncontiguous subscribers

- How to Select a Range of Subscribers, page 11-9

- How to Select a Number of Noncontiguous Subscribers, page 11-10

How to Select a Range of Subscribers

Select the first subscriber in the range.
Press the Shift key and click the last subscriber in the range.
All subscribersin the range are selected.

You can combine this function with the search function; search to display specific subscribers and then
select the entire range.

| oL-7205-19
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How to Select a Number of Noncontiguous Subscribers

Stepl  Pressthe Ctrl key while selecting subscribers.
You can combine this function with selecting a range of subscribers; first select the range of subscribers
and then select additional subscribers.
How to Add a Subscriber
You can add additional individual subscribers to the SCMS-SM.
To add large number of subscribers, export their information from aRADIUS (or DHCP) server toaCSV
file, and then import the CSV file (see Working with Subscriber CSV Files, page 11-6)
Stepl  Inthe SM toolbar, click G (Add Subscriber).
The Add a New Subscriber dialog box appears (Figure 11-9).
Figure 11-9 Add a New Subscriber
General I Network Mappings |
Subscriber ID
ISubscriberz
Subscriber Domain:
| <not introduced= LI
Subscriber Package:
I{package 0= ;I
[T Activate Subscriber Real-Time Monikaring
oK | Cancel | é

Step2  Inthe Subscriber ID field, enter text that identifies the subscriber.

Step3  From the Subscriber Domain drop-down list, select the appropriate domain for the new subscriber.

Step4  From the Subscriber Package drop-down list, select a package to assign to this subscriber.

The contents of the list depend on the selected subscriber domain.

Step5  To activate subscriber real-time monitoring, check the Activate Subscriber Real-time Monitoring
check box. This causes the SCE application to generate Real-Time Subscriber Usage RDRs for this
subscriber.

If you are not going to define network mappings for this subscriber, continue at Step 11.

Step6  Click the Network Mappings tab.

The Network Mappings tab opens (Figure 11-10).
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Figure 11-10 Network Mappings Tab

Add a New Subscriber 1

General Metwork Mappings I

Subscriber Metwork Mappings:
=" IP Address

= WLAN

158731

Managing Subscribers

The system supports either |P addresses or VLAN tags as network identification for subscribers.

Step7  Select one of the Subscriber Network M appings radio buttons.

« |P Address
< VLAN

Step8  Click '{:’ (Add) to add a network mapping of the type selected in the previous Step.

A new network-mapping entry is added to the subscriber network mappings list, displaying a default

value (Figure 11-11).
Step9  Edit the network-mapping entry.

Figure 11-11 Network Mapping Default Value

Add a New Subscriber 1

General Metwork Mappings I

Subscriber Metwork Mappings:
=" IP Address

= WLAN

10.56.216,1/32

| x|

QF | Cancel |

Step 10 Repeat Steps 8 and 9 for other network mappings.

158732
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Step11l Click OK.
The Add A New Subscriber dialog box closes.
The new subscriber is added to the database, and to the subscriber list displayed in the SM GUI tool.

Editing Subscriber Details

You can edit parameters of single or multiple subscribers.
» How to Edit Details for Single Subscribers, page 11-12
« How to Edit Details for a Group of Subscribers, page 11-13

How to Edit Details for Single Subscribers

Stepl  Find and select a subscriber. (See How to Find a Subscriber or Group of Subscribers, page 11-9.)
Step2  Inthe SM toolbar, click l (Edit Subscriber).
The Edit Subscriber dialog box appears (Figure 11-12).

Figure 11-12 Edit Subscriber

Edit Subscriber "Subscriber2™

General I Metwork Mappings |

Subscriber ID
ISubscriberZ

Subscriber Domain:

|subscribers x |

[ #ctivate Subscriber Real-Time Monitaring

apply | Cancel

158812

Step3  Modify subscriber details.
- Edit the entry in the Subscriber ID field.
« From the Subscriber Domain drop-down list, select a subscriber domain.
« From the Subscriber Package drop-down list, select a package to assign to this subscriber.
The contents of the list depend on the selected subscriber domain.
« Check or uncheck the Activate Subscriber Real-time Monitoring check box.
If you are not editing the network mappings for this subscriber, continue at Step 6.
Step4  Click the Network Mappings tab.
The Network Mappings tab opens (Figure 11-13).
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Step 5

Step 6

Edit Subscriber "Subscriber2™

Managing Subscribers

Figure 11-13 Network Mappings Tab

General Metwork Mappings I

Subscriber Metwork Mappings:
=" IP Address

= WLAN

10,1,11,20/32 i

| x|

Apply | Cancel |

158813

Modify subscriber network mappings:

a. Select one of the Subscriber Network M appings radio buttons:
— IP Address
- VLAN
b. To add anew network mapping to thelist, click 5 (Add), and edit the network-mapping field that
is added to the Subscriber Network Mappings list.
c. To delete n,~ntwork mapping from the list, select an entry in the subscriber network mappings list
and click %% (Delete).
Click Apply.
The Edit Subscriber dialog box closes.
The modified subscriber information is saved to the database and displayed in the subscriber list in the
SM GUI tool.

How to Edit Details for a Group of Subscribers

Step 1
Step 2

You can assign the same package or domain to many subscribers at one time.

Select a group of subscribers (see Selecting Subscribers, page 11-9) to modify.

In the SM toolbar, click _ " (Edit).
The Edit Multiple Subscribers dialog box appears (Figure 11-14).

| oL-7205-19

Cisco Service Control Application for Broadband User Guide g



Chapter 11 Using the Subscriber Manager GUI Tool |

M Managing Subscribers

Figure 11-14 Edit Multiple Subscribers
General I Network Mappings |

Subscriber ID
ISubscriberl

Subscriber Damain:

|subscribers LI
Subscriber Package:
| <package 1= ;I

[T Activate Subscriber Real-Time Monikaring

Apply | Cancel |

158806

The Subscriber ID field is dimmed and the Network Mappings tab is disabled.
Step3  Modify fieldsin the General tab.
» From the Subscriber Domain drop-down list, select a subscriber domain.
- From the Subscriber Package drop-down list, select a package to assign to this subscriber.
The contents of the list depend on the selected subscriber domain.
« Check or uncheck the Activate Subscriber Real-time Monitoring check box.
Step4  Click Apply.
The Edit multiple Subscribers dialog box closes.

The modified subscriber information is saved to the database and displayed in the subscriber list in the
SM GUI tool.

How to Delete a Subscriber from the Database

You can del ete subscribers from the database.

Stepl  Select asingle subscriber or a group of subscribers (see Selecting Subscribers, page 11-9).
Step2  Inthe SM toolbar, click ﬁ (Delete Subscriber).

The system asks for confirmation before deleting the selected subscribers (Figure 11-15).

Figure 11-15 Subscriber Warning

3£ subscriber Warning Il x|

® Are vou sure you want ko remove these subscribers?
H

210018
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Step3  Click Yesto confirm.

The selected subscribers are deleted from the database and removed from the subscriber list displayed
in the SM GUI tool.

Cisco Service Control Application for Broadband User Guide
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Using the Signature Editor

Revised: December 14, 2011, OL-7205-19

Introduction

This modul e describes the Signature Editor tool and how to use it to create and modify Dynamic
Signature Script (DSS) files.

The Signature Editor tool allows you to create and modify DSS files that can add and modify protocols
and protocol signatures in the Cisco Service Control Application for Broadband (SCA BB), based on
your knowledge of new network protocols that are not yet supported by SCA BB.

» The Signature Editor Console, page 12-1
- Managing DSS Files, page 12-1

- How to Create DSS Files, page 12-11

» How to Edit DSS Files, page 12-14

« How to Import DSS Files, page 12-15

The Signature Editor Console

The Signature Editor writes log and error messages to the Signature Editor Console (in the Console
view), when appropriate.

Managing DSS Files

- Installing new signatures to an active service configuration is described in Working with Protocol
Packs, page 4-19.

- Working with signatures in the Service Configuration Editor is described in Managing Protocol
Signatures, page 7-39.

- Using servconf, the Server Configuration Utility, to apply signaturesis described in The SCA BB
Service Configuration Utility, page 13-1.

The DSS file components, and the creation and editing of DSSfiles, are explained in the following
sections.

Cisco Service Control Application for Broadband User Guide
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The DSS File Components

The DSS file components are displayed in the Script pane of the Signature Editor, in atree structure. By

selecting the appropriate node of the DSS component tree, you can define the properties associated with
the node in the Property pane.

The DSS file components are described in the following sections.

The DSS File

The DSS File, page 12-2

DSS Protocol List, page 12-2

Information About DSS Protocols, page 12-3
DSS Signatures, page 12-4

DSS Deep Inspection Clauses, page 12-9
DSS Deep Inspection Conditions, page 12-9

The DSS file name is the root hode of the DSS file component tree.

When you select the root node, you can define the following properties for the DSS file:

Script Name—Enter a meaningful name for this script.

Script Description—Enter the reason for creating this script and describe its contents.
Script Version (Mgjor)

Script Version (Minor)

Script Build Number (Major)

Script Build Number (Minor)

Created for Application Version—Select from alist of predefined values.

Figure 12-1 shows the default values for the DSS file properties.

Figure 12-1 Default Values for DSS File Properties
I Properties B | =
Property | Value
Seript Mame MyScript
Seript Description

Seript Version (Major)
Seript Version (Minor)
Script Build no. (Major)
Script Build no. (Minor)
Created for App. Version

WO O

210804

The DSSfile contains a single protocol list.

DSS Protocol List

The protocol list has no propertiesto define. It contains all the protocols that are being added, modified,
or enhanced.
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Information About DSS Protocols
When you select a Protocol nodein the DSSfile component tree, you can define the following properties
of the protocol:
- Basic:
— Protocol Name—See Setting Protocol Name and ID, page 12-3.
— Protocol Description
— Protocol ID—See Setting Protocol Name and ID, page 12-3.
» Protocol Category:
— Buddy Protocol—See The Buddy Protocol, page 12-4.
— Protocol Families—Assign the protocol to one or more protocol families:
- P2P
- SIP
- VOIP
- Worm

Associating a protocol with aprotocol family allows reports about the family to include the new
protocol.

Figure 12-2 shows the default values for the protocol properties.

Figure 12-2 Default Values for the Protocol Properties
Property Value
Protocol Mame <enter a unigue name =
Protocol Description
Protocol Id 1

=1 Protocol Category
Buddy Protocol
Protocol Families

210809

Protocols contain signatures.

Setting Protocol Name and ID
A DSS can include two types of protocols:

« A protocol new to SCA BB—The protocol is being defined in the DSS.

« A protocol that SCA BB already supports—The protocol identification is being enhanced or
modified in the DSS.

Selecting aname and ID is different for the two cases:

» For aprotocol new to SCA BB, the name must not match any of the protocol names that SCA BB
already supports. To see alist of supported-protocol names, open the Protocol Settings dialog box
in the Service Configuration Editor (see How to View Protocols, page 7-22). Assign the protocol a
unique ID in the range 5000 to 9998.

Cisco Service Control Application for Broadband User Guide
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DSS Signatures

» For an existing protocol, the protocol name and I D in the DSS must be identical to the protocol hame
and ID in the service configuration. Locate the name and ID in the Protocol Settings dialog box in
the Service Configuration Editor (see How to View Protocols, page 7-22).

The Buddy Protocol

To simplify the configuration of new protocols added by a DSS, the DSS may specify a Buddy Protocol
for anew protocol. If, when importing a DSS to a service configuration, the application encounters
service elements referring to the Buddy Protocol, it automatically duplicates the set of service elements
that use the Buddy Protocol and replaces all referencesto the Buddy Protocol with referencesto the new
protocol. The association of the new protocol to services will match that of the Buddy Protocol.

A protocol may contain as many different signatures as necessary.
Four different types of signatures may be added to a protocol:
» String Match Signatures
» Payload Length Signatures
« HTTP User Agent Signatures
» HTTP x-Header Signatures
Each of the four signature types tests different conditions against the first payload packet of the flows.
These signature types and their conditions are described in the following subsections.

String Match Signatures and Payload L ength Signatures can contain deep inspection clauses. A signature
whose first payload packet conditions are met will accept aflow if the conditions of any of its deep
inspection clauses are also met.

DSS String Match Signature

When you select a String Match Signature node in the DSS file component tree, you can define the
following properties of the signature:

- Signature Name—A unique name
- Signature Description
» Signature ID—A value in the range 0xC010000 to 0xCO0100FF (decimal 201392128 to 201392383)
» First Payload Packet Conditions:
— Fixed Size Byte String—(Display only) Shows the string formed by the next four fields:

— [O]—Enter the ASCII code for the first byte of the string, or enter “*” to indicate that any value
is acceptable.

— [1]—Enter the ASCII code for the second byte of the string, or enter “*” to indicate that any
value is acceptable.

— [2]—Enter the ASCII code for the third byte of the string, or enter “*” to indicate that any value
is acceptable.

— [3]—Enter the ASCII code for the fourth byte of the string, or enter “*” to indicate that any
value is acceptable.
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— String Position—The position of the Fixed Size Byte String in the packet. The position is the
location of the first byte of the string, counting from the first byte in the packet. To match the
string with the beginning of the packet, this value should be zero. The value must be an integer
divisible by four.

— Packet Direction—Theinitiating side of thefirst packet in the flow that has apayload. Thisfield
can have one of three values:

— From Server
— From Client
— Don’'t Care (either side)

— Port Range—(Display only) The port range formed by the next two fields. The default valueis
the entire port range: 0 to 65535.

— From Port—L ower bound of the port range (inclusive)
— To Port—Upper bound of the port range (inclusive)
— Check before PL—Toggl es between the values true and false.

Thisfield indicates whether to test the signature before or after the execution of the SCA BB
built-in PL (Protocol Library) classification. Testing this signature before the execution of the
built-in classification meansthat if the flow matches this signature, the PL classification will be
skipped. If thisfield is set to “false”, this signature will be tested only if the PL classification
fails to identify any of its supported protocol signatures.

— Asymmetric Routing Classification Mode—This field indicates whether to test the signature
depending on the state of the asymmetric routing classification mode. It can have one of three
values:

— Don't Care—Signifies that this signature should be tested whether asymmetric routing
classification mode is enabled or disabled.

— Disabled
— Enabled

— Flow Type—(Display only) This field shows to which flow types the condition applies (the
condition may be applied to multiple types). It isignored unless asymmetric routing
classification mode is enabled.

The flow type is specified by the next four fields:
— Bidirectional—Toggles between the values true and false.

— Unidirectional Client Side—Toggles between the values true and false. Appliesto TCP flows
for which only packets from the client side have been detected.

— Unidirectional Server Side—Toggles between the valuestrue and false. Applies to TCP flows
for which only packets from the server side have been detected.

— Unknown (UDP)—Toggles between the values tr ue and false. Appliesto UDP flows for which
packets from only one direction have been detected.

Caution

Set Check before PL to true only if the signature identifies the protocol according to the first payload
packet only. If the signature also uses a Deep Inspection Condition that looks into later packets, and the
signature does not match the flow, the PL classification will not perform properly.

Figure 12-3 shows the default values for the String Match Signature properties.

| oL-7205-19
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Figure 12-3

=

]

Value

<enter a unigue name>=

Default Values for the String Match Signature Properties

Signature Description
Signature Id OxCO10000
- First Payload Packet Conditions
[=| Fixed Size Byte String abrcd
[0 97
1 93
2 99
I3 100
String Position a
Packet Direction Don't Care
=l Port Range 0:55535
From port o]
To port 55535
Check before PL false
Asymmetric Routing Classification Mode  Don't Care
= Flow Type Bidirectional
Bidirectional true
Unidirectional Client Side false
Uridirectional Server Side false
Urknaown (UDP) falze b
z
o

A flow that matches the first payload packet conditions of a String Match Signature will then be
compared against the deep inspection conditions of the signature (see DSS Deep Inspection Conditions,

page 12-9).

DSS Payload Length Signature

When you select a Payload Length Signature node in the DSS file component tree, you can define the
following properties of the signature;

Signature Name—A unique name

Signature Description
Signature ID—A value in the range 0xC010000 to 0OxCO100FF (decimal 201392128 to 201392383)
First Payload Packet Conditions:

Packet Direction—The initiating side of the first packet in the flow that hasapayload. Thisfield
can have one of three values:

From Server

From Client

Don't Care (either side)

Payload Length—The number of bytes in the payload packet.

Port Range—(Display only) The port range formed by the next two fields. The default value is
the entire port range: 0 to 65535.

From Port—L ower bound of the port range (inclusive)
To Port—Upper bound of the port range (inclusive)
Check before PL—Toggles between the values true and false.

[l Cisco Service Control Application for Broadband User Guide
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This field indicates whether to test the signature before or after the execution of the SCA BB
built-in PL (Protocol Library) classification. Testing this signature before the execution of the
built-in classification meansthat if the flow matches this signature, the PL classification will be
skipped. If thisfield is set to “false”, this signature will be tested only if the PL classification

fails to identify any of its supported protocol signatures.

— Asymmetric Routing Classification Mode—This field indicates whether to test the signature
depending on the state of the asymmetric routing classification mode. It can have one of three

values:

— Don't Care—Signifies that this signature should be tested whether asymmetric routing
classification mode is enabled or disabled.

— Disabled
— Enabled

— Flow Type—(Display only) This field shows to which flow types the condition applies (the
condition may be applied to multiple types). It isignored unless asymmetric routing
classification mode is enabled.

The flow type is specified by the next four fields:

— Bidirectional—Toggles between the values true and false.

— Unidirectional Client Side—Toggles between the values true and false. Appliesto TCP flows
for which only packets from the client side have been detected.

— Unidirectional Server Side—Toggles between the values true and false. Appliesto TCP flows
for which only packets from the server side have been detected.

— Unknown (UDP)—Toggles between the values tr ue and false. Appliesto UDP flows for which
packets from only one direction have been detected.

Caution  Set Check before PL to true only if the signature identifies the protocol according to the first payload
packet only. If the signature also uses a Deep Inspection Condition that looks into later packets, and the
signature does not match the flow, the PL classification will not perform properly.

Figure 12-4 shows the default values for the Payload L ength Signature properties.
Figure 12-4 Default Values for the Payload Length Signature Properties
BEET
Property
<enter @ unique name=
Sigmature Description
Signature Id 0xC010000
=| First Payload Packet Conditions
Packet Direction Don't Care
Payload Length i
- PortRange 0:65535
From port o]
To port 55535
Check before PL falze
Asymmetric Routing Classification Mode  Don't Care
= Flow Type Bidirectional
Bidirectional true
Unidirectional Client Side false
Unidirectional Server Side false
Unknown (UDP) falze %
=
&
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A flow that matches the first payload packet conditions of a Payload Length Signature will then be
compared against the deep inspection conditions of the signature (see DSS Deep Inspection Conditions,

page 12-9).

DSS HTTP User Agent Signature

When you select an HTTP User Agent Signature node in the DSS file component tree, you can define
the following properties of the signature:

» Signature Name—A unique name
» Signature Description
- Signature ID—A value in the range 0xC010000 to 0xCO0100FF (decimal 201392128 to 201392383)
- Conditions:
— User Agent—The value of the User Agent field in the HTTP header
Figure 12-5 shows the default values for the HTTP User Agent signature properties.

Figure 12-5 Default Values for the HTTP User Agent Signature Properties

BEE T

Signature Mame =enter a unigue name >
Signature Description

Signature Id 0xC0 10000
= Conditions
User Agent <user agent>

210505

DSS HTTP x-Header Signature

When you select an HTTP x-Header Signature node in the DSS file component tree, you can define the
following properties of the signature;

» Signature Name—A unique name
- Signature Description
- Signature ID—A value in the range 0xC010000 to 0xC0100FF (decimal 201392128 to 201392383)
- Conditions:
— X-Header Field Name—A name of afield in the x-Header of the HTTP header
Figure 12-6 shows the default values for the DSS file properties.

Figure 12-6 Default Values for the DSS File Properties

hos

<enter @ unigue name =
Signature Description

Signature Id OxC0O10000
= Conditions
x-Header Field Name <field name =

210806
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DSS Deep Inspection Clauses

N

Note

A deep inspection clause is a conjunctive clause of deep inspection conditions—a signature will accept
aflow only if al conditionsin a clause are met.

If a signature has multiple deep inspection clauses, the clauses (and the deep inspection conditions
making up each clause) are tested in an order based on the value of the Packet Number property of the
deep inspection conditions.

After the first payload packet is accepted by the first payload packet conditions, the clause containing

the condition with the lowest Packet Number is tested. The other conditions in this clause are checked
in ascending Packet Number order. Thus, the Packet Number of any condition in a clause cannot be less
than the largest Packet Number in the clause it succeeds.

DSS Deep Inspection Conditions

A deep inspection condition is a set of conditions that are checked against flows that pass the first
payload packet conditions screening of String Match Signatures or Payload Length Signatures.

When you select a Deep Inspection Condition node in the DSS file component tree, you can define the
following properties of the deep inspection condition:

- Packet Direction—Theinitiating side of the first packet in the flow that has a payload. Thisfield can
have one of three values:

— From Server
— From Client
— Don’'t Care (either side)

» Packet Number—The number of the packet in the flow. The payload packets are numbered from
zero; packets are counted in both directions.

- Payload Length—The length of the packet in bytes. Enter zero to indicate that any valueis
acceptable.

» Printable Characters—Test if the inspected packet contains only printable characters. Thisfield can
have one of three values:

— Printable Characters Only
— At Least One Non-Printable
— Don't Care

» Substring Search—Match a search string with a specific location in the packet. Leave the Search
String fields empty if this condition isirrelevant.

— Position Offset—The position from which to start searching for the search string in the packet.
The offset isrelative to the location specified in the Start Search From field.

— Start Search From—This field can have one of two values:
— Packet beginning
— Last match

Last match means that the search for this search string starts where the last search match ended.
The last match may be from a previous substring search or from the last string-based first
payload packet condition.

| oL-7205-19
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Searchable Range—Search in this number of bytes for the search string.
Search Packets—This field can have one of two values:

This packet only

Multiple packets

Multiple Packets means that the search may span across packets, as long as the overall number
of bytesis less than the number specified in the Searchable Range field.

Search String—Enter the search string in one of the following three fields (the other two fields
will be updated automatically):

ASCII Codes—Enter the ASCII codesfor the characters of the search string. Separate each code
by a comma.

Byte String—Enter the actual search string.

Hex Values—Enter the hexadecimal values of the ASCI| codes for the characters of the search
string. Separate each code by a comma.

» Transport Protocol—This field can have one of three values:

TCP
UDP
Don't Care (either TCP or UDP)

Figure 12-7 shows the default values for the deep inspection condition properties.

Figure 12-7 Default Values for the Deep Inspection Condition Properties
il Properties = -_'E—Iv B
Property Value

Packet Direction Don't Care
Packet Number 0
Payload Length 0
Printable Characters Don't Care
=| Substring Search
Position Offset 0
Start Search From Packet beginning
Searchable Range 3
Search Packets This packet only
-1 Search String
ASCII Codes 97,98,99
Byte String abc
Hex Values 61,62,63
Transport Protocol Don't Care

210803

The structure of deep inspection conditionsisthe same for String Match Signatures and Payload L ength
Signatures.
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How to Create DSS Files

If you have aDSSfile openinthe Signature Editor, save it before you create anew DSSfile. All unsaved
changes will be lost.

. w .
Stepl  From thetoolbar, click || (Createa New DSSFile).

A DSS component tree containing a DSS File node, a Protocol List node, and a Protocol node, is
displayed in the Script view.

The default properties of the new DSS file are displayed in the Properties view (Figure 12-8).

Figure 12-8 Properties Tab

& QService Configuration Editor Signature Editor € Network Navigator

<new D55 = B Properties

Script Mame
= MyScript Script Description

=I-[i2] Protocol List Script Version (Major) 1

& <enter a unique name > Script Version (Minor) 0

Script Build no. (Major) 1

0

3

Script Build no, (Minar)
Created for App. Version

E console G E | CieE

210807

Step2  Edit the DSS file properties.
For an explanation of the properties, see The DSS File, page 12-2.
Step3  Click the Protocol node.
The protocol properties appear in the Properties view (Figure 12-9).
Step4  Edit the protocol properties.
For an explanation of the properties, see Information About DSS Protocols, page 12-3.
Step5  Click the drop-down arrow next to the ':E:' button.

Cisco Service Control Application for Broadband User Guide
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Figure 12-9 Protocol Properties

e QService Configuration Editor Signature Editor & Network Navigator

8 Properties

e = Proserlty
=1 Rasir
= MySaript String Match Signature ol Name
=& Protocol List Payload Length Signature ol Description
o HTTP User Agent Signature ol Id
HTTP x-Header Signature iategory

BUHAY Protocol
Protocol Families

210810

Step6  From the drop-down menu that appears, select a signature type.
A Signature node is added under the Protocol node.

If you selected a String Match Signature or a Payload Length Signature, a Deep Inspection Clause node
and a Deep Inspection Condition node are also added (Figure 12-10).

Figure 12-10 Protocol List Information
=] *<new D35>
= - R E

= ¢» <enter a unique name =
=@ <enter a unigue name>
[=-0€) Desp Inspection Clause
® Deep Inspection Condition

158992

Step7  Click the Signature node.
The signature properties appear in the Properties view.
Step8  Edit the signature properties.
For an explanation of the properties., see DSS Signatures, page 12-4

Step9  If you selected a String Match Signature or a Payload Length Signature, click the Deep Inspection
Condition node to edit the deep inspection condition properties.

The deep inspection condition properties appear in the Properties view.

For an explanation of the properties, see DSS Deep Inspection Conditions, page 12-9.
Step 10  Add additional deep inspection conditions, deep inspection clauses, signatures, and protocols as needed.
Step 11 From the toolbar, click L:1_| (Save).

- If there are duplicate protocol names or protocol IDs, a Validation Error message appears
(Figure 12-11).
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Step 12
Step 13
Step 14

Figure 12-11 Validation Error

3 Validation Error

Cannot save script.
The script contains errors that have to be fixed before saving, See Console
view for errors.

Click OK, remove the duplication, and then click (Save) again.
A Save As dialog box appears.
Browse to the folder where you want to save the new DSSfile.
In the File name field, enter an appropriate name for the DSS file.
Click Save.
The Save As dialog box closes.
The DSSfileis saved.

How to Create DSS Files M
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How to Edit DSS Files

A

You can edit an existing DSS file, and add new protocols, or modify or delete existing protocols.

Caution

Step 1

Step 2
Step 3

Step 4

Step 5

If you have a DSS file open in the Signature Editor, save it before you open a different DSS file. All
unsaved changes will be lost.

From the toolbar, click 'E (Open a DSSFile).

An Open dialog box appears.

Browse to the DSS file that you want to edit.

Click Open.

The Open dialog box closes.

The DSS Component tree of the selected fileis displayed in the Script view.

The DSS File node is selected, and the properties of the DSS file are displayed in the Properties view.
Add, edit, or delete DSS file components.

See the subsections of The DSS File Components, page 12-2for an explanation of the properties of the
different components.

Save the modified DSSfile.
= To overwrite the current DSS file with the changes you have made:
— From the toolbar, click L& (Save).
The changes to the DSS file are saved.
» To save the modified DSS file with a new name:
1. Choose File > Save As.
A Save As dialog box appears.
2. Browse to the folder where you want to save the new DSSfile.
3. Inthe File name field, enter an appropriate name for the DSSfile.
4. Click Save.
The Save As dialog box closes.
The modified DSSfile is saved with the new name.
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How to Import DSS Files
You can import DSS files into the file you are currently editing.

A

Note  Importing signatures may create duplication of protocol names or protocol IDs.

Stepl  From the Console main menu, choose File > Import.
The Import dialog box appears (Figure 12-12).

Figure 12-12 Import

F Import |Z|®

Select
Y

Choose import source, I g -

Select an import source:

|type filker bext |

=+ [ Service Configuration
Import content filkering database settings From an XML file
Import service configuration parts fram a CSW file

(== Signature Editar

Cancel I

274089

Step2  From the import source list, select Import protocols from one DSS file to another DSS.

Step3  Click Next.
The second screen of the Import dialog box opens (Figure 12-13).

Cisco Service Control Application for Broadband User Guide
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Figure 12-13 Import Protocols from One DSS File to Another

3€ Import [‘5_<|

Import Protocols from One DSS File to Another
Select a DSS file containing the protocols you would like to import

D35 File Infomation:

Mo file has been selected.

Choose File

Cancel

158857

Step4  Click Choose File.

An Open dialog box appears.
Step5  Browseto the DSS file to import.
Step6  Click Open.

The Open dialog box closes.

Information about the DSS file that you have chosen is displayed in the DSS File Information area
(Figure 12-14).
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Figure 12-14 Import Protocols from One DSS File to Another

3 Import |g|
Import Protocols from One DSS File to Another
Select a DSS file containing the protocols you would like to import

D35 File Infomation:

D35 File: Loco.dss

Script Name: NewPocoScript
Version: 1.0 build 1.0

Created for SCA BB version: 3.1.0
Description:

The 0S5 contains signatures for the following protocols:
Loco

Choose File

< Back lexk ] Einish | Cancel

211136

Step7  Click Finish.
The Import dialog box closes.
The content of the selected DSS file is imported into the Signature Editor.

Cisco Service Control Application for Broadband User Guide
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Additional Management Tools and Interfaces
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Introduction

This chapter contains the following information:
» The SCA BB Service Configuration Utility, page 13-1
» The SCA BB Real-Time Monitoring Configuration Utility, page 13-4
- The SCA BB Signature Configuration Utility, page 13-7
» Overview of SNMP, MIB, and Traps, page 13-8
« Installing PQI Files from the Command Line, page 13-9
« Managing Subscribers via Other System Components, page 13-10

The SCA BB Service Configuration Utility

The Cisco Service Control Application for Broadband (SCA BB) Service Configuration Utility
(servconf) isacommand-line utility (CLU) for applying and retrieving service configurations. Useit in
a scripting environment to automate service configuration tasks on multiple Service Control Engine
(SCE) platforms.

The Service Configuration Utility can run in Windows, Solaris, and Linux environments.

servconf Syntax

The command-line syntax of servconf is:

servconf <operation> [<option>] [<option>]...

Table 13-1 lists the servconf operations.

Table 13-2, Table 13-3, Table 13-4, Table 13-5, and Table 13-6 list the servconf options.

Cisco Service Control Application for Broadband User Guide
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Table 13-1 servconf Operations

Operation Abbreviation Description

--apply -a Copies the specified service configuration file to the
specified SCE platforms and activates it

--retrieve -r Retrieves the current service configuration

--update-dc -u Updates a Cisco Service Control Management Suite
(SCMS) Collection Manager (CM) with service
configuration values

--status Showsthe service configuration status on the SCE platform

--update-signature Updates the SCE platform with a new protocol pack

--update-signature-pqi Updates the SCE platform with a new SPQI protocol pack

--signature-info -i Shows information about the Dynamic Signature Script
(DSS) file

--help Displays help, then exits

--version Displays the program version number, then exits

Table 13-2 servconf File Options

File Option Abbreviation  |Description

--file=filename -f Specifies a service configuration file or DSSfile

--backup-directory=directory |-b Specifies the directory to which to save the
retrieved PQB file before applying a new protocol

pack

Table 13-3 servconf Connection Options

File Option Abbreviation Description

Specifies the | P address of the destination SCE platform.

To specify multiple SCE platforms, list the |P addresses
separated by semicolons (see Example 1 in the following
section).

--se=address -S

When using a semicolon in a Unix command line, the
command-line argument must be enclosed in quotation
marks.

Specifies the | P address of the destination SCMS-CM
platform (required only for the --update-dc operation).

--dc=address -D

[l Cisco Service Control Application for Broadband User Guide
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Table 13-3 servconf Connection Options (continued)
File Option Abbreviation Description
--passwor d=password |-P Specifies the password for connecting to the SCE platform.
--username=usernam |-U Specifies the username for connecting to the SCE platform.
e If this option is not specified, the following default values
are used:
e SCE—admin
e« CM—pcube
e SM—pcube
Table 13-4 servconf Reference SCE Option
File Option Description
--refer-se=address Specifies the |P address of the SCE platform to which the service
configuration values refer (required only for --update-dc operation)

Table 13-5 servconf Apply Options
File Option Description
--no-dc (Optional) Specifiesthat the --apply operation should not automatically

update the SCMS-CM with service configuration values.

--no-default-signature Applies the service configuration without adding the default DSS to it.

--force-default-signature  |Forcesthe replacement of the DSSin the retrieved PQB with the default
DSS, even if the signatures of the existing DSS are mapped to services.
Without this flag, trying to update a PQB containing a DSS will fail.

Table 13-6 servconf Update Signature Option
File Option Description
--force-signature Forces replacement of the DSS in the retrieved PQB, even if the signatures

of the existing DSS are mapped to services. Without this flag, trying to
update a PQB containing a DSS will fail.

servconf Examples

Example 1

To copy the service configuration file config.pgb from the local machine to two SCE platforms (at
63.111.106.7 and 63.111.106.12), and activate this configuration:

servconf ”"--se=63.111.106.7;63.111.106.12" --username Alice --password ***** __gpply
--file config.pgb

Example 2

| oL-7205-19
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To retrieve the current service configuration from the SCE platform at 63.111.106.7, and save it in file
my_files\config.pgb on the local machine:

servconf -S 63.111.106.7 -U Bob -P ***** _—_retrieve --file my files\config.pgb

Example 3

To update the SCMS-CM at 63.121.116.17 with service configuration values from file config.pgb, asif
they were applied to the SCE platform at 63.111.106.7 (but without actually applying them to the SCE
platform):

servconf -D 63.121.116.17 -U Alice -P ***** __ypdate-dc
--refer-se 63.111.106.7 --file config.pgb

Example 4

To distribute the protocol pack file new_signature.spqi to the SCE platforms at 10.56.216.33 and
10.56.216.36:

servconf --update-signature-pgi -f new_signature.spgi
-S ”10.56.216.33;10.56.216.36" -U userl23 -P **#***

The SCA BB Real-Time Monitoring Configuration Utility

SNM P-based monitoring tools, such as MRTG, allow network administrators to monitor the activity and
health of network devicesin real time. SCA BB includes an SNM P-based real -time monitoring solution,
which isimplemented using MRTG and a graphics utility (RRD Tool).

The SCA BB Real-Time Monitoring Configuration Utility (rtmemd) is a command-line utility (CLU)
for automating the production of the files required by the MRTG tool.

For installation instructions, see How to Install the SCA BB Configuration Utilities, page 4-8. For more
information about installing and using the SCA BB SNM P-based real -time monitoring solution, see the
Cisco SCA BB SNMP Real Time Monitoring User Guide.

« rtmcmd Syntax, page 13-4

« rtmemd Examples, page 13-5

» Thertmemd User Configuration File, page 13-6

» Anrtmemd User Configuration File Example, page 13-7

rtmcmd Syntax

The command-line syntax of the SCA BB Real-Time Monitoring Configuration Utility is:

rtmcmd --sce <SCE (SNMP) addresses> {--file <PQB filename> | (--pgb-sce
<SCE (PQB) addresses> --username <username> --password <password>)} --source-dir <dir>
--dest-dir <dir> --config-file <file>

Table 13-7 lists the rtmemd options.

Cisco Service Control Application for Broadband User Guide
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Table 13-7 rtmcmd Options

Option Abbreviation Description

--sce address -S Specifies the | P address or hostname of the SCE platform from
which SNMP data will be collected.
To specify multiple SCE platforms, list the | P addresses separated
by semicolons.
When using a semicolon in a Unix command line, the
command-line argument must be enclosed in quotation marks.

--filefilename |-f (Required if --pgb-sce is not included) Specifies the service
configuration file to use when generating the configuration and
report files. If this option is specified, the --username/-U and
--passwor d/-P options are prohibited.

--pgb-sce -q (Required if --file is not included) Specifies the hostname or |P

address address of the SCE platform from which the service configuration
should be retrieved. This option requires the --username/-U and
--passwor d/-P options.

--username -U (Required if --pqgb-sce is included) Specifies the username for

<username> connecting to the SCE platform.

--password -P (Required if --usernameisincluded) Specifies the password for

<password> connecting to the SCE platform.

--source-dir -S Specifies the location of the report template files.

<dir>

--dest-dir -d Specifies the directory where the processed report templates

<dir> should be stored.

--config-file -C Specifies the configuration file. (See The rtmcmd User

<file> Configuration File, page 13-6).

You can invoke additional operations (see Table 13-8) to display information about the rtmemd using
the following syntax:

rtmemd <operation>

Table 13-8 rtmcmd Operations

Operation Description

--version Displays the program version number, then exits
--help Displays help, then exits

rtmcmd Examples

Example 1

To use the service configuration file servicecfg.pgb to create configuration and report files for the
collecting and reporting of SNMP information from two SCE platforms (at 63.111.106.7 and

63.111.106.12):

| oL-7205-19
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rtmcemd --sce="63.111.106.7;63.111.106.12" --file=servicecfg.pagb
--source-dir=/rtm-templates --dest-dir=/rtm-output -c./rtmcmd.cfg

Example 2

To use the service configuration loaded on the SCE platform at 63.111.106.7 to create configuration and
report files for the collecting and reporting of SNMP information from two SCE platforms (at
63.111.106.7 and 63.111.106.12):

rtmemd -S "63.111.106.7;63.111.106.12" -U userl23 -P **** _—_pgb-sce=63.111.106.7
--source-dir=/rtm-templates --dest-dir=/rtm-output -c./rtmcmd.cfg

The rtmcemd User Configuration File

The user configuration file contains user-specific information required by the rtmemd utility. The SCA
BB utilities distribution package contains a sample configuration file, named rtmcmd.cfg. You should
edit this file according to the details of your setup.

Table 13-9 lists the configuration parameters that should be present in the user configuration file:

Table 13-9 rtmcmd User Configuration File Parameters
Required/
Parameter Description |Description Default Value |Optional
rrdtool_bin_dir The absolute path to the directory where Required
RRDTool and RRDCGI binary files are
installed.
rtm_dir The absolute path to the directory where Required

RRD archives and CGl files are stored. This
is under the web server web directory.

mrtg_bin_dir The absolute path to the directory where Required
MRTG binary files are installed.

Thislocation is used to create MRTG
invocation commands in the crontab sample
file.

snmpCommunityString | The SNMP community string to use when Public Required
accessing the SCE platforms.

The configuration text file is alisting of key-value pairs, where the key is one of the parameters listed
above, in the following format:

« Each key-value pair is on a separate line.

« A key-value pair may be extended across several adjacent lines by putting a back slash character,
“\", at the end of each line.

» Tousean actual back slash in the value (as in directory names on Windows), the back slash should
be escaped with a second back slash, like this: “\\” (or use a slash “/").

- Tocomment aline, add “#” or “!” at the beginning of the line.

For example:
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# This is a comment line.
# Directory names should use escape backslashes:
rtm_dir=D:\\PROGRA~1\\APACHE~1\\Apache2.2\\htdocs

An rtmcmd User Configuration File Example

#The absolute path to the RRD tool's execution files folder
#Use '\\' or '/' as path separator
rrdtool_bin_dir=C:/rrdtool-1.2.15/rrdtool/Release

#The absolute path where RTM files will be placed.

#This path will be used by MRTG to create and update the RRD files
#Note: path must not contain white spaces!
rtm_dir=C:/PROGRA~1/APACHE~1/Apache2.2/htdocs

#The absolute path to the MRTG bin folder.
#This path will be used to create file crontab.txt
mrtg_bin_dir=C:/mrtg-2.14.5/bin

#The SCE's community string
snmpCommunityString=public

The SCA BB Signature Configuration Utility

The SCA BB Signature Configuration Utility (sigconf) is a command-line utility for installing and
managing the default DSS.

The Signature Configuration Utility can run in Windows, Solaris, and Linux environments.
For installation instructions, see How to Install the SCA BB Configuration Utilities, page 4-8.

sigconf Syntax

The command-line syntax of the SCA BB Signature Configuration Utility is:

sigconf <operation> [--file <filename>]

Table 13-10 lists the sigconf operations.
Table 13-11 lists the sigconf option.

Table 13-10 sigconf Operations

Operation Abbreviation |Description

--set-default-dynamic-signature -d Installs the default DSS on this workstation

--remove-default-dynamic-signature Uninstalls the default DSS from this
workstation

--get-default-dynamic-signature Fetches the default DSS installed on this
workstation

--help Displays help, then exits

Cisco Service Control Application for Broadband User Guide
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Table 13-11 sigconf File Option

File Option

Abbreviation

Description

--file filename

-f

SpecifiesaDSSfile

sigconf Examples

Example 1

To install the file new_signature.dss as the default DSS:

sigconf --set-default-dynamic-signature --file new_signature.dss

Example 2

To retrieve the installed default DSS file, and save it as default_backup.dss:

sigconf --get-default-dynamic-signature --file default_backup.dss

Overview of SNMP, MIB, and Traps

Cisco provides complete network FCAPS (Fault, Configuration, Accounting, Performance, Security)

management.

Two interfaces are provided for network management:

« Command-line interface (CLI)—Accessible through the console port on the front panel of the SCE
platform or through a Telnet connection to the SCE platform, the CL1 is used for configuration and

security functions.

- SNMP (Simple Network Management Protocol)—Provides fault management (via SNM P traps) and
performance monitoring functionality.

SNMP

SNMP is aset of protocols for managing complex networks. SNM P works by sending messages, called
protocol data units (PDUSs), to different parts of a network. SNMP-compliant devices, called agents,
store data about themselves in Management Information Bases (MIBs) and return this datato the SNMP

requesters.

The SCE platform operating system includes an SNMP agent. Configuring the SNMP agent parameters
and enabling the SNMP interface is described in either the “ Configuring the Management I nterface and
Security” chapter of the Cisco SCES8000 10GBE Software Configuration Guide or the “ Configuring the
Management Interface and Security” chapter of the Cisco SCE8000 GBE Software Configuration Guide.

MIB

Management Information Bases (MIBs) are databases of objects that can be monitored by a network
management system. SNM P uses standardized M1B formats that allow standard SNM P tools to monitor

any device defined by a MIB.

[l Cisco Service Control Application for Broadband User Guide
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The SCE platform supports the following MIBs:

« MIB-lI—Defined in RFC 1213, (Management Information Base for Network Management of
TCP/IP-based Internets)

» Cisco Service Control Enterprise MIB—Described by a number of MIB files

The Cisco proprietary MIB allows external management systems to retrieve general information about
the SCE platform operating status and resource utilization, extract real -time measurements of bandwidth
utilization and network statistics, and receive notifications of critical events and alarms.

The part of the Cisco proprietary MIB that provides configuration and runtime status for SCA BB is
documented in the “SCA BB Proprietary MIB Reference” chapter of the Cisco Service Control
Application for Broadband Reference Guide. Other parts of the Cisco proprietary MIB are documented
in either the “Proprietary MIB Reference” appendix of the Cisco SCE8000 10GBE Software
Configuration Guide or the “Proprietary MIB Reference” appendix of the Cisco SCES8000 GBE Software
Configuration Guide. These books also explain the order in which the MIB must be |oaded.

Traps are unsolicited messages generated by the SNM P agent that residesinside the SCE platform. Traps
are generated when an event occurs. When the Network Management System receives the trap message,
it can take suitable actions, such as logging the occurrence or ignoring the signal.

The SCE platform supports two general categories of traps:
» Standard SNMP traps—As defined in RFC 1157 and using the conventions defined in RFC 1215
» Proprietary Cisco Service Control Enterprise traps—As defined in the Cisco proprietary MIB

For a description of the SNMP traps and an explanation of how to configure the SNMP trap
managers, see either the “ Configuring and Managing the SNMP Interface” section in the
“Configuring the Management Interface and Security” chapter of the Cisco SCES8000 10GBE
Software Configuration Guide or the “Configuring and Managing the SNMP Interface” section in
the “ Configuring the Management Interface and Security” chapter of the Cisco SCE8000 10GBE
Software Configuration Guide.

Installing PQI Files from the Command Line

« How to Install a SCA BB PQI File on an SCE Platform, page 13-9
- How to Enter Line Interface Configuration Mode, page 13-10

How to Install a SCA BB PQI File on an SCE Platform

You caninstall aSCA BB PQI file on an SCE platform using the SCE platform Command-Line Interface
(CLI).

Make sure that the PQI fileis available.
Do one of the following:
« Locate the PQI file on the SCE platform.
« Upload the appropriate PQI file to the SCE via FTP.
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Step2  Enter line interface configuration mode. (See How to Enter Line Interface Configuration Mode,
page 13-10.)

Step3  Typepqi install file engXXXXX.pqi.
Step4  Monitor the installation progress until it is completed.

What to Do Next

After you install the Console, you can use the Network Navigator tool to install PQI files. See How to
Install PQI Files on SCE Devices, page 5-24.

How to Enter Line Interface Configuration Mode

Stepl At the SCE platform CLI prompt (sce#), type configure.
Step 2 Press Enter.
The scE (config) # prompt appears.
Step3  TypeinterfaceLineCard O.
Step4  Press Enter.

The sce (config if)# prompt appears.

Managing Subscribers via Other System Components

Other components of the Cisco Service Control solution offer alternatives for subscriber management
(as opposed to using the Subscriber Manager GUI tool in the Console):

» The Cisco Service Control Management Suite (SCMS) Subscriber Manager (SM) has options that
are not available from the Console.

- The SCE platform has a wide range of subscriber-related functions.

This section gives an overview of these alternatives, with emphasis on the SCA BB-specific subscriber
management options. For in-depth explanations, see the appropriate Service Control documentation.

« Anonymous Subscriber Mode, page 13-10

e Subscriber-Aware Mode, page 13-11

» Selecting Subscribers for Real-Time Usage Monitoring, page 13-13
- Managing Subscriber CSV Files, page 13-15

Anonymous Subscriber Mode

An anonymous subscriber is one with a name generated automatically by the SCE platform according to
an anonymous subscriber group specification. An anonymous subscriber is always mapped to asingle
IP address. The actual identity of the customer is unknown to the system.
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An anonymous group is a specified I P range, possibly assigned a subscriber template. If an anonymous
group is configured, the SCE platform generates anonymous subscribers for that group when it detects
traffic with an | P address in the specified | P range. If a subscriber template is assigned to the group, the
anonymous subscribers generated have properties defined by that template. If no subscriber template is
assigned, the default template is used, which cannot be changed by template import operations. Initially,
32 templates are preconfigured, one for each package ID.

Anonymous subscriber groups and subscriber templates are managed using the SCE platform
Command-Line Interface (CL1). You can enter CLI commands via a Telnet session. For more
information, see the Cisco SCE 8000 CLI Command Reference or the Cisco SCE 2000 and SCE 1000
CLI Command Reference.

Use the following commands to import anonymous subscriber groups and subscriber templates from
CSV files and to export subscriber data to these files:

» subscriber anonymous-group import csv-file
» subscriber anonymous-group export csv-file
» subscriber template import csv-file
» subscriber template export csv-file

The preceding CLI commands are line interface configuration commands. You must enter line interface
configuration mode (see How to Enter Line Interface Configuration Mode, page 13-10) and see the
SCE(config if)# prompt displayed before entering a command.

Use the following commands to del ete anonymous groups or subscriber templates from the system.
» no subscriber anonymous-group [all] [name <groupname>]
« clear subscriber anonymous
» default subscriber template all

The preceding CLI commands are line interface configuration commands. You must enter line interface
configuration mode (see How to Enter Line Interface Configuration Mode, page 13-10) and see the
SCE(config if)# prompt displayed before entering a command.

Use the following commands to display anonymous subscriber information:
- show interface LineCard O subscriber templates [index]
» show interface LineCard O subscriber anonymous-group [all] [name <groupname>]
» show interface LineCard O subscriber amount anonymous [ name <groupname>]

» show interface LineCard O subscriber anonymous [name <groupname>]

Subscriber-Aware Mode

In subscriber-aware mode, each subscriber is a specific customer with an externally generated name.
This externally generated name allows the subscriber to be mapped to more than one | P address and still
be identified. Each traffic session (single IP flow, or a group of related IP flows) processed by the SCE
platform is assigned to a recognized subscriber on the basis of the configured subscriber mappings.

There are three options for introducing and managing these subscribers:
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» The SM GUI tool (see Using the SM GUI Tool, page 11-1)
» The SCE platform subscriber CLI
» The SM subscriber management CLU

The SCE Platform Subscriber CLI

Note

Note

Use the following commands to import subscriber data from CSV files and to export subscriber data to
these files:

subscriber import csv-file
subscriber export csv-file

The preceding CLI commands are line interface configuration commands. You must enter line interface
configuration mode (see How to Enter Line Interface Configuration Mode, page 13-10) and see the
SCE(config if)# prompt displayed before entering a command.

Use the following command to remove subscribers from the system.

no subscriber [all] [name <subscriber-name>]

The preceding CLI command is aline interface configuration commands. You must enter line interface
configuration mode (see How to Enter Line Interface Configuration Mode, page 13-10) and see the
SCE(config if)# prompt displayed before entering the command.

Use the following commands to display subscribers meeting various criteria:

show interface LineCard 0 subscriber [amount]

[prefix <prefix>] [property <propertyname> equals \ greater-than | less-than
<property-val>]

show interface LineCard
show interface LineCard

0 subscriber [amount] prefix <prefix>
0
show interface LineCard 0 subscriber mapping IP <iprange>
0
0

subscriber [amount] suffix <suffix>

show interface LineCard subscriber [amount] mapping intersecting IP <iprange>
show interface LineCard subscriber mapping VLANid <vlanid>

Use the following commands to display information about a specific subscriber:

subscriber properties
subscriber name <name>

show interface LineCard 0

show interface LineCard 0

show interface LineCard 0 subscriber name <name> mappings

show interface LineCard 0 subscriber name <name> counters
0

show interface LineCard subscriber name <name> properties

The SM Subscriber Management CLU

The SM Subscriber Management Utility (p3subs) isa CLU for managing subscribers. You can useit to
add or remove subscribers. You can also manage subscriber properties and mappings with this utility.

For more information about p3subs, see the Cisco Service Control Management Suite Subscriber
Manager User Guide.

p3subs Syntax
You run p3subs from the Solaris shell prompt. The command-line syntax of the utility is:
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p3subs <operation> --subscriber=<Subscriber-Name> [--ip=<IP-address>]
[--property=<property-name=value>] [--domain=<domain-name>] [--overwrite]

The following table lists the p3subs operations relevant to managing subscribers.

Table 13-12 p3subs Subscriber Operations

Operation Description

--add Adds a subscriber or replaces the existing subscriber configuration
--set Updates mappings and properties for the specified subscriber
--remove Removes the specified subscriber

--show Displays information for specified subscriber

Selecting Subscribers for Real-Time Usage Monitoring

A

Real-Time Subscriber Usage RDRs report the network activity of a single subscriber per service per
metric, in real-time. You must enable the generation of these subscriber usage RDRs separately for each
subscriber that you wish to monitor.

Caution

Generating and collecting Real-Time Subscriber Usage RDRs for many subscribers can compromise

performance. Enable Real-Time Subscriber Usage RDR generation only for subscribers that must be
monitored.

Generation of Real-Time Subscriber Usage RDRs is controlled by the monitor subscriber property. By
default, generation of these RDRsisdisabled (monitor = 0). TO enable generation of the RDRs, change
the value of the property to 1.

You can modify this property for selected subscribers using either the SM Command-Line Utility (CLU)
or the SCE platform CLI.

« Managing Subscriber Monitoring viathe SM, page 13-13
» Managing Subscriber Monitoring via the SCE Platform, page 13-14

Managing Subscriber Monitoring via the SM

You can enable or disable the generation of the Real-Time Subscriber Usage RDRs using the SM p3subs
utility. You can also create a file that processes a batch of subscribers. For more information, see the
Cisco Service Control Management Suite Subscriber Manager User Guide.

- How to Enable Subscriber Monitoring for a Subscriber, page 13-13

- How to Disable Subscriber Monitoring for a Subscriber, page 13-14

- How to Enable Subscriber Monitoring for Multiple Subscribers, page 13-14

« How to Verify that Subscriber Monitoring is Enabled for a Subscriber, page 13-14

How to Enable Subscriber Monitoring for a Subscriber
You can enable subscriber monitoring for a specified subscriber.
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Step 1

Step 1

Step 1

Step 2

Step 1

From the command line, run sm/server/bin/p3subs --set --subscriber Smith --property monitor=1.

How to Disable Subscriber Monitoring for a Subscriber

You can disable subscriber monitoring for a specified subscriber.

From the command line, run sm/server/bin/p3subs --set --subscriber Smith --property monitor=0.

How to Enable Subscriber Monitoring for Multiple Subscribers

You can enable subscriber monitoring for multiple subscribers.

Create a text file (named monitor.txt in this example) containing the sequence of CLU invocations.
The file would look something like this:

p3subs --set --subscriber Jerry --property monitor=1
p3subs --set --subscriber George --property monitor=1
p3subs --set --subscriber Elaine --property monitor=1
p3subs --set --subscriber Kramer --property monitor=1
p3subs --set --subscriber Newman --property monitor=1

From the command line, run sm/server /bin/p3batch -f monitor.txt.

How to Verify that Subscriber Monitoring is Enabled for a Subscriber

You can check to see whether subscriber monitoring is enabled for a specific subscriber.

From the command line, run sm/server/bin/p3subs --show-property --subscriber Smith --property
monitor.

Managing Subscriber Monitoring via the SCE Platform

Step 1

You can also enable or disable the generation of the Real-Time Subscriber Usage RDRs using the SCE
platform. For more information, see the Cisco SCE8000 CLI Command Reference.

- How to Enable Subscriber Monitoring for a Subscriber, page 13-14

- How to Disable Subscriber Monitoring for a Subscriber, page 13-15

- How to Enable Subscriber Monitoring for Multiple Subscribers, page 13-15

» How to Verify that Subscriber Monitoring is Enabled for a Subscriber, page 13-15

How to Enable Subscriber Monitoring for a Subscriber
You can enable subscriber monitoring for a specified subscriber.

Enter line interface configuration mode. (See How to Enter Line Interface Configuration Mode,
page 13-10.)
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At the sce(config if)# prompt, run subscriber name Smith property name monitor value 1.

How to Disable Subscriber Monitoring for a Subscriber
You can disable subscriber monitoring for a specified subscriber.

Enter line interface configuration mode. (See How to Enter Line Interface Configuration Mode,
page 13-10.)

At the sce(config if)# prompt, run subscriber name Smith property name monitor value O.

How to Enable Subscriber Monitoring for Multiple Subscribers
You can enable subscriber monitoring for multiple subscribers.

Create atext file (named monitor.txt in this example) containing the sequence of CLI invocations,
including the commands to access the appropriate CL1 mode.

The file would ook something like this:

configure

interface LineCard 0

subscriber name Jerry property name monitor value 1
subscriber name George property name monitor value
subscriber name Elaine property name monitor value
subscriber name Kramer property name monitor value
subscriber name Newman property name monitor value

I N

From the SCE platform CLI prompt (sce#), run script run monitor.txt.

How to Verify that Subscriber Monitoring is Enabled for a Subscriber
You can check to see whether subscriber monitoring is enabled for a specific subscriber.

From the SCE platform CLI prompt (sce#), run show interface LineCard 0 subscriber name Smith
properties.

The properties are displayed; monitor istherelevant parameter.

Subscriber smith properties:
subscriberPackage=0

monitor=1

Subscriber 'smith' read-only properties

Managing Subscriber CSV Files

Use the p3subsdb SM utility to import and export subscriber CSV files. You can import subscriber
information for a group of subscribers from a CSV file into the SM database. You can also export
subscriber information from the SM database to a CSV file.
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For more information, see the Cisco Service Control Management Suite Subscriber Manager User
Guide.

CSV file structure is described in the “CSV File Formats” chapter of the Cisco Service Control
Application for Broadband Reference Guide.

» How to Import Subscriber CSV Files, page 13-16
» How to Export Subscriber CSV Files, page 13-16

How to Import Subscriber CSV Files

Stepl At the Solaris shell prompt, run p3subsdb --import <filename>.

How to Export Subscriber CSV Files

Stepl At the Solaris shell prompt, run p3subsdb --export <filename>.

Example: Filtering and Exporting Subscribers

The following example exports every subscriber whose name begins with ‘a’ to the file
silverSubscriberFile.csv

p3subsdb --export --prefix=a --output=silverSubscriberFile.csv
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